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SOP: Oakton PC 700 Bench Series pH/ Conductivity/°C/°F Meter 

Approvals: 

Preparer: Jason McMillan Date 08JAN14 

Reviewer: Dr. Margaret Bryans Date 10JAN14 

1. Purpose:

1.1. To calibrate and operate the Oakton PC 700 Bench Series pH/ Conductivity/°C/°F Meter.

2. Scope:

2.1. To measure the pH and conductivity of solutions and media.

3. Responsibilities:

3.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as directed and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while performing 

the procedure. 

4. References:

4.1. Oakton Bench 700 Series Quick Guide

4.2. Oakton PC 700 Instruction Manual

5. Definitions: N/A

6. Precautions:

6.1. Use caution when handling all samples due to unknown pH.

6.2. Do not wipe or rub pH electrode. This will create a static build up that will interfere with

measurements. 

6.3. Always wear the appropriate personal protective equipment (PPE). 

7. Materials:

7.1. Oakton PC 700 pH Meter and electrodes

7.2. pH electrode storage solution

7.3. commercially made pH standard buffers as required

7.4. wash bottle

7.5. MilliQ water

7.6. waste beaker

7.7. laboratory tissues, such as Kimwipes

8. Procedure:

8.1. pH Preparation

8.1.1. Select the pH 7 standard buffer and a second standard (and third if needed) buffer 

that brackets the expected sample pH. 

8.1.2. Prepare buffers according to manufacturer’s instructions if needed, and ensure that 

they are not expired. 

8.2. pH Calibration 

8.2.1. Press the power key to turn on the pH meter. 

8.2.2. Gently remove the protective cap/sleeve from the bottom of the pH electrode. 

8.2.3. Rinse the pH electrode with MilliQ water and gently blot dry with a laboratory 

tissue. 

8.2.4. Press the “MODE” key until “pH” is displayed on the right side of primary (top) 
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SOP: Oakton PC 700 Bench Series pH/ Conductivity/°C/°F Meter 

reading.      

8.2.5. Dip the pH electrode into the first pH buffer and press the “CAL/MEAS” key. The 

secondary (bottom) reading will lock onto the appropriate buffer value. Provide 

stirring for best results. When the READY indicator appears in the top left portion 

of the LCD screen, press the “ENTER” key to accept. The primary reading will 

flash briefly before the secondary reading begins scrolling the remaining buffers 

available. 

8.2.6. Rinse the pH electrode with MilliQ water, gently blot dry with a laboratory tissue, 

and then dip the pH electrode into the second pH buffer. The secondary reading will 

lock onto the appropriate buffer value. When the READY indicator appears, press 

the “ENTER” key to accept. The primary reading will flash briefly and then display 

the percent efficiency (slope) before the secondary reading begins scrolling the 

remaining available buffers. 

8.2.7. Press the “CAL/MEAS” key to return to measurement mode or to calibrate a third 

buffer repeat step 8.2.6. 

8.2.8. Remove the pH electrode from the solution, rinse the pH electrode with MilliQ 

water and blot dry with a laboratory tissue. 

8.2.9. Replace storage cap if immediate measurement of sample is not needed. 

8.3. pH Measurement 

8.3.1. If necessary, gently remove the protective cap/sleeve from the bottom of the pH 

electrode, rinse the pH electrode with MilliQ water and blot dry with laboratory 

tissue. Be sure MEAS is visible on the top left side of the LCD display 

8.3.2. Insert pH electrode into the sample. Provide stirring. 

8.3.3. Read pH value on the primary reading when the value has stabilized. 

8.3.4. Remove the pH electrode from the solution, rinse the pH electrode with MilliQ 

water and blot dry with a laboratory tissue. 

8.3.5. Repeat steps 8.3.2. through 8.3.4. for additional samples. 

8.3.6. When finished, replace protective cap onto end of the pH electrode and turn off the 

pH meter by pressing the power key. 

8.4. Automatic Conductivity Calibration 

8.4.1. Press the “MODE” key as needed to select conductivity (µS or mS). 

8.4.2. Dip the conductivity electrode into the selected conductivity standard beyond the 

upper steel band (utilize the fill line on the outside of the probe guard for reference) 

and press the “CAL/MEAS” key. Provide stirring. 

8.4.3. The primary reading will show the factory default value, while the secondary 

reading will lock on the appropriate automatic standard value from Table 1. 

8.4.4. When the READY indicator appears, press the “ENTER/RANGE” key to accept. 

The primary reading will flash briefly before returning to measurement mode upon 

successful calibration. 

8.5. Conductivity Measurement 

8.5.1. Rinse the conductivity electrode with MilliQ water and gently blot dry with a 

laboratory tissue. 
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SOP: Oakton PC 700 Bench Series pH/ Conductivity/°C/°F Meter 

8.5.2. Dip the conductivity electrode into the sample beyond the upper steel band (utilize 

the fill line on the outside of the probe guard for reference).    

8.5.3. Allow time for the reading to stabilize on the primary reading. The clear yellow 

protective probe guard must be attached during measurement to prevent 

erroneous results. 

8.5.4. Rinse the conductivity electrode with MilliQ water and gently shake off any excess 

water droplets. 

8.5.5. Turn off the pH/Conductivity meter by pressing the power key. 

9. Attachments:

Figure 1: Oakton PC 700 LCD Annunciators 

(http://static.coleparmer.com/large_images/35420_20a.jpg) 

Oakton PC 700 Manual 
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Figure 2: Meter Connections 
Oakton PC 700 Manual 

Figure 3: Conductivity Electrode 

Oakton PC 700 Manual 

Protective 

Probe Guard 
Sensor Housing 

Stainless Steel 

Bands 
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Table 1: Conductivity Calibration Standard values 

Oakton PC 700 Manual 

10. History:

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 08JAN14 Jason McMillan Initial release 
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 SOP: Denver Instruments APX 323 Balance Calibration 

Approvals: 

Preparer: Jason McMillan Date: 10JAN14 

Reviewer: Tim Kull  Date: 11JAN14 

Reviewer: Dr. Maggie Bryans Date: 12JAN14 

1. Purpose:

1.1. Calibration of Denver Instruments APX 323 Balance. 

2. Scope:

2.1. Applies to the calibration of Denver Instruments APX 323 Balance.     

3. Responsibilities:

3.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is 

performed as directed and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and 

to inform the instructor about any deviations or problems that may occur while 

performing the procedure. 

4. References:

4.1. Denver Instruments APX 323 Balance Instruction Manual 

4.2. Denver Instruments APX 323 Balance Operation SOP 

5. Definitions: N/A

6. Precautions: N/A

7. Materials:

7.1. 200g ASTM Weight Class 2 Mass Standards for External Calibration 

7.2. Denver Instruments APX 323 Balance  

8. Procedure:

8.1. Calibration 

8.1.1. Press “I/O” button to turn the balance on.  

8.1.2. Be sure the weighing pan is clear and press the “ZERO” button to tare the 

balance.  

8.1.3. Press and hold the “PRINT/MENU” button for three seconds or until the 

word Unit appears on the screen and then release.  

8.1.4. Press the “PRINT/MENU” button and Cal is displayed. 

8.1.5. Press the “ARROW” button to enter calibration mode.  

8.1.6. The proper weight needed for calibration is then displayed in grams, 200g 

in this case.  

8.1.7. Place the 200g ASTM Class 2 Mass Standard on the weighing pan. Use 

utensils, do not handle mass standard with your hands.  

8.1.8. When a stable reading has been recorded, the balance will beep, the screen 

will flash (- -) and the reading will return to the weight of the calibration 

weight.  

8.1.9. Calibration is complete. Remove the 200g ASTM Class 2 Mass Standard 

and the balance is now ready to use. 
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 SOP: Denver Instruments APX 323 Balance Calibration 

8. Attachments:

Figure 1:  Denver Instrument APX 323 Display and Keyboard 

Denver Instrument APX 323 Manual 

10. History:

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 10JAN14 Jason McMillan Initial release 
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 SOP: Denver Instrument APX 323 Balance Operation 

Approvals: 

Preparer: Jason McMillan Date: 10JAN14 

Reviewer: Dr. Maggie Bryans Date: 11JAN14 

1. Purpose:

1.1. Operation of Denver Instrument APX 323 Balance. 

2. Scope:

2.1. Applies to the weight measurement of laboratory materials.

3. Responsibilities:

3.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is 

performed as directed and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and 

to inform the instructor about any deviations or problems that may occur while 

performing the procedure. 

4. References:

4.1. Denver Instrument APX 323 Balance Instruction Manual. 

5. Definitions: N/A

6. Precautions: N/A

7. Materials:

7.1. Appropriate weighing container(s) such as a weigh boat, weigh paper, beaker, flask, 

bottle, etc. 

8. Procedure:

8.1. Simple Weighing 

8.1.1. Turn the scale on using the “I/O” button. 

8.1.2. Place weighing container on the balance weighing pan. Press the “ZERO” 

button to zero the weight display. (- -) will appear on the display 

indicating the balance is being zeroed. The balance will then read 0.0000 

after successful taring.  

8.1.3. Remove the weighing container. Load weighing container with material to 

be weighed.  Place loaded weighing container on the weighing pan.  

8.1.4. When the reading is stable the unit of measurement will appear in the 

bottom right-hand corner.   

8.1.5. Record the weight and remove the loaded weighing container. 

8.1.6. To turn balance off, press and hold the “ON/OFF” button. 

8.2. Select Weighing Units 

8.2.1. Press “ON/OFF” button to turn the balance on.  

8.2.2. Press the “Arrow KEY” button to scroll between units. 
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 SOP: Denver Instrument APX 323 Balance Operation 

9. Attachments:

Figure 1: Denver Instrument APX 323 Display and Keyboard 

Denver Instrument APX 323 Manual 

10. History:

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 10JAN14 Jason McMillan Initial release 
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 SOP: Denver Instruments PI 403 Balance Calibration 

Approvals: 

Preparer: Jason McMillan Date: 09JAN14 

Reviewer: Dr. Maggie Bryans Date: 10JAN14 

1. Purpose:

1.1. Calibration of Denver Instruments PI 403 Balance. 

2. Scope:

2.1. Applies to the calibration of Denver Instruments PI 403 Balance.         

3. Responsibilities:

3.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is 

performed as directed and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and 

to inform the instructor about any deviations or problems that may occur while 

performing the procedure. 

4. References:

4.1. Denver Instruments PI 403 Balance Instruction Manual 

4.2. Denver Instruments PI 403 Balance Operation SOP 

5. Definitions: N/A

6. Precautions: N/A

7. Materials:

7.1. 200g Class 2 or better mass standard for External Calibration 

7.2. Denver Instruments SI 4002 Balance  

8. Procedure:

8.1. External Calibration 

8.1.1. Press the “TARE” button. 

8.1.2. Place the 200g Class 2 or better mass standard on the weighing pan. Use 

utensils do not touch the mass standard with your hands. 

8.1.3. Press the “CALIBRATION” button. 

8.1.4. The unit will display CAL external.  

8.1.5. When calibration is complete the reading of the weight will be displayed 

and the unit will return to measurement mode. 

8.2.   Internal Calibration 

8.3.1. Press the “TARE” button.  

8.3.2. Press the “CALIBRATION” button. 

8.3.3. The unit will display CAL internal and perform the calibration.  

8.3.4. When calibration is complete, the unit will return to measurement mode. 
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 SOP: Denver Instruments PI 403 Balance Calibration 

9. Attachments:

Figure 1:  Denver Instrument PI 403 

Denver Instrument PI 403 Manual 

Figure 2:  Denver Instrument PI 403 Display and Keyboard 

Denver Instrument PI 403 Manual 
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10. History:

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 09JAN14 Jason McMillan Initial release 
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 SOP: Denver Instrument PI 403 Balance Operation 

Approvals: 

Preparer: Jason McMillan Date: 10JAN14 

Reviewer: Dr. Margaret Bryans Date: 11JAN14 

1. Purpose:

1.1. Operation of Denver Instrument PI 403 Balance. 

2. Scope:

2.1. Applies to the weight measurement of laboratory materials.     

3. Responsibilities:

3.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is 

performed as directed and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and 

to inform the instructor about any deviations or problems that may occur while 

performing the procedure. 

4. References:

4.1. Denver Instrument PI 403 Balance Instruction Manual. 

5. Definitions: N/A

6. Precautions: N/A

7. Materials:

7.1. Appropriate weighing container(s) such as a weigh boat, weigh paper, beaker, flask, 

bottle, etc. 

8. Procedure:

8.1. Simple Weighing 

8.1.1. Place weighing container on the balance weighing pan. Press the “TARE” 

button to zero the weight display. 

8.1.2. TARING displayed on the screen indicates that the balance is waiting for 

the stable reading before taring. 

8.1.3. The balance will read 0.0000 grams (or selected units to designated 

resolution) after successful taring. 

8.1.4. When the reading is stable, the Denver Instrument icon appears in the 

top, left on the display. When unstable, a U appears.  

8.1.5. Remove the weighing container. Load weighing container with material to 

be weighed.  Place loaded weighing container on the weighing pan. 

Weight for the Denver Instrument icon to appear in the upper left-hand 

corner.  

8.1.6. Record the weight and remove the loaded weighing container. 
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 SOP: Denver Instrument PI 403 Balance Operation 

9. Attachments:

Figure 1:  Denver Instrument PI 403 

Denver Instrument PI 403 Manual 

Figure 2: Denver Instrument PI 403 Display 

Denver Instrument PI 403 Manual 
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10. History:

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 10JAN14 Jason McMillan Initial release 
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 SOP: Denver Instruments SI 4002 Balance Calibration 

Approvals: 

Preparer: Jason McMillan Date: 09JAN14 

Reviewer: Dr. Margaret Bryans Date: 10JAN14 

1. Purpose:

1.1. Calibration of Denver Instruments SI 4002 Balance. 

2. Scope:

2.1. Applies to the calibration of Denver Instruments SI 4002 Balance.       

3. Responsibilities:

3.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is 

performed as directed and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and 

to inform the instructor about any deviations or problems that may occur while 

performing the procedure. 

4. References:

4.1. Denver Instruments SI 4002 Balance Instruction Manual 

4.2. Denver Instruments SI 4002 Balance Operation SOP 

5. Definitions: N/A

6. Precautions: N/A

7. Materials:

7.1. Denver Instruments SI 4002 Balance 

8. Procedure:

8.1. Internal Calibration 

8.1.1. Press “ON/OFF” button to turn the balance on.  

8.1.2. Press the “TARE” button to tare the balance. 

8.1.3. Press the “CAL” button to start calibration. CAL.INT. will be displayed 

followed by CAL.RUN. while the built in weight is applied automatically. 

8.1.4. When calibration is finished the display will read CAL.END and the 

balance is ready to use. 

17



Montgomery County Community College 

340 DeKalb Pike 

Blue Bell, PA 19422  

Document Number:  4.1.0 

Revision Number: 0 

Effective Date: 10JAN14 

Page 2 of 2 

 SOP: Denver Instruments SI 4002 Balance Calibration 

9. Attachments:

Figure 1:  Denver Instrument SI 4002 

Denver Instrument SI 4002 Manual 

Figure 2:  Denver Instrument SI 4002 Display 

Denver Instrument SI 4002 Manual 

10. History:

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 09JAN14 Jason McMillan Initial release 
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 SOP: Denver Instrument SI 4002 Balance Operation 

Approvals: 

Preparer: Jason McMillan Date: 09JAN14 

Reviewer: Dr. Maggie Bryans Date: 10JAN14 

1. Purpose:

1.1. Operation of Denver Instrument SI 4002 Balance. 

2. Scope:

2.1. Applies to the weight measurement of laboratory materials.

3. Responsibilities:

3.1. It is the responsibility of the course instructor /lab assistant to ensure that this SOP is 

performed as directed and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and 

to inform the instructor about any deviations or problems that may occur while 

performing the procedure. 

4. References:

4.1. Denver Instrument SI 4002 Balance Instruction Manual. 

5. Definitions: N/A

6. Precautions: N/A

7. Materials:

7.1. Appropriate weighing container(s) such as a weigh boat, weigh paper, beaker, flask, 

bottle, etc. 

8. Procedure:

8.1. Simple Weighing 

8.1.1. Turn the scale on using the “ON/OFF” button. 

8.1.2. Place weighing container on the balance weighing pan. Press the “TARE” 

button to zero the weight display. 

8.1.3. Remove the weighing container. Load weighing container with material to 

be weighed.  Place loaded weighing container on the weighing pan. Read 

off the weight indicated on the display when g appears on the right side of 

the weight. 

8.1.4. Remove the loaded weighing container.  

8.1.5. To turn balance off, press and hold the “ON/OFF” button. 

8.1.6. Clean off the top of the balance using the balance cleaning brush being 

sure to apply minimal pressure. 

9. Troubleshooting

9.1. See Table 1 
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10. Attachments:

Figure 1:  Denver Instrument SI 4002 

Denver Instrument SI 4002 Manual 
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Figure 2: Denver Instrument SI 4002 Display 

Denver Instrument SI 4002 Manual 

Table 1: Troubleshooting Guide 
Denver Instrument SI 4002 Manual 
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1. Purpose:

1.1. Operation of Fisher Accu 124 Balance. 

2. Scope:

2.1. Applies to the weight measurement of laboratory materials.     

3. Responsibilities:

3.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is 

performed as directed and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and 

to inform the instructor about any deviations or problems that may occur while 

performing the procedure. 

4. References:

4.1. Fisher Accu 124 Balance Instruction Manual. 

5. Definitions: N/A

6. Precautions: N/A

7. Materials:

7.1. Fisher Accu 124 Balance 

7.2. 100g ASTM Class 1 Standard Mass 

8. Procedure:

8.1. Internal Calibration 

8.1.1. Press the “TARE” button to zero the weight display TARING will be 

displayed. 

8.1.2. Press the “CALIBRATION” button. CAL will be displayed during 

calibration. 

8.1.3. When calibration is complete the unit will return to the measurement 

mode. 

8.2. External Calibration 
8.2.1. Press the “TARE” button to zero the weight display.  

8.2.2. Gently place the 100g ASTM Class 1 mass standard on the balance. Be 

sure to use utensils, do not use your hand. 

8.2.3. Press the “CALIBRATION” button. 

8.2.4. The display will read CAL.  

8.2.5. When calibration is complete the display will read 100g and the unit will 

return to measurement mode. 
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9. Attachments:

Figure 1:  Fisher Accu 124 

Fisher Accu 124 Manual 

Figure 2: Fisher Accue 124 Display 

Fisher Accu 124 Manual 

10. History:

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 14JAN14 Jason McMillan Initial release 
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1. Purpose:

1.1. Operation of Fisher Accu 124 Balance. 

2. Scope:

2.1. Applies to the weight measurement of laboratory materials.     

3. Responsibilities:

3.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is 

performed as directed and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and 

to inform the instructor about any deviations or problems that may occur while 

performing the procedure. 

4. References:

4.1. Fisher Accu 124 Balance Instruction Manual. 

5. Definitions: N/A

6. Precautions: N/A

7. Materials:

7.1. Appropriate weighing container(s) such as weigh boat, weigh paper, beaker, flask, 

bottle, etc. 

8. Procedure:

8.1. Simple Weighing 

8.1.1. Place weighing container on the balance weighing pan. Press the “TARE” 

button to zero the weight display TARING will be displayed and then the 

display will read 0.0000g (or selected units to the designated resolution). 

When the reading is stable the weigh units will appear under the weight 

reading on the display.  

8.1.2. Remove the weighing container. Load weighing container with material to 

be weighed.  Place loaded weighing container on the weighing pan. When 

the reading is stable the weigh units will appear under the weight reading 

on the display. Record the weight indicated on the display. 

8.1.3. Remove the loaded weighing container. 
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9. Attachments:

Figure 1:  Fisher Accu 124 

      Fisher Accu 124 Manual 

Figure 2: Fisher Accue 124 Display 

Fisher Accu 124 Manual 

10. History:

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 14JAN14 Jason McMillan Initial release 
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1. Purpose:

1.1. Operation of Fisher Accu 124D Balance. 

2. Scope:

2.1. Applies to the weight measurement of laboratory materials.     

3. Responsibilities:

3.1. It is the responsibility of the course instructor /lab assistant to ensure that this SOP is 

performed as directed and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and 

to inform the instructor about any deviations or problems that may occur while 

performing the procedure. 

4. References:

4.1. Fisher Accu 124D Balance Instruction Manual. 

5. Definitions: N/A

6. Precautions: N/A

7. Materials:

7.1. Fisher Accu 124D Balance 

8. Procedure:

8.1. Internal Calibration 

8.1.1. Press the ON/OFF button if the balance is not on. 

8.1.2. Press the “TARE” button to zero the weight display. 

8.1.3. Press the “CAL/CF” button.  C CAL will be displayed during calibration. 

8.1.4. When calibration is complete the unit will return to the measurement 

mode. 
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9. Attachments:

Figure 1:  Fisher Accu 124D 

10. History:

Revision 

Number 

Effective 

Date Preparer Description of Change 
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1. Purpose:

1.1. Operation of Fisher Accu 124D Balance. 

2. Scope:

2.1. Applies to the weight measurement of laboratory materials.     

3. Responsibilities:

3.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is 

performed as directed and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and 

to inform the instructor about any deviations or problems that may occur while 

performing the procedure. 

4. References:

4.1. Fisher Accu 124D Balance Instruction Manual. 

5. Definitions: N/A

6. Precautions: N/A

7. Materials:

7.1. Appropriate weighing container(s) such as a weigh boat, weigh paper, beaker, flask, 

bottle, etc. 

7.2. Fisher Accu 124D Balance 

8. Procedure:

8.1. Simple Weighing 

8.1.1. Press the “ON/OFF” button if balance is not on. 

8.1.2. Place weighing container on the balance weighing pan. Press the “TARE” 

button to zero the weight display. The display will read 0.0000g (or 

selected units to the designated resolution). When the reading is stable the 

weigh units will appear under the weight reading on the display.  

8.1.3. Remove the weighing container. Load weighing container with material to 

be weighed.  Place loaded weighing container on the weighing pan. When 

the reading is stable the weigh units will appear under the weight reading 

on the display. Record the weight indicated on the display. 

8.1.4. Remove the loaded weighing container. 
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9. Attachments:

Figure 1:  Fisher Accu 124D 

10. History:

Revision 

Number 
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Document Number: B CAL 

Revision Number: 4 

Effective Date: 26OCT09 

Page 1 of 1  

Balance Information 

Name and Description: ________________________ 

Model: _____________________________________ 

Serial Number:_______________________________ 

Calibration Information 

Date of Calibration: __________ Technician:_________________________________ 

Standard Mass Weights Used:____________________________________________________ 

Comments:____________________________________________________________________

Passed Calibration: 

Pass: □Yes  □ No 

Calibration Sticker:  □Yes 

□ No

□ Not Applicable

Next Calibration Due Date:___________ 

Failed  Calibration: 

Reason for Failure:___________________________

Date Out of Service:__________________________

Initials:__________ 

31



Montgomery County Community College 

340 DeKalb Pike 

Blue Bell, PA 19422  

Document Number: 7.0.0 

Revision Number: 0 

Effective Date: 10JAN14 

Page 1 of 5 

SOP: Eppendorf Research Plus Pipette Operation and Maintenance 

Approvals: 

Preparer: Jason McMillan   Date: 08JAN14 

Reviewer: Dr. Maggie Bryans  Date: 10JAN14 

1. Purpose:

Operation of Eppendorf Research Plus through to the P-1000.

2. Scope:

Applies to the operation, cleaning, and trouble shooting of the Eppendorf Research Plus,

designed to dispense precise volumes of liquid safely.

3. Responsibilities:

3.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as directed and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while performing 

the procedure. 

4. References:

4.1. Eppendorf Research Plus Operating Manual

4.1. Tuttnauer 3850 ELV Autoclave SOP

5. Definitions: N/A

6. Precautions:

6.1. Volatile solutions: you should saturate the air-cushion of your pipette by aspirating and

dispensing the solvent repeatedly before aspirating the sample. 

6.2. Acids or other corrosive liquids that emit vapors; can damage pipette to avoid this 

remove the tip holder and rinse the piston and O-ring and seal with distilled water. 

6.3. Temperature extremes can damage the Eppendorf Research Plus. Do not pipette liquids 

having temperatures of above 700C or below 40C. 

7. Materials:

7.1. Eppendorf Research Plus

7.2. pipette tips

7.3. beaker

7.4. weigh boats

7.5. MilliQ Water

7.6. lab towels

7.7. 70% isopropyl alcohol (IPA)

7.8. autoclave

8. Procedure:

8.1. Operation

8.1.1. The volume of liquid to be aspirated is set using the “Volume Display” which is 

read top (most significant digit) to bottom (least significant digit).  

8.1.2. Turn the “Volume Adjustment Ring” to select the desired volume. To obtain the 

maximum accuracy when setting the volume, set the volume 1/3 of a turn above 

the desired volume and then turn down to the desired volume.  

8.1.3. Double check that the set volume is correct while holding the “Volume 

Display” at eye level. 
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8.1.4. Fit a tip into the tip holder, by using a slight twisting motion when pressing the 

Eppendorf Research Plus “Spring Loaded Tip Cone” into a pipette tip to ensure 

a firm and airtight seal. The pipette tip is securely attached to the “Spring 

Loaded Tip Cone” when it responds with spring loaded action.  

8.1.5. Pre-rinse the tip by aspirating the first volume of liquid and then dispensing it 

back into the sample container or a waste container. 

8.2. Aspirating Liquid 

8.2.1. Press down the “Control Button” to the first stop (measuring stroke).  

8.2.2. Immerse the pipette tip vertically approximately 4mm into the liquid.  

8.2.3. To aspirate the liquid, allow the “Control Button” to slide back slowly.  

   Maintain the immersion depth to prevent accidental air aspiration. 

8.2.4. When pipetting large volumes wait approximately 3 seconds before removing 

the pipette tip from the liquid. To ensure maximum precision and accuracy the 

manufacturers recommends wetting each new tip initially by aspirating and 

dispensing the liquid 1-3 times and then commence pipetting. 

8.2.5. Remove the tip slowly from the liquid making sure to slowly wipe the tip 

   against the tube wall to ensure that no outer wetting remains on the tip. 

8.3. Dispensing Liquid 

8.3.1. Place the tip on the tube wall at an angle and press down the “Control Button” 

to the first stop (measuring stroke) and wait until the flow of liquid stops. Then 

Press the “Control Button” until it reaches the second stop (blow out) to empty 

the tip completely. 

8.3.2. Continue holding down the “Control Button” and wipe the tip against the tube 

inner wall and remove the tip from the tube. Let the “Control Button” slide back 

slowly once outside of the tube. 

8.4. Tip removal 

8.4.1. Tip may now be ejected by pressing firmly on the “Ejector” button into a waste 

container. 

8.4.2. Tip changes are required only if aspirating a different liquid, sample or reagent 

or volume. Tips should also be changed if aseptic technique is compromised 

(e.g. if the tip touches the outside of a container). 

8.4.3. When you are finished pipetting, re-set the volume of the Eppendorf Research 

Plus to the maximum volume for proper storage. 

8.5. Leak testing P20 – P200 

8.5.1. Fit a tip onto the Eppendorf Research Plus pipette. 

8.5.2. Set to the maximum volume given in the specification.  

8.5.3. For volumes <20µl pre-wet the tip several times.  

8.5.4. Hold the Eppendorf Research Plus in a vertical position with a full tip for 

approximately 30 seconds. Do not touch the pipette tip.  

8.5.5. Observe the meniscus of the liquid on the tip opening. If there is a leak in the 

   pipette, a droplet will form on the tip opening. 

8.5.6. Verify that the tip is on tightly, and repeat the test. 

8.5.7. If a droplet appears at the end of the tip there is a leak and the Eppendorf 

Research Plus needs repair. 
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8.6. Clean the pipette 

Note: Most pipettes are designed so that the parts that normally come into contact with 

liquid contaminants can easily be cleaned and decontaminated. 

8.6.1. Wipe entire pipette with a lab towel dampened with a mild detergent solution. 

8.6.2. Wipe entire pipette with a lab towel dampened with MilliQ water. 

8.6.3. Remove the ejector sleeve by holding down the ejection button and pulling on the 

    ejector sleeve (Figure 2: Step 1). 

8.6.4. Slide up the ring on the lower part with the label “PUSH TO RELEASE” 

    approximately 5mm until the lower part is released (Figure 2: Step 2 & 3). 

8.6.5. The lower part is then removed from the upper part (Figure 2: Step 4).  

8.6.6. Wipe the ejector sleeve and lower part with a lab towel dampened with a mild 

    soap solution or 70% IPA. 

8.6.7. Wipe the ejector sleeve and lower part with a lab towel dampened with MilliQ 

    water. 

8.6.8. Refit the lower part into the upper part until it engages audibly. 

8.6.9. Refit the ejector sleeve and allow the pipette to dry. 

8.6.10. Dispose of lab towels in bio-hazardous waste receptacle. 

8.7. Chemical decontamination 
8.7.1. Spray a lab towel with 70% IPA to dampen the lab towel. 

8.7.2. Wipe upper part of body with dampened lab towel. 

8.7.3. Wipe ejector sleeve with dampened lab towel. 

8.7.4. Wipe entire pipette with a lab towel dampened with MilliQ water. 

8.7.5. Leave pipette to dry or wipe pipette dry with lab towel. 

8.7.6. Dispose lab towels in bio-hazardous waste receptacle. 

8.8. Autoclaving 

8.8.1. Place the whole Eppendorf research Plus unit into the autoclave 

8.8.2. Run the autoclave on the Unwrapped Delicate Instruments per Tuttnauer 3850 

    ELV Autoclave SOP 

8.8.3. Remove the Eppendorf Research Plus unit and allow it to dry completely and cool 

    Down. 

8.9. Trouble shooting 

8.9.1. See the trouble shooting table (Table 1). 
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9. Attachments:

Figure 1: Eppendorf Research Plus 

Figure 2: Removing the Lower Part 

Eppendorf Research Plus Manual 

Control 

Button 

Volume 

Adjustment 

Ring 

Ejector 

Volume 

Display 

Adjustment 

Opening 

Labeling Field 

Ejector Sleeve 

Spring Loaded 

Tip Cone 

Adjustment 

Display 
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Symptom Possible cause Solution 

Liquid is dripping from the tip and/or the 
dispensed volume is incorrect.  

 The tip is loose or the pipette tip is
poorly fitted.

 Press the tip on firmly.

 Liquid with high vapor pressure 

and/or different density.

 Wet the tip several times and 

adjust the pipette for the liquid

used.

 Pipetted too quickly.  Move the control button slowly.

 The tip is withdrawn from the 
liquid too quickly.

 Slowly remove the tip with a time 
delay (approximately 3 seconds) 

from the liquid. 

 Liquid aspirated with blow-out

and dispensed with blow-out.

 Repeat dispensing correctly.

 The piston is soiled or damaged.  Clean the piston, relubricate 
slightly and/or replace. 

 The tip cone is damaged.  Replace the lower part or channel.

 The O-rings of the tip cones are 

damaged.

 Replace the O-rings (only 100 µl,

300 µl multi-channel).

The control button jams and does not move 

smoothly. 
 The piston is soiled.

 The seal is soiled.

 The pipette is blocked.

 Clean the lower part.

 5ml and 10ml sizes; replace the 
protection filter.

The adjustment seal has been removed; the 

adjustment display has been changed. 
 The pipette has been adjusted for 

another liquid.

 Adjust the pipette for the liquid 

used.

No spring-loading action of the tip cone when 

taking up pipette tips.  
 Spring-loading action is blocked

by a locking ring.

 Remove the locking ring again. 

 The use of a 5ml or 10ml pipette.  No remedy. The tip cone does not
respond with spring-loaded action

in combination with these sizes.

Table 1: Trouble Shooting 

Eppendorf Research Plus Manual 

10. History:

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 08JAN14 Jason McMillan Initial release 
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1. Purpose: To verify the calibration of a single channel pipette.

2. Scope: Covers the cleaning, decontamination and verification of a single channel pipette.

3. Responsibilities:

3.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as directed and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while performing 

the procedure. 

4. References:

4.1. balance operation SOP

4.2. balance calibration SOP

4.3. Tuttnauer 3850 ELV Autoclave SOP

4.4. Eppendorf Research Plus  Operation and Maintenance SOP

5. Definitions: N/A

6. Precautions: N/A

7. Materials:

7.1. balance

7.2. weigh boats

7.3. MilliQ water

7.4. small beaker for holding MilliQ water

7.5. verification labels

7.6. verification form

7.7. verification Pass/Fail form

7.8. pipette tips

7.9. Eppendorf Research Plus (P20, P200, and P1000)

7.10. 70% isopropyl alcohol (IPA)

7.11. lab towels

7.12. tweezers

7.13. thermometer

7.14. calculator

7.15. barometer

8. Procedure:

8.1. Clean the pipette (See Figure 2.)

Note: Most pipettes are designed so that the parts that normally come into contact with 

liquid contaminants can easily be cleaned and decontaminated. 

8.1.1. Wipe entire pipette with a lab towel dampened with a mild detergent solution. 

8.1.2. Wipe entire pipette with a lab towel dampened with distilled water. 

8.1.3. Remove the ejector sleeve by holding down the ejection button and pulling on the 

ejector sleeve (Figure 2: Step 1). 

8.1.4. Slide up the ring on the lower part with the label “PUSH TO RELEASE” 
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approximately 5mm until the lower part is released (Figure 2: Step 2 & 3). 

8.1.5. The lower part is then removed from the upper part (Figure 2: Step 4).  

8.1.6. Wipe the ejector sleeve and lower part with a lab towel dampened with a mild 

soap solution or 70% IPA. 

8.1.7. Wipe the ejector sleeve and lower part with a lab towel dampened with MilliQ 

water. 

8.1.8. Refit the lower part into the upper part until it engages audibly. 

8.1.9. Refit the ejector sleeve and allow the pipette to dry. 

8.1.10. Dispose of lab towels in bio-hazardous waste receptacle. 

8.2. Chemical decontamination 
8.2.1. Spray a lab towel with 70% IPA to dampen the lab towel. 

8.2.2. Wipe upper part of body with dampened lab towel. 

8.2.3. Wipe ejector sleeve with dampened lab towel. 

8.2.4. Wipe entire pipette with a lab towel dampened with MilliQ water. 

8.2.5. Leave pipette to dry or wipe pipette dry with lab towel. 

8.2.6. Dispose lab towels in bio-hazardous waste receptacle. 

8.3. Autoclaving 

8.3.1. Place the whole Eppendorf research Plus unit into the autoclave 

8.3.2. Run the autoclave on the Unwrapped Delicate Instruments per Tuttnauer 3850 

ELV Autoclave SOP 

8.3.3. Remove the Eppendorf research Plus unit and allow it to dry completely and cool 

down. 

8.4. Verification of Calibration 

Note:  To test the accuracy of the pipette you will pipette a set volume 10 times and then 

weigh the total pipetted volume.  1mL of MilliQ water should weigh 1g and 1µL should 

weigh 1mg.  Calculate your % Error using the equation below: 

Expected Mass  -  Actual Mass  x  100 =  % Error 

  Expected Mass 

If the % Error is ≤ 2% the pipette passes verification, if the % Error is > than 2% the 

pipette fails.  We will verify the pipette once at the maximum volume for the pipette, 

once at the ½ maximum volume, and once at the minimum volume.  Altogether you will 

pipette 30 volumes and weigh 3 times for each pipette.   

8.4.1. Record the necessary information on the Verification form. Enter information in 

the empty box to the right of the box specifying the information. 

8.4.2. Verify that the calibration label of the balance is within the dated calibration time 

period.  

8.4.3. Fill a small beaker with MilliQ water. 

8.4.4. Place the weigh boat on the balance. 

8.4.5. Tare the balance and verify that 0.00 is being displayed. 

8.4.6. Verify that the pipette is set to the maximum volume (e.g. the maximum volume 

for a P-20 pipette is 20µL.). 
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8.4.7. On the Pipette Verification Form, beside Selected Volume, enter the volume you 

will be pipetting and the value of that volume times 10 (e.g. for a 20µL pipette 

you will record 20µL for the selected volume and 200µL for the selected volume 

times 10.). 

8.4.8. Calculate the expected mass by converting the selected volume times 10 using the 

following conversions:  1µL = 1mg and 1mL = 1g.  Use the selected volume 

times 10 as the volume (e.g. for a 20µL pipette, 200µL multiplied by 1mg/µL = 

200mg). Record the expected mass in the box beside Expected Mass. 

8.4.9. Verify that the pipette is set to the maximum volume recommended by the 

manufacturer for the pipette.  

8.4.10. Place pipette tip securely on the pipette. 

8.4.11. Aspirate MilliQ water into pipette tip from the beaker and dispense it into weigh 

boat.   

8.4.12. Repeat the above step 9 times. Each time you dispense the selected volume mark 

the Verification form in the numbered box beside Dispense Repetitions. 

8.4.13. Record the final mass on the Verification form next to Recorded Mass. 

8.4.14. Tare the balance and verify that 0.00 is being displayed. 

8.4.15. Set the volume of the pipette to half capacity (e.g. For a P-20 pipette, set it to 

10µL.) and verify the volume. 

8.4.16. Repeat steps 8.4.9. through 8.4.16 with the pipette set to the half-capacity volume. 

8.4.17. Tare the balance and verify that 0.00 is being displayed. 

8.4.18. Set the volume of the pipette to the minimum capacity recommended by the 

manufacturer (e.g. For a P-20 pipette, set it to 2µL.) 

8.4.19. Repeat steps 8.4.9. through 8.4.16 with the pipette set to the minimum-capacity 

volume. 

8.4.20. Calculate the % Error (as directed in the note at the beginning of section 8.4) for 

each test (maximum, half-capacity, and minimum volumes) and record the results 

on the verification form. 

8.4.21. Verify that all fields of the verification form have been filled out and fill out the 

Pipette Verification Pass/Fail form according to the results of the tests. 

9. Attachments:
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Figure 1:  Eppendorf Research Plus 

Figure 2:  Removing the Lower Part 

Eppendorf Research Plus Manual  

Volume 

Display 

Adjustment 

Display 

Spring Loaded 

Tip Cone 

Labeling Field 

Adjustment 

Opening 

Ejector Sleeve 

Volume 

Adjustment 

Ring 

Control 

Button 

Ejector 

40



Montgomery County Community College 

340 DeKalb Pike 

Blue Bell, PA 19422  

Document Number: 7.1.0 

Revision Number: 1 

Effective Date: 10JAN14 

Page 5 of 6 

SOP: Eppendorf Research Plus Performance Verification SOP 

10. History

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 08JAN14 Jason McMillan Initial release 

1 10JAN14 Jason McMillan Added pipette verification form 
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Pipette Information 

Name and Description:_____________________ 

  Model:__________________________________ 

  Serial Number:____________________________ 

Verification Pipette 

Technician Volume Range 

Date Number of Channels 

Test Conditions 

Balance Serial # Balance Model 

Sensitivity Balance Calibration Date 

Correction Factor 

Balance Calibration 

Technician 

Air Temperature 

Barometric Temperature 

Relative Humidity 

Tests 

Test 1 (Max. volume) 

Selected Volume Expected Mass 

Selected Volume X 10 Recorded Mass 

Dispense Repetitions 1 2 3 4 5 6 7 8 9 10 

Test 2 (Half cap. volume) 

Selected Volume Expected Mass 

Selected Volume X 10 Recorded Mass 

Dispense Repetitions 1 2 3 4 5 6 7 8 9 10 

Test 3 (Min. volume) 

Selected Volume Expected Mass 

Selected Volume X 10 Recorded Mass 

Dispense Repetitions 1 2 3 4 5 6 7 8 9 10 

Test results 

% Error Test 1 

% Error Test 2 

% Error Test 3 

Pass or Fail  
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Pipette Information 

  Name and Description: ____________________ 

  Model: _________________________________ 

  Serial Number:____________________________ 

Verification Comments: 

 _______________________________________________________________________________ 

 _______________________________________________________________________________ 

 _______________________________________________________________________________ 

 Technician:________________________ 

 Date:_____________________________ 

Passed Verification: 

Date of Verification_______________ 

Technician_____________________ 

Verification Sticker:  □Yes 

□ No

□ Not Applicable

Next Verification  

Due Date_____________ 

Failed  Verification: 

Reason for Failure__________________________ 

__________________________________________

________________________________________  

Date Out of Service____________________ 

Technician___________________________ 
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Passed Verification:
Date of Verification_______________
Technician_____________________
Calibration Sticker:      Yes

No
Not Applicable

Calibration Due Date_____________

Passed Verification:
Date of Verification_______________
Technician_____________________
Calibration Sticker:      Yes

No
Not Applicable

Calibration Due Date_____________

Passed Verification:
Date of Verification_______________
Technician_____________________
Calibration Sticker:      Yes

No
Not Applicable

Calibration Due Date_____________

Passed Verification:
Date of Verification_______________
Technician_____________________
Calibration Sticker:      Yes

No
Not Applicable

Calibration Due Date_____________

Passed Verification:
Date of Verification_______________
Technician_____________________
Calibration Sticker:      Yes

No
Not Applicable

Calibration Due Date_____________

Passed Verification:
Date of Verification_______________
Technician_____________________
Calibration Sticker:      Yes

No
Not Applicable

Calibration Due Date_____________

Passed Verification:
Date of Verification_______________
Technician_____________________
Calibration Sticker:      Yes

No
Not Applicable

Calibration Due Date_____________

Passed Verification:
Date of Verification_______________
Technician_____________________
Calibration Sticker:      Yes

No
Not Applicable

Calibration Due Date_____________

Passed Verification:
Date of Verification_______________
Technician_____________________
Calibration Sticker:      Yes

No
Not Applicable

Calibration Due Date_____________

Passed Verification:
Date of Verification_______________
Technician_____________________
Calibration Sticker:      Yes

No
Not Applicable

Calibration Due Date_____________

Passed Verification:
Date of Verification_______________
Technician_____________________
Calibration Sticker:      Yes

No
Not Applicable

Calibration Due Date_____________

Passed Verification:
Date of Verification_______________
Technician_____________________
Calibration Sticker:      Yes

No
Not Applicable

Calibration Due Date_____________
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VALIDATION 
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Example of an Autoclave IQ protocol:
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Example of an OQ protocol for an autoclave: 
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Operational Qualification for Autoclave 

Approvals: 

Preparer: Jason McMillan  Date: 17JAN14 

Reviewer: Dr. Maggie Bryans    Date: 18JAN14 

1. Purpose:

1.1. Proper use of BTSure biological indicators to carry out an operational qualification of an

autoclave. 

2. Scope:

2.1. To validate the ability of a laboratory autoclave to sterilize.

3. Responsibilities:

3.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as directed and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while performing 

the procedure. 

4. References:

4.1. BTSure Biological Indicator manufacturer instructions

4.2.  Autoclave SOP

4.3.  Incubator or water bath SOP

5. Definitions: N/A

6. Precautions:

6.1. The contents of the BTSure biological indicator is extremely hot and under pressure after

autoclaving.  It may burst and cause burns. Allow at least 10 minutes to cool before 

handling it. 

6.2. Always wear the appropriate personnel protective equipment. 

7. Materials:

7.1. BTSure biological indicator unit(s)

7.2. BTSure crusher

7.3. autoclave

7.4. incubator (55-60ºC) or water bath

7.5. small beaker

7.6. aluminum foil

7.7. permanent marker

8. Procedure:

8.1. Remove an appropriate number of BTSure units from the box.

8.2. Remove one unit for each area of the autoclave to be tested and one additional unit to

be used as a positive control (this one will not be placed in the autoclave). 

8.3. Label indicators with appropriate information. 

8.4. Place each unit in a small beaker so that they lay horizontally in the bottom of the 

beaker. Use a separate beaker for each BTSure unit. 

8.5. Cover the beakers with aluminum foil. Note: If a flash cycle is selected the goods 

should be unwrapped. If the come up time is less than one minute a three minute 

exposure cycle may have to be extended to four minutes to ensure the BI is killed. 

8.6. Place the beakers inside the autoclave except the positive control.  
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8.6.1. One of the beakers should be situated so that it is directly over or next to the 

drain. Note: The area surrounding the drain is the coolest part of the autoclave 

and considered to be the least effective area for sterilization. 

8.7. Operate the autoclave per autoclave SOP. 

8.8. Remove the beakers from the autoclave. Allow indicators to cool for at least 10 

minutes. 

8.9. Remove the biological indicators from the beakers. 

8.10. Observe the color change (blue to black) of the chemical indicator on the BTSure 

Label. Note: Color change indicates exposure to steam.  It does not indicate 

acceptable sterilization. 

8.11. Incubation 
8.11.1. Place an indicator into the crusher in an upright position and squeeze the crusher 

to break the glass ampoule. This will allow the strip to be immersed in the media. 

8.11.2. Repeat the crushing with each additional indicator including the positive control. 

8.11.3. Immediately place the indicators (including the positive control) into the 

incubator or water bath. 

8.11.4. Incubate at 55 to 60°C for at least 48 hours. 

8.12. Interpretation 
8.12.1. During the incubation examine the indicators at regular intervals starting 

approximately at 4 hours, and again at approximately 8, 12, 18, and 24 hours for 

any change in color. Record results on the Autoclave Monitoring Form. 

8.12.1.1. The positive control tube should change from purple media to yellow.  If it 

does not, the study is invalid and needs to be repeated with a new lot of 

indicators. 

8.12.1.2. The sample indicators should not change color.  No color change (media 

remains purple) indicates adequate sterilization. 

8.12.1.3. If the sample indicators turn yellow this indicates bacterial growth and an 

investigation will need to be conducted. This may include re-performing the 

autoclave cycle. 

8.12.2. Report any indication of bacterial growth to instructor or lab manager. 

8.12.3. Dispose all used BTSure tubes in a biohazard receptacle when finished. 
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9. Attachments:

Figure 1: BTSure Biological Indicator in Plastic Crusher 

10. History:

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 25JAN06 Hope Townes and 

Kari Britt 

Initial release 

1 20JUL06 Bob O’Brien Added photograph and disposal information. 

2 20AUG06 Bob O’Brien Added interval hours for examination. 

3 12FEB07 Bob O’Brien Updated date format. 

4 11APR08 Bob O’Brien College name change 

5 15OCT09 Sonia Wallman Additional information to purpose and scope. 

6 10AUG10 Kari Britt Added data table.  Made formatting edits throughout. 

7 17JAN14 Jason McMillan Additional information to purpose and interpretation, 

college name change. 

Plastic 

Crusher 

Biological 

Indicator 
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Approvals: 

Preparer: John Buford  Date: 25NOV13 

Reviewer: Jason McMillan Date: 25NOV13 

Reviewer:       Maggie Bryans  Date:   26NOV13 

1. Purpose

1.1. Sterilize equipment, instruments, solutions, and biohazardous waste using the Tuttnauer

3850 ELV autoclave. 

2. Scope and Applicability

2.1.  An autoclave sterilizes materials by means of pressurized steam, generally 15 PSI at

121ºC. Items to be autoclaved need to be heat and pressure stable. Items that are 

damaged by heat or pressure should be sterilized by other methods.  

3. Summary of Method

3.1. Prepare items to be sterilized.

3.2. Load the autoclave.

3.3. Select and run a sterilization program.

3.4. Open the autoclave and allow load to cool.

3.5. Perform a visual inspection and verify the sterilizing indicators.

4. References

4.1. Tuttnauer Operation & Maintenance Manual, Laboratory Vertical Steamer Sterilizers

models 2540, 3850, 3870 ELV and 2540, 3850, 3870 ELVC, Cat. No. MAN205-

0350001EN Rev G. 

5. Definitions:

Autoclave A device used to sterilize equipment and supplies by subjecting them to high 

pressure steam. 

Heat-labile Susceptible to alteration or destruction by heat. 

6. Precautions

6.1. Steam from autoclave can cause serious burns. Verify that there is no pressure in the

chamber before opening the autoclave door. Wear appropriate personal protective 

equipment such as eye protection and heat resistant gloves. Keep head and body parts 

well away from the area above the door. Open the door slowly to allow steam to escape. 

6.2. Items being autoclaved will be hot after the cycle completes. Wear appropriate personal 

protective equipment such as eye protection and heat resistant gloves when unloading 

the autoclave.  

6.3. When autoclaving liquids, never fill containers with more than 2/3 full. 
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7. Responsibilities

7.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary.  

7.2. It is the responsibility of the students/technician to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while 

performing the procedure.  

8. Equipment and Materials

8.1. Tuttnauer 3850 ELV autoclave

8.2. Safety glasses

8.3. Heat resistant gloves

8.4. Autoclave indicator tape

8.5. Aluminum foil

8.6. 8 liters laboratory grade water

8.7. Items to be sterilized

9. Procedure

9.1. Preparing items to be sterilized:

9.1.1. Verify that all items are labeled appropriately (for example contents/prep 

date/initials). 

9.1.2. Use only heat-proof glass containers for liquids, filled to no more than 2/3 

capacity to avoid boil-overs. 

9.1.3. Loosen all container caps to avoid breakage due to pressure. 

9.1.4. Plug the opening of media flasks with gauze or cover loosely with aluminum foil. 

9.1.5. Position empty containers upside down to prevent water from accumulating.  

9.1.6. Do not mix liquid and non-liquid items in the same load. 

9.1.7. Do not mix clean and biohazard items in the same load. 

9.1.8. Place a small piece of autoclave indicator tape on each item. 

9.2. Operating the autoclave: 

9.2.1. Open the autoclave door and remove the baskets from the autoclave.  

9.2.2. Load the baskets with items to be sterilized, which have been prepared per section 

9.1 above. 

9.2.2.1.Position items so that steam with be able to penetrate.  

9.2.2.2.Do not crowd or overload the baskets.  

9.2.2.3.Do not exceed 20 liters of liquid or 20 kilograms (44 pounds) of instruments. 

9.2.3. Inspect the door gasket. The gasket should be clean and smooth. Clean if 

necessary by wiping the gasket with a soft cloth using water and a mild soap 

solution.  

9.2.4. Pour deionized water into the autoclave until the water level rises to the 

bottom grate. 

9.2.5. Place the baskets into the autoclave. 

9.2.6. Turn on the main power switch located at the bottom right corner of the keyboard 

panel. 

9.2.7. Close and seal the autoclave door: 

9.2.7.1.Carefully lower the door. 
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9.2.7.2.Lift the tightening bolt into the vertical position, then rotate the handle 

clockwise until the bolt is hand tight. Do not over-tighten the bolt to avoid 

damaging the door gasket. Verify that the open door icon disappeared from the 

main screen and that “READY” is displayed indicating that the door is sealed.  

9.2.8. Select one of the sterilization programs using the up and down arrow buttons on 

the top keypad. See Table 1 below for a description of each sterilization program. 

9.2.9. Start the selected program using the START/STOP button on the top keypad. The 

door lock should click and the sterilization cycle begins. 

9.2.10. The buzzer sounds and “CYCLE END” is displayed on the main screen at the end 

of the sterilization cycle.  

9.2.11. Don appropriate personal protective equipment, including eye protection and heat 

resistant gloves. 

9.2.12. Open the autoclave door: 

(Caution: steam from autoclave can cause serious burns. Keep head and body 

parts well away from the area above the door.) 

9.2.12.1. Verify that there is no pressure in the chamber by checking the pressure 

gauge located on the front. 

9.2.12.2. Rotate the handle of the tightening bolt counter-clockwise until it spins 

loosely, then lower it to the horizontal position. 

(Note: a safety device locks the door when the power is off, when a 

sterilization cycle is in progress, or when a sterilization cycle is stopped due to 

a failure or manual stop. If the tightening bolt will not rotate, ensure that the 

power is on and that a sterilization cycle in not in progress, then press the 

START/STOP key to cancel the door lock.) 

9.2.12.3. Open the door just a crack. Allow steam to escape for at least 30 seconds. 

9.2.12.4. Lift the door slowly to allow any remaining steam to escape. 

9.2.13. Remove each of the loaded baskets by the handle from the autoclave carefully. 

Place loaded baskets in an undisturbed area. Do not touch the sterilized items. 

9.2.14. Allow the loaded baskets to cool to room temperature. 

9.2.15. Unload the baskets and perform a visual inspection to verify that the sterilizing 

indicators changed color and that the load is dry. Tighten container caps. 

9.2.16. Replace the empty baskets in the autoclave and carefully lower the door. Leave 

the door unlatched to permit air circulation. 

9.2.17. Turn off the main power switch located at the bottom right corner of the keyboard 

panel. Retain the paper printout in order to document the sterilization cycle in a 

lab notebook. 
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10. Attachments:

Program Screen Icon 

Sterilization Phase 

Time & Temp Exhaust Phase 

Unwrapped 

Instruments 

(scissors) 

4 minutes at 134ºC Rapid 

Unwrapped 

Delicate 

Instruments 

(empty flask) 

20 minutes at 121ºC Rapid 

Liquid 

(full flask) 

20 minutes at 121ºC Slow 

Table 1. Sterilization Programs 

Tuttnauer 3850 ELV Manual 
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Figure 1. Tuttnauer 3850 ELV Autoclave (top view) 

Tuttnauer 3850 ELV Manual 

11. History

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 27NOV13 John Buford Initial release 

Power 
switch 

Keypad 

Main 
screen 

Printer 
(on front) 

Pressure 
gauge 

(on front) 

Tightening 
bolt 
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1. Purpose

1.1. Operation of the Harvey Sterilemax autoclave.

2. Scope and Applicability

2.1.  Applies to the steam sterilization of a variety of materials.

3. Summary of Method

3.1.  Prepare the items to be sterilized

3.2. Load the autoclave

3.3. Select and sterilization program.

3.4. Open the autoclave and allow the load to cool.

3.5. Perform a visual inspection and verify the sterilizing indicators.

4. References

4.1. Thermo-Scientific (Harvey) Sterilemax Operation Manual

5. Definitions: N/A

6. Precautions

6.1. Do not attempt to open the door before display reads “cycle complete”. Pressure in the

chamber could cause the door to open with extreme force. 

6.2. Use caution when opening the door. Open door slowly and partially to protect yourself 

from steam releasing, boiling liquids and exploding flasks. 

6.3.  Sterilizer trays and items being autoclaved will be very hot after cycle is complete. 

Always wear protective gloves when handling these items. 

6.4. When autoclaving liquids in bottles, beakers or tubes, never fill them more than 75%. 

6.5. Do not add water to the reservoir while cycle is running. 

6.6. Refer to pages 6-8 in operation manual for further precautions. 

7. Responsibilities

7.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary.  

7.2. It is the responsibility of the students/technician to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while 

performing the procedure.  

8. Equipment and Materials

8.1. Item(s) to be sterilized

8.2. Aluminum foil (if no lid applies)

8.3. Autoclave tape

9. Procedure

9.1. Turn on power switch under the right front corner.

9.2. Check water level in the reservoir. The water level should be between the white arm at

the bottom of the reservoir and the metal arm towards the top of the reservoir. If water is 

needed, add MilliQ water making sure to not overfill. 
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9.3. For items lacking a lid, for example over an open beaker or bottle with no lid, loosely 

place aluminum foil over the mouth of the vessel to create a lid. 

9.4.  If a bottle or test tube has a lid or cap, loosen the lid or cap. 

9.5. Any container containing a liquid should be filled no more than 75%. 

9.6. Place a piece of autoclave tape on item(s). 

9.7. Load the sterilizer chamber, with your item(s), onto the perforated tray. 

9.8. Close the door completely and tighten the lever clockwise. 

9.9. Select process cycle by first pressing the start button on touch pad. 

9.9.1. Choose cycle (refer to page 12 of manual). 

9.9.2. Press start again. 

9.10. After cycle is complete autoclave will beep and the screen will read “cycle 

complete” and “open door”. To open the door you must first untighten the lever counter 

clockwise then open the door release on the bottom left of the door. DO THIS WITH 

CAUTION BECAUSE OF STEAM RELEASING OUT!! 

9.11. To retrieve your items out of the autoclave when cycle is finished, be sure to be 

wearing protective gloves.

10. Attachments: N/A

11. History

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 24OCT12 Tim Kull Initial release 

1 13JAN15 Jason McMillan Format change and minor revisions 
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FORM: Autoclave Monitoring 

Autoclave Information 

Name and Description:__________________________ 

Model:_______________________________________ 

Serial Number:_________________________________ 

Biological Indicator Test Results

Date Time Hours since 

incubation began 

Color of media 

inside indicator 

Comments Initials 

Monitoring Results: 

Dates Monitoring Protocol Performed: 

_______________________________ 

Monitoring Protocol Initiator: 

_______________________________ 

Pass: □Yes  □ No 

Failed  Monitoring: 
Reason for Failure:___________________________ 

__________________________________________

__________________________________________ 

Date Out of Service:__________________________ 

Technician:_________________________________ 
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Northeast Biomanufacturing Center 
and Collaborative 

Hazard Communication Program 
(HCP) 

NBC-HCP-000 

Date Issued:    06/27/06 

Date Revised:  05/30/07 

APPLICIPABLE STANDARD:  29CFR1910.1200 

OSHA’s Hazard Communication Standard 

Document Contents 

SECTION CONTENT 

A Application 

B Purpose 

C Definitions 

D Scope 

E Chemical Inventory List 

F  MSDS  

G Labeling 

H Training 

I  Outside Contractors 

Application 

The Northeast Biomanufacturing Center and Collaborative (NBC2), under OSHA’s Hazard 

Communication Standard (HCS), requires chemical manufacturers or importers to assess the 

hazards of all chemicals they produce or import and transmit that information to affected 

employers and employees. The standard requires the Center to provide employee information 

about the potential of hazardous chemical exposure under normal use conditions or in a 

foreseeable emergency; and the transmittal of this information by means of a comprehensive 

Hazard Communication Program which includes container labeling and other forms of 

warning, Material Safety Data Sheets, and employee training.  

In order to comply with the Hazard Communication Standard, this Hazard Communication 

Program has been established for NBC2. All schools, colleges, and administrative offices 

operating within the center are incorporated within this program.  

Primary responsibility for compliance with the Hazard Communication Program lies with the 

individual institution, laboratory, or facility operating within the center.  Each dean, director, 

chair, and lab supervisor is responsible for safety performance and hazard communication 

within their respective institutions and labs.  The Environmental Health and Safety Department 
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(EH&S) is responsible development and coordination of policies and procedures. EH&S also 

provides technical assistance in establishing procedures and monitoring performance in 

activities involving the Hazard Communication Program.  

NBC2 is committed to creating, maintaining and promoting a safe and healthful environment 

for all associated individuals including students, faculty, staff employees, hospital patients, and 

visitors. A critical component of NBC2’s environmental health and safety commitment is 

integrating information concerning chemical hazards into all academic and operational 

activities by means of this Hazard Communication Program.  

This program outlines the definitions, procedures and training requirements to be utilized by 

NBC2 employees and trainees to understand and comply with the Hazard Communication 

Standard.  It is the duty of each employee to become familiar with the contents of this program 

and ensure compliance with its procedures.  Supervisors and instructors shall ensure that 

employees and trainees understand the details of this program and ensure that employees 

receive the proper training.  Supervisors and instructors are also responsible for maintaining 

records of this training.  These records must be current and readily available for review. 

ASSOCIATED DOCUMENTS 
NBC-HCP-001: Safety self-audit 
NBC-HCP-002: Guidance Document 

PURPOSE 

 The NBC2 Hazard Communication Program (HCP) was developed to:

 Inform employees of the hazards associated with chemicals in the workplace.

 Ensure safe use, handling and disposal of hazardous chemicals in the workplace.

 Comply with the Occupational Safety and Health Administration’s (OSHA) Hazard

Communication Standard (29 CFR 1910.1200)

 A successful Hazard Communication Program will reduce potential incidents of

chemical source illnesses and injuries.

Definitions 

Chemical means any element, chemical compound or mixture of elements and or/ compounds. 

Chemical manufacturer means an employer with a workplace where chemical(s) are 

produced for use or distribution. 

Chemical name means the scientific designation of a chemical in accordance with the 

nomenclature system developed by the International Union of Pure and Applied Chemistry 

(IUPAC) or the Chemical Abstracts Service (CAS) rules nomenclature, or a name, which 

clearly identify the chemical for the purpose of conducting a hazard evaluation. 
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Combustible liquid means any liquid having a flashpoint at or above 100 degree F, but below 

200 degree F, except any mixture having components with flashpoints of 200 degree F, or 

higher, the total volume of which make up 99% or more of the total volume of the mixture. 

Common name means any designation or identification such as code name, code number, 

trade name, brand name or generic name used to identify a chemical other than by its chemical 

name. 

Container means any bag, barrel, bottle, box, can, cylinder, drum, reaction vessel, storage 

tank, or the like that contains a hazardous chemical.   

Distributor means a business, other than a chemical manufacturer or importer, which supplies 

hazardous chemicals to other distributors or to employers. 

Employee means a worker who may be exposed to hazardous chemicals under normal 

operating conditions or in foreseeable emergencies. 

Employer means a person engaged in a business where chemicals are either used, distributed, 

or are produced for use or distribution, including a contractor or subcontractor. 

Explosive means a chemical that causes a sudden, almost instantaneous release of pressure, 

gas, and heat when subjected to sudden shock, pressure, or high temperature. 

Exposure or exposed means that an employee is subjected in the coarse of employment to a 

chemical that is a physical or health hazard, and includes potential exposure. 

Flammable means a chemical that falls into one of the flowing categories: 

 “Aerosol, flammable” means an aerosol that, when tested by the method described in

16 CFR 1500.45 yields a flame projection exceeding 18 inches at full valve opening, or

a flashback at any degree of valve opening

 “Flammable Gas” means a gas that, at ambient temperature and pressure, forms a

flammable mixture with air at a concentration of thirteen percent by volume or less; or

a gas that at ambient temperature and pressure, forms a range of flammable mixtures

with air wider than twelve percent by volume, regardless of the lower limit

 “Flammable Liquid” means any liquid having a flashpoint below 100 degree F, except

any mixture having components with flashpoints of 100 degree F or higher, the total of

which make up 99% or more of the total volume of the mixture

 “Flammable Solid” means a solid, other than a blasting agent or explosive as defined in

CFR 1971.109, that is liable to cause fire through friction, absorption of moisture,

spontaneous chemical change, or retained heat from manufacturing or processing, or

which can be ignited readily and when ignited burns so vigorously and persistently as

to create a serious hazard

Flashpoint means the minimum temperature at which a liquid gives off a vapor. 

Foreseeable emergency means any potential occurrence such as, but not limited to, equipment 

failure, rupture of containers, or failure of control equipment, which could result in an 

uncontrolled release of a hazardous chemical into the workplace. 

Hazardous chemical means any chemical, which is a physical hazard or a health hazard. 
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Hazard warning means any words, pictures, symbols, or combination thereof appearing on a 

label or other appropriate form of warning which convey the specific physical and health 

hazard including target organ effects, of the chemicals in the containers. 

Health hazard means a chemical for which there is statistically significant evidence based on 

at least one study conducted in accordance with the established scientific 

principles that acute or chronic health effects may occur in exposed employees.

Identity means any chemical or common name, which is indicated on the material safety data 

sheet (MSDS) for the chemical. 

Immediate use means that the hazardous chemical will be under the control of and used only 

by the person who transfers it from a labeled container and only within the 

work shift it is transferred. 

Label means any written, printed, or graphic material displayed on or affixed to containers of 

hazardous chemicals 

Material Safety Data Sheets (MSDS) means written or printed material concerning a 

hazardous chemical. 

Mixture means any combination of two or more chemicals if the combination is not, in whole 

or in part, the result of a chemical reaction. 

Oxidizer means a chemical other than a blasting agent or explosive as defined in CFR 

1910.109(a), that initiates or promotes combustion on other materials, thereby causing fire 

either of itself or through the release of oxygen or other gases. 

Physical hazard means a chemical for which there is scientifically valid evidence that it is 

combustible liquid, compressed gas, explosive, flammable, an organic peroxide, an oxidizer, 

pyrophoric, unstable or water-reactive. 

Produce means to manufacture, process, formulate, blend, extract, generate, emit, or 

repackage. 

Responsible party means someone who can provide additional information on the hazardous 

chemical and appropriate emergency procedures, if necessary. 

Specific chemical identity means the chemical name, Chemical Abstracts Service (CAS) 

Registry Number, or any other information that reveals the precise chemical 

designation of the substance. 

Unstable (reactive) means a chemical which in the pure state, or as produced or transported, 

will vigorously polymerize, decompose, condense, or will become self-reactive under 

conditions of shocks, pressure, or temperature. 

Use means to package, handle, react, emit, extract, generate as a byproduct, or transfer. 

Water-reactive means a chemical that reacts with water to release a gas that is either 

flammable or presents a health hazard. 
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Work area means a room or defined space in a workplace where hazardous chemicals are 

produced or used, and where employees are present. 

Workplace means an establishment, job site, or project, at one geographical location 

containing one or more work areas. 

SCOPE 

This program applies to: 

• All departments which use or store chemicals and

• All chemicals used by employees under normal conditions of work or in foreseeable

emergencies.

EXCEPTION:  This program does not apply to research laboratories.  These facilities are 

subject to Chemical Hygiene Plan requirements under the OSHA Laboratory Standard, 29 CFR 

1910.1450.   For more information, contact your Chemical Hygiene Officer. 

CHEMICAL INVENTORY LIST 

In Appendix A of this program is a blank Chemical Inventory List Form. All chemicals being 

used in this department and for which there is an MSDS in the binder are to be listed on this 

Inventory form.  The completed, current Inventory is to reside in the MSDS binder kept in this 

department. 

Procedure for maintaining the inventory list: 

1. When a chemical product is received at this department, retrieve the Program

binder.

2. Check the Inventory List for the name of the chemical product as it appears on the

MSDS accompanying the shipment.

3. If the product is not listed, add it to the list.

MSDS 

An MSDS must be kept on file for all chemicals on the Inventory list.  MSDS’s are designed to 

provide the information needed to handle chemicals safely.  MSDS’s may differ somewhat in 

format and content, however all should contain the following: 

1. Substance identification - names, synonyms, manufacturer contact information,

and index numbers.

2. List of active and inert ingredients - components and contaminants.

3. Exposure limits - ACGIH, TLV, OSHA PEL, etc.

4. Physical data – boiling, melting points, vapor pressure, evaporation rate,

specific gravity or density, water solubility, physical description.

5. Fire and explosion data – LEL, flashpoint, flammability, class of hazardous

atmosphere, firefighting media and methods, including fire extinguishers, etc.
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6. Transportation requirements, if any

7. Toxicity and health hazard data - including target organ, specific acute and

chronic health effects, potential cancer risk, first aid and emergency medicine.

8. Storage and disposal - including reporting requirements

9. Spill and emergency response procedures.

10. Measures to protect employees including personal protective equipment, safety

shower and eyewash, etc.

Please contact EHS or the Chemical Hygiene Officer if an MSDS appears to be 

inadequate, illegible, out-of-date or incomplete. 

MSDS Procedures 

1. Obtain and label one or more three ring binders and label “MSDS’s”.  Place all

old and new MSDS’s in the binder(s).  File MSDS’s alphabetically and by use,

location or other suitable category (this may already have been done in many

departments).

2. Check all deliveries of chemicals for the MSDS(s).  An MSDS should

accompany the first shipment of all new or re-formulated chemicals.

3. When a chemical is received with an MSDS, place it in the binder and add the

product name to the Chemical Inventory List.  Discard any old or out-of-date

MSDS for the same or similar product that is no longer in stock.

4. If a chemical is received without an MSDS, check the MSDS binder to

determine if it already contains the MSDS. If not, immediately request one from

the supplier.  Store the chemical separately, label “DO NOT USE” and do not

use until the MSDS is received.

5. MSDSs can also be obtained from vendor web sites.

6. Inform all employees of the location of the MSDS binder.

MSDS Location_______________________________________ 

Use of MSDS in Exposure Incidents 

If an employee is exposed to a chemical and the exposure results in an illness or injury that 

requires treatment by medical personnel: 

1. Ensure that medical personnel see the individual immediately.

2. Provide a copy of the MSDS to the medical personnel involved.  Along with the

MSDS provide any additional information you have on the chemical and when,

where and how it was used.

LABELING 

Primary container label contents - Labels on all primary containers must include: 

1. The identity of the chemical - common name &/or chemical name.

2. A hazard warning – such as “Caution, Warning, Flammable, Toxic”, etc.

3. The name and address of the manufacturer.

4. Chemical hazard ratings for health, fire reactivity (HMIS)

5. Target organs that may be affected by chronic health hazards
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Anytime a container contains the information listed above, an additional HMIS label will not 

be required.  We will accept the manufactures original label if it meets this criteria. 

Primary container label procedure: 

1. When chemicals are received, check all containers to ensure that the product

label meets the requirements outlined above.

2. With each chemical shipment the purchasing agent or his/her designee will

check all containers to ensure that the condition is safe and that all labels meet

the requirements outlined in this program.  Do not accept unsafe containers or

improperly labeled containers.

A secondary container is any container other than the one in which the chemical was received 

from the supplier.  Secondary container labels will contain the same information as labels for 

primary containers.  All labeling information can be obtained from the original container, or 

the MSDS for the product.  Label secondary containers if: 

• More than one employee uses the container.

• The container is used longer than one shift or left unattended in the work area.

• Labels on containers not containing original product will be removed and re-

labeled

• Any portable containers used to store, transport or transfer chemicals which

hold a sufficient amount to present a physical or health hazard must be labeled

It is not necessary to label the secondary container if: 

• one employee uses the chemical without exposing others, and

• returns the contents to the original container or disposes of the rest of it.

We will be using the National Fire Protection Association (NFPA) or Hazardous Material 

Information System (HMIS) to label items that are not correctly labeled or items that do not 

have labels.  This includes numerical ratings for the acute health, flammability and reactivity 

hazard, the assignments of a personal protective equipment index and the designation of 

chronic health hazards 

The hazard communication portion of the NFPA communicate information on: 

1. Chemical identify – common names and code numbers

2. Degree of Acute Health, Flammability and Reactivity hazards – numerical

rating

3. Proper Personal Protective Equipment – pictograms

4. Chronic Health Hazards
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TRAINING 

Training Matrix  - Use this table to determine training requirements.  These requirements apply 

to all employees who will use hazardous chemicals in the course of their job duties.  Please 

contact NBC2 for assistance with your training needs 

When Content Training methods 

Initially, prior to 

assignment to 

work 

 Details of this program

 OSHA requirements

 Physical, health hazards of

exposure to hazardous chemicals

 How to use MSDS’s, labels (and

other warnings if any)

 Location of MSDS’s, inventory list
and copies of this program.

 How to detect presence or release

of hazardous chemicals.

 Measures to protect employees

including safe work practices, PPE,
and emergency procedures

Classroom type training.  

Video, other AV and interactive 

media are useful for this 
application 

Upon 

introduction of 

 Physical, health hazards of

exposure to hazardous chemicals

Safety meeting, job, facility or 

task orientation 
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new hazards, 

(new chemicals, 
new tasks, etc.) 

 Measures to protect employees

including safe work practices, PPE,

and emergency procedures

Upon assignment 

to non-routine 

tasks 

 Physical, health hazards of

exposure to hazardous chemicals

 Measures to protect employees

including safe work practices, PPE,

and emergency procedures

Safety meeting should include 

walkthrough and task 

orientation. 

Keep these training records: 

• Date of training.

• Name and job title of trainer.

• Names of the trainees.

• Training topics.

• Other pertinent information to substantiate the training

Note:  Please see Training Record Form, Appendix B. 

OUTSIDE CONTRACTORS 

During a pre-job walkthrough or meeting: 

• Inform contractors of any hazards in the work area that their employees may

encounter during the term of the contract.

During the term of the contract, observe work practices to ensure that contractors are       

complying with OSHA.  Contractors are required to observe the following guidelines (these 

guidelines apply to all sub-contractors also): 

• Establish and enforce safe work practices.

• Comply with all applicable OSHA requirements

• Inform department in advance of all hazardous materials to be used during a

project.  Inform building occupants upon request by occupants or any employee.

• Supply a copy of all MSDS's for those materials upon request.

• Verify that each container used is labeled in accordance with this HCP.

• A copy of the NBC2 Hazard Communication Program will be available
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Appendix A 

Chemical Inventory List
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Appendix A 
Chemical Inventory List 

Chemical Name Manufacturer/supplier 
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Appendix B 

Employee Training Record 
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Employee Training Record 

Supervisor: Department: 

Unit: Location: 

Date Training Developed: Training Program Revision Dates: 

Employee Name 

Job Title 

General  

Haz Com Training  

(most recent date) 

Unit or Dept Specific 

Haz Com Training  

(most recent date) 

Lab, Clinic, or Unit Specific Hazard Communication Training Provided: List the 

specific training provided by the PI or supervisor to the individuals listed above. Provide 

separate descriptions as necessary. 

1. Explanation of the Completed Unit Specific Haz Com Plan:

2. Chemical Inventory and specific hazardous chemical each employee may

encounter 

3. Location and availability of MSDSs; explanation of hazards associated with

chemicals or groups of chemicals 

4. Labeling system used by unit

5. Specific safety training for each person’s duties including specific equipment and

its use: Specific PPE- the types used, its use, location, and limitations: 
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6. Procedures for non-routine tasks and emergencies

7. Procedures when working with contractors
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Hazard 

Communication 

Program 

Audit Form 

Document 

NBC-HCP-001 

Effective 

14-June-2007 

REV 

1 
Page 1 of 2 

Written Program 

Yes No 

  Department or laboratory has a copy of the Hazard Communication Program. 

  HazCom program Administrator identified. 

  Written HazCom program displayed and accessible to employees at all times. 

  All employees informed of HazCom program location. 

  HazCom Program reviewed annually 

Chemical Inventory 

Yes No 

  All chemicals located in the workplace are listed on the chemical inventory. 

  All employees have access to the chemical inventory list.  

  Individual has been designated to update Chemical Inventory list. 

  List is accurately updated when chemical product is received; chemical inventory is  

checked to ensure chemical is recorded. 

MSDS 

Yes No 

  MSDS location identified and ALL employees are informed of location. 

  MSDS arranged in an orderly fashion to ensure ease of location. 

  Each chemical present has an MSDS. 

  Employee designated to ensure MSDS are maintained in accordance with  

29CFR1910.1200. 

  MSDS for chemicals no longer being used are kept in a separate location. 

  MSDS are legible and current. 

  MSDS for chemicals involved in an exposure incident are kept and present for the 30- 

year requirement. 

  MSDS meets informational requirements in accordance with 29CFR1910.1200. 

Labeling 

Yes No 

  Primary containers contain appropriate labeling information, (Chemical name, name 

and address of manufacturer, and appropriate warning info). 

  Secondary containers contain appropriate labeling information. 

  Employee designated to ensure labels are correct. 

  Primary and Secondary labels are updated and legible 
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Training 

Yes No 

  All employees receive training in Hazard Communication in accordance with the 

NBC2 Hazard communication program and 29CFR1910.1200. 

• Initially, prior to assignment to work

• Upon introduction of new hazards (new chemicals, new tasks, etc.)

• Upon assignment to non-routine tasks

  Training records kept on file by Supervisor / Foreman. 

  Employee’s know what to do in case of an emergency 

Contractors 

Yes No 

  Outside contractors are informed of NBC2 Hazard Communication policy. 

  Outside contractors are informed of hazardous chemicals to which they may  

potentially be exposed. 

  Outside contractors inform employees of Hazardous Chemicals brought onto 

property. 

Comments:_______________________________________________________________________ 

_________________________________________________________________________________ 

________________________________________________________________________________   

Date:_____________________

Evaluator:_____________________________________________ 

Document 

NBC-HCP-001 
Effective 

14-June-2007 
REV 

1 Page 2 of 2 
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www.MSDSAuthoring.com  For MSDS 
Writing/Authoring Assistance.  All of your MSDS 
Compliance needs.  
Phone 209-649-3913
Fax 209-234-5931 

THIS IS A SAMPLE OSHA MSDS TEMPLATE 

Material Safety Data Sheet U.S. Department of Labor 
May be used to comply with OSHA’s Hazard 
Communication Standard, 29 CFR 1910 1200. Standard 
must be consulted for specific requirements. 

Occupational Safety and Health Administration 
(Non-Mandatory Form) 
Form Approved 
OMB No. 1218-0072 

IDENTITY (as Used on Label and List) Note: Blank spaces are not permitted. If any item is not 
         applicable or no information is available, the space  
         must be marked to indicate that. 

Section I 
Manufacturer’s name Emergency Telephone Number

Address (Number, Street, City, State and ZIP Code) Telephone Number for Information

Date Prepared

Signature of Preparer (optional)

Section II—Hazardous Ingredients/Identity Information 
Hazardous Components (Specific Chemical Identity, Common Name(s)) 

OSHA PEL ACGIH TLV 
Other Limits 

Recommended % (optional) 

Section III—Physical/Chemical Characteristics  
Boiling Point Specific Gravity (H20 = 1)

Vapor Pressure (mm Hg) Melting Point

Vapor Density (AIR = 1) Evaporation Rate (Butyl Acetate = 1)

Solubility in Water

Appearance and Odor

Section IV—Fire and Explosion Hazard Data 
Flash Point (Method Used) Flammable Limits LEL UEL

Extinguishing Media

Special Fire Fighting Procedures

Unusual Fire and Explosion Hazards

(Reproduce locally)  OSHA 174 Sept. 1985
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Section V—Reactivity Data 
Stability Unstable Conditions to Avoid

Stable

Incompatibility (Materials to Avoid)

Hazardous Decomposition or Byproducts

Hazardous 
Polymerization

May Occur Conditions to Avoid

Will Not Occur

Section VI—Health Hazard Data 
Route(s) of Entry Inhalation? Skin? Ingestion?

Health Hazards (Acute and Chronic)

Carcinogenicity NTP? IARC Monographs? OSHA Regulated?

Signs and Symptoms of Exposure

Medical Conditions  
Generally Aggravated by Exposure

Emergency and First Aid Procedures

Section VII—Precautions for Safe Handling and Use 
Steps to Be Taken in Case Material Is Released or Spilled

Waste Disposal Method

Precautions to Be Taken in Handling and Storing

Other Precautions

Section VII—Control Measures 
Respiratory Protection (Specify Type)

Ventilation Local Exhaust Special

Mechanical (General) Other

Protective Gloves Eye Protection

Other Protective Clothing or Equipment

Work/Hygienic Practices
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Material Safety Data Sheet
Potassium cyanide MSDS

Section 1: Chemical Product and Company Identification

Product Name: Potassium cyanide

Catalog Codes: SLP3853

CAS#: 151-50-8

RTECS: TS8750000

TSCA: TSCA 8(b) inventory: Potassium cyanide

CI#: Not available.

Synonym:

Chemical Name: Potassium Cyanide

Chemical Formula: KCN

Contact Information:

Sciencelab.com, Inc.
14025 Smith Rd.
Houston, Texas 77396

US Sales: 1-800-901-7247
International Sales: 1-281-441-4400

Order Online: ScienceLab.com

CHEMTREC (24HR Emergency Telephone), call:
1-800-424-9300

International CHEMTREC, call: 1-703-527-3887

For non-emergency assistance, call: 1-281-441-4400

Section 2: Composition and Information on Ingredients
Composition:

Name CAS # % by Weight

Potassium cyanide 151-50-8 100

Toxicological Data on Ingredients: Potassium cyanide: ORAL (LD50): Acute: 5 mg/kg [Rabbit]. 8.5 mg/kg [Mouse]. 5 mg/kg
[Rat].

Section 3: Hazards Identification

Potential Acute Health Effects:
Very hazardous in case of skin contact (irritant, permeator), of eye contact (irritant), of ingestion, of inhalation.
Corrosive to eyes and skin. The amount of tissue damage depends on length of contact. Eye contact can result
in corneal damage or blindness. Skin contact can produce inflammation and blistering. Inhalation of dust will
produce irritation to gastro-intestinal or respiratory tract, characterized by burning, sneezing and coughing.
Severe over-exposure can produce lung damage, choking, unconsciousness or death. Inflammation of the eye is
characterized by redness, watering, and itching. Skin inflammation is characterized by itching, scaling, reddening,
or, occasionally, blistering.

Potential Chronic Health Effects:
CARCINOGENIC EFFECTS: Not available.
MUTAGENIC EFFECTS: Mutagenic for mammalian somatic cells.
TERATOGENIC EFFECTS: Not available.
DEVELOPMENTAL TOXICITY: Not available.
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The substance is toxic to blood, liver.
The substance may be toxic to cardiovascular system, upper respiratory tract, Urinary system, central nervous
system (CNS).
Repeated or prolonged exposure to the substance can produce target organs damage. Repeated exposure of the
eyes to a low level of dust can produce eye irritation. Repeated skin exposure can produce local skin destruction,
or dermatitis. Repeated inhalation of dust can produce varying degree of respiratory irritation or lung damage.
Repeated exposure to a highly toxic material may produce general deterioration of health by an accumulation in
one or many human organs.

Section 4: First Aid Measures

Eye Contact:
Check for and remove any contact lenses. In case of contact, immediately flush eyes with plenty of water for at
least 15 minutes. Cold water may be used. Get medical attention immediately.

Skin Contact:
In case of contact, immediately flush skin with plenty of water for at least 15 minutes while removing contaminated
clothing and shoes. Cover the irritated skin with an emollient. Cold water may be used.Wash clothing before
reuse. Thoroughly clean shoes before reuse. Get medical attention immediately.

Serious Skin Contact:
Wash with a disinfectant soap and cover the contaminated skin with an anti-bacterial cream. Seek immediate
medical attention.

Inhalation:
If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing is difficult, give oxygen. Get
medical attention.

Serious Inhalation:
Evacuate the victim to a safe area as soon as possible. Loosen tight clothing such as a collar, tie, belt or
waistband. If breathing is difficult, administer oxygen. If the victim is not breathing, perform mouth-to-mouth
resuscitation. WARNING: It may be hazardous to the person providing aid to give mouth-to-mouth resuscitation
when the inhaled material is toxic, infectious or corrosive. Seek immediate medical attention.

Ingestion:
If swallowed, do not induce vomiting unless directed to do so by medical personnel. Never give anything by
mouth to an unconscious person. Loosen tight clothing such as a collar, tie, belt or waistband. Get medical
attention immediately.

Serious Ingestion: Not available.

Section 5: Fire and Explosion Data

Flammability of the Product: Non-flammable.

Auto-Ignition Temperature: Not applicable.

Flash Points: Not applicable.

Flammable Limits: Not applicable.

Products of Combustion: Not available.

Fire Hazards in Presence of Various Substances: Not applicable.

Explosion Hazards in Presence of Various Substances:
Risks of explosion of the product in presence of mechanical impact: Not available.
Risks of explosion of the product in presence of static discharge: Not available.
Explosive in presence of oxidizing materials.
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Fire Fighting Media and Instructions: Not applicable.

Special Remarks on Fire Hazards: Contact with acids or acid salts causes immediate formation of toxic and flammable
hydrogen cyanide gas.

Special Remarks on Explosion Hazards:
Chlorates + potassium cyanide explode when heated.
Potassium cyanide + nitrites may cause explosion.
Nitrogen trichloride explodes on contact with potassium cyanide.
Potassium cyanide + hydrogen cyanide is a frictioin and impact-sensitive explosive and may initiate detonation of
liquid hydrogen cyanide.
Mercuric nitrate + potassium cyanide explodes when heated and contained in narrow iignition tubes.
Perchloryl fluoride + potassium cyanide causes an explosive reaction at 100-300 C.
Potassium cyanide + ammoniacal silver, following heating, shock or standing can cause an explosion.
Heating of potassium cyanide & chromium tetraoxide can cause an explosion.
Mixtures of metal cyanides with metal chlorates, perchlorates, or nitrates causes a violent explosion.

Section 6: Accidental Release Measures

Small Spill:
Use appropriate tools to put the spilled solid in a convenient waste disposal container. If necessary: Neutralize
the residue with a dilute solution of acetic acid.

Large Spill:
Corrosive solid. Poisonous solid.
Stop leak if without risk. Do not get water inside container. Do not touch spilled material. Use water spray to
reduce vapors. Prevent entry into sewers, basements or confined areas; dike if needed. Call for assistance on
disposal. Neutralize the residue with a dilute solution of acetic acid. Be careful that the product is not present
at a concentration level above TLV. Check TLV on the MSDS and with local authorities.

Section 7: Handling and Storage

Precautions:
Keep locked up.. Keep container dry. Do not ingest. Do not breathe dust. Never add water to this product. In
case of insufficient ventilation, wear suitable respiratory equipment. If ingested, seek medical advice immediately
and show the container or the label. Avoid contact with skin and eyes. Keep away from incompatibles such as
oxidizing agents.

Storage:
Moisture Sensitive. Light Sensitive. Protect from light. Keep container tightly closed. Keep container in a cool,
well-ventilated area. Do not store above 24°C (75.2°F).

Section 8: Exposure Controls/Personal Protection

Engineering Controls:
Use process enclosures, local exhaust ventilation, or other engineering controls to keep airborne levels below
recommended exposure limits. If user operations generate dust, fume or mist, use ventilation to keep exposure to
airborne contaminants below the exposure limit.

Personal Protection:
Splash goggles. Synthetic apron. Vapor and dust respirator. Be sure to use an approved/certified respirator or
equivalent. Gloves.

Personal Protection in Case of a Large Spill:
Splash goggles. Full suit. Vapor and dust respirator. Boots. Gloves. A self contained breathing apparatus
should be used to avoid inhalation of the product. Suggested protective clothing might not be sufficient; consult a
specialist BEFORE handling this product.
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Exposure Limits:
STEL: 5 (mg/m3) from ACGIH (TLV) [United States]
CEIL: 0.7 from NIOSH [United States]
CEIL: 5 (mg/m3) from NIOSH [United States]
Consult local authorities for acceptable exposure limits.

Section 9: Physical and Chemical Properties

Physical state and appearance:
Solid. (Crystalline or Granular solid. Deliquescent
solid.)

Odor:
Almond-like. Like bitter almonds. Odor of
hydrogen cyanide (Slight.)

Taste: Not available.

Molecular Weight: 65.11 g/mole

Color: White.

pH (1% soln/water): 11 [Basic.]

Boiling Point: 1625°C (2957°F)

Melting Point: 634.5°C (1174.1°F)

Critical Temperature: Not available.

Specific Gravity: 1.553 (Water = 1)

Vapor Pressure: Not applicable.

Vapor Density: Not available.

Volatility: Not available.

Odor Threshold: Not available.

Water/Oil Dist. Coeff.: Not available.

Ionicity (in Water): Not available.

Dispersion Properties: See solubility in water, methanol.

Solubility:
Easily soluble in hot water.
Soluble in cold water.
Partially soluble in methanol.
Very slightly soluble in ethanol.
Partially soluble in glycerol, hydroxylamine, and liquid ammonia.
Very soluble in formamide

Section 10: Stability and Reactivity Data

Stability: The product is stable.

Instability Temperature: Not available.
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Conditions of Instability: Incompatible materials, water, moisture, light,air

Incompatibility with various substances:
Highly reactive with oxidizing agents.
Reactive with acids.

Corrosivity: Non-corrosive in presence of glass.

Special Remarks on Reactivity:
Moisture sensitive.
Air Sensitive.
Deliquescent.
Protect from light.
Reacts with water or any acid releasing hydrogen cyanide.
Toxic gases and vapors (such as hydrogen cyanide and carbon monoxide) may be released when potassium
cyanide decomposes.
Incompatible with acids, acid syrups, alkaloids, chloral hydrate, iodine, metallic salts, permanganates, chlorates,
peroxides.
Potassium cyanide may react with carbon dioxide in ordinary air to form toxic hydrogen cyanide gas.
Potasssium cyanide is readily oxidized by heating to potassium cyanate in presence of oxygen or easily reduced
oxides.

Special Remarks on Corrosivity: Not available.

Polymerization: Will not occur.

Section 11: Toxicological Information

Routes of Entry: Absorbed through skin. Dermal contact. Inhalation. Ingestion.

Toxicity to Animals: Acute oral toxicity (LD50): 5 mg/kg [Rat].

Chronic Effects on Humans:
MUTAGENIC EFFECTS: Mutagenic for mammalian somatic cells.
Causes damage to the following organs: blood, liver.
May cause damage to the following organs: cardiovascular system, upper respiratory tract, Urinary system,
central nervous system (CNS).

Other Toxic Effects on Humans: Very hazardous in case of skin contact (irritant, permeator), of ingestion, of inhalation.

Special Remarks on Toxicity to Animals: Not available.

Special Remarks on Chronic Effects on Humans:
May cause adverse reproductive effects (female fertility and fetotoxicity).
May affect genetic material.

Special Remarks on other Toxic Effects on Humans:
Acute Potential Health Effects:
Skin: May be fatal if absorbed through skin. Causes skin irritation and possible burns especially if the skin is wet
or moist. May be absorbed through skin and cause symptoms similar to those described for ingestion.
Eyes: Causes eye irritation and possible eye burns.
Inhalation: May be fatal if inhaled. Causes respiratory tract and mucous membrane irritation. Inhalation of high
concentrations may cause central nervous system effects similar to those described for ingestion.
Ingestion: May be fatal if swallowed. Causes severe gastrointestinal tract irritation with nausea, vomiting and
possible burns. May cause tissue anoxia. May affect behavior/Central Nervous system, Metabolism,
cardiovascular system, respiratory system, blood, respiration. Symptoms of cyanide poisoning may include
flushing, nausea, vomiting, palpitations, tachycardia, hypotension, hypertension, increased pulse rate,
arrhythmias, heart conduction defects, hypernea, headache, dizziness, confusion, anxiety, agitation, tremors,
weakness, hyperventilation, dyspnea, apnea, severe hypoxic signs in absence of cyanosis (cyanosis is generally
late finding), convulsions, seizures, memory loss, insomnia, metabolic acidosis, poor appetite.
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Chronic Potential Health Effects:
Skin: Prolonged or repeated skin contract may cause dermatitis.
Ingestion: Prolonged or repeated exposure from ingestion may affect the urinary system, brain, liver and thyroid
(goiter) as well have the same effects as acute overexposure.

Section 12: Ecological Information

Ecotoxicity: Not available.

BOD5 and COD: Not available.

Products of Biodegradation:
Possibly hazardous short term degradation products are not likely. However, long term degradation products may
arise.

Toxicity of the Products of Biodegradation: The products of degradation are less toxic than the product itself.

Special Remarks on the Products of Biodegradation: Not available.

Section 13: Disposal Considerations

Waste Disposal:
Waste must be disposed of in accordance with federal, state and local environmental
control regulations.

Section 14: Transport Information

DOT Classification: CLASS 6.1: Poisonous material.

Identification: : Potassium cyanide UNNA: 1680 PG: I

Special Provisions for Transport: Marine Pollutant

Section 15: Other Regulatory Information

Federal and State Regulations:
Connecticut hazardous material survey.: Potassium cyanide
Illinois chemical safety act: Potassium cyanide
New York acutely hazardous substances: Potassium cyanide
Rhode Island RTK hazardous substances: Potassium cyanide
Pennsylvania RTK: Potassium cyanide
Minnesota: Potassium cyanide
Massachusetts RTK: Potassium cyanide
Massachusetts spill list: Potassium cyanide
New Jersey: Potassium cyanide

Other Regulations:
OSHA: Hazardous by definition of Hazard Communication Standard (29 CFR 1910.1200).
EINECS: This product is on the European Inventory of Existing Commercial Chemical Substances.

Other Classifications:

WHMIS (Canada):
CLASS D-1A: Material causing immediate and serious toxic effects (VERY TOXIC).
CLASS E: Corrosive solid.
WHMIS Class B-6: Reactive and very flammable material.
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DSCL (EEC):
R16- Explosive when mixed with
oxidizing substances.
R28- Very toxic if swallowed.
R38- Irritating to skin.
R40- Possible risks of irreversible
effects.
R41- Risk of serious damage to eyes.
S1/2- Keep locked up and out of the reach of
children.
S26- In case of contact with eyes, rinse
immediately with plenty of water and seek
medical advice.
S28- After contact with skin, wash immediately
with plenty of [***]
S36/37- Wear suitable protective clothing and
gloves.
S39- Wear eye/face protection.
S45- In case of accident or if you feel unwell,
seek medical advice immediately (show the
label where possible).
S46- If swallowed, seek medical advice
immediately and show this container or label.

HMIS (U.S.A.):

Health Hazard: 3

Fire Hazard: 0

Reactivity: 0

Personal Protection: j

National Fire Protection Association (U.S.A.):

Health: 3

Flammability: 0

Reactivity: 0

Specific hazard:

Protective Equipment:
Gloves.
Synthetic apron.
Vapor and dust respirator. Be sure to
use an approved/certified respirator or
equivalent. Wear appropriate respirator
when ventilation is inadequate.
Splash goggles.

Section 16: Other Information

References: Not available.

Other Special Considerations: Not available.

Created: 10/11/2005 01:51 PM
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Last Updated: 10/11/2005 01:51 PM

The information above is believed to be accurate and represents the best information currently available to us. However, we
make no warranty of merchantability or any other warranty, express or implied, with respect to such information, and we
assume no liability resulting from its use. Users should make their own investigations to determine the suitability of the
information for their particular purposes. In no event shall ScienceLab.com be liable for any claims, losses, or damages of any
third party or for lost profits or any special, indirect, incidental, consequential or exemplary damages, howsoever arising, even
if ScienceLab.com has been advised of the possibility of such damages.
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QUALITY ASSURANCE: 

GMP POPCORN EXERCISE 
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GMP POPCORN EXERCISE CHECKLIST 

Goal: 

Make a batch of GMP popcorn within a specified timeframe (1.5 hours). 

Objective: 

Understand the complexity of a GMP process. 

Gain appreciation of teamwork and cooperation of all departments.  

How it mirrors industry: 

 You will be frustrated at times

 You will be rushed.

 You will feel a sense of accomplishment once you made the batch!

 The actual time for the chemistry / fermentation / etc. is very small compared to

the time it takes to get all GMP documentation in place.

Supplies: 

1. Department tasks and deliverables

2. Approved labels

3. Quarantine labels

4. Box for approved and quarantine

5. Microwave Popcorn

6. Access to photocopier

7. Access to microwave

8. Water in a squirt bottle

9. 409 or other type of cleaning agent

10. Paper towels

11. Sponge

12. Measuring cups

13. Bags for the finished product

Teams: 

Material Control: 2 people 

QC: 2 people that like to test material 

QA: 2 people that have an eye for written details 

Production: 4 people that like to WORK 

88



Page 1 of 3   Johnson Matthey Pharmaceutical Materials, Inc.

25 PATTON ROAD, DEVENS, MA 01432  TEL:  978.784.5000  FAX:  978.784.5500  WWW.PHARMECO.COM 

Q U A L I T Y   A S S U R A N C E 

ROLE OF QA: 

 Review and Approval all quality related documents.
 Issue all controlled documents.
 Provide oversight on the production campaign.
 Disposition Raw materials and final products.

Checklist of Items to Accomplish: 
o Review and Approve Raw Material Master Specification Sheet
o Review and Approve Final product Master Specification Sheet
o Review and Approve Master Batch Record
o Approve actual Raw Materials for use
o Inspect Microwave for Cleanliness
o Review completed Batch Record after production is complete
o Review QC data and Approve actual Popcorn

Your Tasks are: 

1. APPROVING MASTER SPECIFICATIONS:

Production will be submitting for your review AND approval:
1. RAW MATERIAL SPECIFICATION SHEET for the KERNELS
2. FINAL PRODUCT SPECIFICATION SHEET for the POPCORN.

Instructions:  Review to ensure all boxes that are shaded have been
completed.   All information provided should make sense and be reasonable. 
Try where possible to have the team write in quantitative specifications (i.e. 
“No more than 2 dark pieces of popcorn.”).   If you don’t agree with the 
specifications, or have questions, feel free to go back to the Production Team 
for clarification.  

HOW TO APPROVE A MASTER SPECIFICATION SHEET:     
To make the specification sheet effective complete the following: 

 a).  Sign your name in the shaded box for “QA Approval”. 
       b).  Write in an effective date (i.e. today’s date) in the upper right 

hand corner. 
 c).  Make a photocopy (yes, go to the photocopier) of the original 

document you just signed and give a copy to QC. 
 d).  File the original in QA. 

2. APPROVING A MASTER BATCH RECORD:

Production will be submitting for your review:
1. A Master BATCH RECORD to make the POPCORN.

Instructions:  Review to ensure all boxes that are shaded have been
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completed.   All information provided should make sense and be 
reasonable.  HINT:  The production team should have quantitative 
numbers in the process (i.e. Pop popcorn for 1.5 – 2.5 minutes). If you 
don’t agree with the process description or have questions feel free to go 
back to the Production Team for clarification.  

HOW TO APPROVE A MASTER BATCH RECORD: 
 To make the BATCH RECORD effective complete the following: 
       a).  Sign your name in the shaded box for “QA Approval” on the front 

page and initial the bottom of all pages in the QA box designated.  
       b).  Write in an effective date (i.e. today’s date) in the upper right 

hand corner on ALL PAGES. 
 c).  Make a photocopy of the Master Batch Record 
 d).  Write in the Lot Number on all pages (in the box for LOT 

NUMBER) ON THE PHOTOCOPY OF THE BATCH RECORD.  (See below 
for instructions): 
INSTRUCTIONS FOR ASSIGNING A UNIQUE LOT NUMBER:  
Lot number should be POP-YEAR-001.  For example:  POP-03-001     

 e).  File the original batch record in QA. 
       f).  Give the photocopy of the batch record to production.  (We call

this “Issuing a batch record to production”)

3. APPROVING RAW MATERIALS:

Before production can use the kernels in their production run they must be
approved by QC AND QA!   Follow the instructions below to approve the raw
materials (i.e. Kernals).

HOW TO APPROVE RAW MATERIALS:

1. Once QC finishes the “testing” on the Kernals, review the information
written in on the specification sheet and the accompanying
documentation to ensure no empty spaces.

2. If acceptable, sign your name in the box for QA at the bottom of the
page on the specification sheet and check off “Approved”.

3. Fill in the spots on the Approval labels.  Make one for each
container / package PLUS 1 extra for the receiving report.

4. Complete the remaining boxes designated “QA” on the Receiving
report.  Place your extra label on the receiving report.

5. Give approval labels to Material Control.

4. INSPECTING EQUIPMENT:

Before production can use a piece of equipment it must be clean!  It is a
common practice in industry to have QA inspect the equipment after
production cleans it.

HOW TO INSPECT EQUIPMENT:

1. Production will be requesting QA to visually inspect the microwave
for cleanliness.   If it is not satisfactorily clean, have Production re-
clean the microwave.
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2. Once acceptable, sign/date the Cleaning Log in the spot for “QA
initials”

5. INTERNAL AUDITING:

Feel free to audit the production area during production!

6. REVIEWING COMPLETED PRODUCTION BATCH RECORDS:

Once production of the popcorn is complete, the Production team will be
submitting the completed batch record for your review.  Before the popcorn is
“Dispostioned” QA must review the completed batch record AND completed
Quality Control testing.  BOTH items must be satisfactorily before the popcorn
can be approved!

HOW TO REVIEW A COMPLETED BATCH RECORD:

1. Ensure all information is recorded and completed per requirements of
the batch record.

2. If any items were not completed –return to production for correction.
3. The team must not of deviated from requirements in the batch record.

(i.e:  if it says to “Pop the popcorn in the microwave for 2-3 minutes they
must not go over 3 minutes or under 2 minutes without some
justification.)

4. Once you are satisfied with the completed record, sign your name in the
“Reviewed by QA” box

5. DO NOT YET APPROVE THE BATCH.  YOU NEED THE QC DATA
FIRST.

7. REVIEWING COMPLETED QC DATA

Once the QC data is complete  – review the QC information for completeness.
If both the Batch Record and QC data are acceptable you may sign both
documents as “APPROVED”.  NOW THE POPCORN IS APPROVED.

HOW TO APPROVE QC DATA ON POPCORN

1. Once QC finishes the “testing” on the Popcorn, review the
information written in on the specification sheet and the
accompanying documentation to ensure no empty spaces.

2. If acceptable, sign your name in the box for QA at the bottom of the
page on the specification sheet and check off “Approved”.

3. If the batch record is complete and the QC data is complete you can
now fill out the Approval labels!

4. Complete the remaining boxes designated “QA” on the Receiving
report.  Make one label for each container / package PLUS 1
extra for the receiving report.

5. Place your extra label on the receiving report.
6. Give approval labels to Material Control.
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M A T E R I A L   C O N T R O L 

ROLE OF MATERIAL CONTROL: 

 MC controls the flow of materials and limits the access of materials to
prevent against “off-grade” materials being used in production.

 Material Control inspects all incoming materials/packages for integrity.

 Material control offers expertise in packaging and storing of materials.

Your Tasks are: 

1. STORAGE AREAS:

Designate two separate areas: “Quarantine” and “Approved.”   Use the
boxes provided and label them appropriately.

2. Inspect all incoming packages for possible signs of damage during shipping.

3. RECEIVING RAW MATERIALS:

You will receive raw materials to enter into your system. 

Instructions:
1. By using information on the package - fill in SECTION 1 on the

“Receiving Report".   Use the template provide. 
2. Give a “RECEIVING NUMBER” to the material.  Use the following

format:  DDMMYY – 000
(i.e. for the first item received on January 2, 2007 write: 010207-001)

3. Write this receiving number on the Receiving Report.  Attach the COA to
the Receiving Report.

4. Complete a Quarantine Label and place the completed “Quarantine”
label on the material and transfer to the “Quarantine” area.

5. Give the “Receiving Report" and COA to QC- this is their cue to
sample the material and begin testing.

4. LABELING RAW MATERIALS APPROVED:

1. QA will give Material Control “Approval” labels to apply to the material
that is in “Quarantine”.

2. Place the Approval Label to cover up the word “QUARANTINE” on the
quarantine label.   Move the material to the “Approved” area.

3. Production may now have the material. Give only “Approved” material to
production for their use.
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5. RECEIVING FINAL PRODUCTS INTO QUARANTINE:

You will need to take the final product (i.e. popcorn) and place it in quarantine. 

Instructions:
1. fill in SECTION 1 on the “Receiving Report".   Use the template

provide. Ask production team for lot number. 
2. Complete a Quarantine Label and place the completed “Quarantine”

label on the material and transfer to the “Quarantine” area.
3. Give the “Receiving Report" to QC- this is their cue to sample the

material and begin testing.
4. QA will give Material Control the “Approval” labels to apply to the

material that is placed in “Quarantine”.    Move the material to the
“Approved” area.
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P R O D U C T I O N 

ROLE OF PRODUCTION: 

 Execute the process according the batch record to produce a product
within specifications

 Coordinate the batch record, release of raw materials, and equipment

Checklist of Items to Accomplish: 
 Write Master Raw Material Specification Sheet and circulate for approvals
 Write Master Final Product Specification Sheet and circulate for approvals
 Write Master Batch Record and circulate for approvals
 Ensure Raw Materials have been tested and approved
 Clean Microwave per SOP
 MAKE GMP Popcorn!  And complete batch record as you go!

HINT:   PRODUCTION HAS MANY DOCUMENTS TO WRITE ….IT IS BEST IF YOU MULTI 
TASK AND SPREAD THE WORK AMONG THE DEPARTMENT.  

Your Tasks are: 

1. WRITING MASTER SPECIFICATIONS:

Production must write the following specifications and give to QC and QA to
review and approve:
1. RAW MATERIAL SPECIFICATION SHEET for the KERNELS
2. FINAL PRODUCT SPECIFICATION SHEET for the POPCORN.

Instructions:
Use the template in your package.  Neatly complete all boxes (i.e. 
Vendor, storage conditions, specifications, etc.) that are shaded (except the 
signatures).   All information provided should make sense and be reasonable. 
Try where possible to write quantitative specifications (i.e. “No more than 2 
dark pieces of popcorn).   

1. Circulate for signatures –
  1st: Production signer in “Written By” 
  2nd: Production Supervisor signs 
  3rd: QC Supervisor  
  4th:  QA 

NOTE:  QA will keep the final document. 

2. WRITING A MASTER BATCH RECORD:

Production must write a Master Batch Record for the production of Popcorn.
Use the Template provided.
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Instructions:   
Enter all the information in the boxes that are shaded.  You must describe 
what you think your process will be.  All information provided should make 
sense and be reasonable.  

HOW TO WRITE A MASTER BATCH RECORD: 
 a).  Complete all shaded areas. Sign your name on the front page 

       b).  Give to Production supervisor for review.  Sign your name on the 
front page.  

 c).  Give to QA to review.  Sign your name on the front page.  
 d).  Once QA is happy with the batch record, they will issue you a copy 

to conduct your production. 

3. Don’t forget to check with QC regarding the testing of your raw materials
(i.e.: Kernels).

4. CLEANING EQUIPMENT:

Before production can use a piece of equipment it must be clean!  It is a
common practice in industry to have QA inspect the equipment after
production cleans it.

HOW TO CLEAN EQUIPMENT:

1. Use the SOP provided to clean your equipment (i.e. Microwave).
2. Once the production operator has cleaned the Equipment, complete

the documentation required on the Cleaning log and have the
Supervisor inspect the equipment.

3. Request QA to visually inspect the microwave for cleanliness.
4. Once QA has inspected the equipment and found it acceptable, you

may now use the equipment.

5. STARTING PRODUCTION!

1. Once you have the issued batch record from QA; APPROVED raw
material; and CLEAN equipment, you may start production of the
POPCORN.

2. Follow the process in your batch record and document as you go.
Once the production of the popcorn is complete so should your batch
record.

ENDING PRODUCTION: 

1. Notify Material Control to remove your popcorn from the equipment
and place it in quarantine.

2. While QC is testing the material, the Production Operator must review
the record to ensure all information is complete.
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3. Production supervisor must review and sign the back of the batch
record.

4. Submit to QA for review.
5. Clean the equipment as documented above.
6. Wait to hear from QA if your material is approved!
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Q U A L I T Y   C O N T R O L 

ROLE OF QC: 

 Test all materials to be used by Production.

Checklist of Items to Accomplish: 
o Review Raw Material (i.e Kernals) Specification Sheet
o Test Raw Materials
o Review Final Product (i.e. Popcorn) Specification Sheet
o Test Final Product Materials

Your Tasks are: 

1. APPROVING MASTER SPECIFICATIONS:

Production will be submitting for your review AND approval:
1. RAW MATERIAL SPECIFICATION SHEET for the KERNELS
2. FINAL PRODUCT SPECIFICATION SHEET for the POPCORN.

Instructions:  Review to ensure all boxes that are shaded have been
completed.   All information provided should make sense and be reasonable. 
Try where possible to have the team write in quantitative specifications (i.e. 
“No more than 2 dark pieces of popcorn).   If you don’t agree with the 
specifications or have questions feel free to go back to the Production Team 
for clarification. 

HOW TO APPROVE A MASTER SPECIFICATION SHEET: 
To approve the specification sheet complete the following: 

 a).  Sign your name in the shaded box for “QC Approval”.
 b).  Give to QA for their review.     

2. DOCUMENTS NEEDED:

NOTE:  QA will give you copies of the specification sheets to document the
results of the testing for BOTH the kernels and the popcorn.

3. APPROVING RAW MATERIALS:

Before production can use the kernels in their production run they must be
approved by QC AND QA!   Follow the instructions below to test and approve
the raw materials (i.e. Kernals).

HOW TO TEST AND APPROVE RAW MATERIALS:

1. Material Control will be giving you a RECEIVING REPORT for both
KERNALS and POPCORN (once made).  This is your cue that
something is in quarantine and needs to be tested by QC.   Take your
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specification sheet to quarantine and begin to following the sampling 
and testing instructions.

2. Once the analyst completes the “testing” on the Kernals, review the
information written in on the specification sheet and the accompanying 
documentation to ensure no empty spaces.   The analyst will sign 
his/her initials and date in the column.  

3. The QC Supervisor will review the package of data the analyst
completed and If acceptable, sign your name in the box for QC 
approval at the bottom of the page on the specification sheet and 
check off “Approved”.   

4. Give package to QA.

4. APPROVING FINAL PRODUCT (I.E: Popcorn):

Once production has made the popcorn, you will be required to test the
material.   Follow the instructions below to test and approve the final product
(i.e. popcorn).

HOW TO TEST AND APPROVE FINAL PRODUCTS:

1. Material Control will be giving you a RECEIVING REPORT for the
POPCORN (once made).  This is your cue that something is in
quarantine and needs to be tested by QC.   Take your specification
sheet to quarantine and begin to following the sampling and
testing instructions.

2. Once the analyst completes the “testing” on the Popcorn, review
the information written in on the specification sheet and the
accompanying documentation to ensure no empty spaces.   The
analyst will sign his/her initials and date in the column.

3. The QC Supervisor will review the package of data the analyst
completed and If acceptable, sign your name in the box for QC
approval at the bottom of the page on the specification sheet and
check off “Approved”.

4. Give package to QA.
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       Page 1 of 8 

Batch Production Record 

Product Name: Popcorn    

Effective Date: 

Revision: 0 

Written By: Date: 

Production Supervisor 

Approval: Date: 

Quality Assurance 

Approval: Date: 
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MANUFACTURING DIRECTIONS FOR LAB SCALE BATCH: 

(completed by QA when issued) (Completed by QA on Master) 

Lot Number: Effective Date::::   

RRevision: 0 

COMPOUND: POPCORN   Page 2 of 8 

Document Approval 

Quality Assurance Initial: 

INPUT MATERIALS: 

INPUT MATERIALS 
PRODUCTION 

OPERATOR 

CHECKED 

BY 

Note: 
Input Materials are materials used in your process (i.e.  Kernals). 
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MANUFACTURING DIRECTIONS FOR LAB SCALE BATCH: 

(completed by QA when issued) (Completed by QA on Master) 

Lot Number: Effective Date::::   

RRevision: 0 

COMPOUND: POPCORN   Page 3 of 8 

Document Approval 

Quality Assurance Initial: 

REACTION SCHEME 

HEAT 
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MANUFACTURING DIRECTIONS FOR LAB SCALE BATCH: 

(completed by QA when issued) (Completed by QA on Master) 

Lot Number: Effective Date::::   

RRevision: 0 

COMPOUND: POPCORN   Page 4 of 8 

Document Approval 

Quality Assurance Initial: 

EQUIPMENT CHECKLIST 

(Standard batch size) 

Inventory 
Number 

Production 
Operator 

 Initial and date 

Microwave Oven 
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MANUFACTURING DIRECTIONS FOR LAB SCALE BATCH: 

(completed by QA when issued) (Completed by QA on Master) 

Lot Number: Effective Date::::   

RRevision: 0 

COMPOUND: POPCORN   Page 5 of 8 

Document Approval 

Quality Assurance Initial: 

PROCEDURE 

Date: 

Operator 
init./time 

Coworker 
init./time 

1. 

2. 

3. 

4. 

5. 

6. 
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MANUFACTURING DIRECTIONS FOR LAB SCALE BATCH: 

(completed by QA when issued) (Completed by QA on Master) 

Lot Number: Effective Date::::   

RRevision: 0 

COMPOUND: POPCORN   Page 6 of 8 

Document Approval 

Quality Assurance Initial: 

Date: 

Operator 
init./time 

Coworker 
init./time 

7. 

8. 

9. 

10. 

Comments:  (initial and date any comments) 
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MANUFACTURING DIRECTIONS FOR LAB SCALE BATCH: 

(completed by QA when issued) (Completed by QA on Master) 

Lot Number: Effective Date::::   

RRevision: 0 

COMPOUND: POPCORN   Page 7 of 8 

Document Approval 

Quality Assurance Initial: 

SUMMARY OF RESULTS 

Actual Yield 
%: % 
Operator: Supervisor: 

STORAGE OF MATERIAL 

Total containers of product transferred to storage: 

STORAGE CONDITIONS:   Store at room temperature. 
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MANUFACTURING DIRECTIONS FOR LAB SCALE BATCH: 

(completed by QA when issued) (Completed by QA on Master) 

Lot Number: Effective Date::::   

RRevision: 0 

COMPOUND: POPCORN   Page 8 of 8 

Document Approval 

Quality Assurance Initial: 

CONCLUSION 

Date Production Finished: 
Production Operator  

Initials: 

Production Supervisor  
Approval: Date: 

Quality Assurance 
Reviewer: Date: 

DISPOSITION OF LOT #  _____.      .       .  

Approved Non-Conforming 

Quality Assurance 
Signature: Date: 
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RECEIVING REPORT 

Page 1 of 1 Johnson Matthey Pharmaceutical Materials, Inc. 

25 PATTON ROAD, DEVENS, MA 01432  TEL:  978.784.5000  FAX:  978.784.5500  WWW.PHARMECO.COM 

SECTION I :     RECEIVING (Completed by Material Control) 

Material Name: Date Received: 

Supplier: Receiving Lot No.: 

Quarantine Label Applied:     Yes  Number of Containers:   

Completed by: Date: 

SECTION II:     SAMPLING and INSPECTION  (Completed by QC) 

Total sample quantity (if final product 
otherwise N/A): 

Number of Containers Sampled / 
Inspected: 

By: Date: 

SECTION III: LABELING (Completed by QA) 

Number of labels issued:  (QA) By   Date: 

 Number of sample labels:     (QA) By Date: 

Attach Sample Label Below    (QA) By: Date 

Place sample label below:  
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RAW MATERIAL SPECIFICATION SHEET

Receiving 

Number: 

Revision:  Effective Date: 

Item Description:   KERNELS 

Structure: Written By:  

Date: 

QC Approval: 

Date: 

Production Supervisor Approval: 

Date: 

QA Approval: 

Date: 

Hazards: MAY HARM TEETH! 

Storage Condition:  Supplier: 

SPECIFICATIONS AND RESULTS 

Test Method Specification Result 

QC Analyst 

Init. / Date 

Physical 

Description 

Visual 

QC Approval  Approved

 Non-Conforming

Date: 

QA Approval  Approved

 Non-Conforming

Date: 
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FINAL PRODUCT SPECIFICATION SHEET

Lot Number: Revision:  Effective Date: 

Item Description:   POPCORN 

Structure: Written By:  

Date: 

QC Approval: 

Date: 

Project Team Approval: 

Date: 

QA Approval: 

Date: 

Hazards: 

Storage Condition:  Supplier: 

SPECIFICATIONS AND RESULTS 

Test Method Specification Result 

QC Analyst 

Init./Date 

Physical 

Description 

Visual 

QC Approval  Approved

 Non-Conforming

Date: 

QA Approval  Approved

 Non-Conforming

Date: 
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Receiving/Lot#:________________ 

Initials.:_______ Date:_________ 

Storage Conditions:_____________ 
QUARANTINE 

Receiving/Lot#:________________ 

Initials.:_______ Date:_________ 

Storage Conditions:_____________ 

QUARANTINE 

Receiving/Lot#:________________ 

Initials.:_______ Date:_________ 

Storage Conditions:_____________ 

QUARANTINE 

Receiving/Lot#:________________ 

Initials.:_______ Date:_________ 

Storage Conditions:_____________ 
QUARANTINE 

Receiving/Lot#:________________ 

Initials.:_______ Date:_________ 

Storage Conditions:_____________ 

QUARANTINE 

Receiving/Lot#:________________ 

Initials.:_______ Date:_________ 

Storage Conditions:_____________ 

QUARANTINE 

Receiving/Lot#:________________ 

Initials.:_______ Date:_________ 

Storage Conditions:_____________ 
QUARANTINE 

Receiving/Lot#:________________ 

Initials.:_______ Date:_________ 

Storage Conditions:_____________ 

QUARANTINE 

Receiving/Lot#:________________ 

Initials.:_______ Date:_________ 

Storage Conditions:_____________ 

QUARANTINE 

Receiving/Lot#:________________ 

Initials.:_______ Date:_________ 

Storage Conditions:_____________ 
QUARANTINE 

Receiving/Lot#:________________ 

Initials.:_______ Date:_________ 

Storage Conditions:_____________ 

QUARANTINE 

Receiving/Lot#:________________ 

Initials.:_______ Date:_________ 

Storage Conditions:_____________ 

QUARANTINE 

Receiving/Lot#:________________ 

Initials.:_______ Date:_________ 

Storage Conditions:_____________ 
QUARANTINE 

Receiving/Lot#:________________ 

Initials.:_______ Date:_________ 

Storage Conditions:_____________ 

QUARANTINE 

Receiving/Lot#:________________ 

Initials.:_______ Date:_________ 

Storage Conditions:_____________ 

QUARANTINE 

Receiving/Lot#:________________ 

Initials.:_______ Date:_________ 

Storage Conditions:_____________ 
QUARANTINE 

Receiving/Lot#:________________ 

Initials.:_______ Date:_________ 

Storage Conditions:_____________ 

QUARANTINE 

Receiving/Lot#:________________ 

Initials.:_______ Date:_________ 

Storage Conditions:_____________ 

QUARANTINE 
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01/13/07 1:51 PM 

Confidential 

STANDARD OPERATING PROCEDURE 

Procedure: 

PROCEDURE FOR THE PRODUCT CHANGEOVER 

CLEANING OF A MICROWAVE OVEN 

Procedure No.:  CLN-0001 Revision:   0 

Effective Date:  01/15/07 

Replaces Document:  New 

Written by: 

Dept.:   Production Date:   01/10/07 

Dept. Approval: 

Dept.: Engineering Date:  01/10/07 

Content Review: 

Dept.: Engineering   Date:   01/10/07 

QA Approval: 

Date:  01/13/07 

I. PURPOSE 

This procedure is to ensure proper cleaning of equipment. 

III. PROCEDURE

RESPONSIBILITY 

3.1 Product Changeover Cleaning 

3.1.1 Enter the lot number of the batch on the “Equipment Cleaning 

Log”. 

Production 

3.1.2 Clean the equipment using water as a cleaning agent and paper 

towels as cleaning implements. 

Production 

3.1.3 First wipe the interior top of the microwave from back to 

front. 

Production 

3.1.4 Wipe the interior back of the microwave from top to bottom. Production 

3.1.5 Wipe the interior sides of the microwave from back to front, 

then top to bottom. 

Production 

3.1.6 Wipe the interior bottom of the microwave from back to front. 

If the microwave has a turntable inside, remove pieces and 

clean them using water as a cleaning agent.  Visually inspect for 

contaminants.  Replace them in the microwave when complete. 

Production 

3.1.7 Complete the “Cleaning Log”.  Enter the SOP number used, 

cleaning agent, and time / date of person performing cleaning. 

Production 

3.1.8 Visually inspect for contaminants.  If contaminants are present, 

repeat steps 3.1.2 through 3.1.7.  If acceptance, initial column. 

Supervisor 

3.1.9 Notify QA to Inspect the equipment and verify that it is clean. 

Quality Assurance will sign the log in the “QA Initials 

Column” and check the product changeover box.  

Production 

QA 
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EQUIPMENT CLEANING LOG 

Equipment Name: Microwave  Make.: 

Lot Number of batch 

in production 

Time/Date 

of Cleaning 

1. SOP No.

2. Solvents Used

Initials of person 

performing cleaning 

and a coworker 

verifying  

Cleaning Status 

Lot Number: 

___________________ 

Time: 

Date: 

__________ 

SOP #  

____________ 

Solvent:  

_____________ 

Production Initials: 

____________ 

Supervisor Initials: 

____________ 

 Product Changeover

 QA Initials:______ 

   Date:______ 

Lot Number: 

___________________ 

Time: 

Date: 

__________ 

SOP #  

____________ 

Solvent:  

_____________ 

Production Initials: 

____________ 

Supervisor Initials: 

____________ 

 Product Changeover

 QA Initials:______ 

   Date:______ 

Lot Number: 

___________________ 

Time: 

Date: 

__________ 

SOP #  

____________ 

Solvent: 

_____________ 

Production Initials: 

____________ 

Supervisor Initials: 

____________ 

 Product Changeover

 QA Initials:______ 

   Date:______ 

112



QC MICROBIOLOGY 
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Montgomery County Community College 

340 DeKalb Pike 

Blue Bell, PA  

Document Number: 21.0.0 

Revision Number: 0 

Effective Date: 30JUN14 

Page 1 of 2 

SOP: Operation of MetOne Model 229 B Laser Particle Counter 

Approvals 

Preparer: Sheila Byrne    Date: 23OCT06 

Reviewer: Dr. Maggie Bryans Date: 30JUN14 

1. Purpose:

1.1. Operation of the MetOne Laser Particle Counter.

2. Scope:

2.1.  Applies to the MetOne Laser Particle Counter for performing sampling of air quality.

3. Responsibilities:

3.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technician to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while 

performing the procedure. 

4. References:

4.1. MetOne Model 228/229 Particle Counter Operating Guide

5. Definitions: N/A

6. Precautions: N/A

7. Materials:

7.1. MetOne Unit, Model 229B

7.2. Isokinetic Probe

7.3. Purge Filter

7.4. MetOne Battery Charger

8. Procedure:

8.1. Operation

8.1.1. Place the MetOne unit on the bench or cart at the appropriate location facing into 

 the center of the room . Battery or AC power source may be used. 

8.1.2. Remove the red inlet cap from sensor inlet tube and attach the isokinetic probe. 

8.1.3. Turn on the MetOne unit using the switch on the side of the unit. After power on

the model 229 will start counting and the display will be continuously updated as 

particles are detected. The counter will run for one minute then hold the displayed     

count until the unit is turned off. This count represents the number of particles  

            in one tenth of a cubic foot of air. (To determine the number of particles in 1m3 of 

air divide by 0.002832.) Record this value.   

8.1.4. Turn off the MetOne unit. 

8.1.5.   Remove isokinetic probe and replace red inlet cap on sensor inlet tube. 

8.1.5. Store unit.  

8.2. Recharging the MetOne battery. 

8.2.1. When the “low battery” display appears on the MetOne unit, the battery needs to 

 be recharged. 

8.2.1.1.Turn off the MetOne unit and connect the AC adapter to the unit. 

8.2.1.2.Plug in the AC adapter and charge the battery for 16 hours. 
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SOP: Operation of MetOne Model 229 B Laser Particle Counter 
8.3. Contamination. 

8.3.1. When the counter is used in high concentration or uncontrolled environments, it is 

possible for the sensor to become contaminated. If this happens the sensor light  

will come on. If this occurs, replace the isokinetic probe with the purge filter.      

8.3.2. Run the counter until the display reads 0 counts. 

8.3.3. This usually clears the contamination and the sensor light will go out. (The sensor    

light also comes on if the laser diode fails.) 

9. History

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 23OCT06 Sheila Byrne Initial release 
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SOP: Operation of Met One GT-321 Particle Counter 

Approvals 

Preparer: John Buford Date: 17OCT13 

Reviewer: Tim Kull Date: 18OCT13 

Reviewer: Dr. Maggie Bryans Date: 19OCT13 

1. Purpose

1.1. Measure the number of airborne particulates per cubic foot using the Met One GT-321

particle counter. 

2. Scope and Applicability

2.1.  The Met One GT-321 particle counter measures airborne particles by drawing in

ambient air using a vacuum pump and counting particles using a laser based diode 

sensor. This SOP covers normal operations including air sampling, battery recharging, 

and zero count testing. 

3. Summary of Method

3.1.  Place the unit in the area to be measured.

3.2. Attach the iso-kinetic probe.

3.3. Turn on power and press START; 10 samples are taken automatically and averaged.

3.4. Recharge the battery when “Low Battery” message is displayed.

3.5. Periodically test the unit for air leaks using a zero count test.

4. References

4.1. GT-321 Hand Held Particle Counter Operation Manual, GT-321-9800 Rev D.

5. Definitions

Iso-kinetic Constant movement or velocity 

6. Precautions

6.1. The GT-321 unit contains no user serviceable parts. Do not open or attempt to change

the internal battery pack. 

6.2. Contains a Class I laser, considered not hazardous when properly operated. Repairs 

should be performed by manufacturer train service personnel only. 

7. Responsibilities

7.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary.  

7.2. It is the responsibility of the students/technician to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while 

performing the procedure.  
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SOP: Operation of Met One GT-321 Particle Counter 

8. Equipment and Materials

8.1. Met One GT-321 Particle Counter

8.2. Iso-kinetic probe

8.3. AC to DC converter module

8.4. Zero test filter

9. Procedure

9.1. Air sampling:

9.1.1. Place the MetOne unit on a bench or cart in the area to be measured with the inlet 

nozzle pointing upward. Battery or AC power source may be used. 

9.1.2. Remove the rubber cap from the inlet nozzle on the top of the unit and attach the 

iso-kinetic probe. (The iso-kinetic probe helps reduce errors due to the aerodynamic 

properties of small particles.) 

9.1.3. Turn on the power switch on the left side of the case. The LCD display should 

indicate 0.3u. 

9.1.4. (Optional) Press the SELECT key to cycle through the particle sizes: 0.3u, 0.5u, 

1.0u, 2.0u, and 5.0u. Stop when 0.3u is displayed. 

9.1.5. Press the START/STOP button on the front of the unit. The internal vacuum 

pump will start running. The unit will automatically take 10 ambient air samples, 

one cubic foot per sample. After 9 seconds the first reading will appear on the 

display representing the number of particles that are larger than the size selected 

above. Additional readings will appear every 6 seconds for a total of 10 samples.  

9.1.6. When all 10 samples are taken, the average is computed and displayed. This count 

represents the number of particles in one cubic foot of air. Record this value. (To 

determine the number of particles in one cubic meter, divide by 0.02832.)  

9.1.7. Turn off the MetOne unit. 

9.2. Recharging the battery: 

9.2.1. When the battery needs recharging, the “Low Battery” message is displayed and 

the pump will not activate when the START button is pressed. 

9.2.2. Turn off the unit and connect the AC to DC converter module. 

9.2.3. Plug in the AC to DC converter module and charge the battery for 15 hours. 

9.3. Zero count test: 

9.3.1. Periodically test the Met One unit for air leaks. (Weekly is recommended.) 

9.3.2. Remove the rubber cap from the inlet nozzle on the top of the unit and attach the 

zero test filter.  

9.3.3. Turn on the power switch and press the START/STOP button as if air sampling. 

9.3.4. The result of the 1 minute sampling should be zero. If it does not read zero, the 

unit may need to be repaired by the factory. 
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10. Attachments

Figure 1. Met One GT-321 Particle Counter 

11. History

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 10/17/2013 John Buford Initial release 
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SOP: M Air T Millipore Air Tester 

Approvals: 

Preparer: Dr. Maggie Bryans Date: 09JAN14 

Reviewer: Jason McMillan   Date: 10JAN14 

1. Purpose:

1.1. The purpose of this SOP is to describe the procedure in using the M Air T Millipore Air

Tester in conducting airborne microbial testing. 

2. Scope:

2.1. The scope of this SOP is limited to performing airborne microbial testing using the M

Air T Millipore Air Tester. 

3. Responsibilities:

3.1. It is the responsibility of the course instructor /lab assistant to ensure that this SOP is

performed as directed and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while performing 

the procedure.  

4. References:

4.1. M Air T Millipore Air Tester Operation and Maintenance Instruction

4.2. autoclave SOP

4.3. incubator SOP

5. Definitions: N/A

6. Precautions:

6.1. Always wear the appropriate personnel protective equipment (safety eye glasses and

gloves). 

7. Materials:

7.1. M Air T Millipore Air Tester and accessories.

7.2. M Air T Cassette pre-filled with TSA media

7.3. autoclave

7.4. incubator

7.5. 70% isopropyl alcohol (IPA)

7.6. lab towels

8. Procedure:

8.1. Using the air tester in vertical, horizontal or inclined position

8.1.1. When using the air tester in a vertical position, the tripod is not used. 

8.1.2. When using the air tester in a horizontal position or 30° from the horizontal 

position, the tripod is needed. Fix the tripod onto the air tester by screwing it 

into the tester fixing hole.     

8.2. Powering up the equipment 

8.2.1. If the equipment is used to collect samples inaccessible to power outlets, the 

equipment has internal rechargeable batteries ready for use. Press the ON/OFF 

button. LCD display will be turned on.  

Note: Make sure the battery is fully charged. The LCD will display the battery 

symbol if it is fully charged. 
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SOP: M Air T Millipore Air Tester 

8.2.2. If the equipment is used to collect samples accessible to power outlets, plug the 

power adapter into an empty and convenient power outlet. LCD display will be 

turned on.   

8.3. Adjusting the volume to be processed 

Note: Refer to Figure 2. 

8.3.1. The recommended volume is 1000 Liters. 

8.3.2. Setting up volume other than the recommended volume 

8.3.2.1.To access other preset volumes, press the LITERS button multiple times until 

you find your desired volume. 

8.3.2.2.To change the volume setting, select the volume that is just below the preset 

volume you want to process. Then hold the LITERS button until the tester 

display indicates the desired sampling volume. 

8.4. Adjusting the timer  

Note: Refer to Figure 2. 

8.4.1 The recommended set time is 5 minutes. 

8.4.2 Setting up the time other than the recommended set time. 

8.4.2.1 Hold down the START/DELAY button. The display shows preset 

times in increments of 5 minutes up to one hour. Select the desired 

time by simply releasing the START/DELAY button.  

8.5 Installing the cassette and running the tester 

Note: Refer to Figures 2 and 3 as needed. 

8.5.1 Define the location of the tester according to cGMP requirements  

8.5.2 Ensure that pre-filled cassettes with TSA media are at room temperature before 

starting the test. 

8.5.3 Spray down gloved hands with 70% IPA. 

8.5.4 Sanitize the external surfaces of the tester with 70% IPA. 

8.5.5 Position the wings of the cassette into the recessed area of the tester head. 

8.5.6 Retain the cassette in position by holding on to its wings. Remove the lid and 

place it on the bench, internal face down. 

8.5.7 Lock the micro-perforated sieve into position and remove cover  

8.5.8 Press the ON/OFF button. Set the default volume and time, and then quickly 

press the START/DELAY button twice. 

Note: The first 500 liters of volume of air collected is a slow flow rate 

producing a mild sound while the remaining 500 liters is a faster flow rate 

producing a noisy sound. 

8.5.9 When the display indicates end of cycle (EOC) which is related to the set time, 

unlock the sieve, remove it, and put the lid back on the cassette. 

8.5.10 To remove the cassette from the tester head, lift the cassette while firmly 

holding the edge. 

8.5.11 Label (includes relevant sample data, date, initial and testing location) and 

incubate the cassette (37ºC for 1-3 days) in the upside down position. 

8.5.12 Remove the cover from the sieve. Autoclave the sieve (without the cover) for 30 

minute at 121°C. 

8.5.13 Sanitize the external surfaces of the tester with alcohol. 
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8.5.14 Record use in the usage log. 

8.6 Evaluation of results. 

8.6.1 When incubation is complete, count the colonies on the plate. 

8.6.1.1 The microbial count (CFUs) is to be stated with reference to the 

sample volume (i.e. CFUs/Sample Volume) 

8.6.1.2 Record results in the log book. 

9. Attachments:

9.1.   Figure 1: Diagram of the M Air T Millipore Air Tester with Components

9.2.   Figure 2: Diagram of the M Air T Millipore Air Tester with Display Buttons

9.3. Figure 3: Diagram of the M Air T Millipore Air Tester with Installed Cassette

9.4. Table 1: Environmental Monitoring Testing Sheet

10. History:

Name Date Amendment 

Marlo Austria 01APR06 Initial Release 

Bob O’Brien 11SEP06 Updated procedure. Changed usage log. Added Environmental 

Monitoring Testing Sheet. 

Bob O’Brien 14MAR07 Updated date format. Updated Figures 3 and 4. 

Jason McMillan 10JAN14 Changed College Name, Added Testing Sheet 

       

                      

                  

Figure 1:  Diagram of the M Air T Millipore Air Tester with Components 
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Figure 2:  Diagram of the M Air T Millipore Air Tester with Display Buttons 

Figure 3:  Diagram of the M Air T Millipore Air Tester with Installed Cassette, Micro 

Perforated Sieve and Cap 

Micro -

perforated 

sieve 

On/Off 

button 

Start delay 

button 

Liter 

button 

Air Tester Display area 

Cassette 

pre-filled 

with TSA 

Cover 

122



Montgomery County Community College 

340 DeKalb Pike 

Blue Bell, PA 19422  

Document Number: 23.0.3 

Revision Number: 3 

Effective Date: 10JAN14 

Page 5 of 5 

SOP: M Air T Millipore Air Tester 

Table 1:  Environmental Monitoring Testing Sheet 

Date 

Tested 

Location Air 

Volume 

(L) 

Operator’s 

Initials 

and Date 

Number 

of 

Colonies 

Plate 

Incubation 

Time 

Pass or 

Pail (P/F) 

Operator’s 

Initials 

and Date 
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SOP: Gowning for Entry into Biomanufacturing Suite 

Approvals: 

Preparer: Dr. Maggie Bryans     Date: 18FEB14 

Reviewer: Jason McMillan  Date: 19FEB14 

1. Purpose:

1.1. To describe the proper gowning procedure for personnel entering the biomanufacturing

suite to minimize the number of particles and viable microorganisms in the suite. 

2. Scope:

2.1. Applies to gowning performed in the gowning area prior to entering the biomanufacturing

suite. 

3. Responsibilities:

3.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while performing the 

procedure. 

4. References:

4.1. Gowning for Aseptic Filling, Doxpub, Inc., Document number  02-0028-SOP-1.0

5. Definitions: N/A

6. Precautions:

6.1. 70% isopropyl alcohol is flammable and poisonous if ingested.  Avoid creating excessive

mist when using spray bottles with IPA. 

7. Materials:

7.1. disinfecting hand soap

7.2. sterile 70% (v/v) isopropyl alcohol (IPA)

7.3. head cover

7.4. hood (if needed)

7.5. facial hair cover (if needed)

7.6. cleanroom coverall, sterile Tyvek

7.7. shoe covers

7.8. non-powdered nitrile gloves

7.9. lab tissues such as Kimwipes

8. Procedure:

8.1. Employees should wear clean clothes that are not overly capable of shedding particulates

(i.e., wool sweaters). 

8.2. Gowning must occur only when no one is entering or exiting the gowning area.  Likewise, 

do not enter the gowning area while someone is gowning. 

8.3. Wearing makeup and jewelry is prohibited in the cleanrooms.  If necessary, remove 

makeup and jewelry before proceeding to the Pre-Gowning Area. 

8.4. Pre-Gowning Area 

8.4.1. Enter the pre-gowning area. 

8.4.2. Sanitize hands with hand sanitizer. 

8.4.3. Sanitize safety glasses with 70% (v/v) IPA, dry with a lab tissue, and place on face. 

8.4.4. Don head cover.  Use the mirror to verify that all hair is completely covered up to 

and including the hairline. 
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8.4.5. If applicable, don beard cover and place over facial hair.  Use the mirror to verify 

that all hair is completely covered.  

8.4.5.1. If facial hair is still exposed, replace the head cover with a hood.  Verify 

That all hair is completely covered. 

8.4.6. Disinfect hands. 

8.4.7. Proceed to gowning area. 

8.5. Gowning Area 

Note: Avoid creating excess mist while using IPA throughout this procedure. 

8.5.1. Put on gloves.  Choose gloves that have a snug but not overly tight fit. 

8.5.2. Sanitize gowning bench with sterile 70% (v/v) IPA.   

8.5.3. Sanitize gloves with sterile 70% (v/v) IPA.   

8.5.4. Donning the shoe covers and coverall 

8.5.4.1. Obtain a gowning package. 

8.5.4.1.1. Inspect the integrity of the package and verify that the package 

has been autoclaved. 

8.5.4.2. Open the package. 

8.5.4.3. Inspect the shoe covers for rips or tears.  

8.5.4.3.1. If rips or tears are present, discard the shoe covers in the 

receptacle and repeat step 8.5.5.1. 

8.5.4.4. Sit on bench and put on a single shoe cover.  

8.5.4.5. Swing leg over bench to clean side of gowning area.  Apply other 

shoe cover and stand on clean side of gowning area. 

8.5.4.6. Sanitize gloves with sterile 70% (v/v) IPA.  

8.5.4.7. Remove the coverall from the package.   

Note: Avoid touching the coverall to the floor at all times. 

8.5.4.8. Inspect the coverall for rips or tears.   

8.5.4.8.1. If rips or tears are present, discard the coverall in the  waste 

receptacle and repeat step 8.5.4.1. 

8.5.4.9. Unzip the coverall. 

8.5.4.10. Gather the arms and one leg of the coverall together. 

8.5.4.11. Place leg in coverall and pull up the coverall.  Repeat the process 

 with the other leg.  Do not allow the sleeves to touch the floor. 

8.5.4.12. Pull the coverall up over the body and zip. 

8.6. Sanitize gloves with sterile 70% (v/v) IPA.   

8.7. After gowning, employees may enter the biomanufacturing area.  While performing aseptic 

processing, resanitize gloves as needed.  Reglove or regown if any adverse circumstances 

are observed or suspected that may affect the integrity of the gown components. 

8.7.1. Regown by exiting the biomanufacturing suite and repeating this SOP. 

8.8. Exiting the biomanufacturing suite 

8.8.1. Proceed to the exit area. 

8.8.2. Discard coverall and other cleanroom garb appropriately in the receptacle. 

8.8.3. Regown with fresh supplies when reentering the area. 

8.9. Gowning qualifications for non-qualified personnel. 
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8.9.1. Non-qualified personnel (employees, outside contractors, or visitors) may not 

enter the biomanufacturing suite without permission from the Director of 

 Manufactruing or QA/QC. 

8.9.2. Upon permission, non-qualified personnel must gown with instructions and in the 

presence of a fully qualified operator and be monitored using applicable standard 

procedures. 

8.9.3. All occurrences of non-qualified personnel entering the biomanufacturing suite 

between the time of room sanitization and completion of a batch must be 

documented using a discrepancy report. 

9. Attachments: N/A

10. History:

Name Date Amendment 

Deb Audino 22OCT05 Initial Release 

Deb Audino 06FEB05 Changed donning gown from dirty side to clean side. 

Deb Audino 17JUL08 College name change 

Jason McMillan 19FEB14 College name change 
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Approvals: 

Preparer: Dr. Maggie Bryans Date: 18FEB14 

Reviewer: Jason McMillan   Date: 19FEB14 

1. Purpose:

1.1. To Gram stain samples. 

2. Scope:

2.1. Applies to Gram staining samples using the 3-step method to detect the presence of Gram 

       positive and Gram negative microorganisms. 

3. Responsibilities:

3.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is 

performed as described and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and to 

       inform the instructor about any deviations or problems that may occur while performing 

       the procedure. 

4. References:

4.1 Gram stain pack insert

4.2. microscope SOP

5. Definitions:

5.1. Gram positive microorganism:  a microorganism that stains dark purple when treated with 

       Gram staining solutions. 

5.2. Gram negative microorganism: a microorganism that stains pink when treated with Gram 

       staining solutions. 

6. Precautions:

6.1. Gram Stain reagents are harmful. Wear gloves while performing this SOP. 

7. Materials:

7.1. 4-step Gram stain kit 

7.2. microscope slide 

7.3. P20 pipet and tips 

7.4. Bunsen burner  

7.5. safety gas lighter with flint 

7.6. tongs 

7.7. inoculation loop 

7.8. isopropanol 

7.9. slide staining rack  

7.10. timer 

7.11. water 

7.12. immersion oil 

7.13. microscope with 1000X magnification 

7.14. lab tissues 

7.15. lab towels 

8. Process:

Note: Refer to Figures 1-6 as needed before performing this SOP and throughout the procedure

as needed.

8.1. Sample preparation 
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8.1.1. Label a glass microscope slide with pertinent information. 

8.1.2. Prepare slide following directions for the appropriate sample source: 

8.1.2.1. If sample is from a liquid culture, pipet 10µL of the culture onto the 

 microscope slide.  

8.1.2.1.1. Spread into a thin film with the pipet tip. 

8.1.2.2. If sample is from a colony, pipet 10µL of water onto the slide. 

8.1.2.2.1. Take a sample of the colony using a sterile loop. 

8.1.2.2.2. Place the loop full of sample on the glass microscope slide, mix 

with water and spread into a thin film. 

8.1.3. Gently heat fix the microbes to the slide.  

  Note:  Do not overheat the slide. Excessive heating will cause atypical staining. 

8.2. Gram stain 

8.2.1. Place the slide on a slide rack to cool to room temperature before staining. 

8.2.2. Cover the fixed sample on the slide with crystal violet stain and leave for 

approximately 1 minute.  

8.2.3. Wash with a stream of water until the water runs clear.  

8.2.4. Cover the fixed sample on the slide with iodine mordant and leave for approximately 

1 minute. 

8.2.5. Wash with a stream of water until the water runs clear.  

8.2.6. Rinse with decolorizer. 

8.2.7. Wash with a stream of water until the water runs clear.  

8.2.8. Cover the fixed sample with safranin and leave for 30-60 seconds. 

8.2.9. Wash with a stream of cold water until the water runs clear. 

8.2.10. Air-dry or blot with lab tissue.   

Note: Do not rub glass slide with the lab tissue. 

8.2.11. View with the light microscope at 100x magnification (using oil). 

8.2.12. Record whether cells are Gram positive (dark purple) or Gram negative (pink). 

8.2.13. Discard the slide in the biohazard sharps container. 

9. Attachments: N/A

9.1. Figure 1: Taking sample colony 

9.2. Figure 2: Spreading sample colony thin film   

9.3. Figure 3: Heat fix sample 

9.4. Figure 4: Sample covered with crystal violet 

9.5. Figure 5: Sample covered with iodine mordant 

9.6. Figure 6: Sample covered with safranin 

10. History:

Name Date Amendment 

Bob O’Brien 12Jun07 Initial release 

Deb Audino 04Apr08 College name change 

Jason McMillan 19FEB14 College name change 
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Figure 1: Taking sample colony Figure 2: Spreading sample colony thin film  

Figure 3: Heat fix sample Figure 4: Sample covered with crystal violet 

 Figure 5: Sample covered with iodine mordant Figure 6: Sample Covered with safranin 

Loading 

Sterile loop 

Isolated 

colony 

Wet mount of 

sample 

Heat fix 

sample 

Slide rack 
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SOP: LAL ASSAY - Gel Clot Method 

Approvals: 

Preparer:  Dr. Maggie Bryans Date: 09JAN14 

Reviewer: Jason McMillan  Date: 10JAN14 

1. Purpose:

1.1. To perform the LAL Gel Clot Assay

2. Scope:

2.1. To perform the LAL Gel Clot assay on various samples such as raw materials, in process

materials and the final product for determination of endotoxin concentration. 

3. Responsibility:

3.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while performing 

the procedure. 

4. References:

4.1. LAL pack instructions

4.2. water bath SOP

5. Definitions: N/A

6. Precautions: N/A

7. Materials:

7.1. LRW (LAL reagent water)

7.2. LAL with a label sensitivity of 0.06EU/mL or 0.03EU/mL

7.3. 5-10mL syringe and needle

7.4. de-pyrogenated soda lime test tubes

7.5. 100µl micropipette and sterile pipet tips

7.6. laboratory film, such as Parafilm

7.7. test tube rack

7.8. 37°C water bath

8. Procedure:

8.1. Prepare the LAL Reagent

8.1.1. Reconstitute the LAL by adding LAL grade reagent water (LRW). Swirl 

occasionally until completely dissolved (about 3 minutes). 

8.2. Dilute the Sample 

8.2.1. Set up a row of 7 de-pyrogenated test tubes and label the tubes as: 

Undiluted, 1:2, 1:4, 1:8, 1:16, 1:32, Negative Control.  

Note: Keep tubes covered with laboratory film when not in use. 

8.2.2. Add 100µL LRW to all tubes EXCEPT the “Undiluted” tube using the same pipet 

tip. 

8.2.3. Add 200µL of the sample to the “Undiluted” tube.  Change pipet tip. 

8.2.4. Tip the tube so that the liquid reaches the lip of the tube and remove 100µL of  

 the liquid.  Add it to the 1:2 tube. 

8.2.5. Vortex the tube for 4 seconds. Change pipet tip. 
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8.2.6. Tip the tube so that the liquid reaches the lip of the tube and remove 100µL of 

 the liquid.  Add it to the 1:4 tube. 

8.2.7. Vortex mix the 1:4 tube for 4 seconds. Change pipet tip. 

8.2.8. Tip the tube so that the liquid reaches the lip of the tube and remove 100µL of 

  the liquid.  Add it to the 1:8 tube. 

8.2.9. Vortex mix the 1:8 tube for 4 seconds. Change pipet tip. 

8.2.10. Tip the tube so that the liquid reaches the lip of the tube and remove 100µL of 

 the liquid.  Add it to the 1:16 tube. 

8.2.11. Vortex mix the 1:16 tube for 4 seconds. Change pipet tip. 

8.2.12. Tip the tube so that the liquid reaches the lip of the tube and remove 100µL of 

the liquid.  Add it to the 1:32 tube. 

8.2.13. Vortex mix the 1:32 tube for 4 seconds. Change pipet tip. 

8.2.14. Tip the 1:32 tube, remove 100µL and DISCARD it.  

8.2.15. Do not add sample to the negative control tube.  

Note: All the tubes should have 100µL of liquid. 

8.3. Add the LAL Reagent 
8.3.1. Starting with the negative controls and proceeding from the lowest  to the highest 

sample concentration, add 100µL LAL to each tube. Tips need to be changed after 

each addition. 

Note: LAL must be added to all tubes within 2 minutes. 

8.3.2. Shake the test tube rack vigorously for 30 seconds to mix the LAL and sample. 

8.4. Incubate the Tubes 

8.4.1. Cover the tubes with laboratory film and CAREFULLY place the rack in  the 

water bath at about 37°C (Do not disturb other racks). Record the temperature and 

time. 

Note: Do not disturb the tubes during the incubation.  Once a clot is broken, it 

will not re-form.  

8.4.2. Incubate for approximately 60 minutes. 

8.5. Analyze the Tubes 
8.5.1. Remove the tubes one at a time from the incubator and invert them SLOWLY and 

SMOOTHLY. Score tubes as positive if a firm clot has formed.  Score tubes as 

 negative if a gel holds, but collapses after the tube is fully inverted. 

8.5.2. Record data. 

8.5.3. Determine the amount of endotoxin in the samples using the formula: 

  Endotoxin concentration < LAL label sensitivity x dilution factor of most 

concentrated sample NOT to clot. 

9. Attachments:

9.1. Data Table
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10. History:

Name Date Amendment 

Deb Audino 2001 Initial Release 

Deb Audino 2003 Added more detailed directions. 

Deb Audino 02Feb05 Replaced CSE with a sample. 

Deb Audino 10Oct05 Added undiluted sample, data table, and how to calculate 

endotoxin level. 

Deb Audino 04Apr08 College name change 

Jason McMillan 10JAN14 College name change 

Undiluted 

1 

1:2 1:4 1:8 1:16 1:32 Negative 

Control 

Sample ID 

______________ 

Sample ID 

______________ 
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Approvals: 

Preparer:   Dr. Maggie Bryans Date: 17MAR14 

Reviewer: Jason McMillan  Date: 18MAR14 

1. Purpose:

1.1. To perform a microbial identification assay.

2. Scope:

2.1. This procedure is intended as a standardized identification system for

Enterobacteriaceae and non-fastidious Gram-negative rods included in the database. 

3. Responsibilities:

3.1.  It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary. 

3.2. It is the responsibility of the students to follow the SOP as described and to inform the 

instructor about any deviations or problems that may occur while performing the 

procedure. 

4. References:

4.1. API 20E System Brochure

4.2. Guidance for Industry: Sterile Drug Products Produced by Aseptic Processing – cGMP

(FDA publication, September 2004) 

4.3. United States Pharmacopeia 25 

4.4. Gram Stain SOP 

4.5. Bergey’s Manual of Systematic Bacteriology 

5. Definitions:

5.1. Enterobacteriaceae: Family of Gram-negative, rod bacteria that inhabit soil, water and

are commonly found in the large bowel of humans.  Most common organisms isolated 

from clinical specimens. 

6. Precautions: Aseptic technique and standard precautions for handling microbial cultures.

7. Materials:

7.1. API 20E System strip, incubator tray and cover

7.2. API 20E Results sheet

7.3. API 20E Quick Index Booklet or the API 20E Profile Recognition System

7.4. Test tube rack

7.5. Disposable gloves

7.6. Bacterial cultures including E. coli control (ATCC #25922)

7.7. 10% ferric chloride

7.8. 3% hydrogen peroxide

7.10 McFarland No. 0.5 standard

7.11. Nitrate reagents (I&II)

7.12. Oxidase

7.13. Zn dust

7.14. Kovac’s reagent

7.15. VPI and VP2 reagents

7.16. Sterile mineral oil

7.17. Bacterial incubator set at 36C
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7.18. Test-tube rack 

8. Procedure:

8.1. Using the Gram-stain technique (Gram-stain SOP) determine that the bacterial culture is

a Gram-negative rod. 

8.2. Oxidase test: 

8.2.1. Using aseptic technique select an isolated colony from the streak plate. 

8.2.2. Smear a small amount of the colony over a small area of filter paper. 

8.2.3. Perform the oxidase test according to the manufacturer’s instructions. Record the 

result on the API 20E Results sheet (21st identification test). 

8.3. Preparation of the inoculum: 

8.3.1. Open an ampule of API Suspension Medium (5 ml).   

8.3.2.  Remove a well-isolated colony from the streak plate and transfer to the API 

Suspension Medium.  Mix to emulsify and obtain a homogenous suspension. 

8.3.3. Check the turbidity of the suspension to that of the McFarland No. 0.5 standard.  

If necessary, add more bacteria. 

8.3.4. The suspension must be used promptly after preparation. 

8.4. Preparation of the API strip: 

8.4.1. Obtain an incubation box (tray and lid).   

8.4.2. Add 5 ml of distilled water to the bottom of the incubation tray. 

8.4.3. Record your name, date and strain reference on the elongated flap of the 

incubation tray. 

8.4.4. Remove the strip from the sealed pouch and place it in the incubation tray. 

8.5. Inoculation of the API strip: 

8.5.1. Gently shake the 5 ml of bacterial suspension.   

8.5.2. Remove the cap and fill the 5-ml Pasteur pipette with the bacterial suspension.  

8.5.3. Tilt the incubation strip to avoid forming air bubbles. 

8.5.4. Using the Pasteur pipette, fill both the tube and the cupule of the tests CIT, VP 

and GEL. 

8.5.5. Fill only the tube (NOT the cupule) of the other tests. 

8.5.6. Overlay mineral oil and completely fill the cupule section of the tests ADH, LDC, 

ODC, H2S and URE. 

8.5.7. Place the lid on the incubation tray and incubate at 36C  2C for 18-24 hours. 

8.5.8. Make an isolation streak on a TSA plate with a portion of the bacterial suspension 

to ascertain the purity of the sample. 

8.6. Reading the API strip: 

8.6.1. After the incubation period, read the strip by referring to the Reading Table. 

8.6.2. If 3 or more tests are positive, record all reactions not requiring the addition of 

reagents (do NOT read TDA, VP, IND).  Record the results by placing a (+) for a 

positive reaction and a (–) for a negative reaction and continue with step 8.6.3.If the 

number of positive tests is less than 3 reincubate the strip for a further 24 hours ( 2 

hours) before continuing to step 8.6.3 

8.6.3. Reveal the tests which require the addition of reagents and add the following test 

reagents in the order listed.  In all cases, read the results immediately after adding 
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the reagents and waiting the proper length of time.  Do not replace the lid on the tray 

until all results have been collected.  Record results. 

8.6.3.1.TDA test: Add 1 drop of 10% ferric chloride to the TDA tube.  A reddish 

brown color indicates a positive reaction.  A negative reaction is yellow. 

8.6.3.2.VP test: Add 1 drop each of VP1 (40% KOH) and VP2 (α-napthol) solutions 

to the VP microtube.  The KOH solution should be added first.  Wait at least 

10 minutes.  A pink color developed in the whole cupule indicates a positive 

reaction.  No color change is a negative reaction. 

8.6.3.3.IND test: This test must be performed last. Add 1 drop of Kovac’s/James 

reagent to the IND tube.  A positive test is indicated by a red ring with 2 

minutes.  A yellow ring is a negative reaction. 

8.7.  Interpretation: 

8.7.1. Identification is determined by the numerical profile. 

8.7.2. On the result sheet, the tests are separated into groups of 3 and a value of 1, 2 or 4 

is indicated for each.  By adding together the values corresponding to positive 

reactions within each group, a 7-digit profile number is obtained for the 20 tests of 

the API 20 E strip.  The oxidase reaction constitutes the 21st test and has a value of 4 

if it is positive. 

8.7.3. Identify the microorganism by entering the 7-digit numerical profile manually 

using the APIweb software. 

8.7.4. Print out and record your results. 

8.7.5. If the 7-digit profile is not discriminatory enough perform the following 

supplementary tests. 

8.7.5.1.Reduction of nitrates to nitrites (NO2) and N2 gas:  Add 1 drop each of NIT 1 

and NIT2 to the GLU tube.  Wait 2 to 5 minutes.  A red color indicates a 

positive reaction (NO2).  A negative reaction (yellow) may be due to the 

reduction to nitrogen.  Add 2 to 3 mg of Zn dust to the GLU tube.  After 5 

minutes, if the tube remains yellow this indicates a positive reaction (N2).  If 

the test turns orange-red, this is a negative reaction. 

8.7.5.2.Identify the microorganism by entering the 9-digit numerical profile manually 

using the APIweb software. 

9. History:

Name Date Amendment 

Melanie Lenahan 29MAY07 Initial Release 

Sheila Byrne 22MAY08 Revision 1 

Sheila Byrne 19JUL10 Revision 2 

Jason McMillan 18MAR14 College name change, 

added Reading Table 
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10. Attachments:

Figure 1: Reading Table 

TESTS ACTIVE 

INGREDIENTS 

QTY 

(mg/cup.) 

REACTIONS/ENZYMES RESULTS 

NEGATIVE POSITIVE 

ONPG 2-nitrophenyl-βD-

galactopyranoside 

0.223 Β-galactosidase (Ortho 

NitroPhenyl-βD-

Galactopyranosidase 

colorless yellow (1) 

ADH L-arginine 1.9 Arginine DiHydrolase yellow red/orange (2) 

LDC L-lysine 1.9 Lysine DeCarboxylase yellow red/orange (2) 

ODC L-ornithine 1.9 Ornitithine DeCarboxylase yellow red/orange (2) 

CIT Trisodium citrate 0.756 CITrate utilization pale green/yellow blue-green/blue 

(3) 

H2S sodium thiosulfate 0.075 H2S production colorless/greyish black 

deposit/thin line 

URE urea 0.76 UREase yellow red/orange (2) 

TDA L-tryptophane 0.38 Tryptophane DeAnimase  TDA/immediate 

yellow reddish brown 

IND L-tryptophane 0.19 INDole Production James/immediate 

colorless pale 

green/yellow 

pink 

VP sodium pyruvate 1.9 acetoin production (Vogues 

Proskauer) 

VP1 + VP2/10 min 

colorless pink/red (5) 

GEL Gelatin (bovine 

origin) 

0.6 GELatinase no diffusion diffusion of 

black pigment 

GLU D-glucose 1.9 fermentation/oxidation 

(GLUcose) (4) 

blue/blue-green yellow/greyish 

yellow 

MAN D-mannitol 1.9 fermentation/oxidation 

(MANnitol) (4) 

blue/blue-green yellow 

INO onositol 1.9 fermentation/oxidation 

(INOsitol) (4) 

blue/blue-green yellow 

SOR D-sorbitol 1.9 fermentation/oxidation 

(SORbitol) (4) 

blue/blue-green yellow 

RHA L-rhamnose 1.9 fermentation/oxidation 

(RHAmnose) (4) 

blue/blue-green yellow 

SAC D-sucrose 1.9 fermentation/oxidation 

(SACcharose) (4) 

blue/blue-green yellow 

MEL D-melibiose 1.9 fermentation/oxidation 

(MELibiose) (4) 

blue/blue-green yellow 

AMY amygdalin 0.57 fermentation/oxidation 

(AMYgdalin) (4) 

blue/blue-green yellow 

ARA L-arabinose 1.9 fermentation/oxidation 

(ARAbinose) (4) 

blue/blue-green yellow 

OX (see oxidase test package insert) cytochrome-Oxidase (see oxidase test package insert) 
(1) A very pale yellow should also be considered positive. 

(2) An orange color after 36-48 hours incubation must be considered negative. 

(3) Reading made in the cupule (aerobic).  
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(4) Fermentation begins in the lower portion of the tubes, oxidation begins in the cupule. 

(5) A slightly pink color after 10 minutes should be considered negative. 

* The quantities indicated may be adjusted depending on the titer of the raw materials used.

* Certain cupules contain products of animal origin, notably peptones.
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Reviewer: Jason McMillan  Date: 19FEB14 

1. Purpose:

1.1. Testing of samples for presence of mycoplasma.

2. Scope:

2.1. Applies to testing of solutions including media and cultures for presence of mycoplasma.

3. Responsibilities:

3.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and 

to inform the instructor about any deviations or problems that may occur while 

performing the procedure. 

4. References:

4.1. Takara mycoplasm testing protocol

4.2. Amersham Bioscience puReTaq Ready to go PCR beads protocol

4.3. thermocycler SOP

4.4. gel documentation System SOP

5. Definitions: N/A

6. Precautions:

6.1. Ethidium Bromide is a mutagen.  Use care and wear double gloves.

6.2. UV light can damage eyes, wear UV shields when using the UV light box

7. Materials:

7.1. Takara Mycoplasma Detection PCR Kit (Catalog number: 6601)

7.1.1. Takara forward primer diluted 1:5 with PCR grade water 

7.1.2. Takara reverse primer diluted 1:5 with PCR grade water 

7.1.3. Takara control template diluted 1:5 with PCR grade water 

7.2. Amersham Bioscience pure Taq Ready to Go PCR beads (Catalog number: 27-9557-01) 

7.3. PCR grade water 

7.4. mineral oil 

7.5. agarose 

7.6. 10x TBE buffer 

7.7. 1% ethidium bromide solution 

7.8. DNA sample buffer 

7.9. 1kb DNA ladder (New England Biolabs, Catalog number: 3232L) 

7.10. sterile filter pipet tips (0-30µL and up to 200µL) 

7.11. thermal cycler 

7.12. horizontal electrophoresis box 

7.13. power Supply 

7.14. gel documentation system with UV light 

8. Procedure:

8.1. PCR amplification

8.1.1. Preparation of samples 
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8.1.1.1. Verify that a bead is visible at the bottom of each tube.  If necessary tap 

the tube against a hard surface to force the bead to the bottom of the tube. 

8.1.1.2. Label tubes as: sample, +C1, +C2, -C  

Write the date and your initials on all tubes. 

8.1.1.3. Add the following to each tube containing a PCR bead: 

   Sample    + Control 1     + Control 2      - Control 

Sterile distilled water      18µL 22µL 17µL 23µL 

Forward primer   1µL   1µL   1µL   1µL 

Reverse primer         1µL   1µL   1µL   1µL 

Control DNA    n/a   1µL   1µL    n/a 

Sample DNA        5µL    n/a   5µL    n/a        

8.1.1.4. Mix the contents of the tubes by gently pipetting up and down. 

8.1.1.5. Overlay each reaction mix with 50µL mineral oil. 

8.1.2. Amplification of samples 

8.1.2.1. Turn on instrument. 

8.1.2.2. Verify wells in the thermocycler have mineral oil and add mineral oil if 

needed. 

8.1.2.3. Verify that PCR program number 47 has not been changed. 

Program should be: 

94C 5min       1 cycle 

94C 1min    \ 

55C 2min          35 cycles 

72C 1min       / 

4C      10min 

If necessary, edit the program. 

8.1.2.4. Place all tubes in the thermal cycler. 

8.1.2.5. Start program number 47. 

8.1.2.6. When program is complete, shut off instrument and remove tubes. 

8.1.2.7. Store tubes at -20°C. 

8.2. Analysis by Electrophoresis 

8.2.1. Preparation of 1x TBE Running Buffer 

8.2.1.1. Dilute the 10x TBE to 1x TBE by combining 100mL 10x TBE with 

900mL DI water. Mix well. 

8.2.2. Preparation of 2% Agarose Gel  

8.2.2.1. Assemble gel box WITHOUT the comb. 

8.2.2.2. Weigh out 2 ±0.1 grams of agarose and place into a 250mL Erlenmeyer 

flask. 

8.2.2.3. Add 100mL 1xTBE buffer to the agarose. 

8.2.2.4. Microwave the agarose mixture until it begins to boil (~3 minutes). 

8.2.2.5. Carefully remove from microwave and swirl to mix. 

8.2.2.6. Pour agarose mix into the gel box tray until the height of the agarose mix 

is approximately 0.5cm. 

8.2.2.7. Add 10µL ethidium bromide and mix with the pipet tip. 
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Reminder: Ethidium bromide is a mutagen, use care when handling and 

wear double gloves. 

8.2.2.8. Place the comb into the tray. 

8.2.2.9. Allow the gel to set (approximately 30 minutes). 

8.2.2.10. When the gel is set, remove the comb, reverse the tray and add enough 

1X TBE buffer to just cover the gel. 

8.2.3. Running the Gel 

8.2.3.1. Remove PCR tubes from the -20°C freezer and IMMEDIATELY remove 

as much mineral oil from the top as soon as possible before the samples 

thaw. 

8.2.3.2. Add 10µL sample buffer to each tube and mix well. 

8.2.3.3. Load 15µL of each sample into individual wells. Record position of 

samples. 

8.2.3.4. Load 10µL of DNA ladder into an adjacent well. Record position of 

ladder. 

8.2.3.5. Connect the lid to the electrophoresis apparatus. 

8.2.3.6. Connect the leads to the power supply making sure to use the color codes. 

8.2.3.7. Turn on the power supply and run at 100Vfor approximately 1-2 hours. 

8.2.3.8. Turn off the power supply. 

8.2.4. Analysis 

8.2.4.1. Wearing double gloves, carefully remove gel and tray from the apparatus 

and place into a storage container designated for ethidium bromide. 

8.2.4.2. Observe under the UV light box. 

Reminder: Use the UV shield. 

8.2.4.3. Take a photograph of the gel. 

8.2.4.4. Molecular weight of the + Control PCR band should be 810bp. 

9. Attachments:

9.1. Data Table

9.2. Picture of 1kb DNA Ladder

10. History:

Name Date Amendment 

Deb Audino 02Feb05 Initial Release 

Deb Audino 10Oct05 Added catalog number for the Takara kit. Added concentration of 

ethidium bromide stock solution. Reduced volume of ethidium 

bromide solution for gel. Added attachments. 

Deb Audino 04Apr08 College name change 

Jason McMillan 19Feb14 College name change 

Lane ID of PCR Presence (+) or 
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Position reaction loaded Absence (-) of 

810bp band 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

14 

1kb DNA Ladder (New England Biolabs) 
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Approvals: 

Preparer: Jason McMillan   Date: 17JAN14 

Reviewer: Dr. Margaret Bryans   Date: 18JAN14 

1. Purpose:

1.1. Operation of the Biological Safety Cabinet (BSC).

2. Scope:

2.1. Applies to the use of the BSC for maintaining a sterile environment for media

preparation, culture inoculation and culture sampling. 

3. Responsibilities:

3.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while performing 

the procedure. 

4. References:

4.1. Labconco Purifier Class 2 Biological Safety Cabinet Operator’s Manual

5. Definitions: N/A

6. Precautions:

6.1. UV Light is damaging to eyes and skin.  Avoid exposure.

7. Materials:

7.1. 70% Isopropanol (IPA) in spray bottle

7.2. lab towels

7.3. lab coat

7.4. gloves

8. Procedure:

8.1. UV Decontamination – Performed for initial use of the day

8.1.1. Put on gloves and lab coat. 

8.1.2. Open sash slightly and immediately turn on blower.  

8.1.3. Spray and wipe down the stainless steel work surfaces of the BSC with 70% IPA. 

8.1.4. With gloved hands, spray all necessary materials not affected by UV with 70% 

IPA and place in BSC.   

8.1.5. Close the sash, turn off the blower, and turn on the UV light. This switch is 

located on the control panel. Refer to Figure 1.  

8.1.6. Leave the UV light on for at least 15 minutes.  

8.1.7. Place a biohazard waste receptacle adjacent to the cabinet.  

8.1.8. Once the appropriate time has elapsed, turn off the UV light.  

8.1.9. Turn on the visible light. This is located on the control panel.  

8.1.10. Turn on the receptacle power. 

8.1.11. Open the sash slightly, and immediately turn on the blower.  

8.1.12. After blower is on, raise the sash to the safe operating level indicated by a red dot 

on the left side of the cabinet.  
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Note: The alarm will sound if the sash is raised above this level. 

8.2. Operation 
8.2.1. Replace gloves with new ones. 

8.2.2. Spray down hands with 70% IPA prior to entering the BSC. 

Note: Allow 30 seconds for the 70% IPA to dry. This ensures disinfection. 

8.2.3. Spray all necessary equipment that needs to go into the BSC with 70% IPA, and 

allow to dry for 30 seconds.  

8.2.4. Place all necessary equipment inside of the BSC.  

8.2.5. Perform protocol while working in center of the work surface. 

Note: Do not block the intake grills. This ensures proper airflow. Refer to Figure 

3. 

8.2.6. Once the protocol is completed, remove all equipment from the BSC. 

8.2.7. Place any disposable materials that have contacted any cellular organism into the 

biohazard waste receptacle. 

8.2.8. Spray down the stainless steel work surfaces with 70% IPA.  Allow 30 seconds 

for the IPA to dry, then wipe down stainless steel work surfaces with a lab towel. 

Spray down the work surfaces once more, but allow the IPA to dry without 

wiping. 

8.2.9. Dispose lab towels used to clean BSC into the biohazard waste receptacle. 

8.2.10. Turn off the BSC.  

9. Attachments:
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Figure 1: Biological Safety Cabinet Control Panel 
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Figure 2: Biological Safety Cabinet Components 

Figure 3: Air Flow Diagram 
http://www.labconco.com/product/purifier-logic-class-ii-type-a2-biosafety-cabinets-2/4261 

10. History:

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 17JAN14 Jason McMillan Initial release 
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Approvals: 

Preparer:  Dr. Maggie Bryans Date: 03APR09 

Reviewer: Jason McMillan  Date: 03APR09 

1. Purpose:

1.1. Cleaning and assembling of the Bellco Spinner Flask (100mL). 

2. Scope:

2.1. Applies to the Bellco Spinner Flask (100mL) for maintaining suspension of cultures. 

3. Responsibilities:

3.1. It is the responsibility of the course instructor/lab assistant to ensure that the SOP is 

performed as described and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while performing the 

procedure. 

4. References:

4.1.1. Bellco Adjustable Hanging Bar Spinner Flask (100mL) manufacturer insert 

4.1.2. Autoclave SOP 

4.1.3. Bellco Micro-Carrier Spinner Flasks (500mL) SOP 

4.1.4. http://www.bellcoglass.com/ 

5. Definitions: N/A

6. Precautions: N/A

7. Materials:

7.1. magnetic stirrer plate 

7.2. glassware detergent 

7.3. bottle brush 

7.4. autoclave 

8. Procedure:

8.1. Preparation 

8.1.1. Gather all parts: glass spinner flask body, sidearm caps, top cap, compression 

          fitting body, compression fitting retaining nut, cap liner, shaft lock (cap nut, washer 

         and o-ring), glass impeller shaft, magnet and magnet holder. 

8.1.2. Wash all parts with a bottle brush, warm water and glassware detergent. Rinse 

         several times with tap water, and then several times with deionized water. 

8.2. Assembly 

8.2.1. Insert the glass impeller shaft into the hole at the bottom of the magnet holder. The 

          knob at the bottom of the shaft will catch and the magnet holder should spin freely. 

8.2.2. Insert magnet into the remaining holes on the magnet holder so that it is centered  

          across the bottom. 

8.2.3. Insert cap liner into the top cap.  Push the compression fitting body up through the 

hole in the bottom of the top cap and lock in place using the retainer nut on the 

topside of the top cap. 

8.2.4. Gently slide the glass impeller shaft through the cap from the bottom. Slide the o-

ring onto the shaft so that it is flush with the cap liner. 
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8.2.5. Insert the impeller assembly into the glass spinner flask body and screw on the top 

cap. 

8.2.6. Adjust the height of the impeller assembly by sliding the glass shaft up or down so 

that the magnet hangs just above the floor of the glass spinner flask body.  

8.2.7. Slide the cap nut onto the glass impeller shaft on top of the washer and tighten. 

8.2.8. Test the behavior of the impeller assembly by placing the assembled flask on a 

magnetic stir plate, and adjusting the height of the glass impeller shaft until the 

impeller spins properly. 

8.2.9. Screw on the side arm caps. 

8.3.1. Autoclave per autoclave SOP before and after use. (Remember to 

loosen side arm caps prior to autoclaving). 

9. Attachments:

9.1. Figure 1:  Spinner Flask Cap Assembly (http://www.bellcoglass.com/) 

9.2. Figure 2:  Spinner Flask Impeller Assembly (http://www.bellcoglass.com/) 

Figure 1:  Spinner Flask Cap Assembly              Figure 2:  Spinner Flask Impeller Assembly 
(http://www.bellcoglass.com/)      (http://www.bellcoglass.com/) 
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10. History:

Name Date Amendment 

Kari Britt 

Katrice Jalbert 

03FEB06 Initial release 

Deb Audino 04APR08 College name change 

Kari Britt 03APR09 Formatting and clarification to 

directions 

Jason McMillan 18MAR14 College name change 
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SOP: Batch Culture of Recombinant tPA Secreting CHO Cells 

Approvals: 

Preparer:  Jason McMillan Date 19MAR14 

Reviewer: Dr. Margaret Byans Date 20MAR14 

1. Purpose:

1.1. To produce a batch culture of mammalian cells.

2. Scope:

2.1.  Applies to the production of human tissue plasminogen activator (tPA) protein from

recombinant Chinese Hamster Ovary (CHO) cells. 

3. Responsibilities:

3.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and to inform 

the instructor about any deviations or problems that may occur while performing the 

procedure. 

4. References:

4.1. ATCC CRL9606 growth guidelines

4.2. Bellco Spinner Flask (100mL) Cleaning and Autoclaving SOP

4.3. Labconco Purifier Class 2 Biological Safety Cabinet (BSC) Operation SOP

4.4. CO2 Incubator SOP

4.5. Oakton PC 700 Bench Series pH/ Conductivity/°C/°F Meter SOP

4.6. spectrophotometer SOP

4.7. Glucose Determination Assay SOP

4.8. Lactate Determination Assay SOP

4.9. Trypan Blue Assay SOP

4.10. Human tPA Total Antigen ELISA SOP

4.11. Human tPA Activity ELISA SOP

4.12. Applikon ez-Control Bioreactor Controller Operation SOP

5. Definitions: N/A

6. Precautions:

6.1. Use BL2 safety measures and discard waste in biohazard containers.

7. Materials:

7.1. biological safety cabinet

7.2. vial of CHO cells (ATCC 9606-CRL) recombinant for human tissue plasminogen activator

(tPA) 

7.3. Ham's F12 Medium 

7.4. fetal bovine serum (FBS) 

7.5. 10X PBS 

7.6. 100mL vessel 

7.7. 1M NaHCO3  (sodium bicarbonate) 

7.8. 200mM glutamine 

7.9. 10mg/mL gentamycin 

7.10. sterile 100mL Bellco spinner flasks 

7.11. sterile transfer pipets (2mL, 5mL, 25 ml, and 50mL) and pipette aid 
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7.12. CO2 incubator containing magnetic stir plate 

7.13. UV-visible recording spectrophotometer  

7.14. cuvettes for spectrophotometer  

7.15. cuvette rack 

7.16. 15ml conical tubes 

7.17. Test tube rack 

7.18. 1.5mL microfuge tubes 

7.19. Microfuge tube holder 

7.20. P20 and P1000 micropipette  

7.21. microscope with 1000x magnification 

7.22. cryogenic vials (1mL capacity) for storage of CHO cell master/working cell bank 

7.23. sterile 250mL glass bottles for storage of CHO cell media  

7.24. 100 mL glass bottle 

7.25. 1L addition bottle 

7.26. Male and female autoclavable connectors 

8. Procedure:

8.1. Initial Media Preparation: Ham's F12 Medium, 90%; Fetal Bovine Serum, 10%:

8.1.1. Clean, assemble, and autoclave 100mL Bellco spinner flasks per SOP.  

8.1.2. Gather the following items, spray with 70% isopropanol, and place in the biological 

safety cabinet: 

(1) Pipette aid  

(2) 5mL sterile pipettes 

(2) 25mL sterile pipettes 

(2) 100mL sterile Bellco spinner flasks  

(1) 500mL bottle of pre-sterilized Ham's F12 Medium  

(1) 50mL tube of pre-sterilized, heat inactivated fetal bovine serum (FBS) 

8.1.3. Prepare biological safety cabinet (BSC) per Labconco Purifier Class 2 Biological Safety 

Cabinet (BSC) Operation SOP. 

8.1.4. Sterilely remove 21.6mL of Ham's F12 Medium from a 500mL bottle of Ham's F12 and 

add to a sterile 100mL spinner flask. 

8.1.4.1.  Repeat with a second 100mL spinner flask. 

8.1.5. Sterilely add 2.4mL of FBS to the sterile 100mL spinner flask. 

8.1.5.1.   Repeat with the second 100mL spinner flask. 

8.1.6. Label one spinner flask as 90% Ham’s F12, 10% FBS, [date], [group#], [operator 

initials]. Label the second spinner flask as BLANK, [date], [group#], 

[operator initials] 

8.1.7. Place all spinner flasks containing CHO cell media in the CO2 incubator. Set the speed 

of the magnetic stirrer to 60 rpm to ensure an even mixing of the culture without 

foaming. 

8.1.7.1. Verify that the temperature is 37 ± 0.5°C and percentage of CO2 is      

5 ± 0.5%. 

8.1.8. Check media for contamination after a minimum of 24 hours. 

8.2. Inoculation 
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8.2.1. Spray two 2mL sterile pipettes and a pipette aid with 70% isopropanol and place in the 

BSC. 

8.2.2. Prepare Biological Safety Cabinet per BSC SOP. 

8.2.3. Remove two vials of CHO cells from storage in the -80°C freezer and note in the 

ScienTemp -80°C Freezer Log. 

8.2.4. Thaw contents rapidly by agitation in a 37°C ± 0.5°C water bath. 

8.2.5. Spray vials with 70% isopropanol, and place in the biological safety cabinet. 

8.2.6. Sterilely transfer the entire contents of both 1mL vials of thawed CHO Cells into the 

Bellco Spinner Flask labeled 90% Ham’s F12, 10% FBS, [date], [group#], [operator          

initials] using a 2mL sterile pipet. Do not add anything to the Bellco Spinner Flask 

labeled BLANK, [date], [group#], [operator initials]. 

8.2.7. Swirl to mix. 

8.2.8. Immediately after adding CHO Cells to Bellco Spinner Flask labeled 90% Ham’s F12, 

10% FBS, [date], [group#], [operator initials] using a 2mL sterile pipet (day 0) and at 1-

day intervals the culture will be sampled to determine the OD, pH, viable cell count, 

analyte levels and tPA concentration.  The culture will be scaled up just before the 

exponential phase of the growth curve begins to slow down, indicating the cell culture 

is moving into the stationary phase of the growth curve. The live cell concentration 

should be approaching 1 million cells/ml. 

8.3. Sampling the Culture 

8.3.1. Turn on the spectrophotometer to allow the lamp to warm up for use. 

8.3.2. Collect the following items: 

(4) microfuge tubes labeled “tPA” and “cells” and “trypan” and “microcentrifuge 

counterbalance” 

(1) microfuge tube holder 

(2) spectrophotometers cuvettes (1 labeled “Sample” and 1 labeled “Blank”) 

(1) cuvette holder 

(1)  P1000 pipette 

(1) P20 pipette 

(1) pipette aid 

8.3.3. Prepare biological safety cabinet per Labconco Purifier Class 2 Biological Safety 

Cabinet (BSC) Operation SOP. 

8.3.4. Collect the following items, spray with 70% IPA and place in Biological Safety 

Cabinet: 

(1) 15ml conical tube 

(1) test tube rack 

(1) cuvette 

(1) cuvette rack 

(1) pipette aid 

(1)  5mL pipette 

(1)  2mL pipettes 

8.3.5. Prepare pH Meter per Oakton PC 700 Bench Series pH/ Conductivity/°C/°F Meter SOP. 

8.3.6. Prepare spectrophotometer per spectrophotometer SOP using media from the BLANK,  

[date], [group#], [operator initials] Bellco Spinner Flask to zero the machine.  
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8.3.7. Spray BLANK, [date], [group#], [operator initials] Bellco Spinner Flask and 90% 

Ham’s F12, 10% FBS, [date], [group#], [operator initials] Bellco Spinner Flask with 

70% IPA and place in biological safety cabinet. 

8.3.8. Using aseptic technique, remove 3 mL from 90% Ham’s F12, 10% FBS, [date], 

[group#], [operator initials] Bellco Spinner Flask and place into a 15ml conical tube.  

Using aseptic technique, remove 1 mL from BLANK, [date], [group#], [operator 

initials] Bellco Spinner Flask and place into a cuvette. 

8.3.9. Remove all items from the biological safety cabinet. 

8.3.10. Return 90% Ham’s F12, 10% FBS, [date], [group#], [operator initials] Bellco Spinner 

Flask and BLANK, [date], [group#], [operator initials] Bellco Spinner Flask to the CO2 

incubator, making sure to loosen side arm caps once in incubator. 

8.3.11. Cover the blank cuvette with Parafilm. 

8.3.12. Remove 1ml of sample from 15ml conical tube and place in cuvette labeled “Sample.” 

8.3.13. Take OD Reading at 650nm per spectrophotometer SOP.  

8.3.13.1. Mix CHO sample by inverting the cuvette several times before taking reading. 

8.3.13.2. After reading return to 15ml conical tube for pH measurement.  

8.3.14. Remove 100µl from 15ml conical tube and place in microfuge tube labeled “cells.” 

8.3.15. Determine cell count using the Trypan Blue SOP.   

8.3.16. Using the 2.9ml in the conical tube take the pH reading per Oakton PC 700 Bench  

Series pH/ Conductivity/°C/°F Meter SOP. 

8.3.17. Remove 1ml of sample and place in a 1.5mL tube and centrifuge in the benchtop mini 

centrifuge for 5minutes being sure to counterbalance the sample microfuge tube with 

the “microcentrifuge counter balance” microfuge tube containing 1ml of water.  

Remove the supernatant and place in the microfuge tube labeled “tPA,” and label with 

Date, Group Name, and Vessel Name. Store at 2-8°C in a microfuge tube storage box 

labeled with Date, Group Name, Vessel Name until needed. 

8.3.18. Record all sample data in batch record.  

8.4. Scale up to 100ml of media in 90% Ham’s F12, 10% FBS, [date], [group#], [operator 

initials] Bellco Spinner 

8.4.1. Gather the following items, spray with 70% isopropanol, and place in the biological 

safety cabinet: 

(1) Pipette aid  

(2) 10mL sterile pipettes 

(4) 50mL sterile pipettes 

90% Ham’s F12, 10% FBS, [date], [group#], [operator initials] Bellco Spinner 

Flask  

(1) 500mL bottle of pre-sterilized Ham's F12 Medium  

(1) 50mL tube of pre-sterilized, heat inactivated fetal bovine serum (FBS) 

8.4.2. Sterilely remove 74.7mL of Ham's F12 Medium from a 500mL bottle of Ham's F12 and 

add to 90% Ham’s F12, 10% FBS, [date], [group#], [operator initials] Bellco Spinner 

Flask. 

8.4.3.  Sterilely remove and add 8.3mL of FBS to 90% Ham’s F12, 10% FBS, [date], [group#], 

[operator initials] Bellco Spinner Flask. 

8.4.4. Return 90% Ham’s F12, 10% FBS, [date], [group#], [operator initials] Bellco Spinner 
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Flask to the CO2 incubator, making sure to loosen side arm caps once in incubator. 

8.5. Scale up to 1L bioreactor 

Note: When the 100mL suspension culture of CHO cells reaches a concentration of 

approximately 1,000,000 cells/mL, the entire contents of the 100mL spinner flask will be 

added to the bioreactor containing 1L of CHO cell growth media. 

8.5.1. Prepare 1M  NaHCO3 (sodium bicarbonate) 

8.5.1.1.Weigh out 21 ± 1 grams of NaHCO3 and transfer to an Applikon bioreactor 

 feed bottle. 

8.5.1.2.Label the bottle as 1M NaHCO3, [date], [initials], [group number], storage: 

 room temp, disposal: drain. 

8.5.1.3.Using a 250mL graduated cylinder, measure 250 ± 5mL deionized water and 

transfer into the feed bottle. 

8.5.1.4.Add a magnetic stir bar and stir on a magnetic stirrer to dissolve. 

8.5.1.5.Remove the stir bar and add lid and tubing per Applikon ez-Control Bioreactor 

Controller Operation SOP.  

8.5.2. Prepare the Applikon bioreactor and 1L addition bottle with tubing and autoclavable 

male connector attached for autoclaving per the Applikon ez-Control Bioreactor 

Controller Operation SOP including calibrating the pH probe. 

8.5.3. Autoclave the Applikon bioreactor with 100ml of 1X PBS and 1L addition bottle with 

tubing and autoclavable male connector attached per the Applikon ez-Control 

Bioreactor Controller Operation SOP. 

8.5.4. Remove the Applikon bioreactor vessel from the autoclave and connect the DO probe to 

the controller. 

8.5.5. Gather the following items, spray with 70% isopropanol, and place in the biological 

safety cabinet: 

(1) Pipette aid  

(1) 10mL sterile pipette 

(2) 50mL sterile pipettes 

(2) 500mL bottle of pre-sterilized Ham's F12 Medium  

(1) 50mL tube of pre-sterilized, heat inactivated fetal bovine serum (FBS) 

(1) 10mL bottle of 10mg/mL gentamycin 

(1) empty 50ml tube 

1L addition bottle with tubing and autoclavable male connector attached 

8.5.6. Aseptically remove 50ml from one 500mL bottle of pre-sterilized Ham's F12 Medium 

and place in the empty 50ml tube. 

8.5.7. Aseptically add the remaining 450ml and an additional 500mL bottle of pre-sterilized 

Ham's F12 Medium to the 1L addition bottle with tubing and autoclavable male 

connector attached.    

8.5.8. Aseptically add 50ml of FBS to the 1L addition bottle with tubing and autoclavable 

male connector attached. 

8.5.9. Aseptically add the 10mL bottle of 10mg/mL gentamycin.  

8.5.10. Be sure the cap is on tightly and remove the 1L addition bottle with tubing and 

autoclavable male connector attached and bring it over to the Applikon bioreactor. 
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8.5.11. Carefully remove the foil from the female connector on the addition port of the 

Applikon bioreactor.  

8.5.12. Carefully remove the aluminum foil from the male connector on the 1L addition bottle 

and connect the male connector to the female connector on the addition port of the 

bioreactor. 

8.5.13. Remove the clamp on the female connector on the addition port of the Applikon 

bioreactor. 

8.5.14. On the Applikon touch screen select Menu > Manual Control > Acid Pump On 

8.5.15. As the pump turns feed the tubing around it. Use care to avoid pinching fingers.  

8.5.16. Once all of the media has transferred into the vessel turn off the acid pump. On the 

Applikon touch screen select Menu > Manual Control > Acid Pump Off 

8.5.17. Disconnect the male connector of the addition bottle from the female connector on the 

addition port of the bioreactor. Bend the tubing of the addition port and reattach the 

clamp. 

8.5.18. Connect the remaining parts of the bioreactor to the controller. 

8.5.19. Input the setpoints and limits listed in the table below per the bioreactor SOP. 

Parameter pH Temp (oC) %DO Stirrer (rpm) 

Set point 7.2 37 50 75 

Upper Limit 7.3 38 52 76 

Lower Limit 7.1 36 48 74 

8.5.20. Allow the DO probe to polarize for a minimum of 6 hours. 

8.5.21. Calibrate the DO probe per the  Applikon ez-Control Bioreactor Controller Operation 

SOP. 

8.5.22. Immediately (Day 0) and at 1-day intervals, sample the culture to determine OD, pH, 

 viable cell count, analytes and tPA over time (see step 8.7). 

8.6. When the cell count reaches approximately 1,000,000 cells/mL shut down the bioreactor per 

the Applikon ez-Control Bioreactor Controller Operation and harvest cells as described below. 

8.7. Bioreactor Sampling Instructions Days 0-2 

8.7.1. Log in as operator if not already done. 

8.7.2. Raise the stirrer upper limit to 150 rpm.  

8.7.3. Change the stirrer setting to 125 rpm.  

8.7.4. Spray the headplate near the sampling tube with 70% IPA. 

8.7.5. Remove the black clamp and set on the head plate.  

8.7.6. Pull out the autoclavable female connector and set it next to the black clamp.  

8.7.7. Place a 50ml pipette into the sampling tube and remove 50ml of sample and place in a 

50ml tube. 

8.7.8. Put the female autoclavable connector back into the sampling tube.  

8.7.9. Bend the sampling tubing and place the black clamp back on the tubing. 

8.7.10. Change the stirrer setting to 75 rpm.  

8.7.11. Change the stirrer upper limit back to 76 rpm.  

8.7.12. Testing preparation 

        8.7.12.1. Remove 1ml for OD and return back to the 50ml tube. 
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      8.7.12.2. Spin the 50ml tube at 900 rpm for 5 minutes.  

      8.7.12.3. Remove 1 ml of supernatant and store with previous tPA samples.  

8.7.12.4. Remove all of the supernatant being sure not to disturb the pellet.  

      8.7.12.5. Re-suspend the pellet in 1ml of excess supernatant using a 5ml pipette. Discard 

         the additional supernatant. 

      8.7.12.6. Perform the trypan blue assay per SOP. 

8.8. Bioreactor Sampling Instructions Days 3-EOR 

8.8.1. Log in as operator if not already done.  

8.8.2. Raise the stirrer upper limit to 150 rpm.  

8.8.3. Change the stirrer setting to 125 rpm.  

8.8.4. Spray the headplate near the sampling tube with 70% IPA. 

8.8.5. Remove the black clamp and set on the head plate.  

8.8.6. Pull out the autoclavable female connector and set it next to the black clamp.  

8.8.7. Place a 5ml pipette into the sampling tube and remove 5ml of sample and place in a 

15ml tube. 

8.8.8. Put the female autoclavable connector back into the sampling tube. 

8.8.9. Bend the sampling tubing and place the black clamp back on the tubing. 

8.8.10. Change the stirrer setting to 75 rpm. 

8.8.11. Change the stirrer upper limit back to 76 rpm. 

8.8.12. Perform testing per SOP’s. 

8.9. Determine tPA Concentration 

8.9.1. Determine the tPA concentration at each time point per Human tPA Total Antigen 

ELISA SOP. 

8.9.2. Determine the activity of the tPA at each time point per Human tPA Activity ELISA 

SOP. 

8.10. Determine Lactate Concentration 

8.10.1. Determine the lactate concentration at each time point per the Lactate Determination 

Assay SOP. 

8.11. Determine Glucose Concentration 

8.11.1. Determine the glucose concentration at each time point per the Glucose Determination 

Assay SOP. 

8.12. Prepare Growth Curves 

8.12.1. Plot OD, pH, viable cells, glucose, lactate, and tPA vs. time (use 2 y-axes). 

8.12.2. Attach growth curve to Batch Record. 

8.12.3. Determine growth rate and doubling time of the 100mL spinner flask and 1L      

bioreactor cultures. 

8.12.4. Attach calculations to Batch Record. 

9. Attachments:

9.1. Data table

10. History:

Name Date Amendment 

Jason McMillan 18Mar14 Initial Release 

Jason McMillan 26JUN15 Extensive modification for optimization 
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The following parameters are recorded in the batch record doc #.... 

TIME 

(hours) 

OD 

650nm 
pH 

LIVE 

Cell 

Count 

DEAD 

Cell 

Count 

Viable 

Cells/mL 

Percent 

Viability 
GLU 

mg/dL 

LAC 

mmol/L 
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Approvals 

Preparer: John Buford Date: 19DEC13 

Reviewer: Jason McMillan Date: 20DEC13 

Reviewer: Dr. Margaret Bryans Date: 21DEC13 

1. Purpose

1.1. Cultivate a cell culture using an Applikon ez-Control bioreactor controller and a 3-liter

glass autoclavable bioreactor. 

2. Scope and Applicability

2.1.  A bioreactor controller is used to measure and control process variables (temperature,

pH, dissolved oxygen, stirrer speed, and so on) within a bioreactor vessel such as a glass 

autoclavable bioreactor, a single use bioreactor, or a single use wave bag. This SOP 

provides the basic steps required to cultivate a cell culture using the Applikon ez-Control 

and a 3-liter glass autoclavable bioreactor. Other process SOPs are intended to provide 

additional details such as culture medium composition and volume, control process 

settings, and run time. 

3. Summary of Method

3.1. Preparing the controller

3.1.1. Power up the controller and login 

3.1.2. Enter the project name (optional) 

3.1.3. Emergency stop and resume (emergency only) 

3.2. Preparing the bioreactor 

3.2.1. Fill the bioreactor with culture medium  

3.2.2. Calibrate the pH sensor 

3.2.3. Mount sensors to the bioreactor 

3.2.4. Prepare the liquid addition bottles 

3.2.5. Mount connections to the bioreactor 

3.2.6. Autoclave the bioreactor and addition bottles 

3.3. Connecting the bioreactor to the controller 

3.3.1. Verify that all control loops are switched off 

3.3.2. Connect the sensors 

3.3.3. Connect the heating blanket 

3.3.4. Connect the aeration 

3.3.5. Connect the stirrer motor 

3.3.6. Connect the alkaline bottle 

3.3.7. Enter process parameter settings 

3.3.8. Start all control loops 

3.3.9. Calibrate the DO sensor 

3.3.10. Reset dose monitor values 

3.4. Starting the cultivation 

3.4.1. Start process data acquisition 

3.4.2. Inoculate the bioreactor 

3.5. Monitoring the cell culture 
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3.5.1. View process data 

3.5.2. Sample the cell culture 

3.6. Harvesting the cell culture 

3.6.1. Stop the controllers  

3.6.2. Save process data 

3.6.3. Disconnect the bioreactor 

3.6.4. Decant the cell culture 

3.7. Cleaning the bioreactor 

3.7.1. Clean the sensors  

3.7.2. Pre-clean the bioreactor in place 

3.7.3. Disassemble the bioreactor and clean all parts 

3.7.4. Clean the porous sparger tip (optional) 

4. References

4.1. ez-Control Hardware Manual for Autoclavable Bioreactors, Applikon Biotechnology,

Hardware version 2, Documentation version 1.10. 

4.2. ez-Control Operator Manual for Autoclavable Bioreactors, Applikon Biotechnology, 

Software version 1.6X, Documentation version 1.0. 

4.3. ez-Control Software Reference Manual, ez-Control for Autoclavable and Single Use 

Applications, Applikon Biotechnology, Software version 1.6X, Documentation version 

1.0. 

4.4. BioXpert Lite Data Acquisition Program User Manual, Applikon Biotechnology, 

Software version 1.1X, February 2010. 

4.5. Tuttnauer 3850 ELV Autoclave Operation, document number 14.02.01, effective date 

November 25, 2013 

4.6. Labconco Purifier Class 2 Biosafety Cabinet SOP 

5. Precautions

5.1. Alkaline solutions used for controlling pH are caustic. Read the Material Safety Data

Sheet (MSDS) for hazards, handling and storage information. Wear personal protection 

equipment (PPE).  

5.2. Do not put the stirrer motor or the heating blanket in the autoclave. 

6. Responsibilities

6.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary.  

6.2. It is the responsibility of the students/technician to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while 

performing the procedure.  

7. Equipment and Materials

7.1. Applikon 3-liter glass autoclavable bioreactor:

7.1.1. Vessel 

7.1.2. Head plate 

7.1.3. Gas sparger (pre-mounted on the head plate) 

7.1.4. Impeller (pre-mounted on the head plate) 

7.1.5. Air outlet condenser (pre-mounted on the head plate) 

7.1.6. Septum (pre-mounted on the head plate) 
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7.1.7. Sample pipe (pre-mounted on the head plate) 

7.1.8. pH sensor 

7.1.9. DO sensor 

7.1.10. Temperature sensor 

7.1.11. Stirrer motor 

7.1.12. Heating blanket 

7.2. Applikon ez-Control bioreactor controller 

7.3. Laboratory gasses: 

7.3.1. Air compressor 

7.3.2. O2 (optional) 

7.3.3. CO2 

7.4. pH 4.0 and pH 7.0 buffer standards 

7.5. Liquid addition bottles 

7.6. Alkaline solution (generally 1M sodium bicarbonate) 

7.7. Gas filters, 0.2 µm  

7.8. Autoclavable silicone tubing, size 14 (1.6 mm interior diameter)  

7.9. Autoclavable silicone tubing, size 16 (3.1 mm interior diameter) 

7.10. Autoclavable silicone tubing, size 25 (4.8 mm interior diameter) 

7.11. Tubing clamps 

7.12. Cotton and aluminum foil (for autoclaving) 

7.13. Autoclave indicator tape 

7.14. Culture medium 

7.15. Culture inoculum 

7.16. Autoclave (such as a Tuttnauer 3850 ELV) 

7.17. Computer system with BioXpert Lite installed  

8. Procedure

8.1. Preparing the controller

8.1.1. Power up the controller and login 

The controller is used to measure and control process variables (temperature, pH, 

dissolved oxygen, and stirrer speed) within a bioreactor. After switching on the 

power of the controller, it presents itself (after initialization) on the touch screen 

display with its Home screen, which is generally configured as the Synoptic View 

shown in Figure 2. The operator uses the touch screen display to monitor the 

bioreactor conditions and to enter process control parameters. Four authorization 

(login) levels allow access to various controller capabilities: View (initial level), 

Operator, System engineer, and Service engineer level. The View authorization level 

only allows process values to be monitored. To set process control parameters, the 

user needs to login as Operator. For an example of how to navigate the controller 

screens, see Example 1. 

8.1.1.1.Power up the controller using the green power switch located on the back of 

the controller (upper right).  

8.1.1.2.The touch screen display located on the front shows that the controller is 

initializing. Once initialization completes, the display switches to the Home 

screen. 
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8.1.1.3.Login as Operator using the touch screen display: 

8.1.1.3.1. Home > login button (top middle) > Operator > Login 

8.1.1.3.2. Enter the Operator password: 0000 

8.1.1.4.To logout: 

Home > login button (top middle) > View 

Note: logout is automatic after a period of inactivity (generally 10 minutes). 

8.1.1.5.The touch screen backlight is switched off automatically after a period of 

inactivity (generally 30 minutes) and the touch screen goes dark. To switch on 

the backlight, touch the screen. 

8.1.2. Enter the project name (optional) 

The project name is displayed on the top of all controller screens in order to identify 

the bioreactor system and cell culture being cultivated. 

8.1.2.1.Login as Operator per section 8.1.1.3 if not already logged in. 

8.1.2.2.Home > project name button (top left)  

8.1.2.3.Enter a descriptive name 

8.1.3. Emergency stop and resume (emergency only) 

The Emergency Stop button on the front of the control shuts down all control loops 

immediately and displays the Emergency Stop screen. Measurements continue to be 

collected.   

8.1.3.1.In the event of an emergency requiring the bioreactor process to stop 

immediately, press the red Emergency Stop button located on the front of the 

controller. 

8.1.3.2.To resume the bioreactor process: 

8.1.3.2.1. Remove the cause of the Emergency Stop. 

8.1.3.2.2. Turn the Emergency Stop button clockwise until it resets itself to the 

normal position. 

8.1.3.2.3. Login as System Engineer. 

8.1.3.2.4. Verify that the bioreactor is in a safe condition. 

8.1.3.2.5. Select Resume on the Emergency Stop screen to restart the control 

loops.  

8.2. Preparing the bioreactor 

8.2.1. Fill the bioreactor with culture medium 

The bioreactor is filled with culture medium before it is autoclaved (if it will not 

damage the media) so that the medium is sterilized along with the bioreactor. Do 

not exceed the working volume of the bioreactor (2.4 liters for a 3-liter bioreactor). 

Leave enough space for inoculation and nutrients to be added during cultivation. 

8.2.1.1.A process SOP should provide details regarding culture medium composition 

and volume. 

8.2.1.2.Loosen the six mill nuts that fastens the head plate on the bioreactor vessel and 

remove the head plate. 

8.2.1.3.Add culture medium to the vessel. 

8.2.1.4.Mount the head plate on top of the vessel and fasten with the six mill nuts finger-

tight. 

8.2.2. Calibrate the pH sensor 
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Before the bioreactor is autoclaved, the pH (acidity) sensor needs to be calibrated 

with pH 4.0 and pH 7.0 buffer standards in order to obtain accurate measurement 

values during cultivation. 

8.2.2.1. Measure the temperature of the pH buffer standards using a thermometer. 

8.2.2.2. Remove the protective cap from the bottom of the pH sensor. Rinse the pH 

sensor with de-ionized water and pat it dry with a clean lint-free laboratory 

wipe. 

8.2.2.3. Remove the pH sensor screw cap. Connect the pH sensor to the pH sensor 

cable on the right side of the controller. Verify that the pH sensor cable is 

plugged into the controller correctly.  

8.2.2.4. Login as Operator per section 8.1.1.3 if not already logged in. 

8.2.2.5. Go to the controller pH Settings screen: Home > pH (bottom)  

8.2.2.6. Verify that the pH control loop is off (i.e. the pH Process Value button is 

grey or yellow, not green). If it is on, touch the button Stop pH controller. 

8.2.2.7. Touch the button Calibrate pH to go to the pH Calibration screen. The 

numerical data for Slope, Offset and any Sample correction are displayed. 

8.2.2.8. Touch the button 2-point calibration. 

8.2.2.9. Enter the temperature of the buffer solutions using the numeric keypad. 

8.2.2.10. When prompted for the pH value of the first buffer solution, put the pH 

sensor in the pH 4.0 buffer standard and wait until the shown process value 

stabilizes (shown near the Cancel button). Enter the pH value using the 

numeric keypad. 

8.2.2.11. Rinse the pH sensor and repeat using the pH 7.0 buffer standard. Again, 

wait for the shown process value to stabilize and enter the corresponding pH. 

8.2.2.12. Return to the pH Calibration screen to verify the newly found calibration 

data (slope and offset). 

8.2.3. Mount sensors to the bioreactor 

pH and DO sensors are mounted to the bioreactor before it is autoclaved so that the 

sensors are sterilized along with the bioreactor. Some systems also use a foam / 

level sensor.  

8.2.3.1.Disconnect the cable of the pH sensor. 

8.2.3.2.Cover the pH sensor connector with the pH sensor screw cap. Verify that the 

rubber gasket is in place between the sensor connector and the cap. 

8.2.3.3.Insert the pH sensor into its port in the head plate and fasten it. See Figure 6 

for the location of the pH sensor port. 

8.2.3.4.Remove the protective cap from the bottom of the DO sensor. Repeat steps 

8.2.3.2 and 8.2.3.3 for the DO sensor. 

8.2.4. Prepare the liquid addition bottles 

Liquid addition bottles are used to add liquids to the bioreactor aseptically (see 

Figure 7). For example, alkaline solution is added to raise pH and inoculum is 

added to begin cultivation. Addition bottles are sterilized along with the bioreactor. 

8.2.4.1.A process SOP should provide details regarding alkaline solution composition 

and volume. 
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8.2.4.2.Fill a liquid addition bottle with alkaline solution, no more than 2/3 full so that 

it can be autoclaved. Cap the alkaline bottle with a two-port top. 

8.2.4.3.Connect the air inlet on the alkaline bottle to a gas filter using a short length 

(approx. 7 cm) of size 25 tubing. Do not clamp. 

8.2.4.4.Add 5 mL laboratory grade water to an addition bottle to be used for 

transferring inoculum. This will improve the heat transfer during sterilization 

in the autoclave. Cap the inoculum transfer bottle with a two-port top. 

8.2.4.5.Connect the air inlet on the inoculum transfer bottle to a gas filter using a 

short length (approx. 7 cm) of size 25 tubing. Do not clamp. 

8.2.4.6.Connect the liquid outlet on the inoculum transfer bottle to an autoclavable 

male connector using a long length (approx. 50 cm) of size 25 tubing. Secure 

the needle to the tubing using a clamp or tape. Leave the cap on the needle. 

8.2.4.7.Cover the gas filters and autoclavable male connector loosely with aluminum 

foil. 

8.2.5. Mount connections to the bioreactor 

Gas filters and silicone tubing connections are mounted to the bioreactor before it 

is autoclaved so that they are sterilized along with the bioreactor. See section 7 for 

the silicone tubing size specifications. 

8.2.5.1. Connect one of the medium inlet triplet nipples to a second triplet nipple 

using a short length (approx. 7 cm) of size 14 tubing. Connect a medium length 

(approx. 15 cm) of size 14 tubing to the third medium inlet triplet nipple. 

Clamp the tubing closed. 

8.2.5.2. Connect the addition pipe to the liquid outlet on the alkaline bottle using an 

extra-long length (approx. 75 cm) of size 25 tubing. Clamp the tubing closed. 

8.2.5.3. Connect a medium length (approx. 15 cm) of size 25 tubing to the sample 

pipe. Clamp the tubing closed. 

8.2.5.4. Connect the sparger inlet to a gas filter using a short length (approx. 7 cm) 

of size 25 tubing. Do not clamp. 

8.2.5.5. Connect the bottom condenser nipple on the middle condenser nipple using 

a medium length (approx. 15 cm) of size 25 tubing. 

8.2.5.6. Connect the top condenser nipple to a gas filter using a long length (approx. 

50 cm) of size 25 tubing. Do not clamp. 

8.2.5.7. Insert a septum into its holder in the head plate and fasten it.  

8.2.5.8. Close all open tubing ends with cotton plugs and cover with aluminum foil. 

8.2.5.9. Verify that the gas filters are open to avoid pressure differences during 

autoclaving. Cover the gas filters loosely with aluminum foil. 

8.2.6. Autoclave the bioreactor and liquid addition bottles 

The assembled bioreactor is autoclaved before cultivation in order to create a 

sterile environment inside the bioreactor. Do not autoclave the heating blanket or 

the stirrer motor. Single use bioreactors are not autoclaved; they are sterilized by 

the manufacturer.  

8.2.6.1. Apply autoclave indicator tape to the aluminum foil on the alkaline bottle 

and the inoculum transfer bottle. 
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8.2.6.2. Place the assembled bioreactor, the alkaline bottle, and the inoculum 

transfer bottle in the autoclave without disconnecting the tubing.  

8.2.6.3. Loosen the caps on the alkaline bottle and the inoculum transfer bottle.  

8.2.6.4. Close the autoclave and run it on the liquid cycle per the autoclave SOP. 

8.2.6.5. When the cycle completes, allow the autoclave to cool gradually. Do not 

open the autoclave until the temperature in the autoclave has dropped below 

90°C. After reaching that temperature, open the autoclave to allow it to cool 

down until the contents can be unloaded safely. 

8.2.6.6. Tighten the caps on the alkaline bottle and the inoculum transfer bottle. 

8.2.6.7. Remove the assembled bioreactor and the alkaline bottle together and place 

beside them on the right side of the controller without disconnecting the 

tubing. 

8.2.6.8. Remove the inoculum transfer bottle and place it in a biological safety 

cabinet. 

8.2.6.9. Allow to cool to room temperature. 

8.2.6.10. Perform a visual inspection to verify that the autoclave indicator tape 

changed color and that the bioreactor is dry. 

8.2.6.11. Remove aluminum foil and cotton plugs from tubing ends and gas filters on 

the bioreactor and alkaline bottle. Leave the foil on the inoculum transfer 

bottle. 

8.3. Connecting the bioreactor to the controller 

After the assembled bioreactor is autoclaved, it must be connected to the controller. 

8.3.1. Verify that all control loops are switched off 

8.3.1.1.Login as Operator per section 8.1.1.3 if not already logged in. 

8.3.1.2.Verify that all control loops are switched off. The Process Value buttons 

(bottom of Home Screen) should be gray or yellow. If necessary, stop 

controllers:  

Home > Menu (top right) > Start/Stop all controllers > Stop all controllers 

8.3.2. Connect the sensors 

Sensors are connected electrically to the controller. 

8.3.2.1.Place the bioreactor and alkaline bottle on the right side of the controller if 

they are not already. 

8.3.2.2.Remove the pH sensor screw cap. Connect the pH sensor to the pH sensor 

cable on the right side of the controller. Verify that the pH sensor cable is 

plugged into the controller correctly. 

8.3.2.3.Remove the DO sensor screw cap. Connect the DO sensor to the DO sensor 

cable on the right side of the controller. Verify that the DO sensor cable is 

plugged into the controller correctly. 

8.3.2.4.Insert the temperature sensor into the thermometer pocket. Verify that the 

temperature sensor cable is plugged into the controller correctly. Fill the 

thermometer pocket with MilliQ water in order to decrease the dead time of the 

sensor and make temperature control more accurate. 

8.3.3. Connect the heating blanket 
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An electric heating blanket is used for warming the bioreactor as needed. Some 

systems also use a thermo circulator and cooling water for cooling the bioreactor. 

8.3.3.1.Wrap the heating blanket around the bioreactor vessel (around the glass and 

inside the support legs). Position the blanket so that the volume markings on 

the vessel are visible. Fasten the blanket in place using the Velcro ends of the 

blanket. 

8.3.3.2.Verify that the heating blanket is plugged into the controller correctly. 

8.3.4. Connect the aeration 

8.3.5. Laboratory gasses (air, O2, and CO2) are added by the controller to the bioreactor 

sparger in order to control DO and to lower pH as needed. 

8.3.5.1.Connect the aeration outlet of the controller to the gas filter on the bioreactor 

sparger inlet using size 16 tubing. 

8.3.5.2.Turn on the air compressor and set its regulator to 30 psi. 

8.3.5.3.Open the CO2 tank and set its regulator to 30 psi. 

8.3.6. Connect the stirrer motor 

The stirrer motor and the impeller are used to control agitation of the cell culture. 

When connecting the stirrer motor, it is helpful for the stirrer to be on. 

8.3.6.1.Login as Operator per section 8.1.1.3 if not already logged in. 

8.3.6.2.Go to the Stirrer Settings screen: Home > Stirrer (bottom left) 

8.3.6.3.Set a slow stirrer speed: touch the button Stirrer setpoint and enter 60. 

8.3.6.4.Start the stirrer: touch the button Start Stirrer controller. 

8.3.6.5.Position the stirrer motor vertically over the bioreactor head plate and slowly 

lower it into place. Verify that the impellor is turning. 

8.3.6.6.Stop the stirrer: touch the button Start Stirrer controller. 

8.3.7. Connect the alkaline bottle 

A peristaltic pump is used to dispense measured amounts of alkaline solution from 

an addition bottle to the bioreactor. The silicone tubing that connects the alkaline 

bottle to the bioreactor needs to be threaded through the pump. See Figure 8. 

8.3.7.1.Login as Operator per section 8.1.1.3 if not already logged in. 

8.3.7.2.Locate the alkaline pump on the right front panel of the controller. Open the 

pump cover. 

8.3.7.3.Locate the tubing that connects the alkaline bottle to the bioreactor. Bend the 

middle of the tubing into a U shape and hold in one hand. Clip the tubing U 

into the lower pump clamp. 

8.3.7.4.Turn the pump on manually: 

Home > Menu > Manual control> Alkaline pump: On 

8.3.7.5.Ease the tubing into the pump as the pump rotors are turning. Use care to 

avoid pinching fingers.  

8.3.7.6.Turn the pump off. 

8.3.7.7.Clip the tubing into the upper pump clamp. 

8.3.7.8.Close the pump cover. 

8.3.7.9.Turn the pump on manually and watch the solution being drawn from the 

bottle into the tubing. When the solution reaches the bioreactor, turn the pump 

off. 
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8.3.8. Enter process parameter settings 

The pH, temperature, DO, and stirrer control loops should be adjusted to desired 

process parameter settings. Each control loop has settings for upper alarm limit, 

lower alarm limit, and setpoint. Additional settings for PID controls may also be set 

at this time.  

8.3.8.1.A process SOP should provide details regarding process setpoints and alarm 

limits. 

8.3.8.2.Login as Operator per section 8.1.1.3 if not already logged in. 

8.3.8.3.Go to the pH Settings screen: Home > pH (bottom) 

8.3.8.4.Enter the process settings for the pH control loop: 

8.3.8.4.1. Enter the pH upper alarm limit: 

pH settings > Alarm limits > Upper alarm limit 

Enter the pH upper alarm limit value provided by the process SOP. 

8.3.8.4.2. Enter the pH lower alarm limit: 

pH settings > Alarm limits > Lower alarm limit 

Enter the pH lower alarm limit value provided by the process SOP. 

8.3.8.4.3. Enter the pH setpoint: 

pH settings > pH setpoint 

Enter the pH setpoint value provided by the process SOP. 

8.3.8.4.4. Enter any additional pH PID controls provided by the process SOP: 

pH settings > pH controller setup 

8.3.8.5.Repeat for each of the temperature, DO, and stirrer control loops. 

8.3.9. Start all control loops 

The DO sensor needs to be polarized for at least 6 hours and the temperature and 

pH need to be stabilized at setpoint before the DO sensor can be calibrated. 

8.3.9.1.Login as Operator per section 8.1.1.3 if not already logged in. 

8.3.9.2.Start all control loops: 

Home > Menu > Start/Stop all controllers > Start all controllers 

8.3.9.3.Go to the Home screen and verify that the control loops are on. The Process 

Value buttons (bottom of Home Screen) should change to green or red, the 

actuators (heat, pumps, valves, and stirrer) should begin activating, and the 

impeller should begin turning. 

8.3.9.4.Allow the process to run for at least 6 hours. 

8.3.10. Calibrate the DO sensor 

The DO measurement is based on the polarographic principle (Clark-cell). 

Therefore, the sensor must be polarized for at least 6 hours before it can be 

calibrated. 

8.3.10.1. Login as Operator per section 8.1.1.3 if not already logged in. 

8.3.10.2. Verify that the medium in the bioreactor is stable at process temperature. 

8.3.10.3. Stop the DO control loop:  

Home > DO (bottom) > Stop DO controller 

8.3.10.4. Go to the DO Calibration screen:  

Home > DO > Calibrate DO  

The numerical data for Slope and Offset are displayed. 

166



Montgomery County Community College 

340 DeKalb Pike 

Blue Bell, PA 

Document Number: 34.0.1 

Revision Number:  1 

Effective Date: 21DEC13 

Page 10 of 19 

SOP: Applikon ez-Control Bioreactor Controller Operation 

8.3.10.5. Verify if the measuring range is set to Air. If not, set it for air: 

 Calibrate DO > Set measurement range > Measurement range for air 

8.3.10.6. Open the aeration valve manually: 

Home > DO > Manual control > O2 Valve: On 

8.3.10.7. Continue aeration until DO reading is stable (15 to 20 minutes). 

8.3.10.8. Close the aeration valve manually: 

Home > DO > Manual control > O2 Valve: Off 

8.3.10.9. Set the DO calibration value to 100%: 

Home > DO > Calibrate DO > Calibrate > Enter Calibration Value > 100 

8.3.10.10. Return to the DO Calibration screen to verify the newly found calibration 

data (slope and offset). The expected slope value of the sensor (for 

measurement range for air) is: 

2.0 to 4.0 at 25 °C 

1.5 to 3.0 at 37 °C 

8.3.10.11. Start the DO control loop: DO (bottom) > Start DO controller. 

8.3.11. Reset dose monitor values 

When all control loops are at set-point, the bioreactor system is ready for 

cultivation (inoculation). All Dose Monitor values should be reset to 0 ml. 

8.3.11.1. Go to the Home screen and verify that the control loops are on. Allow the 

process to run until all control loops are at set-point. 

8.3.11.2. Reset all dose monitor values: 

Home > Menu > Dose Monitor > Reset all dose monitors > Are you sure? Yes 

8.4. Starting the cultivation 

8.4.1. Inoculate the bioreactor 

Once the process parameters in the bioreactor are at their setpoints, the inoculum is 

added to the bioreactor aseptically. This SOP makes use of a sterile addition bottle 

for this purpose.  

8.4.1.1.Fill the sterile inoculum transfer bottle with inoculum using aseptic technique 

per the biosafety cabinet SOP. Do not remove the foil from the gas filter or the 

autoclavable male connector. Recap the bottle before removing it from the 

biosafety cabinet. 

8.4.1.2.Login as Operator per section 8.1.1.3 if not already logged in. 

8.4.1.3.Stop all control loops:  

Home > Menu > Start/Stop all controllers > Stop all controllers 

8.4.1.4.Disinfect the septum with 70% ethanol. 

8.4.1.5.Remove the foil and cap from the needle, sterilize the needle with a flame, and 

pierce the needle through the septum. 

8.4.1.6.Remove the foil from the gas filter on the inoculum transfer bottle. Transfer 

the inoculum from the bottle to the bioreactor using a large volume syringe to 

pump air through the gas filter into the bottle.  

8.4.1.7.Remove the needle from the septum. Disconnect the needle from the tubing 

and dispose in a sharps container. 

8.4.1.8.Re-start all control loops: 

Home > Menu > Start/Stop all controllers > Start all controllers 
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8.5. Monitoring the cell culture 

8.5.1. View process data 

Process values for the last 72 hours are stored in controller memory and can be 

displayed using the Trend View screen. Process values for the entire run are stored 

and displayed using BioXpert Lite. 

8.5.1.1.To view process data for a specific process parameter using the Trend View: 

8.5.1.1.1. Login as Operator per section 8.1.1.3 if not already logged in. 

8.5.1.1.2. Home > process value button (2nd row from the bottom) 

8.5.1.1.3. Touch the X-axis button (bottom left) in order to change the range of 

the time axis (between 1 and 72 hours). 

8.5.1.1.4. Touch the Y-axis upper limit button (top right) or lower limit button 

(bottom right) in order to change the range of the process value axis. 

8.5.2. Sample the cell culture 

Periodically, the cell culture is sampled in order to measure cell concentration and 

perform product assays per the process SOP. Some bioreactors include a sample 

system connected to the sample pipe which enables cell culture to be drawn into a 

sample bottle that can then be replaced aseptically. This system simply uses a 

pipette to draw cell culture from the sample pipe.  

8.5.2.1.Locate the clamped tubing connected to the sample pipe on the bioreactor 

head plate. Connect a pipette to the sample pipe tubing. 

8.5.2.2.Release the clamp, withdraw 5 mL of cell culture, and re-clamp. 

(Sample pipe volume = 4mm ID X 25 cm = 3.2 cm3 = 3.2 mL) 

Discard this sample. 

8.5.2.3.Again, release the clamp, withdraw 5 mL of cell culture, and re-clamp. 

Use this sample for cell counts and product assays per the process SOP. 

8.6. Harvesting the cell culture  

A process SOP should specify when the cell culture is to be harvested. 

8.6.1. Stop the controllers  

8.6.1.1.Login as Operator per section 8.1.1.3 if not already logged in. 

8.6.1.2.Stop all control loops: 

Home > Menu > Start/Stop all controllers > Stop all controllers 

8.6.1.3.Close the CO2 tank. 

8.6.1.4.Turn off the air compressor. 

8.6.2. Disconnect the bioreactor 

The bioreactor must be disconnected from the controller so that the bioreactor can 

be decanted. 

8.6.2.1.Locate the tubing that connects the alkaline bottle to the bioreactor. Clamp the 

tubing near the bioreactor. Disconnect the tubing from the alkaline bottle and 

remove the tubing from the controller pump. 

8.6.2.2.Lift the stirrer motor from the bioreactor head plate and set the motor aside. 

8.6.2.3.Disconnect the gas filter on the bioreactor sparger inlet from the tubing to the 

aeration outlet of the controller. 

8.6.2.4.Unwrap the heating blanket from around the bioreactor vessel and set the 

blanket aside being sure it is lying flat. 
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8.6.2.5.Disconnect the pH sensor cable from the pH sensor. Cover the pH sensor 

connector with the pH sensor screw cap. 

8.6.2.6.Repeat step 8.6.2.5 for the DO sensor. 

8.7. Cleaning the bioreactor 

8.7.1. Clean and store the sensors 

8.7.1.1.Remove pH and DO sensors from the bioreactor head plate. 

8.7.1.2.Rinse the pH and DO sensors thoroughly with MilliQ water, being careful to 

remove all broth-residue. Gently pat dry with a clean lint-free laboratory wipe. 

Spray with 70% IPA and gently pat dry with a clean lint-free laboratory wipe 

8.7.1.3.. Rinse with MilliQ water and pat dry with a clean lint-free laboratory wipe. 

8.7.1.4.Fill the protective cap of the pH sensor 1/2 full with 3M potassium chloride 

(KCl) solution. Cover the tip of the pH sensor with its protective cap. Verify 

that the pH electrode is completely immersed in KCl solution. 

8.7.1.5.Cover the tip of the DO sensor with its protective cap. The DO sensor may be 

stored dry. 

8.7.1.6.Cover the pH sensor connector with the pH sensor screw cap. Repeat for the 

DO sensor.  

8.7.2. Decant the cell culture 

8.7.2.1.Place the disconnected bioreactor in a biosafety cabinet if specified by the 

process SOP. 

8.7.2.2.Loosen the six mill nuts that fasten the head plate on the bioreactor vessel and 

remove the head plate. 

8.7.2.3.Decant the cell culture into a suitable container per the process SOP. 

8.7.2.4.Re-mount the head plate on top of the vessel and fasten with the six mill nuts 

finger-tight. 

8.7.3. Pre-clean the bioreactor in place 

8.7.3.1.Fill the bioreactor with a working volume of 0.1M NaOH solution (2.4 liters 

for a 3-liter bioreactor). 

8.7.3.2.Connect the stirrer motor per section 8.3.6. 

8.7.3.3.Activate the stirrer at 250 RPM for 30 minutes. Visual check for dissolution of 

foam, debris and other contamination in the bioreactor. 

8.7.3.4.Stop the stirrer. Lift the stirrer motor from the bioreactor head plate and set 

the motor aside. 

8.7.3.5.Drain the bioreactor. 

8.7.4. Disassemble the bioreactor and clean all parts 

8.7.4.1.Remove all tubing and gas filters from the bioreactor head plate assembly and 

discard in biohazardous waste. 

8.7.4.2.Remove the septum from the head plate. 

8.7.4.3.Remove the air outlet condenser from the head plate and disassemble the 

condenser for cleaning.  

8.7.4.4.Remove the head plate from the bioreactor vessel. 

8.7.4.5.Clean all parts carefully and thoroughly using a small soft bristle brush (e.g. 

tooth brush) and a dilute laboratory glassware cleaner. Rinse with MilliQ water 

and then repeat with a 10% bleach solution. Rinse thoroughly with MilliQ 
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water and spray with 70% IPA and place on paper towels on a lab bench to 

dry. 

8.7.4.6.Let dry all the parts. 

8.7.5. Clean the porous sparger tip (optional) 

Depending on the type of medium that is used (presence of proteins and/or 

peptides), the porous sparger tip may require a special cleaning procedure. 

8.7.5.1.1. Remove the sparger tip from the air inlet pipe. 

8.7.5.2.2. Soak the sparger overnight in a solution of 10 mg/mL pepsin / 0.01M HCl. 

8.7.5.3.3. Use ultrasonic cleaning with water and/or ethanol. 

8.7.5.4.4. Replace the sparger tip onto the air inlet pipe. 
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9. Attachments

Figure 1. Applikon ez-Control Bioreactor Controller and Bioreactor 
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Figure 2. Home Screen (synoptic view) 

Example 1. Navigating the Controller Screens to Login 

Instructions Explanation 

Home > Login (top middle) > Operator > Login 

Enter the Operator password: “0000”  

On the Home screen, touch the Login button (top middle). 

The display changes to the Access Control screen. 

On the Access Control screen, touch the button Operator 

(left side). The display changes to the Operator screen. 

On the Operator screen, touch the button Login. The display 

changes to a keyboard and prompts for the Operator 

password. 

Enter the Operator password: “0000” 

Then touch the button Enter. 

The display changes back to the Home screen. 

Process Values 
Gray: off 
Green: on 
Yellow: off, alarm 
Red: on, alarm  

Process Name 

Menu button 

Login button 
(authorization level) 

Process Parameter 
 Settings 
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Figure 3. Main Menu Screen 

Figure 4. pH Setpoint Screen 
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Figure 5. Applikon 3-Liter Glass Autoclavable Bioreactor 

Figure 6. Bioreactor Head Plate (top view, unassembled) 
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Figure 7. Liquid Addition Bottle 

Figure 8. Peristaltic Pump (Alkaline Pump) 

Air 
Inlet 

Liquid 
Outlet 

From 
Addition Bottle 

To 
Bioreactor 

175



Montgomery County Community College 

340 DeKalb Pike 

Blue Bell, PA 

Document Number: 34.0.1 

Revision Number:  1 

Effective Date: 21DEC13 

Page 19 of 19 

SOP: Applikon ez-Control Bioreactor Controller Operation 

10. History

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 20DEC13 John Buford Initial release 

1 16SEP14 Jason McMillan Various fixes and adjustments 
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Reviewer: Dr. Maggie Bryans Date: 09JUL15 

Reviewer: Hetal Doshi Date: 10JUL15 

1. Purpose

1.1. To perform cell count and viability measurements of trypan blue stained samples.

2. Scope and Applicability

2.1.  Applies to the counting and viability measurement of trypan blue stained samples using

the Life Technologies Countess II Cell Counter. 

3. Summary of Method

3.1. Turn on the Countess II Automated Cell Counter.

3.2. Mix cell aliquot with trypan blue stain.

3.3. Load 10µl of cell/trypan blue stain mixture into Side A of the Countess Cell Counting

Chamber Slide.  

3.4. Insert the Countess Cell Counting Chamber Slide into the slide port. 

3.5. Perform count.  

3.6. Remove the Countess Cell Counting Chamber Slide and turn around the slide, and 

reinsert Side B into the slide port.  

3.7. Perform count. 

3.8. Remove the Countess Cell Counting Chamber Slide and dispose of into the sharps 

container.  

3.9. Load USB drive into the Countess II Automated Cell Counter and save data. 

3.10. Turn off the Countess II Automated Cell Counter. 

4. References

4.1. Countess II/Countess II FL Automated Cell Counter Quick Reference Guide

5. Definitions

5.1. N/A

6. Precautions

6.1. N/A

7. Responsibilities

7.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary.  

7.2. It is the responsibility of the students/technician to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while 

performing the procedure.  

8. Equipment and Materials

8.1. Life technologies Countess II Automated Cell Counter

8.2. Countess Cell Counting Chamber Slide

8.3. 0.4% trypan blue stain

8.4. P20 micropipette
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8.5. P20 micropipette tips 

8.6. Microcentrifuge tube 

8.7. Microcentrifuge rube rack 

9. Procedure

9.1. Turn on the Countess II Automated Cell Counter by pressing the switch on the lower,

right hand corner on the back of the system.  

9.1.1. The power indicator light will illuminate and the 7” capacitive touchscreen will 

illuminate and flash the Life Technologies logo, Countess II Automated Cell 

Counter logo, Life technologies and Countess II Automated Cell Counter logos, and 

finally settling on the home screen that prompts the user to “Insert Slide.” 

9.2. Prepare sample by adding 10µl of cell suspension to 10µl of 0.4% trypan blue stain.  

9.3. Remove a Countess Cell Counting Chamber Slide and open by tearing the wrapper at the 

portion labeled “Tear Here.” 

9.3.1. Remove the Countess Cell Counting Slide and locate Side A.  

9.4. Load 10µl of the sample mixture into Side A of the Countess Cell Counting Chamber 

Slide.  

9.5. Insert the Countess Cell Counting Slide, Side A first, into the slide port until you hear a 

soft click. 

9.6. The instrument automatically illuminates the sample and focusses the cells. 

9.6.1. To enable the auto focus to function properly, manually focus the cells using the 

“Focus” slider and press “Set” to set the optimal focus. 

9.6.2. Set exposure using the “Light source” slider, and press “Capture” on the 7” 

capacitive touchscreen. The instrument captures the image and displays the results 

(total concentration, percentage and concentration of live and dead cells). 

9.7. To count the second chamber, remove the Countess Cell Counting Slide and turn around 

the slide to Side B, and reinsert into the slide port until you hear a soft click. 

9.7.1. Repeat steps 9.5. and 9.6. 

9.8. To save data 

9.8.1. On the 7” capacitive touchscreen press “Save” 

9.8.2. Insert USB Drive into the USB port 

9.8.3. Press “Save” on the 7” capacitive touchscreen, a check mark with the phrase 

“Save Complete” will appear. 

9.8.4. On the 7” capacitive touchscreen press “Close.” 

9.8.5. Remove USB drive 

9.9. Remove the Countess Cell Counting Slide and dispose of in a sharps container. 

9.10. Turn off the Countess II Automated Cell Counter by pressing the switch on the 

lower, right side on the rear of the instrument. 

10. Attachments 
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Figure 1. Countess II Cell Counter front panel 
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1. Purpose:

1.1. Use of the Trypan Blue Assay.

2. Scope:

2.1. Applies to determining viable cell count of mammalian and insect cells.

3. Responsibilities:
3.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while performing 

the procedure. 

4. References:

4.1. http://plaza.ufl.edu/johnaris/Protocols/MiscMethods/HemoCytometer.pdf

4.2. microscope SOP

5. Definitions:

5.1. Hemacytometer: a specialized microscope slide with etched glass in grid formation

6. Precautions:

6.1. Trypan Blue Solution is a teratogen.  It may cause birth defects.  It may cause cancer.

Wear gloves, eye protection and a lab coat.  

7. Materials:

7.1. 0.4% Trypan Blue Solution

7.2. microfuge tubes

7.3. P-20 micropipette and tips

7.4. cell sample in solution

7.5. hemacytometer

7.6. hemacytometer coverslip

7.7. microscope

7.8. lab towels

7.9. lab tissues such as Kimwipes

7.10. deionized water

7.11. push button counter

8. Procedure:

8.1. Mix  Trypan Blue Solution with cell sample solution

8.1.1. Mix culture sample well to resuspend cells. 

8.1.2. Remove 20µL of culture sample and dispense into a microfuge tube. 

8.1.3. Add 20µLof 0.4% Trypan Blue Solution to the same tube. 

8.1.4. Mix the above solution by gently aspirating and dispensing the solution with the 

micropipette.  Proceed to the next step immediately. 

8.2. Transfer sample to hemacytometer 
8.2.1. Center the coverslip on top of the hemacytometer.  The metal notches should be    

partially exposed. 
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8.2.2. Hold the micropipette straight up and dispense 10µL of the cell/Trypan Blue 

solution into a notch of the hemacytometer.  The tip of the pipette should be very 

close to the metal surface.  The solution will spread through capillary action. 

8.3. Observe cells under the microscope 

8.3.1. Turn on the microscope per SOP.  

8.3.2. Place the hemacytometer on the microscope stage. 

8.3.3. Focus on the hemacytometer grid using 100X magnification (10X objective lens). 

Live cells are clear. Dead cells are blue. 

8.4. Count cells  

8.4.1. The grid is divided into four main quadrants (Figure 2).  Beginning with quadrant 

1 and moving through to quadrant 4, depress the correct button on the push button 

 counter for every cell in each square.  

8.4.1.1. Make sure the counter is set to 0. Count total live cells first. After live cell 

count is completed, count total dead cells.  

8.4.1.2. Count in a serpentine fashion: work left to right across the top row of the 

quadrant.  Move down to the second row and count the cells in each square 

moving right to left. Change to opposite direction each time a row is   

completed.   

8.4.1.3. Count cells touching the top and left borders of a main quadrant, but not the 

bottom and right borders. Do not count cells outside of the main 

quadrants. 

8.4.1.4. Record the number of live and dead cells each time a quadrant is completed. 

8.4.2. Repeat counting procedure per section 8.4.1. for the second grid. 

8.4.3. Average the cell counts of the two grids to obtain the live cell count for the viable 

cell concentration calculations. 

8.5.   Clean the hemacytometer 

8.5.1. Remove the coverslip.  

8.5.2. Blot dry the coverslip and hemacytometer on a lab towel. 

8.5.3. Rinse the cover slip and hemacytometer with 70% EtOH by holding each one 

over a lab towel and using a squirt bottle of DI water. Note: Handle the 

hemacytometer and coverslip gently.  The coverslip is not disposable.  Do not 

discard it. 

8.5.4. Dry the coverslip and hemacytometer with a lab tissue. 

8.6.  Calculate viable cell concentration. 

8.6.1. Formula to determine live cell count: C = (N/V) x D 

C = live cell count in cells per milliliter 

N = total number of live cells obtained from averaging the number of live cells 

counted in the two grids  

V = volume of counting area 

Note:  The total volume of the four quadrants is 0.0004mL. (Each quadrant is 

0.0001mL.)  

D = dilution factor. For this procedure the dilution factor is 2. 

8.7. Calculate percent viability 
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8.7.1. Formula for percent viability: % viability = (live cell count/total cell count)*100 

9. Attachments:

9.1. Figure 1:  Diagram of hemacytometer and cover glass

9.2. Figure 2:  Diagram of hemacytometer quadrants

10. History:

Name Date Amendment 

Kari Britt 26JUL07 Initial release 

Deb Audino 04APR08 College name change, format of history 

Kari Britt 05AUG10 Proofreading, formatting and grammar edits throughout 

Jason McMillan 02JAN14 College name change, fixed quadrant number labels 

Figure 1: Diagram of hemacytometer and cover glass 

Image:  http://plaza.ufl.edu/johnaris/Protocols/MiscMethods/HemoCytometer.pdf 
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Figure 2:  Diagram of hemacytometer quadrants 
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tPA Lot Number_____________________

Record Keeping Standards: 

For each step in the batch record: the operator of the task will enter their initials (each 

operator has their own unique set of initials) and the date in the appropriate section(s) of 

the batch record. Another operator must initial and date in the appropriate section of the 

batch record to verify that the task was completed per SOP. No operator will verify their 

own work at any point. "If you didn't document it, you didn't do it!"  

Batch records will be completed in blue or black ball point pen ONLY, and must be 

legible.  

Any errors on a batch record will be crossed out with a single line through the error with 

the initials of the operator and the date. Corrections will be written in next to the crossed 

out error.  

Use the following format to record dates: DDMMMYY.  For July 10, 2006 use 10JUL06. 

Use the 24 hour clock or "military time" to record time: 3:00pm would be written as 

15:00.  

Any and all deviations from a protocol or SOP, including abnormal results or retests 

performed, will be entered into the comments section at the end of each batch record. Be 

as detailed and specific as possible, include all steps taken before and/or after an 

abnormal reading, and provide an explanation for any deviations from a step.  
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tPA Lot Number_____________________

1. Initial Media Preparation

Clean, assemble and autoclave two 100mL Bellco Spinner flasks per 

SOP.  

Spinner flask ID#______________Spinner flask ID#______________ 

Operator/Date Verifier/Date 

Obtain sterile Fetal Bovine Serum (FBS). 

Manufacturer:________________Catalog number: ________________ 

Lot number: _________________Expiration date:_________________ 

Operator/Date Verifier/Date 

Obtain sterile Ham's F12 Medium  

Manufacturer:________________Catalog number: ________________ 

Lot number: _________________Expiration date:_________________ 

Operator/Date Verifier/Date 

Sterilely add 21.6mL of Ham's F12 Medium to a spinner flask.  Repeat 

with the second spinner flask 

100mL spinner flask ID#__________Vol of Ham’s F12_________mL 

100mL spinner flask ID#__________Vol of Ham’s F12_________mL 

Operator/Date Verifier/Date 

Sterilely add 2.4mL ± 1 mL of FBS to each spinner flask. 

100mL spinner flask ID#______________Vol of FBS_________mL 

100mL spinner flask ID#______________Vol of FBS_________mL 

Operator/Date Verifier/Date 

Label spinner flasks as 90% Ham’s F12, 10% FBS, [date], [group#], 

[operator initials]. 

Operator/Date Verifier/Date 

Place spinner flasks containing CHO cell media in the CO2 incubator. 

Set the speed of the magnetic stirrer to the maximum setting that 

ensures an even vortexing of the culture without foaming.   

Operator/Date Verifier/Date 

Verify that CO2 is set to 5±0.5% and that temperature is set to 

37±0.5ºC. 

CO2__________________%       Temperature ___________ ºC 

Operator/Date Verifier/Date 

Check media for contamination after a minimum of 24 hrs.  

Elapsed Incubation Time ___________ 

100mL spinner flask ID____________ Contamination:  Y / N  (Circle) 

100mL spinner flask ID____________ Contamination:  Y / N  (Circle) 

Operator/Date Verifier/Date 

Comments: Operator/Date Verifier/Date 
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tPA Lot Number_____________________

2. Inoculation of Spinner Flasks

Pre-warm  the spinner Flasks containing CHO Cell Culture Medium at 

37° C ± 0.5°C overnight. 

Operator/Date Verifier/Date 

Remove two vials of CHO cells from storage in the -86°C freezer. 

Vial ID:_________________________ 

_________________________ 

Vial ID:_________________________ 

_________________________ 

Operator/Date Verifier/Date 

Sterilely transfer the entire contents of each 1mL vial of thawed CHO 

Cells into the previously prepared Spinner Flask containing 100mL 

CHO Cell Culture Medium using a 2mL sterile pipette. Swirl to mix.  

Be sure to not add any CHO Cells to the Spinner Flask labeled 

“Blank.” 

Operator/Date Verifier/Date 

Comments: Operator/Date Verifier/Date 
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tPA Lot Number_____________________

3. Scale Up to 100ml Media Preparation

Remove the inoculated 100mL Bellco Spinner flask from the CO2 

incubator.  

Spinner flask ID#______________Spinner flask ID#______________ 

Operator/Date Verifier/Date 

Obtain sterile Fetal Bovine Serum (FBS). 

Manufacturer:________________Catalog number: ________________ 

Lot number: _________________Expiration date:_________________ 

Operator/Date Verifier/Date 

Obtain sterile Ham's F12 Medium  

Manufacturer:________________Catalog number: ________________ 

Lot number: _________________Expiration date:_________________ 

Operator/Date Verifier/Date 

Sterilely add 74.7mL of Ham's F12 Medium to a spinner flask.  Repeat 

with the second spinner flask 

100mL spinner flask ID#__________Vol of Ham’s F12_________mL 

100mL spinner flask ID#__________Vol of Ham’s F12_________mL 

Operator/Date Verifier/Date 

Sterilely add 8.3mL ± 1 mL of FBS to each spinner flask. 

100mL spinner flask ID#______________Vol of FBS_________mL 

100mL spinner flask ID#______________Vol of FBS_________mL 

Operator/Date Verifier/Date 

Return the inoculated spinner flask to the CO2 incubator. Operator/Date Verifier/Date 

Verify that CO2 is set to 5±0.5% and that temperature is set to 

37±0.5ºC. 

CO2__________________%       Temperature ___________ ºC 

Operator/Date Verifier/Date 

Check media for contamination after a minimum of 24 hrs.  

Elapsed Incubation Time ___________ 

100mL spinner flask ID____________ Contamination:  Y / N  (Circle) 

Operator/Date Verifier/Date 

Comments: Operator/Date Verifier/Date 
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tPA Lot Number_____________________

100mL Spinner Flask ID#____________________________________ 

TIME 

(hours) 

OD 

650nm pH 
LIVE CELL 

Count 

DEAD CELL 

Count 

Viable cells/ml 

Cells/ml

Percent Viability GLUCOSE 

(mg/dl) 

LACTATE 

(mmol/L) 

Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier 

Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier 

Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier 

Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier 

Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier 
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tPA Lot Number_____________________

100mL Spinner Flask ID#____________________________________ 

TIME 

(hours) 

OD 

650nm pH 
LIVE CELL 

Count 

DEAD CELL 

Count 

Viable cells/mL 

Cells/ml

Percent Viability GLUCOSE 

(mg/dl) 

LACTATE 

(mmol/L) 

Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier 

Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier 

Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier 

Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier 

Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier 
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4. Solution and Buffer Preparation

500mL  1M (NaHCO3) sodium bicarbonate 

100mL of 1X PBS Phosphate buffered Saline 

Weigh out 21.0 ± 1 grams of (NaHCO3) sodium bicarbonate.   

Label container: 1M NaHCO3, [date], [initials], [group number], 

storage: room temp, disposal:  drain. 

Balance ID #:_______________________ 

Manufacturer:________________Catalog number: ________________ 

Lot number: _________________Expiration date:_________________ 

Amount weighed:________________grams 

Operator/Date Verifier/Date 

Dissolve NaHCO3 in 250 ± 5mL of deionized water using magnetic 

stirrer. 

Volume of water added _____________________ mL 

Operator/Date Verifier/Date 

Dilute 10 ± 0.5mL of 10X stock solution, with 90 ± 5mL of deionized 

water in 100mL bottle using magnetic stirrer. 

Label container: 1X PBS, [date], [initials], [group number], storage: 

room temp, disposal:  drain. 

Manufacturer:________________Catalog number: ________________ 

Lot number: _________________Expiration date:_________________ 

Volume of 10x PBS added:________________mL 

Volume of water added: __________________mL 

Operator/Date Verifier/Date 

Comments: Operator/Date Verifier/Date 
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tPA Lot Number_____________________

5. Assemble/Autoclave Bioreactor

5.1.  Assemble Vessel Stand 

Inspect the integrity of the large O-rings on the vessel stand and     

headplate. Replace if worn or cracked. 

Bioreactor ID #________________________ 

Vessel stand O-ring worn or cracked?   Yes / No (Circle one.) 

     O-ring replaced?    Yes / No (Circle one.) 

Headplate O-ring worn or cracked?      Yes / No (Circle one.) 

     O-ring replaced?     Yes / No (Circle one.) 

Operator/Date Verifier/Date 

5.2.  Assemble Headplate-Underside 

Inspect the integrity of the O-rings on the harvest tube, sparger, and the 

thermowell. 

Harvest tube O-ring worn or cracked? Yes / No (Circle one.) 

     O-ring replaced?   Yes / No (Circle one.) 

Sparger O-ring worn or cracked?         Yes / No (Circle one.) 

     O-ring replaced? Yes / No (Circle one.) 

Thermowell O-ring worn or cracked?  Yes / No (Circle one.) 

     O-ring replaced?                              Yes / No (Circle one.) 

Operator/Date Verifier/Date 

Attach harvest tube, sparger and thermowell.  Verify that the sparger 

tube is aligned beneath the stirrer impeller. 

Operator/Date Verifier/Date 

5.3. Attach Headplate to Vessel Stand.  

Place the headplate onto the vessel stand, positioning the holes on the 

outer edge of the headplate with the bolts on the vessel stand. 

Operator/Date Verifier/Date 

Place the sample bottle assembly onto the bolt located by the 3 addition 

port and attach with a mill fastener. 

Operator/Date Verifier/Date 

Secure the headplate with the 5 mill fasteners. Operator/Date Verifier/Date 

5.4.   Assemble Headplate – Topside 

Inspect the integrity of the O-ring in the condenser port of the 

headplate.  Replace if worn or cracked. 

Condenser port O-ring worn or cracked?  Yes / No (Circle one.) 

O-ring replaced?:                                  Yes / No (Circle one.) 

Operator/Date Verifier/Date 
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tPA Lot Number_____________________

Inspect the black seal at the bottom of the condenser underneath the 

retainer nut.  Replace if worn or cracked.   

Condenser black seal worn or cracked?   Yes / No (Circle one.) 

Black seal replaced?                            Yes / No (Circle one.) 

Operator/Date Verifier/Date 

Attach condenser to headplate Operator/Date Verifier/Date 

Remove protective cap from the bottom of the DO probe and inspect 

screen. Replace if damaged. 

Protective screen damaged?         Yes / No (Circle one.) 

Protective screen replaced?     Yes / No (Circle one.) 

Operator/Date Verifier/Date 

Unscrew the membrane module from the bottom housing of the probe 

tip.  Inspect the integrity of the O-ring.  Replace if worn or cracked. 

O-ring worn or cracked?              Yes / No (Circle one.) 

O-ring replaced?                      Yes / No (Circle one.) 

Operator/Date Verifier/Date 

Replenish DO electrolyte with O2 electrolyte solution.  Operator/Date Verifier/Date 

Inspect the integrity of the O-ring at the top of the stainless steel DO 

probe.   Replace if worn or cracked. 

O-ring worn or cracked?               Yes / No (Circle one.) 

O-ring replaced?                       Yes / No (Circle one.) 

Operator/Date Verifier/Date 

Inspect the black seal at the top of the DO probe under the retainer nut.  

Replace if worn or cracked. 

    Black seal worn or cracked?           Yes / No (Circle one.) 

Black seal replaced?                  Yes / No (Circle one.) 

Operator/Date Verifier/Date 

Attach DO probe to the headplate. Operator/Date Verifier/Date 

Calibrate the pH probe. 

pH 7 Buffer           Manufacturer:_______________________ 

Catalog number: _____________________ 

Lot number: ________________________ 

Expiration date:______________________ 

pH 4 Buffer           Manufacturer:_______________________ 

Catalog number: _____________________ 

Lot number: ________________________ 

Expiration date:______________________ 

Operator/Date Verifier/Date 
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Record pH calibration values. 

pH 7.00 standard:     pH value ______________ temp_____________ 

pH 4.00 standard:     pH value ______________ temp_____________ 

Slope from the Display __________________Expected value: 0.95-1.05   

Offset from the Display__________________Expected value: < ±0.3 

Operator/Date Verifier/Date 

Inspect the integrity of the O-ring at the top of the pH probe.  Replace if 

worn or cracked. 

O-ring worn or cracked?               Yes / No (Circle one.) 

O-ring replaced?                       Yes / No (Circle one.) 

Operator/Date Verifier/Date 

Inspect the black seal at the top of the pH probe under the retainer nut.  

Replace if worn or cracked. 

Black seal worn or cracked?          Yes / No (Circle one.) 

 Black seal replaced?                  Yes / No (Circle one.) 

Operator/Date Verifier/Date 

Attach pH probe to the headplate. Operator/Date Verifier/Date 

5.5. Attach Filters and Tubing 

Place silicone tubing on the Sparger tube, Condenser top outlet, and 

CO2 overlay port. 

Use a small piece of silicon tubing to connect together 2 of the ports on 

the 3 port addition. 

Connect the pharmed tubing from the feed bottle to the 3 addition port.  

Connect the sample bottle tubing to the harvest tube. 

Operator/Date Verifier/Date 

Clamp off all tubing (near the headplate) except the condenser top 

outlet.  The condenser top outlet must remain unclamped to release 

pressure during autoclaving. 

Operator/Date Verifier/Date 

Close all open ends with glass wool and cover with aluminum foil 

(including the harvest tube and sample bottle assembly tubing). 

Operator/Date Verifier/Date 

Autoclave per SOP. 

Autoclave at 121°C for 20 minutes, using slow exhaust. 

Operator/Date Verifier/Date 

Comments: Operator/Date Verifier/Date 
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tPA Lot Number_____________________

6. Media Preparation and Addition / Run Preparation

Add approximately 50mL of Fetal Bovine Serum and 10mL of 

10mg/mL gentamycin to 950ml of Ham’s F12 Medium. Pour into 

bioreactor. 

Ham’s F12 Medium: 

Manufacturer:________________Catalog number: ________________ 

Lot number: _________________Expiration date:_________________ 

Fetal Bovine Serum: 

Manufacturer:________________Catalog number: ________________ 

Lot number: _________________Expiration date:_________________ 

Amount added:_______________mL 

Gentamicin: 

Manufacturer:________________Catalog number: ________________ 

Lot number: _________________Expiration date:_________________ 

Amount added:_______________mL 

Operator/Date Verifier/Date 

Verify that deionized H2O has been added to the thermowell with the 

Pt-100 temperature probe.  Add more if necessary. 

Operator/Date Verifier/Date 

Verify that thermal blanket is wrapped around the vessel and plugged 

into the ADI 1025 unit. 

Operator/Date Verifier/Date 

Input the following limits per the process SOP and activate the control 

loops. 

Parameter        Upper limit             Set Point            Lower limit 

pH 7.3 7.2 7.1 

Temperature  38    37 36 

DO   52    50 48 

Stirrer RPM 76 75 74 

Operator/Date Verifier/Date 

Calibrate DO probe per Applikon Bioreactor Operation SOP. 

Note:  Allow DO probe to polarize for at least 6 hours before 

performing calibration. 

Record slope: _____________________ 

Expected values are: 1.5-3.0 at 37oC or 2.0-4.0 at 25oC 

Operator/Date Verifier/Date 
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tPA Lot Number_____________________

Turn on Air supply at pump  

Tank pressure __________________ 

Tank Volume____________________ 

Operator/Date Verifier/Date 

Turn on CO2 supply at regulator to the bioreactor 

Tank pressure __________________ 

Tank Volume____________________ 

Operator/Date Verifier/Date 

Check the media for contamination before inoculation. 

Contamination?  Yes / No (Circle one.) 

Operator/Date Verifier/Date 

Inoculate bioreactor when the 100mL suspension culture of CHO cells 

reaches a concentration of about 1,000,000 cells/ml. 

          Volume of culture added:__________________________ 

Operator/Date Verifier/Date 

Comments: Operator/Date Verifier/Date 
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tPA Lot Number_____________________

Applikon Bioreactor ID#______________________________________________________________ 

TIME 

(hours) 

OD 

650nm pH 
LIVE CELL 

Count 

DEAD CELL 

Count 

Viable cells/ml 

Cells/ml

Percent 

Viability 
GLUCOSE 

(mg/dl) 

LACTATE 

(mmol/L) 

Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier 

Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier 

Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier 

Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier 

Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier Operator/verifier 
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7. Ending a Run

Turn off each control loop. 

Turn off the supply of Air pump. 

Turn off the supply of CO2 tank. 

Operator/Date Verifier/Date 

Aseptically remove the culture through the harvest port. Operator/Date Verifier/Date 

Clean the pH and DO probes with a 10% bleach solution and rinse with DI 

water. Spray with 70% IPA and pat dry with a lint-free laboratory wipe. 

Place protective caps on the pH probe. 

Place protective caps on the DO probes. 

Operator/Date Verifier/Date 

Clean the bioreactor per SOP. Operator/Date Verifier/Date 

Comments: Operator/Date Verifier/Date 

8. Harvest and Preparation of Working Cell Bank

Using a 25mL sterile pipet, divide the 500mL suspension culture into 

about 20 sterile 30mL centrifuge tubes (about 25mL per tube). 

Operator/Date Verifier/Date 

Centrifuge tubes for 10min at 2000rpm. (If using the Sigma 2K15 choose 

program 75). BE SURE TO BALANCE TUBES WHEN LOADING 

ROTOR. 

Operator/Date Verifier/Date 

Comments: Operator/Date Verifier/Date 
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9. Prepare storage menstruum:

In a container capable of holding >50mL add 40mL ± 1mL of Ham’s F12 

manufacturer: ____________________________________  

lot number: ______________________________________  

expiration date: ___________________________________ 

   volume Ham’s F12:________________________________ 

Operator/Date Verifier/Date 

Into the same container add 5mL ± 0.5mL of FBS 

manufacturer: ____________________________________  

lot number: ______________________________________  

expiration date: ___________________________________  

   volume FBS:______________________________________ 

Operator/Date Verifier/Date 

Into the same container add 5mL ± 0.5mL of glycerol 

manufacturer: ____________________________________  

lot number: ______________________________________  

expiration date: ___________________________________  

   volume FBS:______________________________________ 

Operator/Date Verifier/Date 

Filter sterilize and label bottle as CHO storage Menstruum with the date. Operator/Date Verifier/Date 

Following centrifugation, decant tPA containing medium into sterile 

250mL bottles.  Label bottles as unpurified tPA in Ham’s F12/FBS and 

date.   Store supernatant in the refrigerator at 2-8°C. 

Operator/Date Verifier/Date 

Add about 1mL of storage menstruum to each centrifuge tube to resuspend 

the pelleted CHO cells. 

Sterilely dispense 1mL ± 0.1mL aliquots into sterile 1.5mL cryovials. 

Label in the following manner using a cryopen: CHO (ATCC CRL-9606), 

[DATE], [INITIALS]. 

Place in a styrofoam tube rack, label container same as cryovials. 

Store at -85°C. 

Operator/Date Verifier/Date 

Comments: Operator/Date Verifier/Date 
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tPA Lot Number_____________________

10. Prepare Growth Curves

Plot: 

Spinner Flask 

Cells/ml, glucose, and lactate vs. time (use 2 y-axes). 

tPA concentration and cells/ml vs. time (use 2 y-axes). 

Attach graphs to Batch Record. 

Bioreactor 

Cells/ml, % viability, and total cells vs. time (use 2 y-axes). 

Cells/ml, glucose, and lactate vs. time (use 2 y-axes).  

tPA concentration and cells/ml vs. time (use 2 y-axes).  

Attach graphs to Batch Record. 

Operator/Date Verifier/Date 

Send samples to QC Chemistry department for ELISA and Activity 

Assays.  

Operator/Date Verifier/Date 

Attach QC data to the batch record. Operator/Date Verifier/Date 

Comments: Operator/Date Verifier/Date 
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DOWNTREAM PROCESSING: 

CHO CELL TPA 
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Diagram: tPA Downstream Process Flow Chart 

Bioreactor: End of Run – conditioned medium 

Centrifugation to pellet cells 

Supplementation with protease inhibitors (aprotinin, leupeptin, PMSF) & Tween 80 (0.1%) 

Concentration by tangential flow filtration; final volume ~20 ml + 10 ml rinse 

Acidification: adjustment of pH to 5.0 (add acetic acid dropwise; transfer to Oak Ridge tubes; incubate 

on ice 30 min to ON; centrifugation at 10000xg, 20 min) 

Further concentration via Centricon 15 (30k MW cutoff; 20+ minutes, 4000xg) 

Cation Exchange Chromatography on AKTA pure system. 

Analysis of fractions by ELISA. 

SDS-PAGE of EOR concentrate and tPA-containing fractions. 

201



Montgomery County Community College 

340 DeKalb Pike 

Blue Bell, PA 19422  

Document Number: 41.0.0 

Revision Number: 0 

Effective Date: 07JAN14 

Page 1 of 8 

SOP: Millipore Tangential Flow and Diafiltration Using Pellicon XL Device of 

tPA 

Approvals: 

Preparer: Jason McMillan Date: 07JAN14 
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1. Purpose:

1.1. To concentrate and perform buffer exchange of protein products using tangential flow

and diafiltration processes. 

2. Scope and Applicability:

2.1. Applies to performing Tangential Flow Filtration with the Millipore Pellicon XL Device

to concentrate and perform buffer exchange. 

3. Summary of Method:

3.1. Preparation of solutions

3.2. Install resonate and permeate tubing and tank outlet valve on the Labscale 500ml

Reservoir and add the stir bar 

3.3. Connect the Labscale 500 ml Stir Base to power and check operation 

3.4. Install the Pellicon XL Device 

3.5. Flush and precondition the Labscale Tangential Flow Filtration System 

3.6. Concentrate the sample, perform a buffer exchange on the sample, and then retrieve the 

sample. 

3.7. Flush, clean, and drain the system. 

3.8. Flush and prepare the Pellicon XL Device for storage. 

3.9. Clean the Labscale Tangential Flow Filtration System. 

4. References:

4.1. pH meter SOP

5. Definitions:

5.1. Permeate- the material that passes through the membrane.

5.2. Retentate- the material that does not pass through the membrane.

6. Precautions:

6.1. 0.1N NaOH is very corrosive. It is extremely damaging to eyes and mucous membranes.

It causes burns. Avoid contact with skin. It is harmful if swallowed or inhaled.  The 

Millipore Pellicon XL Device is stored flat at 4-25°C with 10ml of 0.1N NaOH. 

6.2. NEVER tighten the clamp enough to completely restrict the flow in the Retentate tube.  

This could damage the filter and cause the tubing to disconnect. 

7. Responsibilities:

7.1 It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary.  

7.2 It is the responsibility of the students/technician to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while 

performing the procedure.  

8. Equipment and Materials:

8.1. 0.1N NaOH (sodium hydroxide)

8.2. 0.05N NaOH (sodium hydroxide)
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8.3. NaH2PO4 (sodium phosphate monobasic, anhydrous) 

8.4. Na2HPO4-7H2O (sodium phosphate dibasic, heptahydrate) 

8.5. preconditioning buffer 

8.6. pH Meter and pH paper 

8.7. 2 L filter unit 

8.8. 2 magnetic stir plate and stir bars 

8.9. Millipore Tangential Flow Filtration System and Pellicon XL Device and Accessories 

8.10.   3 containers, 500mL 

8.11.   50 mL graduated cylinder 

8.12. MilliQ Water  

8.13. 2L graduated cylinder 

8.14. 2L Flask 

8.15. 10ml graduated cylinder  

8.16. 25 ml beaker 

9. Procedure:

9.1. Preparation and Set Up

9.1.1. Prepare 0.1N NaOH for cleaning. 

9.1.1.1.  Using a 1L graduated cylinder, measure 1L of MilliQ water. 

9.1.1.2.  Transfer water to a 1L flask. 

9.1.1.3.  Weigh 4.0±0.05g of NaOH. 

9.1.1.4.  Transfer NaOH to flask. 

9.1.1.5.  Add magnetic stir bar and stir to dissolve. 

9.1.1.6.  Sterile filter the solution and label container: 0.1N NaOH, [date],  

  [initials], [group number], Storage: room temp, Disposal: adjust to pH 7 

  then drain. 

9.1.2. Prepare 0.05N NaOH for Pellicon XL Device Storage 

9.1.2.1  Using a 10 ml graduated cylinder, measure 5 ml of MilliQ water 

9.1.2.2  Transfer MilliQ water to 25 ml beaker 

9.1.2.3  Using a 10 ml graduated cylinder, measure 5 ml of 0.1N NaOH 

9.1.2.4  Transfer 5 ml of 0.1N NaOH to 25 ml beaker 

9.1.2.5  Add magnetic stir bar and stir to dissolve. 

9.1.2.6  Sterile filter the solution and label container: 0.05N NaOH, [date],  

[initials], [group number], Storage: room temp 

9.1.3 Diafiltration Buffer Preparation (20mM Phosphate Buffer pH 7.1) 

9.1.3.1 Weigh out 0.80±0.02g NaH2PO4 and place into 1L flask 

9.1.3.2 Weigh out 3.60±0.2g Na2HPO4-7H2O and place into the 1L flask 

containing NaH2PO4. 

9.1.3.3 Using a 1L graduated cylinder, measure 1L of MilliQ water.  

9.1.3.4 Add the water to the 1L flask containing the phosphates. 

9.1.3.5 Add a magnetic stir bar and stir to dissolve. 

9.1.3.6 Adjust pH to 7.1±0.1. 

9.1.3.7 Sterile filter the solution and label container: 20mM Phosphate Buffer pH 

7.1, [date], [initials], [group number], Storage: room temp, Disposal: drain 
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9.2. Labscale 500ML Reservoir Set Up 
9.2.1  Install Retenate tubing 

Note: All tubing lengths are recommended to minimize recirculation volume. 

Longer lengths may be used. After prolonged storage, the tubing may absorb a 

small volume of water. As a result, the tubing color may change from translucent 

to opaque, which is normal. Air or oven drying will return the color to translucent. 

9.2.1.1.Cut silicone (translucent) tubing and install fittings as shown in figure 10. 

9.2.1.2.Remove plugs from retenate outlet (RET OUT) and retenate inlet (RET 

IN) ports. 

9.2.1.3.Insert the male luer end of the retenate tubing into the RET OUT port and 

the female luer end of the retenate tubing into the RET IN port. Turn 

fittings until snug. 

9.2.2. Install Permeate tubing 

9.2.2.1.Cut silicone (translucent) tubing and install fittings as shown in figure 12. 

9.2.2.2.Remove the plug from the permeate outlet port (PERM 2) and insert the 

male luer end of the permeate silicone (translucent) tubing into the 

PERM2 port. Turn fittings until snug. 

9.3. Install Tank Outlet Valve 

9.3.1. Remove plug from the tank outlet port (TANK OUT) and insert the female luer 

end of the tank outlet valve over the TANK OUT port. Turn the lock nut until 

snug. 

9.3.2. Install Vent Filter (If required) 

9.3.3. If a sterile vent is required, remove plug from the vent (VENT) port and insert the 

male luer end of MILLEX filter into the vent port. 

9.4. Install Stir Bar 

9.4.1. If mixing is required, open reservoir cover and drop stir bar to the bottom of the 

reservoir.  

9.5. Labscale Stir Base Set Up 

9.5.1. Power Connection 

9.5.1.1.Turn Stirrer and pump speed controls to the off position. 

9.5.1.2.Connect power cord to the power cord receptacle located at the rear of the 

system base. 

9.5.1.3.Align detent on connector with receptacle. 

9.5.1.4.Press connector into receptacle and turn lock ring to secure. 

9.5.2. Check Operation 

9.5.2.1.Remove the plugs from the pump inlet and pump outlet ports. 

9.5.2.2.Turn on the pump speed control, set to 2, and listen for pump motor. 

9.5.2.3.Turn off the pump speed control. 

9.5.2.4.Turn on the stirrer speed control and listen for the stirrer motor.  

9.5.2.5.Turn off the stirrer speed control.  

9.6. Install Pellicon XL Device 
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9.6.1. Remove the plugs from FEED, RET, PERM 1, and PERM 2 ports on the Pellicon 

XL Device.  

9.6.2. Align the Pellicon XL device ports with Labscale 500 ml Reservoir ports being 

sure the PERM and RET DEVICE ports of the Pellicon XL Device and reservoir 

match. Press the device firmly onto the reservoir ports. Turn the lock nuts until 

snug.  

9.7. Flushing 

9.7.1. Disconnect retenate silicone (translucent) tubing from RET IN port and place end 

of retenate tubing in waste collection vessel. 

9.7.2. Place end of permeate silicone (translucent) tubing into waste collection vessel.  

Open retenate valve by turning the counterclockwise.  

9.7.3. Remove the reservoir cover and fill reservoir with 500 ml of MilliQ water. 

Remove the plug from VENT port and open tank outlet valve.  

9.7.4. Turn the pump on and increase the speed until the feed pressure gauge reads 1.38 

Bar (20 psi). 

9.7.5. Continue pumping to the waste collection vessel until the level in the reservoir 

drops to 350 ml and then turn the pump off.  

9.7.6. Reconnect the retenate silicone (translucent) tubing to the RET IN port and turn 

the pump on. Slowly increase the pump speed until feed pressure gauge reads 

1.38 Bar (20 psi). Check the system for leaks and tighten connections if leaks are 

found.  

9.7.7. Adjust retenate valve restriction by slowly turning retenate valve clockwise until 

the retenate pressure gauge reads 0.69 Bar (10 psi). 

9.7.8. Adjust pump speed and retenate valve restriction to achieve 2.07 Bar (30 psi) feed 

pressure and 0.69 Bare (10 psi) retenate pressure. 

9.8. Pre-conditioning 

9.8.1. Place end of permeate tubing silicone (translucent) in the waste collection vessel. 

9.8.2. Remove reservoir cover and fill the reservoir with 50 ml of an appropriate buffer 

and then remove the Vent port plug. 

9.8.3. Open the tank outlet valve. Turn the pump on and increase the pump speed until 

the feed pressure gauge reads 1.38 Bar (20 psi). Check all system connections for 

leaks and tighten any connections as necessary. 

9.8.4. Continue pumping to the waste connection vessel until the level in the reservoir 

drops to the bottom of the reservoir stir bar well making sure to stop the pump 

before air is pumped into the system. Turn the pump off. 

9.9. Drain Permeate Tubing 

9.9.1. Disconnect the permeate tubing (silicone, translucent) from the permeate outlet 

(Perm 2) port. Drain the permeate tubing into the waste collection vessel. 

9.9.2. Reconnect the permeate tubing to the PERM 2 port. 

9.10. Concentrate the Sample 

9.10.1. Remove the reservoir cover and fill the reservoir with tPA sample to be 

concentrated. 
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9.10.2. Ensure the vent port is open by removing the plug from the VENT port and 

leaving it open or installing a Millex Filter if required. Open the tank outlet valve. 

9.10.3. Turn the pump on and increase the pump speed until the feed pressure gauge 

reads 1.38 Bar (20 psi). Check all system connections for leaks and tighten any 

connections as necessary.  

9.10.4. Adjust the retenate valve restriction by slowly turning the retenate valve 

clockwise until the retenate pressure gauge reads 0.69 Bar (10 psi). 

9.10.5. Adjust the pump speed and retenate valve restriction to achieve desired feed 

retenate pressures (2.07 Bar (30 psi feed / 0.69 Bar (10 psi) retenate). Do not 

exceed 4.14 Bar (60 psi) feed pressure.  

9.10.6. Filter the solution until the desired volume is reduced 10 fold.  

9.10.7. Turn off the pump and empty the permeate container into a large bottle with a cap 

and label ad: tPA Permeate Waste, disposal; bleach then drain, [initials], [date]. 

9.11. Perform a Buffer Exchange on the Sample 

9.11.1. Add the 20mM Phosphate Buffer to the sample to bring the volume back to the 

pre-concentrated volume.  

9.11.2. Repeat Concentrate the Sample (Number will go here) until the pH of the 

concentrated retenate is 7.1 ±0.1 as measured with a pH meter. 

9.12. Retrieve the Sample 

9.12.1. Disconnect the pump outlet tubing (Sta-Pure, white) from pump outlet port and 

place in product recovery collection vessel. 

9.12.2. Disconnect the retenate tubing (silicone, translucent) from the retenate in port. 

Fluid should now drain by gravity. If additional drainage is required, a syringe 

can be placed on the end of the retenate tube and fluid can be blown down.  

9.12.3. Replace retenate tubing (silicone, translucent) in retenate port. Reconnect pump 

outlet tubing (Sta-Pure, white). 

9.12.4. Disconnect FEED IN tubing and place in collection vessel. Open tank outlet 

valve, turn pump speed up to drain reservoir.  

9.12.5. Reconnect the pump outlet tubing (Sta-Pure, white) to the Feed In port.  

9.12.6. Label the recovery collection vessel Concentrated tPA, [date], [initials]. 

9.12.7. Store in 2°C-8°C refrigerator for use in further purification steps.  

9.13. Flushing 

9.13.1. Repeat Flushing as described in 9.7 

9.14. Cleaning 

9.14.1. Disconnect the retenate tubing (silicone, translucent) from RET IN port and place 

in waste collection vessel. Place the end of the permeate tubing in the waste 

collection vessel. 

9.14.2. Open the retenate valve by turning it counterclockwise.  

9.14.3. Remove the reservoir cover and fill with 500 ml of 0.1N NaOH. Ensure the vent 

port is open by removing the plug from the VENT port and either leave open or 

install a Millex Filter.  

9.14.4. Open the tank outlet valve. 
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9.14.5. Turn the pump on and increase the pump speed until the feed pressure gauge 

reads 1.38 Bar (20 psi). Check all system connections for leaks and tighten any 

connections as necessary. 

9.14.6. Continue pumping to the waste collection vessel until the level in the reservoir 

drops to 250 ml and then turn the pump off. Reconnect the retenate (silicone, 

translucent) tubing to the RET IN port.  

9.14.7. Connect the male luer end of the permeate tubing to the recirculation (DIA / 

RECIRC) port. Turn the pump on and increase the pump speed until the feed 

pressure gauge reads 1.38 Bar (20 psi). Check all system connections for leaks 

and tighten any connections as necessary. 

9.14.8. Adjust the retenate valve restriction by slowly turning the retenate valve 

clockwise until the retenate pressure gauge reads 0.69 Bar (10 psi). Adjust the 

pump speed and retenate valve restriction to achieve 2.07 Bar (30 psi) feed 

pressure and 0.69 Bar (10 psi) retenate pressure.  

9.14.9. Recirculate the cleaning solution for 30-60 minutes and then turn the pump off. 

9.15. Drain the System 

9.15.1. Disconnect the pump outlet (Sta-pure, white) tubing from the pump outlet port 

and place in waste collection vessel.  

9.15.2. Disconnect the retenate silicone (translucent) tubing from the RET IN port. Fluid 

should now drain by gravity. If additional drainage is required, a syringe can be 

placed on the end of the retenate tube and fluid can be blown down.  

9.16. Flushing 

9.16.1. Repeat Flushing as described in 9.7 

9.17. Pellicon XL Device Storage  

9.17.1. Turn all of the lock nuts until you are able to remove the Pellicon XL Device. 

9.17.2. Fill a syringe with 0.05N NaOH Storage solution. 

9.17.3. Attach the syringe to the retenate port and slowly push the solution into the 

device. Remove the syringe and replace all of the plugs on the ports and store flat 

at 4°C-25°C. 

9.18. Clean Base 

9.18.1. Disconnect the power cord. 

9.18.2. Clean exterior surfaces, reservoir, and Labscale System Base with a mild soap and 

water solution. 

10. Attachments:
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Figure 1: Reservoir Set Up 

(http://www.millipore.com/userguides.nsf/docs/p60085) 

208

http://www.millipore.com/
http://www.millipore.com/userguides.nsf/docs/p60085


Montgomery County Community College 

340 DeKalb Pike 

Blue Bell, PA 19422  

Document Number: 41.0.0 

Revision Number: 0 

Effective Date: 07JAN14 

Page 8 of 8 

SOP: Millipore Tangential Flow and Diafiltration Using Pellicon XL Device of 

tPA 

Figure 2: Pump Base Set Up 

(http://www.millipore.com/userguides.nsf/docs/p60085) 

Figure 3: Installation of Pellicon XL Device 

(http://www.millipore.com/userguides.nsf/docs/p60085) 

11. History

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 07JAN14 Jason McMillan Initial release 
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1. Purpose:

1.1. To harvest t-PA-containing conditioned medium and prepare for purification of t-PA by

TFF concentration and pH adjustment; intermediate steps include centrifugation to 

remove cells prior to tangential flow filtration and to pellet precipitated protein 

following pH adjustment. 

2. Scope and Applicability:

2.1. A biomanufacturing environment requires proper steps to recover and purify active

pharmaceutical ingredient from a bioreactor or fermentor. This SOP provides bench 

scale procedures to accomplish that goal using conditioned medium from cells 

expressing recombinant tissue-type plasminogen activator. The method demonstrates the 

principles of tangential flow filtration, centrifugation, and pH dependent protein 

precipitation in preparation for downstream processing by column chromatography as 

may be employed in a typical process development, for later scale up to manufacturing. 

3. Summary of Method:

3.1. Preparation of solutions:

3.1.1. PBS/Tween 80 for preconditioning of the Pellicon cassette (for TFF) 

3.1.2. 0.1 N NaOH for cleaning the Pellicon cassette following use 

3.1.3. 0.05 N NaOH for storage of the Pellicon cassette  

3.2. Flushing and preconditioning of TFF/Pellicon. 

3.3. Transfer of culture from bioreactor to centrifuge bottles. 

3.4. Centrifugation to pellet cells. 

3.5. Transfer of conditioned medium (CM) from centrifuge bottle to storage vessel/bottle. 

3.6. Addition of protease inhibitors and Tween 80. 

3.7. Concentration of supplemented CM by tangential flow filtration. 

3.8. Adjustment of pH of concentrated CM. 

3.9. Centrifugation. 

4. References:

4.1 Millipore Tangential Flow and Diafiltration Using Pellicon XL Device of tPA SOP

4.2  Oakton PC 700 Bench Series pH/Conductivity/°C/°F Meter SOP (Doc # 1.0).

5. Definitions:

5.1. Permeate- the material that passes through the membrane.

5.2. Retentate- the material that does not pass through the membrane.

5.3. TFF – tangential flow filtration

5.4.  CM – conditioned medium, which contains the API of interest
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6. Precautions:

6.1. 0.1N NaOH is very corrosive. It is extremely damaging to eyes and mucous membranes.

It causes burns. Avoid contact with skin. It is harmful if swallowed or inhaled.  The 

Millipore Pellicon XL Device is stored flat at 4-25°C with 10ml of 0.1N NaOH. 

6.2. Acetic acid vapor is extremely irritating to the airways upon inhalation, and should 

therefore be used only in the fume hood. 

6.3. NEVER tighten the clamp enough to completely restrict the flow in the Retentate tube.  

This could damage the filter and cause the tubing to disconnect. 

6.4. Luer Lock fittings on the TFF device should be tightened with care not to exert too much 

force, to avoid stripping threads or damaging the fitting. 

7. Responsibilities:

7.1 It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary.  

7.2 It is the responsibility of the students/technician to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while 

performing the procedure.  

8. Equipment and Materials:

8.1.  250 ml Nalgene centrifuge bottles (3)

8.2. 250 ml Corning bottles (3)

8.3.  0.1N NaOH (sodium hydroxide)

8.4.  0.05N NaOH (sodium hydroxide)

8.5.  acetic acid, glacial

8.6. 10% (w/v) Tween 80

8.7.  NaH2PO4 (sodium phosphate monobasic, anhydrous), or pre-made PBS (phosphate

buffered saline) 

8.8.  Na2HPO4-7H2O (sodium phosphate dibasic, heptahydrate), or pre-made PBS 

8.9.  preconditioning buffer (PBS containing 0.1% Tween 80)- 50 ml 

8.10. Stock solutions of protease inhibitors:  

8.10.1. 10 mg/ml PMSF (phenylmethylsulfonylflouride); 250X 

8.10.2. Leupeptin, 2 mg/ml; 4000x 

8.10.3. Aprotinin, 10 mg/ml, 5000x 

8.11.  pH Meter and pH paper 

8.12.  2 magnetic stir plate and stir bars 

8.13.  Millipore Tangential Flow Filtration System and Pellicon XL Device and Accessories 

8.14.  MilliQ Water 

8.15. 10ml graduated cylinder  

8.16. 25 ml beaker 

9. Procedure:

9.1. Preparation and Set Up

9.2. Preparation of solutions (provided).

9.2.1. Prepare 0.1N NaOH for cleaning. 

9.2.1.1.  Using a 1L graduated cylinder, measure 1L of MilliQ water. 

9.2.1.2.  Transfer water to a 1L flask. 
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9.2.1.3.  Weigh 4.0±0.05g of NaOH. 

9.2.1.4.  Transfer NaOH to flask. 

9.2.1.5.  Add magnetic stir bar and stir to dissolve. 

9.2.1.6.  Sterile filter the solution and label container: 0.1N NaOH, [date],  

  [initials], [group number], Storage: room temp, Disposal: adjust to pH 7 

  then drain. 

9.2.2. Prepare 0.05N NaOH for Pellicon XL Device Storage 

9.1.2.1  Using a 10 ml graduated cylinder, measure 5 ml of MilliQ water 

9.1.2.2  Transfer MilliQ water to 25 ml beaker 

9.1.2.3  Using a 10 ml graduated cylinder, measure 5 ml of 0.1N NaOH 

9.1.2.4  Transfer 5 ml of 0.1N NaOH to 25 ml beaker 

9.1.2.5  Add magnetic stir bar and stir to dissolve. 

9.1.2.6  Sterile filter the solution and label container: 0.05N NaOH, [date],  

[initials], [group number], Storage: room temp 

9.3. Labscale 500ML Reservoir Set Up  
9.4. Flushing and preconditioning of TFF/Pellicon. One should become familiar with the 

location of ports and tubing connection points as shown in the attachments at the end of 

this SOP prior to beginning setup. 

9.4.1. Set up the apparatus and confirm that all tubing connections are secure, according 

to the SOP (Millipore Tangential Flow and Diafiltration Using Pellicon XL 

Device of tPA SOP). 

9.4.2. Remove the 4 plugs on the Pellicon cassette and attach the Pellicon cassette to the 

Labscale apparatus. 

9.4.3. Add 500 ml MilliQ water to the reservoir and flush the cassette as described in 

section 9.4.4. 

9.4.4. Flushing the Pellicon cassette. 
9.4.4.1. Disconnect retentate silicone (translucent) tubing from RET IN port and 

place end of retentate tubing in waste collection vessel. 

9.4.4.2. Place end of permeate silicone (translucent) tubing into waste collection 

vessel.  Open retentate valve by turning the counterclockwise.  

9.4.4.3. Remove the reservoir cover and fill reservoir with 500 ml of MilliQ 

water. Remove the plug from VENT port and open tank outlet valve.  

9.4.4.4. Turn the pump on and increase the speed until the feed pressure gauge 

reads 1.38 Bar (20 psi). 

9.4.4.5. Continue pumping to the waste collection vessel until the level in the 

reservoir drops to 350 ml and then turn the pump off.  

9.4.4.6. Reconnect the retentate silicone (translucent) tubing to the RET IN port 

and turn the pump on. Slowly increase the pump speed until feed pressure 

gauge reads 1.38 Bar (20 psi). Check the system for leaks and tighten 

connections if leaks are found.  

9.4.4.7. Adjust retentate valve restriction by slowly turning retentate valve 

clockwise until the retentate pressure gauge reads 0.69 Bar (10 psi). 
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9.4.4.8. Adjust pump speed and retentate valve restriction to achieve 2.07 Bar (30 

psi) feed pressure and 0.69 Bare (10 psi) retentate pressure. 

9.4.4.9. Allow to run until 50 ml remains in the chamber. 

9.4.4.10. Disconnect the pump outlet (Sta-pure, white) tubing from the 

pump outlet port and place in waste collection vessel. 

9.4.4.11. Disconnect the retentate silicone (translucent) tubing from the RET 

IN port. Fluid should now drain by gravity. If additional drainage is 

required, a syringe can be placed on the end of the retentate tube and fluid 

can be blown down.  

9.4.4.12. Remove the remainder of water in the chamber as follows: Replace 

retentate tubing (silicone, translucent) in retentate port. Reconnect pump 

outlet tubing (Sta-Pure, white).  

9.4.4.13. Disconnect FEED IN tubing and place in collection vessel. Open 

tank outlet valve, turn pump speed up to drain reservoir.  

9.4.4.14. Reconnect the pump outlet tubing (Sta-Pure, white) to the Feed In 

port. 

9.5. Pre-conditioning 

9.5.1. Place end of permeate tubing silicone (translucent) in the waste collection vessel. 

9.5.2. Remove reservoir cover and fill the reservoir with 50 ml of PBS containing 0.1% 

Tween 80 (or other appropriate buffer) and then remove the Vent port plug.  

9.5.3. Open the tank outlet valve. Turn the pump on and increase the pump speed until 

the feed pressure gauge reads 1.38 Bar (20 psi at its maximum; the needle will 

pulse as the pump turns). Check all system connections for leaks and tighten any 

connections as necessary.  

9.5.4. Continue pumping to the waste collection vessel until the level in the reservoir 

drops to the bottom of the reservoir stir bar well making sure to stop the pump 

before air is pumped into the system. Turn the pump off. 

9.6. Transfer of culture from bioreactor to centrifuge bottles. 

9.6.1. Refer to the SOP: Applikon ez-Control Bioreactor Controller Operation for 

instructions on removing the headplate of the bioreactor, providing access to the 

cells and conditioned medium.  

9.6.2. Transfer the culture to three 250 ml centrifuge bottles using a 50 ml pipet and 

PipetAid.  Residual culture can be transferred to an Ehrlenmeyer flask for 

temporary storage.  

9.6.3. Centrifuge cells in pre-chilled Sorvall centrifuge, fitted with a SLA1500 rotor,  at 

500 x g for 5 min, 4 degrees C. 

9.6.4. Transfer conditioned medium (CM) from centrifuge bottle to storage vessel/bottle 

by carefully decanting the supernatant to appropriately labeled 250 ml Corning 

bottles. 

9.6.5. Add protease inhibitors and Tween 80 as follows. To each 250 ml bottle of CM 

supernatant, add 1 ml 10mg/ml PMSF, 50 l of 10 mg/ml Aprotinin stock and 

62.5 l 2 mg/ml Leupeptin stock. Also add 2.5 ml 10% Tween 80 (final 

concentration will be 0.1%).  
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9.7. Concentrate the Sample 

9.7.1. Remove the reservoir cover and fill the reservoir with tPA sample (up to 500 ml) 

to be concentrated. 

9.7.2. Ensure the vent port is open by removing the plug from the VENT port and 

leaving it open or installing a Millex Filter if required. Open the tank outlet valve. 

9.7.3. Turn the pump on and increase the pump speed until the feed pressure gauge 

reads 1.38 Bar (20 psi). Check all system connections for leaks and tighten any 

connections as necessary. 

9.7.4. Adjust the retentate valve restriction by slowly turning the retentate valve 

clockwise until the retentate pressure gauge reads 0.69 Bar (10 psi). 

9.7.5. Adjust the pump speed and retentate valve restriction to achieve desired feed 

retentate pressures [2.07 Bar (30 psi feed / 0.69 Bar (10 psi) retentate]. Do not 

exceed 4.14 Bar (60 psi) feed pressure. 

9.7.6. Filter the solution until the desired volume is reduced 10 fold or greater, but 

ideally down to about 20 ml. 

9.7.7. Turn off the pump and empty the permeate container into a large bottle with a cap 

and label as: tPA Permeate Waste, disposal; bleach then drain, [initials], [date]. 

9.8. Retrieve the Sample 

9.8.1. Disconnect the pump outlet tubing (Sta-Pure, white) from pump outlet port and 

place in product recovery collection vessel (beaker with small stir bar is preferred; 

or 50 ml tube).  

9.8.2. Disconnect the retentate tubing (silicone, translucent) from the retentate in port 

and open back pressure regulation valve (turn counterclockwise). Fluid should 

now drain by gravity.  

9.8.3. When drainage ceases, rinse the Pellicon innards by injection of 5 ml PBS/0.1% 

Tween 80 from the retentate tube using a 10 ml syringe. Additional drainage is 

required; a syringe can be placed on the end of the retentate tube and fluid can be 

blown down.  

9.8.4. Replace retentate tubing (silicone, translucent) in retentate port. Reconnect pump 

outlet tubing (Sta-Pure, white). 

9.8.5. Disconnect FEED IN tubing and place in collection vessel. Open tank outlet 

valve, turn pump speed up to drain reservoir. 

9.8.6. Stop the pump, close the outlet valve, and add 5 ml PBS/Tween80 to the chamber 

to rinse sides and effect collection of residual tPA. Pipet the solution along the 

walls repeatedly to rinse, then collect and transfer to the collection vessel. 

9.8.7. Reconnect the pump outlet tubing (Sta-Pure, white) to the Feed In port. 

9.8.8. Label the recovery collection vessel Concentrated tPA, [date], [initials]. 

9.9. Adjustment of pH of concentrated Conditioned Medium (CM). 

Glacial acetic acid is irritating to the airways upon inhalation. Therefore perform the 

following operation in the fume hood with the sash as low as is comfortably possible to 

work.  
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9.9.1. Place the beaker containing concentrate on a stir plate, insert pH probe and 

monitor pH. 

9.9.2. Add glacial acetic acid dropwise to the concentrated tPA to reduce the pH to  5.0 

+/- 0.1. 

9.9.3. Transfer the mixture to the minimum number of Oak Ridge centrifuge tubes 

necessary to contain it (capacity of each tube is about 40 ml). 

9.9.4. Leave the mixture on ice for at least 30 min (overnight at 4°C is acceptable, and 

offers a convenient stopping point) to allow formation of precipitate. 

9.10. Clarification of pH 5.0 Solution by Centrifugation 

9.10.1. Centrifuge pH 5.0 mixture at 10,000 x g for 10 minutes, 4°C. 

9.10.2. Transfer the supernatant to appropriately sized tube(s) labeled tPA-TFF/pH 5. 

9.10.3. Store in 2°C-8°C refrigerator for use in further purification steps.  

9.11. Flushing 

9.11.1. To begin cleaning the Millipore TFF apparatus and Pellicon filter, repeat Flushing 

as described in 9.4.4 

9.12. Cleaning the Labscale TFF/Pellicon cassette. 
9.12.1. Disconnect the retentate tubing (silicone, translucent) from RET IN port and place 

in waste collection vessel. Place the end of the permeate tubing in the waste 

collection vessel. 

9.12.2. Open the retentate valve by turning it counterclockwise.  

9.12.3. Remove the reservoir cover and fill with 500 ml of 0.1N NaOH. Ensure the vent 

port is open by removing the plug from the VENT port and either leave open or 

install a Millex Filter.  

9.12.4. Open the tank outlet valve. 

9.12.5. Turn the pump on and increase the pump speed until the feed pressure gauge 

reads 1.38 Bar (20 psi). Check all system connections for leaks and tighten any 

connections as necessary. 

9.12.6. Continue pumping to the waste collection vessel until the level in the reservoir 

drops to 250 ml and then turn the pump off. Reconnect the retentate (silicone, 

translucent) tubing to the RET IN port.  

9.12.7. Connect the male luer end of the permeate tubing to the recirculation (DIA / 

RECIRC) port. Turn the pump on and increase the pump speed until the feed 

pressure gauge reads 1.38 Bar (20 psi). Check all system connections for leaks 

and tighten any connections as necessary. 

9.12.8. Adjust the retentate valve restriction by slowly turning the retentate valve 

clockwise until the retentate pressure gauge reads 0.69 Bar (10 psi). Adjust the 

pump speed and retentate valve restriction to achieve 2.07 Bar (30 psi) feed 

pressure and 0.69 Bar (10 psi) retentate pressure.  

9.12.9. Recirculate the cleaning solution for 30-60 minutes and then turn the pump off. 

9.13. Drain the System 

9.13.1. Disconnect the pump outlet (Sta-pure, white) tubing from the pump outlet port 

and place in waste collection vessel. 
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9.13.2. Disconnect the retentate silicone (translucent) tubing from the RET IN port. Fluid 

should now drain by gravity. If additional drainage is required, a syringe can be 

placed on the end of the retentate tube and fluid can be blown down.  

9.14. Flushing 

9.14.1. Repeat Flushing as described in 9.4.4. 

9.15. Pellicon XL Device Storage  

9.15.1. Turn all of the lock nuts until you are able to remove the Pellicon XL Device.  

9.15.2. Fill a 10 ml syringe with 0.05N NaOH Storage solution. 

9.15.3. Place the cassette in sink or tray that can contain any overflow. Attach the syringe 

to the retentate port and slowly push the solution into the device. Remove the 

syringe and replace all of the plugs on the ports and store flat at 4°C-25°C. 

9.16. Clean Base 
9.16.1. Disconnect the power cord. 

9.16.2. Clean exterior surfaces, reservoir, and Labscale System Base with a mild soap and 

water solution. 

10. Attachments:

Figure 1: Reservoir Set Up 

(http://www.millipore.com/userguides.nsf/docs/p60085) 
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Figure 2: Pump Base Set Up 

(http://www.millipore.com/userguides.nsf/docs/p60085) 

Figure 3: Installation of Pellicon XL Device 

(http://www.millipore.com/userguides.nsf/docs/p60085) 

Reservoir 
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11. History

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 07JAN14 Jason McMillan Initial release 
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1.0 Description 

1.1 This batch production record covers the precise operating steps necessary to purify recombinant 

tissue-type plasminogen activator from concentrated conditioned cell culture medium using 

cation exchange chromatography. 

2.0 Reference 

Title Document Number 

TFF ref. SOP DP 2 

Supplementation/Acidification/Precipitation 

GE Healthcare AKTA pure Equipment SOP DP 5 

SOP for Bradford Protein Assay 

SOP for tPA ELISA QCB 1 

3.0 Equipment 

Equipment Type Manufacturer, Model 

Number 

Calibration Due 

Date 

Initials/Date Verifier/Date 

Chromatography 

System 

GE Healthcare AKTApure 

Column HiTrap SP, 5ml N/A 

4.0 Components 

Component Quantity 

Required 

Quantity Used Initials/Date Verifier/Date 

Fraction tubes 50 

Syringe, 1 ml 1 

Ehrlenmeyer flask, 125 ml 1 

Ehrlenmeyer flask, 1L 1 

5.0 Solutions 

Solution ID Date Prepared Volume 

Required 

Volume 

Used 

Initials/

Date 

Start Buffer 0.2M NaOAc, pH 5, 

0.1% Tween 80 

250 ml 

End Buffer 0.2M NaOAc, pH 5,  

0.1% Tween 80, 1M NaCl 

250 ml 

Filtered, 

degassed MilliQ 

500 ml 

219



Montgomery County Community College 

340 DeKalb Pike 

Document Number: tPA-AKTA 

Revision Number:  0 

Blue Bell, PA 19422 Effective Date: 23JUN15 

Page 2 of 6 

Batch Process Record: tPA Production from CHO Cells: Chromatography Operation 

water 

6.0 Procedure 

6.1 Chromatography system setup 

# Task 
Performed 

Initial/Date 

Verified 

Initial/Date 

1 Place or verify that Buffer A is in place, 

securely located atop the instrument.  

Insert tubing for inlet A1 to the bottom of the 

container. 

Approximate volume of Buffer A:_________ 

ml 

2 Place or verify that the Buffer B container is in 

place, securely located atop the instrument. 

Insert tubing for inlet B1 to the bottom of the 

container. 

Approximate volume of Buffer B:_________ 

ml 

3 Verify that the tubing labelled Outlet is placed 

into a 125 ml E. flask 

4 Verify that the Waste effluent tubing labeled 

W, W1, and W2, are placed in a 1L E flask 

5 Confirm that an adequate supply (50) of tubes 

are placed in the fraction collector carousel. 

6 Rotate the tube carousel so that the #1 position 

is set to receive the initial drops. Lift the arm 

and swing it over to rest against the side of the 

first tube.  

7 Load a 5 ml syringe with Buffer A, removing 

air bubbles,  and flush the 0.5 ml sample loop 

by injecting the entire volume 

8 Turn the AKTApure system on. The on/off 

switch is on the right side toward the rear of 

the instrument. 

9 Turn on the computer and login 

10 Open the Unicorn 6.3 software by: 
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1) double clicking the desktop icon

2) clicking ‘OK’ at the Log On-Unicorn dialog

box 

11 Confirm that the installed column is a HiTrap  

SP HP 5 ml 
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6.2 Column conditioning 

# Task 
Performed 

Initial/Date 

Verified 

Initial/Date 

11 Equilibrate system and column. 

1)Navigate to the System Control window.

2) If the window is blank, choose menu item

System\Connect to System and choose OK 

2) In the File menu, select Open\HiTrap SP 5ml

Equilibration 

3) Click Next until the Start button is shown, then choose

it. 

4) Allow the method to run to completion (about 15

minutes). 

12 Verify that eluent is directed into the waste flask 

13 Empty waste flask when the method is complete, then 

return it. 

6.3 tPA Chromatography 

# Task Performed 

Initial/Date 

Verified 

Initial/Date 

1 Record the sample information. 

Sample origin: 

Batch #: 

Date prepared: 

Volume: 

pH: 

2 Centrifuge the sample at 10000 x g for 5 min. 

3  Sample injection into 0.5 ml sample loop: 

1) Fill 1 ml syringe with sample, being careful to avoid

precipitated matter and eliminate any air bubbles 

2) Dispense excess sample back into its original container,

retaining 0.6 ml in the syringe 

3) Insert syringe firmly into sample inlet port (refer to

diagram 1). 
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4) Inject into the 0.5 ml sample loop

4 Initiate the run: 

1)Using the Unicorn 6.3 software, open the System

Control window. 

2)Under the File menu, choose Open\HiTrapSP tPA

Production 

3) In the resulting dialog box, input Sample Info into the

designated cell. 

4) Enter

5) Click Next until the Start button is shown in the dialog

box. 

6) Click Start to begin the separation process.

Chromatographic run sequence is as follows: 

1) Inject entire contents of 0.5 ml sample loop; begin collecting 5 ml fractions.

2) Wash unbound proteins through with up to 12 column volumes (CV) buffer A, until A280

stabilizes; eluent 

 directed to waste. 

3) Elute bound protein (mostly contaminants, with minor amount of t-PA) with linear gradient of 0-

0.2M NaCl 

 in 5CV; collect 5 ml fractions. 

4) Hold at 0.2M NaCl for 2CV.

5) Elute bound t-PA with 0.5M NaCl in 2 CV; collect 2 ml fractions.

6) Flush column with 2 CV of 1.0M NaCl; collect 5 ml fractions.

7) Re-equilibrate column in 5 CV buffer A.

6.4  Evaluate Chromatographic Separation 

# Task 
Performed 

Initial/Date 

Verified 

Initial/Date 

1 Open chromatogram (should be the most recent one listed) in 

Unicorn “Evaluation” tool as follows: 

1) In Unicorn 6.3 software, under the Tools menu, choose

Evaluation. 

2) In the Evaluation window, click the Results tab.

3) Find yours in the listed chromatograms, then double click to

display it in the right frame. 

2 Optional: 

Customize chromatogram: 

1)Open Customize tool

2)Accept the default, or select curves for UV, conductivity,

fractions; 
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3)adjust Y axis values for optimum display of curves

3 Optional. Determine protein content per fraction by Bradford 

Protein Estimation. Refer to the SOP for that procedure.  

4 Use Operations\Fraction Histogram to indicate average protein 

content per fraction. 

5 Use Operations\

numbered fractions XX-YY; refer to the tPA ELISA SOP. 

6 Save and Print: 

Save the chromatogram as a pdf: 

1) While displaying finished chromatogram, choose File\Print

2) In the resulting dialog box, choose Preview

3) In the window that opens, click File\Save as PDF

4) Enter a name which refers to the sample, column and date (e.g.

tPA from TFF on HiTrap SP 09APR15) 

5) Print a copy of the chromatogram for record keeping

7 Save changes. 
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Approvals 

Preparer: Dr. David Frank Date: 16JUL15 

Reviewer: Jason McMillan Date: 16JUL15 

Reviewer: Dr. Maggie Bryans Date: 16JUL15 

1. Purpose

1.1. This procedure describes the operation of the ÄKTA pure Chromatography System,

controlled by Unicorn 6.3 software. 

2. Scope and Applicability

2.1. Applies to chromatography of proteins, etc using a column installed on the GE ÄKTA

pure Chromatography System and controlled by Unicorn 6.3 software. 

3. Summary of Method

3.1. Method writing (programming)

3.2. Manual control of the instrument

3.3.  Equilibration of system and column

3.4.  Fraction collector setup

3.5.  Application of sample

3.6.  Washing and elution of column

3.7.  Regeneration of system in preparation for subsequent run

3.8.  Procedures for cleaning and short or long term storage of the system

4. References

4.1.  Unicorn 6.3 Users Guide (electronic)

4.2.  AKTA pure 25 Users Guide (electronic)

4.3.  Manufacturer’s literature/spec sheets for media

4.3.1. HiTrap SP HP 5 information booklet (GE) 

4.3.2. L-Lysine HyperD reference sheet (Pall) 

4.3.3. Capto Q information booklet (GE) 

4.3.4. Ni2+ IMAC Profinity reference sheet (BioRad) 

4.4.  End-of-Run t-PA Process SOP: Harvest, Centrifugation, Concentration, pH Adjustment 

(Document Number DP 3); 13Apr15 

5. Definitions

5.1. N/A

6. Precautions

6.1. Routine care should be exercised in handling of buffers and samples of biological

materials, which may have harmful biological activity in the case of accidental ingestion, 

needle stick, etc. 

6.2. User should read and be familiar with general good practice as outlined in the AKTA 

pure Cue Cards located near the instrument. 

6.3. Avoid damaging the threads through the use of excessive force when connecting plastic 

fasteners. 

6.4. Care must be taken to avoid air in the fluid path, which could damage the pumps or give 

spurious and uninterpretable readout from the UV and/or conductivity detectors.  
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6.5. Gloves and protective eyewear should be worn when handling samples and reagents 

(buffers), however it is preferable that the user remove gloves prior to entering 

commands via the computer keyboard or mouse.  

6.6. Buffers must be degassed and filtered prior to use with the AKTA pure instrument. 

Samples should be centrifuged at 10000xg for 5 min before injection/introduction into 

the fluid path. 

6.7. Equipment calibration check: The AKTA pure system calibration is automatic; baseline 

for measurements of A280 and conductivity are zeroed at the beginning of a 

chromatography run. Further adjustment is beyond the scope of this document and 

should be referred to a qualified technician. 

7. Responsibilities

7.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary. 

7.2. It is the responsibility of the students/technician to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while 

performing the procedure. 

8. Equipment and Materials

8.1.  AKTA pure chromatography system

8.2.  Additional Lab Equipment:   pH meter, balance

8.3.  Lab Utensils: Beakers (250, 500ml), 500 ml graduated cylinders

8.4.  Reagents: Filtered deionized water (MilliQ or similar), 20% ethanol

8.5. Lab Supplies:  Filters (0.2 m) and bottles for vacuum filtration and degassing of all

chromatography buffers. Syringe (1ml).  Tubes for fraction collector (3 ml – 15 ml 

capacity). 

8.6. Column cleaning solution for HiTrap SP (GE) – 0.1M NaOH 

8.7. Column cleaning solution for Lysine HyperD (Pall) – 0.1M NaOH; 

8.8. Column cleaning solution for Capto-Q (GE) – 0.1M NaOH 

8.9. Column cleaning solution for Ni2+ IMAC Profinity (Bio Rad) -  

9. Procedure

9.1. Sample Collection and Preparation is described in “End-of-Run t-PA Process SOP:

Harvest, Centrifugation, Concentration, pH Adjustment” Please refer to that document 

(DP 3, 13Apr15).  The operator will require 0.6 ml of sample per sample injection (see 

below).The goal (analytical vs preparative) of the chromatography will dictate the 

amount of sample needed and/or applied to the column. Concentration of the sample and 

buffer components/pH should be chosen to be compatible with the mode of separation.  

9.2.  Reagent Recommendations:  Buffers should be prepared from the highest available 

grade reagents and water, filtered through a 0.2 µm filter and degassed thoroughly. 

Buffer preparation is beyond the scope of this document. Examples of buffers for 

specific applications with t-PA are : 

9.2.1. HiTrap SP HP Cation exchange column: 

9.2.1.1.Buffer A = 0.2M sodium acetate, pH 5.0, 0.01% Tween 80 

9.2.1.2.Buffer B: 0.2M sodium acetate, pH 5.0, 0.01% Tween 80, 1M NaCl 

9.2.2 L-Lysine Ceramic HyperD Affinity column:  

Buffer A: 20mM sodium phosphate, pH 7.5, 0.01% Tween 80 
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Buffer B: 20mM sodium phosphate, pH 7.5, 0.01% Tween 80, 1M NaCl 

Elution Buffer: 20mM sodium phosphate, pH 7.5, 0.01% Tween 80, 0.2M 

arginine hydrochloride 

 9.2.3 Ni2+-IMAC column: 

Buffer A: 20mM sodium phosphate, pH 7.0, 0.5M NaCl 0.01% Tween 80 

Buffer B: 20mM sodium phosphate, pH 7.0, 0.5M NaCl, 0.01% Tween 80, 0.5M 

imidazole 

9.3. Method writing in Unicorn 6.3. 

For the Unicorn 6.3 software to be able to control the AKTA pure instrument, it is 

necessary to assemble programmed steps into a method. The steps vary for a given 

column and protein of interest, but typically include Sample Loading, Column Washing, 

Elution, and Equilibration. Often more steps are required. In most situations, the method 

will be written and stored in the Method Navigator within Method Editor; refer to the 

Batch Process Record or Process SOP for the protein of interest to find the name of the 

specific method. In the event a new or modified method is required, here are the 

(minimum) steps needed. 

9.3.1. In the Unicorn software, navigate to the Method Editor window.  

9.3.2. Under the File menu, choose New Method. 

9.3.3. In the pop-up window, choose a pre-defined method for the type of 

chromatography you will be doing, then click OK. 

9.3.4. Each step in the program is referred to as a ‘Phase’ in the software. The phases for 

the predefined method will appear in the center pane of the Method Editor window.  

9.3.5. Click the Method Settings phase to display its properties in the right hand pane. If 

you are using a GE Life Sciences prepacked column, find and select it in the 

Column Type dropdown menu. Its properties and suggested flow rate will 

automatically be chosen. If your column is not listed, enter the Column Volume, 

Pressure Limit and Flow Rate (specified by the manufacturer) in their respective 

boxes. Choose Inlets, usually A1 and B1; these can be specified for each step 

(phase) as you progress through method writing. 

9.3.6. While still in the Method Settings pane, click the Start Protocol button. A pop-up 

window appears that allows the operator to choose items that will be presented for 

operator’s information/approval when a run of the method is initiated. Check the 

boxes for Method Information (which will show the expected volume and time 

required, allowing one to check that the pumps will not run dry due to inadequate 

supply of buffer), and for Questions. Click the button labeled Define Questions. 

This allows the operator to specify useful information that must be entered before 

the run can start, which may include sample characteristics, buffer 

composition/preparation date, operator, etc. Follow the prompts to enter questions, 

check the Mandatory and Display in Chromatogram boxes, then Preview to confirm 

the appearance.  

9.3.7. Click the button for Equilibration phase in the center pane to display its properties 

in the right pane. Confirm that ‘Reset UV monitor’ is checked. Check ‘Fill the 

system with the selected buffer’ to quickly flush inappropriate buffers between the 

pumps and the injection valve.  
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9.3.8.   Click the Sample Application phase in the center pane to display the parameters. 

9.3.8.1.Uncheck the box ‘Use the same flow rate as in Method Settings’ – typically a 

capture method such as ion exchange or affinity separations achieves higher 

binding efficiency at lower flow rates.  

9.3.8.2.Select the Loop type, and enter the sample volume to be injected. In the 

‘Empty loop with’ box, enter a volume sufficient to flush all sample from the 

loop.  

9.3.8.3. Confirm that the correct inlet lines are specified; most methods use A1 and 

B1. 

9.3.8.4. If you suspect that your sample will exceed the capacity of the column, check 

the ‘Interrupt sample application at UV’ and enter a value (which will likely 

have to be determined empirically). A better approach is to limit the quantity 

of sample applied so that the operator is confident that the capacity of the 

column will be adequate to the task. 

9.3.8.5.In the ‘Fractionate’ section, choose the path that the eluent should follow. It is 

customary to collect the unbound protein in a container (‘using outlet valve’ 

directs the flow-thru to the tube labeled ‘Out’; place it in a clean flask) or in 

fractions (‘using fraction collector’).  

9.3.8.6. Fractionation settings: choose ‘Fixed outlet’ using outlet valve. Choose ‘fixed 

volume fractionation’ to collect the flow-thru in constant volume fractions 

with the fraction collector. 

9.3.9. Click the Column Wash phase button in the center pane. 

9.3.9.1. Check the box to ‘Use the same flow rate as in Method Settings’. 

9.3.9.2.Confirm the inlets for A and B, and that the ‘Fill the system….’ box is 

unchecked. 

9.3.9.3. Select a value for ‘Wash until’, which should be at least 10 column volumes 

(for the small columns used in this course). Select the radio button for ‘the 

following condition is met’, choose Stable UV, set the Accepted UV 

fluctuation to 0.1mAU (experience may dictate a change, so revisit this setting 

on occasion), and set the Maximum wash volume to 20 CV. 

9.3.9.4.Fractionate: column wash is diverted ‘in waste (do not collect)’. 

9.3.10. Click the Elution button in the center pane and make these settings: 

9.3.10.1. Check the box for ‘Use the same flow rate as in Method Settings’ 

9.3.10.2. Confirm Inlet A and B specify the tubing that is placed in buffers A and B. 

9.3.10.3. Gradient elution is the default selection.  

9.3.10.3.1. Choose the ‘Start at’ concentration of buffer B, usually 0%.  If greater 

than 0%, check the ‘Fill the system….’ box. 

9.3.10.3.2. Specify the Type of gradient (step or linear), target % B and total 

volume (recommend 10 CV initially) for the gradient in this segment. 

9.3.10.3.3. Add more segments as needed. Commonly a final elution of 2-3 CV at 

high strength eluting conditions (e.g. 1M NaCl for an ion exchange 

separation) is included. 
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9.3.10.3.4. Fractionate settings should be for ‘using fraction collector’ and ‘fixed 

volume fractionation’. Set the Fixed fractionation volume to a volume 

that represents about 1/20 of the total gradient volume. 

9.3.11. Click the (second) Equilibration button to set parameters for re-equilibration of 

the column for subsequent runs.  

9.3.11.1. Confirm that the ‘Reset UV Monitor’ box is unchecked. 

9.3.11.2. Check the ‘Use the same flow rate…..’ box.  

9.3.11.3. Confirm that Inlet A and B are correct and correspond to the buffers A and 

B. 

9.3.11.4. Set the ‘Equilibrate until’ volume to 5 CV. 

9.3.12.  Under the File menu, choose Save and name the method uniquely; select the 

correct folder and Save. 

9.4. Manual Control of the instrument. 

The AKTA pure instrument may be controlled ‘manually’ via the System Control 

window lower pane graphic interface (or ‘Process Picture’), as pictured here. 

9.4.1. A control panel that allows selection of inlet pumps/lines A1, A2 B1 and B2 will 

appear when one clicks on the small bisected circle on the left side. 

9.4.2. By clicking on either Pump A or Pump B in the depiction, you can access a dialog 

box which allows for quick setting of flow rate and buffer composition, as well as 

convenient pump wash features as shown: 
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9.4.3. The large circle (approximately the center of components) in the diagram 

represents the sample injection valve. Upon clicking it, one will see a panel of 6 

options for the position of the valve (five are visible in the diagram below).  

Hovering over each option causes a new diagram to appear that shows the flow path 

through the valve for that particular selection; shown here is the Inject position, with 

flow coming from the system pumps (SyP), going through LoopE valve inlet, 

carrying contents of the sample loop out through LoopF valve outlet and onto the 

column (Col).  
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9.4.4. Clicking the UV detector icon reveals a command to ‘Auto Zero UV’.  

9.4.5. The small circle to the right is the Outlet valve. By clicking on it with the 

electronic mouse pointing device, the operator may select whether the eluent goes to 

Waste, the Outlet tubing, or the Fraction Collector.  

9.4.6. Various parameters of the current run condition are displayed directly above the 

manual control interface. Pay particular attention to pre-column pressure (PreC x.xx 

MPa) to avoid over pressuring/damaging the column. Most of our columns have a 

limit of 0.5 MPa.  

9.5. Start-up and preparation of AKTA pure Instrument and computer: 

Degassed buffers should be in place prior to turning on the AKTA pure instrument.  

Equipment start-up requires turning on the instrument and, separately, the computer 

connected to it.   

9.5.1. Place the degassed buffers A and B on top of the AKTA pure instrument.  

9.5.2. Locate Inlet tubing A1 and B1 (atop the instrument and resting in water or 20% 

ethanol). Each has a filter unit attached, which distinguishes them from A2 and B2; 

those end in a male threaded fitting and will not be used for a two-buffer procedure. 

9.5.3. Transfer tubing Inlet A1 to the buffer A bottle. 

9.5.4. Transfer tubing Inlet B1 to the buffer B bottle.  

9.5.5. The On/Off switch for the instrument is located on the right side toward the rear 

of the housing. Switch to the ‘On’ position. Audible emanations from within the 

instrument cabinet indicate that the AKTA pure system is going through its brief 

initialization sequence. 

9.5.6. The computer On/Off switch is located on the front of the Dell desktop computer 

unit, near the top of the case.  Press in to turn on the computer. 

9.5.7. Login to the computer using credentials provided by the College. 

9.5.8. Double click the Unicorn 6.3 icon on the desktop to open the software which 

controls the instrument functions.  Click OK in the “Log In – Unicorn” dialog box 

that appears. 

9.5.9. Open the System Control window (under Tools menu, if not opened automatically 

on startup). 

9.5.10. The top pane of the window will show the current state of the instrument, and the 

bottom pane shows the fluid path and manual controls. If the window is blank, go to 

the System menu and select Connect to Systems, check the box by AKTA pure 25 

and click OK.  

9.5.11.  Confirm that the correct column (HiTrap SP 5 ml) is attached to the system. If 

not, refer to Section 9.4 (Installing/Changing a Chromatography Column on the 

AKTA pure Chromatography System). 

9.5.12. Under the File menu, choose Open and select the method with file name “HiTrap 
SP 5ml Equilibration”. 

9.5.13.  A dialog box appears that allows the method to be run. Click Start to initiate 

flushing of the pumps and equilibration of the column.  

9.5.14. While the equilibration method is running, prepare the fraction collector for later 

steps by filling the carousel with clean tubes. 
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9.5.15. Allow the program to run to completion, about 15 minutes. 

9.6. Installing/Changing a Chromatography Column on the AKTA pure Chromatography 

System. 
It is imperative that the following operations be performed in such a way as to prevent 

the introduction of air bubbles into the column and fluid path, which is achieved by 

making liquid-to-liquid (drop-to-drop) contact prior to inserting the threaded fitting into 

its position. 

9.6.1. Have on hand a few paper lab towels and a 250 ml beaker to catch waste. 

9.6.2. Remove tube connector from the UV detector inlet by unscrewing the knurled 

fastener. 

9.6.3. Initiate flow manually at 0.5 ml/min collecting waste in the beaker or towel. 

9.6.4. Remove the plug from the column inlet and place a few drops of 20% ethanol in 

the inlet, filling it to insure the absence of air. Also add drops of 20% ethanol to the 

UV detector inlet. 

9.6.5. As a droplet emerges from the inlet tubing, touch it to the liquid in the column 

inlet and begin to thread the fitting in, leaving slight looseness of threads so that 

liquid escapes around the fitting and pressure buildup in the column is prevented. 

9.6.6. Remove the column bottom plug and screw the column directly into the UV 

detector inlet. 

9.6.7. Tighten the column inlet fitting just enough to prevent leaking. 

9.6.8. The column is now ready to equilibrate in buffer (step 9.3.12) prior to performing 

a chromatography run. 

9.7. How to fill a sample loop. 
9.7.1. Fill an appropriately sized syringe with sample, taking care to remove bubbles. 

9.7.2. Connect the syringe to the injection port (see Fig. 4). 

9.7.3. Open the System Control module in the Unicorn software. 

9.7.4. In the Process Picture click the Injection Valve and select Manual load to confirm 

that the valve is in, or switch the valve to, manual load position. 

9.7.5. Depress the syringe plunger to inject sample into the sample loop, and leave the 

syringe attached to the port (prevents sample loss due to siphoning). Regarding 

amount to inject, if sample preservation is a consideration, inject only enough to fill 

the loop. If sample is abundant and/or relatively easy to generate, inject about twice 

the loop volume to insure complete filling.  

9.8. Performing a chromatography run: 

9.8.1. Place the fraction collector tube 1 near the outlet tubing from the instrument (refer 

to attachment Fig 1) so that it will touch the arrow on the white paddle of the 

fraction collector arm. Note: To rotate the carousel, reach around the left side of the 

collector to find a rubber roller pressing against the carousel (Fig 2). Pull the roller 

away from the carousel (Fig. 3); the carousel will rotate freely as long as the roller is 

held. When the first tube is in the correct position, release the roller. 

9.8.2. Gently raise the arm and swing it into position against tube 1.  

9.8.3. Place all ‘Waste’ tubing, labeled W, W1 & W2 in 1 L Erlenmeyer flask. 

9.8.4. Place the tube labeled Out in a 125 ml Erlenmeyer flask. 
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9.8.5. Using a 1 ml syringe, aspirate 0.6 ml of the tPA sample into the syringe, expel 

any bubbles and insert the loaded syringe into the injection port. 

9.8.6. Inject the sample into the port to fill the 0.5 ml sample loop.  

9.8.7. Open the Unicorn software and navigate to the System Control window.  

9.8.8. Under the File menu, choose Open and select the method with file name “HiTrap 

SP tPA Cation Exchange”. 

9.8.9. In the dialog box that opens, enter operator’s name, sample notes. 

9.8.10. Click Next; note the time and volume for the run; make sure there is excess buffer 

A and B. 

9.8.11.  Click Next. Record the buffer composition of each buffer and the sample 

identity. 

9.8.12. Click Next. Enter a filename composed of the method name, date, operator or 

group initials, for example “HiTrapSP tPA 16May15 CertGroup”. 

9.8.13. Click Start. The instrument should begin to execute the method, as evidenced by a 

soothing hum from the pumps and drops of liquid falling into tube 1 from the 

fraction collector outlet. 

9.8.14. Observe that the fraction collector is receiving drops.  

9.8.15. Monitor the computer screen for error messages or warnings.  

9.8.16. Allow the method to run to completion, at which time the system will be re-

equilibrated and ready for subsequent runs by repeating section 9.4. 

9.9. Equipment shut-down and short term (less than 3 days) storage 
9.9.1. After completion of the final separation of the day, transfer Inlet tubing A1 and 

B1 to a flask of degassed MilliQ water (250ml or greater).  

9.9.2. In the Unicorn software, open the System Control window. 

9.9.3. Under the File menu, choose Open, then select the method ‘System Short Term 

Storage’. 

9.9.4. Click Start. 

9.9.5. Allow the method to run to completion, as indicated by an audible tone and 

onscreen window. 

9.9.6. Turn off the instrument or perform the long term storage routine as needed 

(section 9.6). 

9.10.   Equipment shut-down and long term (3 days or more) storage 
9.10.1. After completion of the System Short Term Storage method, transfer Inlet tubing 

A1 and B1 to a flask of degassed 20% ethanol (250ml or greater).  

9.10.2. In the Unicorn software, open the System Control window. 

9.10.3. Under the File menu, choose Open, then select the method ‘System Long Term 

Storage’. 

9.10.4. Click Start. 

9.10.5. Allow the method to run to completion, as indicated by an audible tone and 

onscreen window. 

9.10.6. Turn off the instrument. 
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9.11. Cleaning the system 

9.11.1. Column Removal – have paper towels on hand to catch drips. You will also need 

an appropriate plug for each end of the column. 

9.11.1.1. Use the Manual Control in the System Control window to set the flow rate 

of buffer or water to 0.5 ml/min. 

9.11.1.2. Disconnect the column outlet from the UV detector and fit the connector 

with a plug, slowly so that emerging droplets displace all air from the plug. 

Leave the plug slightly loose so as to prevent backpressure buildup. 

9.11.1.3. Slowly disconnect the tubing from the column inlet, allowing liquid to fill 

the cavity where the connector attaches.  Attach the tubing directly to the UV 

detector inlet and stop the flow of buffer/water. 

9.11.1.4. Completely tighten the column outlet plug, but be careful not to 

overtighten and strip the threads. 

9.11.1.5. Carefully insert a plug into the column inlet threads, displacing liquid but 

not allowing air to enter. 

9.11.1.6. The column may now be stored.  

9.11.2. Minimal Cleaning – After every run, perform short-term storage (9.10). 

9.11.3. Thorough Cleaning – Should be performed weekly.  

9.11.3.1. Remove the column (9.12.1) from the system prior to thorough cleaning of 

the system with 0.5M NaOH. 

9.11.3.2. Immerse all pump inlet tubes in a container of 0.5M NaOH. 

9.11.3.3. Run the method ‘System Clean’.  

9.11.3.4. Remove the pump inlet tubing from the NaOH container, rinse each 

carefully with a squirt bottle of MilliQ water and place in a flask of filtered and 

degassed MilliQ water. 

9.11.3.5. Run the method ‘System Short Term Storage’. 

9.12. Chromatogram printout 
9.12.1. In the Unicorn software interface, open the Evaluation window. 

9.12.2. In the Result Navigator pane, click the Results tab. 

9.12.3. Locate the file of interest and double click its name to display your chromatogram 

in the right pane. 

9.12.4. Optional:  Click the Customize button to open a dialog box that allows you to 

specify what curves display and the scale of each axis. Recommended are the UV 

Chrom curve, Conductivity, and Fraction Number. 

9.12.5. Click the Report button, check the Default report in the selection window and 

click Preview. 

9.12.6. Under File, choose to Print (or Save as PDF to use a different printer).  
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10. Attachments/Figures

Fig. 1.  Diagram of AKTA pure instrument, fraction collector and computer 

 

Fig. 2. AKTA pure Instrument Features 
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Fig 3.  System Control window within the Unicorn 6.3 software. 

Fig. 4. Detail of Injection Port with Syringe in Place. 
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Fig. 5.  Fraction collector carousel rubber advancement roller/gear. 

Fig. 6.  Release of roller to allow free rotation of the carousel. 

Roller/gear 
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Fig. 7.  Location of tube #1 under the fraction collector drip outlet. 

11. History

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 17JUL15 Dr. David Frank Initial release 
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1. Purpose

1.1. This procedure describes the operation of the ÄKTA pure Chromatography System,

controlled by Unicorn 6.3 software, for the purpose of cation exchange chromatography 

of samples containing tissue type plasminogen activator (tPA). 

2. Scope and Applicability

2.1. Applies to purification of t-PA from prepared conditioned medium, which has been

concentrated and its pH adjusted to 4.5, using a HiTrap SP HP 5 ml column installed on 

the GE ÄKTA pure Chromatography System and controlled by Unicorn 6.3 software. 

3. Summary of Method

3.1.  Preparation of buffer(s)

3.2.  Equilibration of system and column

3.3.  Fraction collector setup

3.4.  Application of sample

3.5.  Washing and elution of column

3.6.  Regeneration of system in preparation for subsequent run

3.7.  Procedures for short or long term storage of the system

4. References

4.1.  Unicorn 6.3 Users Guide (electronic)

4.2.  AKTA pure 25 Users Guide (electronic)

4.3.  HiTrap SP HP 5 information booklet

4.4.  End-of-Run t-PA Process SOP: Harvest, Centrifugation, Concentration, pH Adjustment

(Document Number DP 3); 13Apr15 

5. Definitions

5.1. N/A

6. Precautions

6.1. Routine care should be exercised in handling of buffers and samples of biological

materials, which may have harmful biological activity in the case of accidental ingestion, 

needle stick, etc. 

6.2. User should read and be familiar with general good practice as outlined in the AKTA 

pure Cue Cards located near the instrument. 

6.3. Avoid damaging the threads through the use of excessive force when connecting plastic 

fasteners. 

6.4. Care must be taken to avoid air in the fluid path, which could damage the pumps or give 

spurious and uninterpretable readout from the UV and/or conductivity detectors.  
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6.5. Gloves and protective eyewear should be worn when handling samples and reagents 

(buffers), however it is preferable that the user remove gloves prior to entering 

commands via the computer keyboard or mouse.  

6.6. Buffers must be degassed and filtered prior to use with the AKTA pure instrument. 

Samples should be centrifuged at 10000xg for 5 min before injection/introduction into 

the fluid path. 

6.7. Equipment calibration check: The AKTA pure system calibration is automatic; baseline 

for measurements of A280 and conductivity are zeroed at the beginning of a 

chromatography run. Further adjustment is beyond the scope of this document and 

should be referred to a qualified technician. 

7. Responsibilities

7.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary. 

7.2. It is the responsibility of the students/technician to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while 

performing the procedure. 

8. Equipment and Materials

8.1.  AKTA pure chromatography system

8.2.  Additional Lab Equipment:   pH meter, balance

8.3.  Lab Utensils: Beakers (250, 500ml), 500 ml graduated cylinders

8.4.  Reagents: Glacial acetic acid, sodium chloride, filtered deionized water (MilliQ or

similar). 10 % w/v Tween 80, 20% ethanol, NaOH 

8.5. Lab Supplies:  Filters (0.2 m) and bottles for vacuum filtration and degassing of all 

chromatography buffers. Syringe (1ml).  Tubes for fraction collector. 

9. Procedure

9.1. Sample Collection and Preparation is described in “End-of-Run t-PA Process SOP:

Harvest, Centrifugation, Concentration, pH Adjustment” Please refer to that document 

(DP 3, 13Apr15).  The operator will require 0.6 ml of sample per sample injection (see 

below). 

9.2.  Reagent Preparation:  Buffers should be prepared dependent on the mode of separation 

employed; in this instance cation exchange chromatography provides good separation of 

tPA from contaminating protein at pH 5.0. 

9.2.1. Cation Exchange Buffer: 0.2M Sodium Acetate, pH 5.0, 0.1% Tween 80 

9.2.1.1. Dissolve 11.5 ml glacial Acetic Acid in 950 ml filtered deionized water in a 

one liter beaker, with stir bar. 

9.2.1.2.. Prepare 10M NaOH by dissolving 40.0 gm solid in filtered deionized water. 

Adjust the final volume to 100 ml. Use CAUTION as the solution becomes 

very hot, and is caustic. 

9.2.1.3.  Titrate the pH of the HOAc solution to 5.0 by addition of 10M NaOH. Use a 

3 ml transfer pipet to add about 15 ml to the HOAc, then proceed dropwise 

until pH 5.0 is obtained.   
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9.2.1.4.  Add 10 ml of 10% Tween 80, then adjust the final volume to 1000 ml. Set 

aside 500 ml of this solution and label ‘Buffer A’ along with its precise 

composition and date of preparation. Filter and degas the buffer by passage 

through a vacuum filter device attached to house vacuum, leaving the filtered 

solution under vacuum for 15-20 minutes.  

9.2.1.5.  Use the remaining 500 ml to dissolve 29.22 gm of NaCl in a 400 ml beaker. 

Following dissolution, filter and degas this mixture and label the bottle ‘Buffer 

B’, along with the actual contents (0.2 M NaOAc, pH 4.5, 0.1% Tween80, 1 M 

NaCl).  

9.3. Start-up and preparation of AKTA pure Instrument and computer: 

Degassed buffers should be in place prior to turning on the AKTA pure instrument.  

Equipment start-up requires turning on the instrument and, separately, the computer 

connected to it.   

9.3.1. Place the degassed buffers A and B on top of the AKTA pure instrument.  

9.3.2. Locate Inlet tubing A1 and B1 (atop the instrument and resting in water or 20% 

ethanol). Each has a filter unit attached, which distinguishes them from A2 and B2; 

those end in a male threaded fitting and will not be used for this procedure. 

9.3.3. Transfer tubing Inlet A1 to the buffer A bottle. 

9.3.4. Transfer tubing Inlet B1 to the buffer B bottle.  

9.3.5. The On/Off switch for the instrument is located on the right side toward the rear 

of the housing. Switch to the ‘On’ position. Audible emanations from within the 

instrument cabinet indicate that the AKTA pure system is going through its brief 

initialization sequence. 

9.3.6. The computer On/Off switch is located on the front of the Dell desktop computer 

unit, near the top of the case.  Press in to turn on the computer. 

9.3.7. Login to the computer using credentials provided by the College. 

9.3.8. Double click the Unicorn 6.3 icon on the desktop to open the software which 

controls the instrument functions.  Click OK in the “Log In – Unicorn” dialog box 

that appears. 

9.3.9. Open the System Control window (under Tools menu, if not opened automatically 

on startup). 

9.3.10. The top pane of the window will show the current state of the instrument, and the 

bottom pane shows the fluid path and manual controls. If the window is blank, go to 

the System menu and select Connect to Systems, check the box by AKTA pure 25 

and click OK.  

9.3.11.  Confirm that the correct column (HiTrap SP 5 ml) is attached to the system. If 

not, refer to Section 9.4 (Installing/Changing a Chromatography Column on the 

AKTA pure Chromatography System). 

9.3.12. Under the File menu, choose Open and select the method with file name “HiTrap 
SP 5ml Equilibration”. 

9.3.13.  A dialog box appears that allows the method to be run. Click Start to initiate 

flushing of the pumps and equilibration of the column. 
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9.3.14. While the equilibration method is running, prepare the fraction collector for later 

steps by filling the carousel with clean tubes. 

9.3.15. Allow the program to run to completion, about 15 minutes.  

9.4. Installing/Changing a Chromatography Column on the AKTA pure Chromatography 

System. 
It is imperative that the following operations be performed in such a way as to prevent 

the introduction of air bubbles into the column, which is achieved by making liquid-to-

liquid (drop-to-drop) contact prior to inserting the threaded fitting into its position. 

9.4.1. Have on hand a few paper lab towels and a 250 ml beaker to catch waste. 

9.4.2. Remove tube connector from the UV detector inlet by unscrewing the knurled 

fastener. 

9.4.3. Initiate flow manually at 0.5 ml/min collecting waste in the beaker or towel. 

9.4.4. Remove the plug from the column inlet and place a few drops of 20% ethanol in 

the inlet, filling it to insure the absence of air. 

9.4.5. As a droplet emerges from the inlet tubing, touch it to the liquid in the column 

inlet and begin to thread the fitting in, leaving slight looseness of threads so that 

liquid escapes around the fitting and pressure buildup in the column is prevented. 

9.4.6. Remove the column bottom plug and screw the column directly into the UV 

detector inlet. 

9.4.7. Tighten the column inlet fitting just enough to prevent leaking. 

9.4.8. The column is now ready to equilibrate in buffer (step 9.3.12) prior to performing 

a chromatography run. 

Performing a chromatography run: 

9.4.9. Place the fraction collector tube 1 near the outlet tubing from the instrument (refer 

to attachment Fig 1) so that it will touch the arrow on the white paddle of the 

fraction collector arm. Note: To rotate the carousel, reach around the left side of the 

collector to find a rubber roller pressing against the carousel (Fig 2). Pull the roller 

away from the carousel (Fig. 3); the carousel will rotate freely as long as the roller is 

held. When the first tube is in the correct position, release the roller. 

9.4.10. Gently raise the arm and swing it into position against tube 1.  

9.4.11. Place all ‘Waste’ tubing, labeled W, W1 & W2 in 1 L Erlenmeyer flask. 

9.4.12. Place the tube labeled Outlet in a 125 ml Erlenmeyer flask. 

9.4.13. Using a 1 ml syringe, aspirate 0.6 ml of the tPA sample into the syringe, expel 

any bubbles and insert the loaded syringe into the injection port.  

9.4.14. Inject the sample into the port to fill the 0.5 ml sample loop.  

9.4.15. Open the Unicorn software and navigate to the System Control window.  

9.4.16. Under the File menu, choose Open and select the method with file name “HiTrap 

SP tPA Production”. 

9.4.17. In the dialog box that opens, enter operator’s name, sample notes. 

9.4.18. Click Next; note the time and and volume for the run; make sure there is excess 

buffer A and B.  

9.4.19.  Click Next. Record the buffer composition of each buffer and the sample 

identity. 
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9.4.20. Click Next. Enter a filename composed of the method name, date, operator or 

group initials, for example HiTrapSP tPA CEX 16May15 CertGroup. 

9.4.21. Click Start. The instrument should begin to execute the method, as evidenced by a 

soothing hum from the pumps and drops of liquid falling into tube 1 from the 

fraction collector outlet. 

9.4.22. Observe that the fraction collector is receiving drops.  

9.4.23. Monitor the computer screen for error messages or warnings.  

9.4.24. Allow the method to run to completion, at which time the system will be re-

equilibrated and ready for subsequent runs by repeating section 9.4. 

9.5. Equipment shut-down and short term (less than 3 days) storage 
9.5.1. After completion of the final separation of the day, transfer Inlet tubing A1 and 

B1 to a flask of degassed MilliQ water (250ml or greater). 

9.5.2. In the Unicorn software, open the System Control window. 

9.5.3. Under the File menu, choose Open, then select the method ‘System Short Term 

Storage’. 

9.5.4. Click Start. 

9.5.5. Allow the method to run to completion, as indicated by an audible tone and 

onscreen window. 

9.5.6. Turn off the instrument or perform the long term storage routine as needed 

(section 9.6). 

9.6.   Equipment shut-down and long term (3 days or more) storage 
9.6.1. After completion of the System Short Term Storage method, transfer Inlet tubing 

A1 and B1 to a flask of degassed 20% ethanol (250  ml or greater).  

9.6.2. In the Unicorn software, open the System Control window. 

9.6.3. Under the File menu, choose Open, then select the method ‘System Long Term 

Storage’. 

9.6.4. Click Start. 

9.6.5. Allow the method to run to completion, as indicated by an audible tone and 

onscreen window. 

9.6.6. Turn off the instrument. 

9.7. Chromatogram printout 
9.7.1. In the Unicorn software interface, open the Evaluation window. 

9.7.2. In the Result Navigator pane, click the Results tab. 

9.7.3. Locate the file of interest and double click its name to display your chromatogram 

in the right pane. 

9.7.4. Optional:  Click the Customize button to open a dialog box that allows you to 

specify what curves display and the scale of each axis. Recommended are the UV 

Chrom curve, Conductivity, and Fraction Number. 

9.7.5. Click the Report button, check the Default report in the selection window and 

click Preview. 

9.7.6. Under File, choose to Print (or Save as PDF to use a different printer).  
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Attachments/Figures 

Fig. 1.  Diagram of AKTA pure instrument, fraction collector and computer 
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Fig. 2. AKTA pure Instrument Features 
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Fig 3.  System Control window within the Unicorn 6.3 software. 

Fig. 4. Detail of Injection Port with Syringe in Place. 
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0.5 ml Sample 
Loop 
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Fig. 5.  Fraction collector carousel rubber advancement roller/gear. 

Fig. 6.  Release of roller to allow free rotation of the carousel. 

Roller/gear 
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Fig. 7.  Location of tube #1 under the fraction collector drip outlet. 

10. History

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 16JUL15 Dr. David Frank Initial release 
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Approvals 

Preparer: Jason McMillan Date: 09APR14 

Reviewer: Dr. Margaret Bryans Date: 10APR14 

1. Purpose

1.1. Quantitative determination of total tPA

2. Scope and Applicability

2.1.  Human tPA Total Antigen ELISA may be used for quantitative determination of total

tPA in cell culture and tissue lysate samples as well as human plasma and other 

biological fluids.  

3. Summary of Method

3.1.  Preparation of standard

3.2. Standard and unknown addition

3.3. Primary antibody addition

3.4. Secondary antibody addition

3.5. Substrate incubation

3.6. Measurement

3.7. Calculation of results

4. References

4.1. Molecular Innovations Human tPA Total Antigen ELISA Kit (Cat # HTPAKT-TOT)

Manual  

4.2. Bio Rad iMark Microplate Absorbance Reader SOP 

5. Precautions

5.1. None

6. Responsibilities

6.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary.  

6.2. It is the responsibility of the students/technician to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while 

performing the procedure.  

7. Equipment and Materials

7.1. Molecular Innovations Human tPA Total Antigen ELISA Kit (Cat # HTPAKT-TOT)

7.2. 20µl, 200µl, and 1000µl pipettes and tips

7.3. Shaking platform capable of reaching 300rpm

7.4. Bio Rad iMark Microplate Absorbance Reader

7.5. Microtubes and rack

7.6. Blocking Buffer (3% BSA (w/v) in TBS buffer (0.1M Tris, 0.15M NaCl, pH 7.4))

7.7. 1M HCl

7.8. 1X washing Buffer

7.9. tPA Samples from Spinner Flask and Bioreactor

8. Procedure

8.1. Preparation of Standard (Dilutions for the standard curve and zero standard must be

made and applied to the plate immediately) 
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8.1.1. Combine 50µl of 1,000ng/ml standard with 150µl blocking buffer to create a 

250ng/ml intermediate. Follow dilution table located in Attachments Section for 

standard preparation. 

8.2. Remove microtiter plate from the bag and add 100µl of tPA standards and unknowns to 

their individual wells. Be sure to carefully record their position on the microtiter plate. 

8.2.1. Shake plate at 300rpm for 30 minutes. 

8.2.2. Wash wells three times with 300µl of wash buffer. Remove excess wash buffer by 

gently tapping microtiter plate on a paper towel or kimwipe. 

8.3. Primary Antibody Addition 

8.3.1. Add 100µl of primary antibody to all wells.  

8.3.2. Shake plate at 300rpm for 30 minutes. 

8.3.3. Wash wells three times with 300µl of wash buffer. Remove excess wash buffer by 

gently tapping microtiter plate on a paper towel or kimwipe. 

8.4. Secondary Antibody Addition 

8.4.1. Add 100µl of primary antibody to all wells.  

8.4.2. Shake plate at 300rpm for 30 minutes. 

8.4.3. Wash wells three times with 300µl of wash buffer. Remove excess wash buffer by 

gently tapping microtiter plate on a paper towel or kimwipe. 

8.5. Substrate Incubation 

8.5.1. Add 100µl of TMB substrate to all wells and shake at 300rpm for approximately 

4 minutes. Substrate will change from colorless to different shades of blue.  

8.5.2. Quench reaction by adding 50µl of 1M HCl in the same order as the substrate was 

added to stop the reaction when the sample shades of blue match the gradient of 

blue in the standards. The color will change from blue to yellow. Mix thoroughly by 

gently shaking the microtiter plate by hand for approximately one minute.  

8.6. Measurement 

8.6.1. Measure the absorbance in all wells at 450nm using the Bio Rad iMark 

Microplate Absorbance Reader. 

8.7. Calculation of Results 

8.7.1. Subtract the value of the zero point standard from all of the standards and 

unknowns to determine the corrected absorbance (A450). 

8.7.2. Plot A450 against the amount of tPA in the standards to create a Full Range Total 

Human tPA in BSA standard curve.   

8.7.3. Fit a straight line through the linear points of the Full Range Total Human tPA in 

BSA standard curve to create a Linear Range Total Human tPA in BSA standard 

curve.  

8.7.4. The amount of tPA in the unknowns can be determined from the standard curve. 

8.7.5. Create a graph showing concentration of tPA over time in days. 

9. Attachments
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tPA Concentration (ng/ml) Dilutions 

25 450µl (blocking buffer) + 50µl (250ng/ml) 

10 300µl (blocking buffer) + 200µl (25ng/ml) 

5 250µl (blocking buffer) + 250µl (10ng/ml) 

2 300µl (blocking buffer) + 200µl (5ng/ml) 

1 250µl (blocking buffer) + 250µl (2ng/ml) 

0.5 250µl (blocking buffer) + 250µl (1ng/ml) 

0.2 300µl (blocking buffer) + 200µl (0.5ng/ml) 

0 250µl (blocking buffer) Zero point to 

determine background 

Figure 1. Dilution table for preparation of human tPA standard 

Figure 2. Total Human tPA in BSA Full Range (Example Only) 
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Figure 3. Total Human tPA in BSA Linear Range (Example Only) 

Figure 4. tPA Concentration Over Time (Example Only) 
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Figure 5. ELISA Plate Layout 

10. History

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 09APR14 Jason McMillan Initial release 
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Approvals 

Preparer: Jason McMillan Date: 10APR14 

Reviewer: Dr. Margaret Bryans Date: 11APR14 

1. Purpose

1.1. Quantitative determination of active tPA

2. Scope and Applicability

2.1.  Human tPA Total Antigen ELISA may be used for quantitative determination of total

tPA in cell culture and tissue lysate samples as well as human plasma and other 

biological fluids.  

3. Summary of Method

3.1.  Biotinylated Human PAI-1 Addition

3.2. Preparation of Standard

3.3. Standard and unknown addition

3.4. Primary antibody addition

3.5. Secondary antibody addition

3.6. Substrate incubation

3.7. Measurement

3.8. Calculation of results

4. References

4.1. Molecular Innovations Human tPA Activity ELISA Kit (Cat # HTPAKT)  Manual

4.2. Bio Rad iMark Microplate Absorbance Reader SOP

5. Precautions

5.1. None

6. Responsibilities

6.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary.  

6.2. It is the responsibility of the students/technician to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while 

performing the procedure.  

7. Equipment and Materials

7.1. Molecular Innovations Human tPA Activity ELISA Kit (Cat # HTPAKT)

7.2. 20µl, 200µl, and 1000µl pipettes and tips

7.3. Shaking platform capable of reaching 300rpm

7.4. Bio Rad iMark Microplate Absorbance Reader

7.5. Microtubes and rack

7.6. Blocking Buffer (3% BSA (w/v) in TBS buffer (0.1M Tris, 0.15M NaCl, pH 7.4))

7.7. 1M HCl

7.8. 1X washing Buffer

7.9. tPA Samples from Spinner Flask and Bioreactor
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8. Procedure

8.1. Biotinylated Human PAI-1 Addition

8.1.1. Remove microtiter plate from the bag and add 100µl of Biotinylated Human PAI-

1 to all wells. 

8.1.2. Shake plate at 300rpm for 30 minutes. 

8.1.3. Wash wells three times with 300µl of wash buffer. Remove excess wash buffer by 

gently tapping microtiter plate on a paper towel or kimwipe.  

8.2. Preparation of Standard (Dilutions for the standard curve and zero standard must be 

made and applied to the plate immediately) 

8.2.1. Dilute 100µl of 61 IU/ml standard with 900µl blocking buffer to create a 6.1 

IU/ml standard. Follow dilution table located in Attachments Section for standard 

preparation. 

8.3. Add 100µl of tPA standards and unknowns to their individual wells. Be sure to carefully 

record their position on the microtiter plate. 

8.3.1. Shake plate at 300rpm for 30 minutes. 

8.3.2. Wash wells three times with 300µl of wash buffer. Remove excess wash buffer by 

gently tapping microtiter plate on a paper towel or kimwipe. 

8.4. Primary Antibody Addition 

8.4.1. Add 100µl of primary antibody to all wells.  

8.4.2. Shake plate at 300rpm for 30 minutes. 

8.4.3. Wash wells three times with 300µl of wash buffer. Remove excess wash buffer by 

gently tapping microtiter plate on a paper towel or kimwipe. 

8.5. Secondary Antibody Addition 

8.5.1. Add 100µl of primary antibody to all wells.  

8.5.2. Shake plate at 300rpm for 30 minutes. 

8.5.3. Wash wells three times with 300µl of wash buffer. Remove excess wash buffer by 

gently tapping microtiter plate on a paper towel or kimwipe. 

8.6. Substrate Incubation 

8.6.1. Add 100µl of TMB substrate to all wells and shake at 300rpm for approximately 

4 minutes. Substrate will change from colorless to different shades of blue.  

8.6.2. Quench reaction by adding 50µl of 1M HCl in the same order as the substrate was 

added to stop the reaction when the sample shades of blue match the gradient of 

blue in the standards. The color will change from blue to yellow. Mix thoroughly by 

gently shaking the microtiter plate by hand for approximately one minute.  

8.7. Measurement 

8.7.1. Measure the absorbance in all wells at 450nm using the Bio Rad iMark 

Microplate Absorbance Reader. 

8.8. Calculation of Results 

8.8.1. Subtract the value of the zero point standard from all of the standards and 

unknowns to determine the corrected absorbance (A450). 

8.8.2. Plot A450 against the amount of active tPA in the standards to create a Full Range 

Active Human tPA in BSA standard curve.  
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8.8.3. Fit a straight line through the linear points of the Full Range Active Human tPA 

in BSA standard curve to create a Linear Range Active Human tPA in BSA standard 

curve.  

8.8.4. The amount of tPA in the unknowns can be determined from the standard curve. 

8.8.5. Create a graph showing activity of tPA over time in days. 

9. Attachments

tPA Concentration 

(IU/ml) 

µl of 6.1 IU/ml tPA 

Standard 

µl of blocking 

buffer 

Total volume (µl) 

1 100 510 610 

0.5 50 560 610 

0.4 40 570 610 

0.25 25 585 610 

0.1 10 600 610 

0.05 5 605 610 

0.02 2 608 610 

0.01 1 609 610 

0 0 500 500 

Figure 1. Dilution table for preparation of human tPA standard 

Figure 2. Active Human tPA Full Range (Example Only) 
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Figure 3. Active Human tPA Linear Range (Example Only) 

Figure 4. tPA Activity Over Time (Example Only) 
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Figure 5. ELISA Plate Layout 

10. History

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 09APR14 Jason McMillan Initial release 

259



Montgomery County Community College 

340 DeKalb Pike 

Blue Bell, PA 19422  

Document Number: 53.0.0 

Revision Number: 0 

Effective Date: 26JUN14 

Page 1 of 2 

SOP: Glucose Determination Assay 

Approvals: 

Preparer: Jason McMillan  Date: 26JUN14 

Reviewer: Dr. Maggie Bryans Date: 27JUN14 

1. Purpose:

1.1. Use of the Glucose Determination Assay.

2. Scope:

2.1. Applies to the quantitative determination of Glucose in serum.

3. Responsibilities:
3.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while performing 

the procedure. 

4. References:

4.1. http://www.pointescientific.com/uploads/inserts/G7519-01-932.pdf

5. Precautions:

5.1. The reagent should not be used if it has developed turbidity or other signs of microbial

growth. 

5.2. The reagent should not be used if it fails to meet linearity claims or fails to recover 

control values in the stated range.  

6. Materials:

6.1. P-20 and P-1000 micropipette and tips

6.2. Micro centrifuge tubes

6.3. Timer

6.4. Spectrophotometer able to read at 500nm

6.5. Cuvettes

6.6. Water bath (37°)

6.7. Glucose reagent

6.8. Glucose standard

6.9. Control with known normal range

7. Procedure:

7.1. Running Assay

7.1.1. Turn on water bath and set to 37°C. 

7.1.2. Label micro centrifuge tubes “Blank,” Control,” Standard,” “Sample Name #’s.” 

7.1.3. Pipette 1.0ml of working reagent to all of the tubes and place in the 37°C water 

bath for 5 minutes. 

7.1.4. Remove micro centrifuge tubes from the water bath.  

7.1.5. Add 10µl of control solution to the “Control” tube, 10µl of Glucose standard to 

the “Standard” tube, and 10µl of sample to each of their respective “Sample” 

micro centrifuge tubes and mix by gently aspirating and dispensing the solution 

with the micropipette.   

7.1.6. Place all of the micro centrifuge tubes except for the “Blank” micro centrifuge 

tube back into the 37°C water bath for 10 minutes. 
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7.1.7. Remove the micro centrifuge tubes from the 37°C water bath and immediately 

remove 1ml from each microfuge tube and place it in a corresponding labeled 

cuvette. 

7.1.8. Read and record the absorbance of the tubes at 500nm using the “Blank” tube to 

zero the spectrophotometer. 

7.1.9. Record absorbance values for each of the tubes and calculate the concentration of 

Glucose.  

7.2. Calculate Glucose Concentration. 

7.2.1. Formula to determine glucose concentration: 

Glucose (mg/dl) = Abs of sample    x  Concentration of standard (mg/dl) 

Abs of standard 

8. History:

Name Date Amendment 

Jason McMillan 26JUN14 Initial release 
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Approvals: 

Preparer: Jason McMillan  Date: 26JUN14 

Reviewer: Dr. Maggie Bryans Date: 27JUN14 

1. Purpose:

1.1. Use of the Lactate Determination Assay.

2. Scope:

2.1. Applies to the quantitative determination of Lactate in serum.

3. Responsibilities:
3.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary. 

3.2. It is the responsibility of the students/technicians to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while performing 

the procedure. 

4. References:

4.4.1. http://www.pointescientific.com/uploads/inserts/L7596-01-984.pdf

5. Precautions:

5.1. Reagents contain sodium azide as preservative. Upon disposal flush with large volumes

of water. 

5.2. Do not use the reagents beyond the expiration date printed on the label.  

6. Materials:

6.1. P-20 and P-1000 micropipette and tips

6.2. Micro centrifuge tubes

6.3. Timer

6.4. Spectrophotometer able to read at 550nm

6.5. Cuvettes

6.6. Heating block (37°)

6.7. Lactate reagents R1 and R2

6.8. Lactate standard

6.9. Control with known normal range

7. Procedure:

7.1. Running Assay

7.1.1. Turn on heating block and set to 37°C. 

7.1.2. Label micro centrifuge tubes “Blank,” Control,” Standard,” “Sample Name #’s.” 

7.1.3. Prepare Lactate working reagent by combining R1 and R2 using a 3 to 2 ratio. Ex: 

Mix 3ml of R1 reagent with 2ml of R2 reagent. 

7.1.4. Pipette 1.0ml of working reagent to all of the tubes and place in the 37°C heating 

block for 5 minutes. 

7.1.5. Remove micro centrifuge tubes from the heating block.  

7.1.6. Add 10µl of control solution to the “Control” tube, 10µl of Lactate standard to the 

“Standard” tube, and 10µl of sample to each of their respective “Sample” micro 

centrifuge tubes and mix by gently aspirating and dispensing the solution with the 

micropipette.   

7.1.7. Place all of the micro centrifuge tubes except for the “Blank” micro centrifuge 

tube back into the 37°C heating block for 5 minutes. 
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7.1.8. Remove the micro centrifuge tubes from the 37°C heating block and immediately 

remove 1ml from each microfuge tube and place it in a corresponding labeled 

cuvette. 

7.1.9. Read and record the absorbance of the tubes at 550nm using the “Blank” tube to 

zero the spectrophotometer. 

7.1.10. Record absorbance values for each of the tubes and calculate the concentration of 

Lactate.  

7.2. Calculate Lactate Concentration. 

7.2.1. Formula to determine lactate concentration: 

Lactate (mmol/L) = Abs of sample    x  Concentration of standard (mmol/L) 

   Abs of standard 

7.2.2. If the result exceeds 20 mmol/L, the sample should be diluted 1:1 with normal 

saline, ran again, and the result multiplied by 2. 

8. History:

Name Date Amendment 

Jason McMillan 26JUN14 Initial release 
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Approvals 

Preparer: Jason McMillan Date: 09APR14 

Reviewer: Dr. Margaret Bryans Date: 09APR14 

1. Purpose

1.1. To measure absorbance values for use in determining Human tPA concentration and

activity. 

2. Scope and Applicability

2.1.  The Bio Rad iMark Microplate Absorbance Reader is an eight-channel, vertical path

length photometer that measures the absorbance of the contents in the wells of a 96-well 

microtitration plates. It can perform single or dual wavelength measurements and can 

report absorbance values to three decimal places.  

3. Summary of Method

3.1. Turn on and load 96 well plate into Bio Rad iMark Microplate Absorbance Reader.

3.2. Run protocol.

3.3. Remove 96 well plate and turn off Bio Rad iMark Microplate Absorbance Reader

4. References

4.1. iMark Microplate Absorbance Reader Instruction Manual

5. Precautions

5.1. Be sure to open and close the “Reading Chamber Door” by pressing the “Open/Close”

key on the “Keypad”. Attempting to manually open or close the “Reading Chamber 

Door” can lead to damage.  

6. Responsibilities

6.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary.  

6.2. It is the responsibility of the students/technician to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while 

performing the procedure.  

7. Equipment and Materials

7.1. iMark Microplate Absorbance Reader

7.2. 96 Well Plate

8. Procedure

8.1. Turn on the iMark Microplate Absorbance Reader by holding the “Power Button” until

the “LCD” illuminates 

8.1.1. The “LCD” will display “Self Diagnosis” followed by “Initializing” Once 

initialization is complete, a login screen will appear.  

8.1.2. The login name will read “Common User” and a prompt for a password will be 

shown. Enter “00000” and press “Enter” on the “Keypad.”  

8.1.3. “Lab Name, Kit Name, Reading Mode, and Measurement Filter” appears on 

screen (be sure the Measurement Filter is set at 450nm, the filter specific for tPA 

ELISAs), self-initialization is complete, and the Bio Rad iMark Microplate 

Absorbance Reader is ready for measurement.  

8.2. Open the “Reading Chamber Door” by pressing the “Open/Close” key on the “Keypad”. 
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8.2.1. Once “Reading Chamber Door” is open, place 96 Well Plate into the “Reading 

Chamber” being sure to line the 96 Well Plate with the plate holding guides.  

8.3. Close the “Reading Chamber Door” by pressing the “Open/Close” key on the “Keypad”. 

8.4. Start measurement reading by pressing the “Start/Stop” key on the “Keypad”. The 

measurement function will begin and all data will be printed indicating the completion of 

the measurement function. 

8.4.1. Remove data printout 

8.5. Open the “Reading Chamber Door” by pressing the “Open/Close” key on the “Keypad”. 

8.5.1. Once “Reading Chamber Door” is open, remove 96 Well Plate from the “Reading 

Chamber.”  

8.6. Close the “Reading Chamber Door” by pressing the “Open/Close” key on the “Keypad”. 

8.7. Turn off the Bio Rad iMark Microplate Absorbance Reader by holding the “Power 

Button” until the “LCD” reads “Power Off” and “Yes” is highlighted, press “Enter” key. 

Bio Rad iMark Microplate Absorbance Reader will shut down. 

9. Attachments

Figure 1. External Features of Bio Rad iMark Microplate Absorbance Reader 
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Figure 2. Keypad Guide for Bio Rad iMark Microplate Absorbance Reader 

10. History

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 09APR14 Jason McMillan Initial release 
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Approvals 

Preparer: John Buford  Date: 24SEP13 

Reviewer: Jack O’Neill Date: 24SEP13 

Reviewer: Tim Kull Date: 25SEP13 

Reviewer: Dr. Margaret Bryans Date: 26SEP13 

1. Purpose

1.1. Remove dissolved atmospheric gases from a solution by means of sparging with helium.

2. Scope and Applicability

2.1.  Applicable to preparing solvent solutions for use in High Performance Liquid

Chromatography (HPLC). Solution volume is limited to the range of 25 mL to 800 mL. 

3. Summary of Method

3.1.  Helium gas is delivered from a compressed gas tank to a porous metal sparger that is

placed in a bottle of solution. Helium is bubbled through the solution for 15 minutes. 

4. References

4.1. Airgas® Operation and Safety Instructions For Specialty Gas Regulation Equipment,

form #320-517 Rev. 5/03 

5. Definitions

Helium sparge Using a stream of helium bubbles to sweep dissolved air out of liquids (helium 

is virtually insoluble in most HPLC solvent solutions, so very little helium 

replaces the air) 

HPLC High Performance Liquid Chromatography 

PSI Pounds per Square Inch 

6. Precautions

6.1. A helium tank is compressed to pressures up to 2000 PSI. A sudden release of pressure

can cause serious damage to personnel and equipment. Handle the helium tank and gas 

regulator with care and wear eye protection.  

6.2. Helium sparging entails some risk of changing the composition of an HPLC solvent 

solution by selectively evaporating the more volatile components. Avoid an excessively 

vigorous flow of helium. 

7. Responsibilities

7.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary.  

7.2. It is the responsibility of the students/technician to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while 

performing the procedure.  
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Equipment and Materials 

7.3. Laboratory grade (99.9+%) helium in a compressed gas cylinder (helium tank) 

7.4. Airgas® gas cylinder regulator pre-connected to the helium tank 

7.5. Porous metal sparger 

7.6. Flexible gas tubing 

7.7. Laboratory bottle containing HPLC storage solution (e.g. 50% MeOH/H2O or 50% 

Acetonitrile/H2O). 

7.8. Solution to be sparged (25 to 800 mL)  

7.9. Empty laboratory bottle (50, 100, 250, 500, or 1000 mL) 

7.10.  Two-hole stopper that is sized to the empty laboratory bottle (size # 1 for 50 or 

100 mL bottle, size #6.5 for 250, 500, or 1000 mL bottle) 

7.11. Laboratory grade water in a wash bottle 

7.12. Waste beaker 

7.13. Timer 

8. Procedure

8.1. Verify that all personnel in the area are wearing eye protection.

8.2. Connect the sparger to the helium tank if it is not connected already:

(See Figure 1 for location of valves.) 

8.2.1. Turn the gas pressure off by turning the regulator valve counter-clockwise for two 

full turns (in the direction marked “DECREASE”). 

8.2.2. Close the delivery valve by turning it clockwise until it stops. 

8.2.3. Close the tank valve by turning it clockwise until it stops.  

8.2.4. Connect one end of the flexible gas tubing to the gas regulator.  

8.2.5. Connect the other end of the flexible gas tubing to the porous metal sparger.  

8.2.6. Insert the gas tubing nearest the sparger through one of the stopper holes. 

8.2.7. Place the sparger in the HPLC storage solution bottle and cap with the stopper. 

8.3. Open the helium tank with the flow of helium turned off: 

8.3.1. Verify that the gas pressure is turned off by turning the regulator valve counter-

clockwise for one half turn (in the direction marked “DECREASE”). The valve 

knob should turn freely. 

8.3.2. Close the delivery valve by turning it clockwise until it stops. 

8.3.3. Slowly open the tank valve by turning it counter-clockwise. 

8.4. Dispense the solution to a correctly sized laboratory bottle: 

8.4.1. Select an empty laboratory bottle that has 20%-50% more volume than the 

quantity of solution to be sparged. (Note: additional volume is needed as head space 

to accommodate the sparger and bubbles without spilling.) 

8.4.2. Measure the desired amount of solution and transfer it to the selected bottle. 

Verify that the bottle is at least 50% full and no more than 80% full. 

8.5. Place the sparger in the solution bottle: 

8.5.1. Remove the sparger from where it was stored in the HPLC storage solution bottle. 

8.5.2. Rinse the sparger with water from a wash bottle over a waste beaker. 

8.5.3. Place the sparger into the solution bottle and cap with the stopper.  

8.5.4. Verify that the sparger is submerged in the solution and that the unused stopper 

hole is unobstructed. 
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8.6. Turn on the flow of helium and set the deliver pressure to 3 PSI: 

8.6.1. Verify that the gas pressure is turned off by turning the regulator valve counter-

clockwise for one half turn (in the direction marked “DECREASE”). The valve 

knob should turn freely. 

8.6.2. Slowly open the delivery valve by turning it counter-clockwise. 

8.6.3. Watching the delivery pressure gauge, slowly increase the gas pressure by turning 

the regulator valve clockwise (in the direction marked “INCREASE”) until the 

delivery gauge reads 3 PSI. 

8.6.4. Observe bubbles rising from the sparger. Verify that there is sufficient head space 

in that bottle so that solution is not expelled from the bottle. 

8.7. Sparge the solution for 15 minutes. 

8.8. Turn off the flow of helium: 

8.8.1. Turn the gas pressure off by turning the regulator valve counter-clockwise for two 

full turns (in the direction marked “DECREASE”). 

8.8.2. Close the delivery valve by turning it clockwise until it stops. 

8.9. Store the sparger: 

8.9.1. Remove the sparger from the solution bottle and cap the solution bottle. 

8.9.2. Rinse the sparger with water from a wash bottle over a waste beaker. 

8.9.3. Place the sparger in the HPLC storage solution bottle and cap with the stopper. 

8.10. Close the tank valve by turning it clockwise until it stops. 
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9. Attachments

Figure 1. Helium Tank and Gas Regulator 

Figure 2. Porous Metal Sparger 

10. History

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 09/25/2013 John Buford Initial release 
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Preparer: John Buford Date: 16OCT13 

Reviewer: Tim Kull Date: 30OCT13 

Reviewer: Dr. Margaret Bryans Date: 31OCT13 

1. Purpose

1.1. Basic operation of the Buck Scientific BLC-20P isocratic HPLC system in order to assay

a sample using reverse phase high performance liquid chromatography (RP-HPLC). 

2. Scope and Applicability

2.1. High performance liquid chromatography (HPLC) is an analytical chemistry technique

for separating the components of a liquid sample and for identifying and quantifying the 

components of the sample. This SOP provides the basic operations required to perform 

an assay using the Buck Scientific BLC-20P isocratic HPLC system, a reverse phase 

HPLC column, and a compatible mobile phase solution. Other process-specific SOPs are 

intended to provide the details of HPLC column selection, mobile phase solution 

preparation, sample preparation, flow rates, and run times.  

3. Summary of Method

3.1. Prepare the mobile phase and storage solutions

3.2. Power up the HPLC system components and start the PeakSimple data collection

software 

3.3. Equilibrate the system with mobile phase solution 

3.4. For each sample, run an assay: 

3.4.1. Use PeakSimple to start a new run  

3.4.2. Load and inject the sample  

3.4.3. Collecting data and store data 

3.4.4. Re-equilibrate the system if directed by the process-specific SOP 

3.5. Wash the system with storage solution 

3.6. Power down the system 

4. References

4.1. SOP: Degassing a Solution by Helium Sparge

4.2. SUPPLEMENT to Operator’s Manuals, BLC-20S PLUS Stack HPLC Systems, PN:

DS090-0056, Rev A A333. 
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5. Definitions

CV Column Volume; the volume (mL) of the column containing the stationary 

phase; CV=2.91 mL for a standard size (4.6 X 250 mm) column 

Equilibration Running the mobile phase solution through the column prior to injecting the 

sample in order to bring the system into equilibrium  

Flow rate The rate (mL/min) that solution is pumped through the column. The 

operating flow rate is determined by the assay protocol, generally 1.0 

mL/min for a standard size (4.6 X 250 mm) column 

Helium sparge Using a stream of helium bubbles to sweep dissolved air out of liquids 

(helium is virtually insoluble in most HPLC solvent solutions, so very little 

helium replaces the air) 

HPLC High Performance Liquid Chromatography 

Isocratic The composition of the mobile phase solution is constant; the system has 

only one pump. 

Mobile phase The solvent solution used to carry the sample through the column 

PeakSimple  Software used to collect and display data  

PSI Pounds per Square Inch 

Reverse phase 

chromatography 

Separation based on hydrophobicity under conditions where the stationary 

phase is more hydrophobic than the mobile phase.  

Stationary 

phase 

The chromatography matrix through which the sample travels.  

6. Precautions

6.1. Most solvents used for HPLC are toxic and flammable. For each solvent, read the

Material Safety Data Sheet (MSDS) for hazards, handling and storage information. Wear 

personal protection equipment (PPE) and use a fume hood as required. Store solvents as 

indicated by the MSDSs.  

6.2. HPLC systems operate at high pressures. Personnel injury and equipment damage can 

result if maximum pressure is exceeded or the pump runs dry. Monitor pressure readings 

and solution level whenever the pump is running. If pressure exceeds 2500 psi or if the 

solution runs out, stop the pump immediately by pressing the RUN/STOP button. Do not 

set the flow rate higher than 1.5 ml/min with a 250 mm column. 

6.3. Different mobile phase solutions interact with the stationary phase differently, resulting 

in different back pressures for a given flow rate (see Table 3 for example pressure 

readings for various mobile phase solutions). When changing mobile phase solutions, 

monitor pressure readings carefully while running the first 5 CV of the new solution as it 

replaces the old solution in the lines and column. 

6.4. Flow rate consistency is affected by the quality of the solutions. Use HPLC-grade 

solvents and filter solutions using a sub-micron filter (preferably 0.22 μm). Degas 

solutions prior to use.  

6.5. To avoid microbial growth, do not leave the system in a high aqueous solution for a 

prolonged period. The system should be washed with a storage solution of 50% 

Methanol/H20 or 50% Acetonitrile/H20 if it is to be idle more than a few hours. 
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7. Responsibilities

7.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary.  

7.2. It is the responsibility of the students/technician to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while 

performing the procedure.  

8. Equipment and Materials

8.1. Buck Scientific BLC-20P HPLC system pre-configured with:

8.1.1. UV-Vis detector 

8.1.2. Fluorometer (optional) 

8.1.3. PeakSimple Chromatography Data System 

8.1.4. Computer system with PeakSimple software installed 

8.1.5. Reverse phase HLPC column 

8.2. HPLC-grade solvent for mobile phase solution 

8.3. HPLC-grade methanol for storage solution 

8.4. HPLC-grade water 

8.5. Chemically compatible sub-micron filters (preferably 0.22 μm) 

8.6. 2 laboratory bottles for mobile phase solution and waste 

8.7. 2 laboratory bottles for storage solution and waste 

8.8. Small bottle for mobile phase (to be used for cleaning the sample syringe) 

8.9. Sample overflow waste beaker 

8.10. 5 mL Luer-Lok syringe 

8.11. 100 μL HPLC sample syringe 

8.12. Parafilm 

8.13. Timer 

9. Procedure

Note: this BLC-20P isocratic HPLC is configured with one pump, a UV-Vis detector, an 

add-on fluorescence detector, and a four channel serial port connected to a computer 

running PeakSimple software. The pump and UV-Vis detector are controlled by the 

HPLC front panel. Data is collected and displayed by the PeakSimple software on the 

computer.  

9.1. Prepare mobile phase and storage solutions: 

9.1.1. A process-specific SOP should provide the composition and volume of mobile 

phase required. For an example, see Table 2. Example Solution Volume 

Calculations. 

9.1.2. Prepare the mobile phase solution into a labeled laboratory bottle that is sized 

appropriately for degassing per the Degassing a Solution by Helium Sparge SOP. 

Filter the solution using a sub-micron filter (preferably 0.22 μm) that is chemically 

compatible. 

9.1.3. Prepare a minimum of 300 mL 50% Methanol/H20 or 50% Acetonitrile/H20 

storage solution into a labeled 500 mL laboratory bottle. Filter the solution using a 

sub-micron filter (preferably 0.22 μm) that is chemically compatible. 

9.1.4. Degas both the mobile phase and storage solutions per the Degassing a Solution 

by Helium Sparge SOP. 
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9.1.5. Transfer approximately 10 mL of mobile phase solution to a small labeled bottle 

to be used for rinsing the sample syringe. 

9.1.6. Label an empty laboratory bottle as storage solution waste. Label another empty 

bottle as mobile phase solution waste. 

9.2. Power up the HPLC system components and start the PeakSimple data collection 

software: 

9.2.1. Power up the computer system and monitor, then login. 

9.2.2. Power up the pump unit using the switch located on the lower-right side in the 

back. 

9.2.3. Power up the data system unit using the switch located on the upper-left side in 

the back. 

9.2.4. Optionally, power up the fluorometer unit using the switch on the front. 

9.2.5. Launch the PeakSimple data collection software: 

9.2.5.1.Double click on the PeakSimple icon on the desktop. (Alternatively, navigate 

to C:\ Peak426-32bit and run Peak426-32bit.exe.) The PeakSimple window 

should appear as the software automatically connects to the HPLC hardware. 

9.2.6. Allow the UV-Vis detector to warm up for 60 minutes prior to collecting data. 

9.3. Switch the system to mobile phase solution: 

9.3.1. Verify that the pump is off. The Run LED should be off. 

9.3.2. Place the intake line into the mobile phase solution bottle and cover with 

Parafilm. Verify that the frit is submerged in the solution. 

9.3.3. Place the outlet line into the mobile phase waste bottle. 

9.3.4. Place the sample overflow line into a small waste beaker. 

9.4. Purge the intake line and prime the pump: 

9.4.1. Attach an empty 5 mL Luer-Lok syringe to the purge valve.  

9.4.2. Open the prime/purge valve by turning it two full turns counter-clockwise. 

9.4.3. Watching the intake line for bubbles, slowly draw the syringe plunger until it is 

fully drawn. Mobile phase solution and bubbles should fill the syringe. 

9.4.4. Close the prime/purge value by rotating it clockwise until it stops. 

9.4.5. Remove the syringe from the purge valve and expel the contents into the waste 

bottle. 

9.4.6. Repeat attaching the syringe to the purge valve, drawing bubbles and solution into 

the syringe, and expelling into the waste bottle until free of bubbles (generally 10-

to-15 mL of mobile phase are needed). 

9.5. Start the pump and gradually increase the flow rate to the operating rate: 

9.5.1. A process-specific SOP should provide the flow rate for the mobile phase. 

9.5.2. Set the initial flow rate to 0.1 mL/min: 

9.5.2.1.Press the MODE button on the front panel repeatedly until the Flow LED 

turns on. The current flow rate (in ml/min) appears on the digital display. 

9.5.2.2.Press the Flow up arrow button to increase the flow rate setting and press the 

down arrow button to decrease the flow rate setting. 

9.5.2.3.Repeat pressing the Flow arrow buttons until 0.10 is displayed. 

9.5.3. Start the pump by pressing the RUN/STOP button. The Run LED should turn on. 

9.5.4. Monitor the pressure readings and solution level: 
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9.5.4.1.Display the pressure reading by pressing the MODE button repeatedly until 

the Pressure LED turns on. The current pressure (in psi) appears on the digital 

display. 

9.5.4.2.Verify that that solution is dripping into the waste bottle. 

9.5.4.3.If pressure exceeds 2500 psi or if the solution runs out, stop the pump 

immediately by pressing the RUN/STOP button. 

9.5.5. Gradually increase the flow rate in 0.1 mL/min increments over a period of 5 

minutes to the specified flow rate: 

9.5.5.1.Press the MODE button on the front panel repeatedly until the Flow LED 

turns on. The current flow rate (in ml/min) appears on the digital display. 

9.5.5.2.Increase the flow rate setting by 0.1 mL/min by pressing the Flow up arrow 

button. 

9.5.5.3.Monitor the pressure readings and solution level. 

9.5.5.4.Repeat increasing the flow rate setting by 0.1 mL/min increments over a 

period of 5 minutes until the specified flow rate is achieved and pressure 

readings stabilize.  

9.6. Set the UV-Vis detector wavelength and autozero the detector: 

9.6.1. A process-specific SOP should provide the assay run time and the UV-VIS 

detector wavelength. 

9.6.2. Set the UV-Vis detector wavelength by pressing the λ up and down buttons on the 

front panel until the specified wavelength is displayed. 

9.6.3. Autozero the UV-Vis detector by pressing the AUTOZERO button on the front 

panel. 

9.7. Equilibrate the system by running mobile phase: 

9.7.1. A process-specific SOP should provide the equilibration run time. The run time 

may be expressed in terms of column volumes (CV); see Equation 1 for an example 

of converting a CV to a run time. 

9.7.2. Operate the pump to run for the specified run time. Monitor the pressure readings 

and solution level. Monitor detector values and notify the instructor if the values 

appear to be unstable. 

9.7.3. Alternatively, run an assay of a blank (see below) using mobile phase solution as 

the sample. 

9.8. For each sample, run an assay: 

9.8.1. Use PeakSimple to start a new run and edit the run time: 

9.8.1.1.Select File > New from the menu bar. 

9.8.1.2.Select Edit > Channels… from the menu bar. The Channels dialog box should 

appear. 

9.8.1.3.Select Channel 1: Details from the Channels dialog box. The Channel details 

dialog box should appear. 

9.8.1.4.Enter the run time in the End time box. 

9.8.1.5.Verify that the Remote start check box is checked. 

9.8.1.6.Close the Channel details and Channels dialog boxes. 

9.8.2. Autozero the UV-Vis detector by pressing the AUTOZERO button on the front 

panel. 
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9.8.3. Load and inject the sample: 

9.8.3.1.Verify that the injector port handle is set to the “Load” position. 

9.8.3.2.Fill the HPLC sample syringe with 100 μL of sample, using care to avoid 

bubbles in the syringe. 

9.8.3.3.Insert the syringe needle into the sample injection port. See Figure 4. Sample 

Injection Port with HLPC Syringe Attached. 

9.8.3.4.Depress the syringe plunger, using care to avoid introducing bubbles. (Often 

there is a small bubble at the base of the plunger. Watch carefully and stop 

depressing the plunger before the bubble is loaded into the injector port. It is 

OK to leave a few μL of sample in the syringe.) 

9.8.3.5.Turn the injector port handle clockwise from the “Load” to the “Inject” 

position. Note that the PeakSimple has started displaying the elapsed run time 

in upper right corner. 

9.8.3.6.After 10 seconds, turn the injector port handle counter-clockwise from the 

“Inject” back to the “Load” position. 

9.8.3.7.Remove the syringe from the sample injection port. 

9.8.3.8.Rinse the syringe by filling it from the small bottle of mobile phase solution 

and expelling it into the mobile phase waste bottle at least three times. 

9.8.4. Operate the pump for the specified run time. Monitor pressure readings and 

solution level. At the end of the run time, note that PeakSimple elapsed run time 

switches to STANDBY in upper right corner. 

9.8.5. Use PeakSimple to view results and save the data to a chromatogram file: 

9.8.5.1.Select View > Results… from the menu bar. The Results dialog box should 

appear. 

9.8.5.2.Click the Copy button to copy the data. 

9.8.5.3.Paste the data into an Excel spreadsheet. 

9.8.5.4.Close the Results dialog box. 

9.8.5.5.Select File > Save as… from the menu bar. The Save as dialog box should 

appear. 

9.8.5.6.Enter a directory and a meaningful file name (e.g. operator initials, experiment 

name, and run number). Click the Save button. 

9.8.6. Re-equilibrate the system if directed by the process-specific SOP. 

9.8.7. Repeat this section for each sample. 

9.9. Stop the pump: 

9.9.1. Press the RUN/STOP button. The Run LED should turn off and pressure readings 

should decrease gradually.  

9.9.2. Monitor the pressure until it decreases to less than 100 psi. 

9.10. Wash the system by running 5 CV of storage solution: 

9.10.1. Switch the system to storage solution per the instructions in section 9.2.6 above. 

9.10.2. Purge the intake line and prime the pump per the instructions in section 9.4 above. 

9.10.3. Set the initial flow rate to 0.1 mL/min. 

9.10.4. Start the pump and gradually increase the flow rate to 0.5 mL/min over a period 

of 5 minutes. 

9.10.5. Operate the pump for 30 minutes. Monitor pressure readings and solution level. 
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9.10.6. Stop the pump and allow the pressure to decrease to less than 100 psi. 

9.11. Power down the system: 

9.11.1. Exit PeakSimple by selecting File > Exit from the menu bar. A prompt should 

appear asking Save all before exiting? Click the No button.  

9.11.2. Power down the pump unit using the switch located on the lower-right side in the 

back. 

9.11.3. Power down the data system using the switch located on the upper-left side in the 

back. 

Attachments

Figure 1. Buck Scientific BLC-20P HPLC System with Column and Fluorometer 
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Figure 2. HPLC Front Panel 

Figure 3. Purge Valve with Luer-Lok Syringe Attached 
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Figure 4. Sample Injection Port with HLPC Syringe Attached 

Table 1. Common Column Volumes 

Column 

dimension 

Column 

volume (mL) 

250 x 4.6 mm 2.91 

150 x 4.6 mm 1.74 

100 x 4.6 mm 1.16 

50 x 4.6 mm 0.58 

250 x 4.0 mm 2.20 

125 x 4.0 mm 1.10 

250 x 2.0 mm 0.55 

150 x 2.0 mm 0.33 

50 x 2.0 mm 0.11 

𝐶𝑉 =  𝜋𝑟2𝐿
where: 

CV = column volume in mL 

r = column radius in cm 

L = column length in cm 
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Table 2. Example Solution Volume Calculations  

Mobile Phase solution 

Operation Calculation Volume (ml) 

Prime and purge 20 mL 20 

Increasing flow rate 0.75 mL/min * 5 min 4 

Initial equilibration 15 CV = 15 * 3 mL 45 

Assays N * flow rate * run time = 4 * 0.75 mL/min * 15 min 45 

Syringe cleaning 10 mL 10 

Re-equilibration N * 5 CV = 4 * 3 mL 12 

Reserve volume 100 mL 100 

Subtotal Sum of the above 236 

Minimum volume Subtotal * 120% 284 

Storage solution 

Operation Calculation Volume (ml) 

Prime and purge 20 mL 20 

Increasing flow rate 0.5 mL/min * 5 min 3 

Wash 15 CV = 15 * 3 mL 45 

Reserve volume 100 mL 100 

Subtotal Sum of the above 168 

Minimum volume Subtotal * 120% 202 

Equation 1. Example Run Time Calculations 

𝑅𝑢𝑛 𝑣𝑜𝑙𝑢𝑚𝑒 = 15 𝐶𝑉 

𝐶𝑜𝑙𝑢𝑚𝑛 𝑣𝑜𝑙𝑢𝑚𝑒 (𝐶𝑉) = 3 𝑚𝐿 

𝐹𝑙𝑜𝑤 𝑟𝑎𝑡𝑒 =  0.75 𝑚𝑙/𝑚𝑖𝑛 

𝑅𝑢𝑛 𝑡𝑖𝑚𝑒 =
𝑅𝑢𝑛 𝑣𝑜𝑙𝑢𝑚𝑒

𝐹𝑙𝑜𝑤 𝑟𝑎𝑡𝑒
=

15 𝐶𝑉 ∗  3 𝑚𝐿/𝐶𝑉

0.75 𝑚𝐿/𝑚𝑖𝑛
= 60 𝑚𝑖𝑛. 

Table 3. Example Flow Rates and Pressure Readings for a Haisil 100 C18 5μm 250 X 4.6mm Column 

Mobile Phase Solution Flow Rate (mL/min) Pressure Readings (psi) 

50% MeOH/H2O 0.5 1400-1600 

100% Isopropyl alcohol 0.5 1750-1950 

100% H2O 1.0 1600-1800 

100% Acetonitrile 1.0 650-850 

95% Hexane 1.0 500-700 
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10. History

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 31OCT13 John Buford Initial release 
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Approvals 

Preparer: John Buford Date: 23OCT13 

Reviewer: Tim Kull Date: 30OCT13 

Reviewer: Dr. Margaret Bryans Date: 31OCT13 

1. Purpose

1.1. Quantify concentration of caffeine in a coffee sample using isocratic reverse phase high

performance liquid chromatography (RP-HPLC) configured with a C18 column and a 

UV-Vis detector set for 275 nm. 

2. Scope and Applicability

2.1.  High performance liquid chromatography (HPLC) is an analytical chemistry technique

for separating the components of a liquid sample and for identifying and quantifying the 

components of the sample. This SOP uses an HPLC to quantify the caffeine 

concentration in generic brewed coffee by assaying a series of caffeine standards in 

order to construct a calibration curve, and then assaying coffee samples and calculating 

caffeine concentration against the calibration curve. This SOP provides the details of 

HPLC column selection, mobile phase solution preparation, sample preparation, flow 

rates, and run times. Refer to the SOPs listed below for step-by-step HPLC operation 

instructions. 

3. Summary of Method

3.1. Prepare mobile phase solution

3.2. Prepare caffeine standards and coffee samples

3.3. Power up the HPLC system and equilibrate with mobile phase solution

3.4. Run an assay for each of the caffeine standards and coffee samples

3.5. Wash the system with mobile phase solution

3.6. Graph the calibration curve

3.7. Compute the caffeine concentration of the coffee samples

3.8. Power down the system

4. References

4.1. SOP: Buck Scientific BLC-20P HPLC Operation, document QCB 7, revision 0, effective

4.2. SOP: Degassing a Solution by Helium Sparge, document number QCB 6, revision 0,

effective 25SEP13. 

5. Definitions

CV Column Volume; the volume (mL) of the column containing the stationary 

phase; CV=2.91 mL for a standard size (4.6 X 250 mm) column 

Equilibration Running the mobile phase solution through the column prior to injecting 

the sample in order to bring the system into equilibrium  

Flow rate The rate (mL/min) that solution is pumped through the column. The 

operating flow rate is determined by the assay protocol. 

Helium sparge Using a stream of helium bubbles to sweep dissolved air out of liquids 

(helium is virtually insoluble in most HPLC solvent solutions, so very 

little helium replaces the air) 

HPLC High Performance Liquid Chromatography 
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Isocratic The composition of the mobile phase solution is constant; the system has 

only one pump. 

Mobile phase The solvent solution used to carry the sample through the column 

PeakSimple  Software used to collect and display data  

PSI Pounds per Square Inch 

Reverse phase 

chromatography 

Separation based on hydrophobicity under conditions where the stationary 

phase is more hydrophobic than the mobile phase.  

Stationary 

phase 

The chromatography matrix through which the sample travels.  

6. Precautions

6.1. HPLC systems operate at high pressures. Personnel injury and equipment damage can

result if maximum pressure is exceeded or the pump runs dry. Monitor pressure readings 

and solution level whenever the pump is running. If pressure exceeds 2500 psi or if the 

solution runs out, stop the pump immediately by pressing the RUN/STOP button. Do not 

set the flow rate higher than 1.5 ml/min with a 250 mm column. 

6.2. Flow rate consistency is affected by the quality of the solutions. Use HPLC-grade 

solvents and filter solutions using a sub-micron filter (preferably 0.22 μm). Degas 

solutions prior to use.  

6.3. To avoid microbial growth, do not leave the system in a high aqueous solution for a 

prolonged period. The system should be washed with a storage solution of 50% 

Methanol/H20 or 50% Acetonitrile/H20 if it is to be idle more than a few hours. 

6.4. Methanol is flammable. Can cause blindness if swallowed. Vapor is harmful. Irritating to 

skin and eyes. 

7. Responsibilities

7.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary.  

7.2. It is the responsibility of the students/technician to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while 

performing the procedure.  

8. Equipment and Materials

8.1. Buck Scientific BLC-20P HPLC system pre-configured with:

8.1.1. UV-Vis detector 

8.1.2. PeakSimple Chromatography Data System 

8.1.3. Computer system with PeakSimple software installed 

8.1.4. Haisil 100 C18 5μm 250 X 4.6mm HPLC column  

8.2. HPLC-grade methanol 

8.3. HPLC-grade water 

8.4. Laboratory-grade caffeine 

8.5. 2 different samples of generic-brewed regular coffee 

8.6. Sample overflow waste beaker 

8.7. Analytic balance 

8.8. 250 mL or 500 mL graduated cylinder 

8.9. 500 mL volumetric flask 

8.10. 100 mL volumetric flask 
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8.11. 1 mL volumetric pipette 

8.12. Stirring plate 

8.13. 2 – 500 mL laboratory bottles (for mobile phase solution and waste) 

8.14. Small laboratory bottle (for mobile phase to rinse the sample syringe) 

8.15. 100 mL laboratory bottle (for stock caffeine solution) 

8.16. Nalgene Rapid-flow filtration unit 

8.17. 2 – 0.45 μm or 0.22 μm syringe filters 

8.18. 2 – small beakers (for filtered coffee) 

8.19. 6 – microfuge tubes (for caffeine standards and diluted coffee samples) 

8.20. 5 mL Luer-Lok syringe 

8.21. 100 μL HPLC sample syringe 

8.22. Parafilm 

8.23. Timer 

9. Procedure

9.1. Prepare 500 mL 50% methanol/H2O mobile phase solution (also to be used as storage

solution): 

9.1.1. Measure 250 mL HPLC-grade methanol using a graduated cylinder into a 500 mL 

volumetric flask.  

9.1.2. Bring to volume 500 mL with HPLC-grade H2O. Cover with parafilm and invert 

to mix. Check the volume and repeat. (When methanol and water combine, the total 

volume may be slightly less than the sum of the original volumes.) 

9.1.3. Filter the mobile phase solution using a Nalgene Rapid-flow filtration unit. 

Transfer approximately 10 mL of mobile phase solution to a small labeled bottle to 

be used for rinsing the sample syringe. Transfer remaining solution to a labeled 500 

mL laboratory bottle. 

9.1.4. Label an empty bottle as mobile phase solution waste. 

284



Montgomery County Community College 

340 DeKalb Pike 

Blue Bell, PA 

Document Number: 58.2.0 

Revision Number:  0 

Effective Date: 31OCT13 

Page 4 of 6 

SOP: Quantification of Caffeine in Coffee using HPLC 

9.2. Prepare 100 mL 1000 ppm caffeine stock solution: 

9.2.1. Weigh 100 mg of caffeine on weighing paper or weighing boat using an analytic 

balance. 

9.2.2. Transfer caffeine to a 100 mL volumetric flask. 

9.2.3. Bring to volume 100 mL with mobile phase solution. 

9.2.4. Rinse a stir bar, insert it into the flask, cover the flask with parafilm, and mix on a 

stir plate for 10 minutes. Remove the stir bar. 

9.2.5. Filter the caffeine stock solution using the Nalgene Rapid-flow filtration unit. 

Transfer caffeine stock solution to a labeled 100 mL bottle. 

9.3. Prepare 500 μL each of 200, 100, 50, and 25 ppm caffeine standards in labeled 

microfuge tubes as a serial dilution from 1000 ppm caffeine stock solution and mobile 

phase solution using a micropipette. Pipette up and down, then cap and vortex to mix 

each standard.  

9.4. Filter approximately 5 mL of each coffee sample into a small labeled beaker using a 0.45 

μm or 0.22 μm syringe filter, one beaker and filter per sample. 

9.5. Prepare 1000 μL 20% coffee samples in labeled microfuge tubes by diluting the filtered 

coffee with mobile phase solution using a micropipette. Pipette up and down, then cap 

and vortex to mix each sample. 

9.6. Degas the mobile phase solution per the Degassing a Solution SOP.  

9.7. Power up the HPLC system and equilibrate with mobile phase solution for 30 minutes at 

the flow rate 0.5 mL/min: 

9.7.1. Power up the HPLC system components and start the PeakSimple data collection 

software per the HPLC Operation SOP. 

9.7.2. Switch the system to mobile phase solution per the HPLC Operation SOP. 

9.7.3. Purge the intake line and prime the pump per the HPLC Operation SOP. 

9.7.4. Start the pump and gradually increase the flow rate to 0.5 mL/min over 5 minutes 

per the HPLC Operation SOP. 

9.7.5. Set the UV-Vis detector wavelength to 275 nm and autozero the detector per the 

HPLC Operation SOP. 

9.7.6. Equilibrate the system with mobile phase solution at the flow rate 0.5 mL/min for 

30 minutes per the HPLC Operation SOP. Monitor the UV-Vis detector readings. 

9.7.7. Ensure that the UV-Vis detector warms up for 60 minutes prior to collecting data 

per the HPLC Operation SOP. 

9.8. For each of the 25, 50, 100 and 200 ppm caffeine standards, run an assay for 10 minutes 

at 0.5 mL/min per the HPLC Operation SOP: 

9.8.1. Use PeakSimple to start a new 10 minute run. 

9.8.2. Autozero the UV-Vis detector. 

9.8.3. Load and inject a caffeine standard. 

9.8.4. Operate the pump for 10 minutes at 0.5 mL/min. 

9.8.5. Note the time at the center of the caffeine peak on the chromatograph. 

9.8.6. Save the data to a separate chromatogram file. 

9.8.7. View the results and copy the data to a separate sheet in an Excel workbook. 
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9.9. For each of the coffee samples, run an assay for 10 minutes each at 0.5 mL/min per the 

HPLC Operation SOP: 

9.9.1. Use PeakSimple to start a new 10 minute run. 

9.9.2. Autozero the UV-Vis detector. 

9.9.3. Load and inject a coffee sample. 

9.9.4. Operate the pump for 10 minutes at 0.5 mL/min. 

9.9.5. Identify the caffeine peak on the chromatograph at the time noted above. 

9.9.6. Save the data to a separate chromatogram file. 

9.9.7. View the results and copy the data to a separate sheet in an Excel workbook. 

9.10. Wash the system with mobile phase solution for 30 minutes at the flow rate 0.5 

mL/min. 

9.11. Graph the calibration curve using Excel: 

9.11.1. Add a new sheet to the Excel workbook with the columns “Caffeine Standard” 

and “Area”.  

9.11.2. Fill in the Caffeine Standard column with the values 25, 50, 100, and 200. 

9.11.3. Fill in the Area column with the peak area values from the corresponding caffeine 

standard data collected above. 

9.11.4. Use a scatter graph to display Caffeine Standard values on the x-axis and Area 

values on the y-axis. 

9.11.5. Add a linear trendline to the graph, displaying the equation and R-squared value 

on the graph. 

9.12. Compute the caffeine concentration of the coffee samples using the Excel 

TREND function. 

9.13. Stop the pump and allow the pressure to decrease to 0 per the HPLC Operation 

SOP. 

9.14. Power down the system per the HPLC Operation SOP. 
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10. Attachments

Figure 1. Example Calibration Curve 

11. History

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 31OCT13 John Buford Initial release 
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Approvals 

Preparer: John Buford, Jason McMillan, Jack O’Neill Date: 16JUL15 

Reviewer: Dr. Maggie Bryans Date: 17JUL15 

1. Purpose

1.1. Basic operation of the Buck Scientific BLC-30G gradient HPLC system in order to assay

a sample using reverse phase high performance liquid chromatography (RP-HPLC). 

2. Scope and Applicability

2.1. High performance liquid chromatography (HPLC) is an analytical chemistry technique

for separating the components of a liquid sample and for identifying and quantifying the 

components of the sample. This SOP provides the basic operations required to perform 

an assay using the Buck Scientific BLC-30G gradient HPLC system, a reverse phase 

HPLC column, and a compatible mobile phase solution. Other process-specific SOPs are 

intended to provide the details of HPLC column selection, mobile phase solution 

preparation, sample preparation, flow rates, and run times.  

3. Summary of Method

3.1. Prepare the mobile phase and storage solutions

3.2. Power up the HPLC system components and start the PeakSimple data collection

software 

3.3. Equilibrate the system with mobile phase solution 

3.4. For each sample, run an assay: 

3.4.1. Use PeakSimple to start a new run  

3.4.2. Load and inject the sample  

3.4.3. Collecting data and store data 

3.4.4. Re-equilibrate the system if directed by the process-specific SOP 

3.5. Wash the system with storage solution 

3.6. Power down the system 

4. References

4.1. SOP: Degassing a Solution by Helium Sparge

4.2. BLC-30G Easy Installation and Quick Start Guide

5. Definitions

CV Column Volume; the volume (mL) of the column containing the stationary 

phase; CV=2.91 mL for a standard size (4.6 X 250 mm) column 

Equilibration Running the mobile phase solution through the column prior to injecting the 

sample in order to bring the system into equilibrium  

Flow rate The rate (mL/min) that solution is pumped through the column. The 

operating flow rate is determined by the assay protocol, generally 1.0 

mL/min for a standard size (4.6 X 250 mm) column 

Helium sparge Using a stream of helium bubbles to sweep dissolved air out of liquids 

(helium is virtually insoluble in most HPLC solvent solutions, so very little 

helium replaces the air) 

HPLC High Performance Liquid Chromatography 
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Isocratic The composition of the mobile phase solution is constant; the system has 

only one pump. 

Mobile phase The solvent solution used to carry the sample through the column 

PeakSimple  Software used to collect and display data  

PSI Pounds per Square Inch 

Reverse phase 

chromatography 

Separation based on hydrophobicity under conditions where the stationary 

phase is more hydrophobic than the mobile phase.  

Stationary 

phase 

The chromatography matrix through which the sample travels.  

6. Precautions

6.1. Most solvents used for HPLC are toxic and flammable. For each solvent, read the

Material Safety Data Sheet (MSDS) for hazards, handling and storage information. Wear 

personal protection equipment (PPE) and use a fume hood as required. Store solvents as 

indicated by the MSDSs.  

6.2. HPLC systems operate at high pressures. Personnel injury and equipment damage can 

result if maximum pressure is exceeded or the pump runs dry. Monitor pressure readings 

and solution level whenever the pump is running. If pressure exceeds 2500 psi or if the 

solution runs out, stop the pump immediately by pressing the RUN/STOP button. Do not 

set the flow rate higher than 1.5 ml/min with a 250 mm column. 

6.3. Different mobile phase solutions interact with the stationary phase differently, resulting 

in different back pressures for a given flow rate (see Table 3 for example pressure 

readings for mobile phase solutions). When changing mobile phase solutions, monitor 

pressure readings carefully while running the first 5 CV of the new solution as it replaces 

the old solution in the lines and column. 

6.4. Flow rate consistency is affected by the quality of the solutions. Use HPLC-grade 

solvents and filter solutions using a sub-micron filter (preferably 0.22 μm). Degas 

solutions prior to use.  

6.5. To avoid microbial growth, do not leave the system in a high aqueous solution for a 

prolonged period. The system should be washed with a storage solution of 50% 

Methanol/H20 or 50% Acetonitrile/H20 if it is to be idle more than a few hours. 

7. Responsibilities

7.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary.  

7.2. It is the responsibility of the students/technician to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while 

performing the procedure.  

8. Equipment and Materials

8.1. Buck Scientific BLC-30G HPLC system pre-configured with:

8.1.1. UV-Vis detector 

8.1.2. BLF-10 Fluorescence Detector  

8.1.3. PeakSimple Chromatography Data System 

8.1.4. Computer system with PeakSimple software installed 

8.1.5. Reverse phase HLPC column  

8.2. HPLC-grade solvent for mobile phase solution 
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8.3. HPLC-grade methanol for storage solution 

8.4. HPLC-grade water 

8.5. Chemically compatible sub-micron filters (preferably 0.22 μm) 

8.6. 2 laboratory bottles for mobile phase solution and waste 

8.7. 2 laboratory bottles for storage solution and waste 

8.8. Small bottle for mobile phase (to be used for cleaning the sample syringe) 

8.9. Sample overflow waste beaker 

8.10. 25 mL Luer-Lok syringe 

8.11. 100 μL HPLC sample syringe 

8.12. Parafilm 

8.13. Timer 

9. Procedure

Note: this BLC-30G Gradient HPLC is configured with two pumps, a UV-Vis detector, 

an add-on fluorescence detector, and a four channel serial port connected to a computer 

running PeakSimple software. The pumps and detectors are either controlled by the 

HPLC front panel (Figure 2) or the PeakSimple software, with the Run/Stop functions 

accessed through the Relay and Pump window. Data are collected and displayed by the 

PeakSimple software on the computer. For example, the UV-Vis data and Gradient 

functions are monitored/set through Channel 1. The FL data and Pump B functions are 

monitored/set through Channel 2. The Pressure is monitored through Channel 6.  

9.1. Prepare mobile phase and storage solutions: 

9.1.1. A process-specific SOP should provide the composition and volume of mobile 

phase required. For an example, see Table 2. Example Solution Volume 

Calculations. 

9.1.2. Prepare the mobile phase solution into a labeled laboratory bottle that is sized 

appropriately for degassing per the Degassing a Solution by Helium Sparge SOP. 

Filter the solution using a sub-micron filter (preferably 0.22 μm) that is chemically 

compatible. 

9.1.3. Prepare a minimum of 300 mL 50% Methanol/H20 solution into a labeled 500 mL 

laboratory bottle. Filter the solution using a sub-micron filter (preferably 0.22 μm). 

9.1.4. Degas the mobile phase & storage solutions per the Degassing a Solution by 

Helium Sparge SOP. 

9.1.5. Transfer approximately 10 mL of mobile phase solution to a small labeled bottle 

to be used for rinsing the sample syringe. 

9.1.6. Label an empty laboratory bottle as storage solution waste. Label another empty 

bottle as mobile phase solution waste. 

9.2. Power up the HPLC system components and start the PeakSimple data collection 

software: 

9.2.1. Power up the computer system and monitor, then login. 

9.2.2. Power up the pump units UV-Vis detector, and fluorescence detector using the 

red switch located on the power strip to the left of the unit. 

9.3. Launch the PeakSimple data collection software: 
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9.3.1.1.Double click on the PeakSimple icon on the desktop. (Alternatively, navigate 

to C:\ Peak426-32bit and run Peak426-32bit.exe.) The PeakSimple window 

should appear as the software automatically connects to the HPLC hardware. 

9.3.1.2.Navigate to “Edit” in the top left corner and select “Channels” from the 

dropdown menu. 

9.3.1.3.Next to Channel 1:Uv-Vis, ensure that “active,” “display” and “integrate” all 

have checks in them. 

9.3.1.4.Select “Details” 

9.3.1.5.Under the section “Control by” select “Gradient” 

9.3.1.6.Under “End Time” input a value in minutes for the length of the run. 

9.3.1.7.Press “OK” when finished. 

9.3.1.8.Select “Gradient” 

9.3.1.9.Select “Clear” 

9.3.1.10. Select “Add” 

9.3.1.11. Fill in the values to create the desired gradient. 

9.3.1.12. If multiple gradient steps are necessary, repeat steps 9.2.3.9. and 9.2.3.10. 

9.3.1.13. Press “OK” when finished. 

9.3.1.14. Next to Channel 2: Fluorescence, ensure that “active,” “display” and 

“integrate” all have checks in them. 

9.3.1.15. Select “Details” 

9.3.1.16. Under the section “Control by” select “Gradient” 

9.3.1.17. Under “End Time” input a value in minutes for the length of the run. 

9.3.1.18. Press “OK” when finished. 

9.3.1.19. Next to Channel 6, ensure that “active,” and “display” have checks in 

them. 

9.3.1.20. Select “Details” 

9.3.1.21. Ensure that “Datalogger mode” has a check in the box next to it. 

9.3.1.22. Ensure Offset = 0 

9.3.1.23. Ensure Gain = 1 

9.3.1.24. Ensure Decimal Places = 0 

9.3.1.25. Under “End Time” input a value in minutes for the length of the run. 

9.3.1.26. Press “OK” when finished. 

9.3.1.27. Press “OK” to close the Channels window. 

9.3.1.28. Allow the detectors to warm up for 60 minutes prior to collecting data. 

9.4. Switch the system to mobile phase solution: 
9.4.1. Verify that the pump is off. The Run LED should be off. 

9.4.2. Place the intake lines into the mobile phase solution bottle and cover with 

Parafilm. Verify that the frit is submerged in the solution. 

9.4.3. Place the outlet line into the mobile phase waste bottle. 

291



Montgomery County Community College 

340 DeKalb Pike 

Document Number: 59.0.0 

Revision Number:  0 

Blue Bell, PA Effective Date: 17JUL15 

Page 5 of 12 

SOP: Buck Scientific BLC-30G HPLC Operation 

9.4.4. Place the sample overflow line into a small waste beaker. 

9.5. Purge the intake line and prime the pump: 

9.5.1. Attach an empty 25 mL Luer-Lok syringe to the purge valve (Figure 3).  

9.5.2. Open the prime/purge valve by turning it two full turns counter-clockwise. 

9.5.3. Watching the intake line for bubbles, slowly draw the syringe plunger until it is 

fully drawn. Mobile phase solution and bubbles should fill the syringe. 

9.5.4. Close the prime/purge value by rotating it clockwise until it stops. Stop the 

pumps. 

9.5.5. Remove the syringe from the purge valve and expel the contents into the waste 

bottle. 

9.5.6. Repeat attaching the syringe to the purge valve, drawing bubbles and solution into 

the syringe, and expelling into the waste bottle until free of bubbles (generally 20-

to-30 mL of mobile phase are needed). 

9.6. Start the pump and gradually increase the flow rate to the operating rate: 

9.6.1. A process-specific SOP should provide the flow rate for the mobile phase. 

9.6.2. Set the initial flow rate to 0.1 mL/min: 

9.6.2.1.Press the MODE button on the front panel repeatedly until the Flow LED 

turns on. The current flow rate (in ml/min) appears on the digital display. 

9.6.2.2.Press the Flow up arrow button to increase the flow rate setting and press the 

down arrow button to decrease the flow rate setting. 

9.6.2.3.Repeat pressing the Flow arrow buttons until 0.10 is displayed. 

9.6.3. Start the pump by pressing the RUN/STOP button. The Run LED should turn on. 

9.6.4. Monitor the pressure readings and solution level: 

9.6.4.1.Display the pressure reading by pressing the MODE button repeatedly until 

the Pressure LED turns on. The current pressure (in psi) appears on the digital 

display. 

9.6.4.2.Verify that that solution is dripping into the waste bottle. 

9.6.4.3.If pressure exceeds 2500 psi or if the solution runs out, stop the pump 

immediately by pressing the RUN/STOP button. 

9.6.5. Gradually increase the flow rate in 0.1 mL/min increments over a period of 5 

minutes to the specified flow rate: 

9.6.5.1.Press the MODE button on the front panel repeatedly until the Flow LED 

turns on. The current flow rate (in ml/min) appears on the digital display. 

9.6.5.2.Increase the flow rate setting by 0.1 mL/min by pressing the Flow up arrow 

button. 

9.6.5.3.Monitor the pressure readings and solution level. 

9.6.5.4.Repeat increasing the flow rate setting by 0.1 mL/min increments over a 

period of 5 minutes until the specified flow rate is achieved and pressure 

readings stabilize.  

9.7. Set the UV-Vis detector wavelength and autozero the detector: 

9.7.1. A process-specific SOP should provide the assay run time and the UV-VIS 

detector wavelength.  

9.7.2. Set the UV-Vis detector wavelength by pressing the λ up and down buttons on the 

front panel until the specified wavelength is displayed. 
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9.7.3. Autozero the UV-Vis detector by pressing the AUTOZERO button on the front 

panel. 

9.8. Equilibrate the system by running mobile phase: 

9.8.1. A process-specific SOP should provide the equilibration run time. The run time 

may be expressed in terms of column volumes (CV); see Equation 1 for an example 

of converting a CV to a run time. 

9.8.2. Operate the pump to run for the specified run time. Monitor the pressure readings 

and solution level. Monitor detector values and notify the instructor if the values 

appear to be unstable. 

9.8.3. Alternatively, run an assay of a blank (see below) using mobile phase solution as 

the sample. 

9.9. For each sample, run an assay: 

9.9.1. Use PeakSimple to start a new run and edit the run time: 

9.9.1.1.Select File > New from the menu bar. 

9.9.1.2.Select Edit > Channels… from the menu bar. The Channels dialog box should 

appear. 

9.9.1.3.Select Channel 1: Details from the Channels dialog box. The Channel details 

dialog box should appear. 

9.9.1.4.Ensure previously set values are still in place.  

9.9.1.5.Verify that the “Remote start” check box is checked.  

9.9.1.6.Press “OK” when finished. 

9.9.1.7.Select Channel 2: Details from the Channels dialog box. The Channel details 

dialog box should appear. 

9.9.1.8.Ensure previously set values are still in place. 

9.9.1.9.Verify that the “Remote start” check box is checked.  

9.9.1.10. Press “OK” when finished. 

9.9.1.11. Select Channel 6: Details from the Channels dialog box. The Channel 

details dialog box should appear. 

9.9.1.12. Ensure previously set values are still in place. 

9.9.1.13. Verify that the “Remote start” check box is checked. 

9.9.1.14. Press “OK” when finished. 

9.9.1.15. Press “OK” to close the Channels window. 

9.9.2. Autozero the UV-Vis detector by pressing the AUTOZERO button on the front 

panel. 

9.9.3. Load and inject the sample: 

9.9.3.1.Verify that the injector port handle is set to the “Load” position. 

9.9.3.2.Fill the HPLC sample syringe with 100 μL of sample, using care to avoid 

bubbles in the syringe. 

9.9.3.3.Insert the syringe needle into the sample injection port (Figure 4).  

9.9.3.4.Depress the syringe plunger, using care to avoid introducing bubbles. (Often 

there is a small bubble at the base of the plunger. Watch carefully and stop 

depressing the plunger before the bubble is loaded into the injector port. It is 

OK to leave a few μL of sample in the syringe.) 
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9.9.3.5.Turn the injector port handle clockwise from the “Load” to the “Inject” 

position (Figure 5). Note, the PeakSimple software has started displaying the 

elapsed run time in upper right corner. 

9.9.3.6.After 10 seconds, turn the injector port handle counter-clockwise from the 

“Inject” back to the “Load” position. 

9.9.3.7.Remove the syringe from the sample injection port. 

9.9.3.8.Rinse the syringe by filling it from the small bottle of mobile phase solution 

and expelling it into the mobile phase waste bottle at least three times. 

9.9.4. Operate the pump for the specified run time. Monitor pressure readings and 

solution level. At the end of the run time, note that PeakSimple elapsed run time 

switches to STANDBY in upper right corner. 

9.9.5. Use PeakSimple to view results and save the data to a chromatogram file: 

9.9.5.1.Select View > Results… from the menu bar. The Results dialog box should 

appear.  

9.9.5.2.Click the Copy button to copy the data. 

9.9.5.3.Paste the data into an Excel spreadsheet. 

9.9.5.4.Close the Results dialog box. 

9.9.5.5.Select File > Save as… from the menu bar. The Save as dialog box should 

appear. 

9.9.5.6.Enter a directory and a meaningful file name (e.g. operator initials, experiment 

name, and run number). Click the Save button. 

9.9.6. Re-equilibrate the system if directed by the process-specific SOP. 

9.9.7. Repeat this section for each sample. 

9.10. Stop the pump: 

9.10.1. Press the RUN/STOP button. The Run LED should turn off and pressure readings 

should decrease gradually.  

9.10.2. Monitor the pressure until it decreases to less than 100 psi. 

9.11. Wash the system by running 5 CV of storage solution: 

9.11.1. Switch the system to storage solution per the instructions in section 9.4 above. 

9.11.2. Purge the intake line and prime the pump per the instructions in section 9.5 above. 

9.11.3. Set the initial flow rate to 0.1 mL/min. 

9.11.4. Start the pump and gradually increase the flow rate to 0.5 mL/min over a period 

of 5 minutes. 

9.11.5. Operate the pump for 30 minutes. Monitor pressure readings and solution level. 

9.11.6. Stop the pump and allow the pressure to decrease to less than 100 psi. 

9.12. Power down the system: 

9.12.1. Exit PeakSimple by selecting File > Exit from the menu bar. A prompt should 

appear asking Save all before exiting? Click the No button.  

9.12.2. Power down the pump units and the detectors using the red switch located on the 

power strip to the left of the pumps. 

9.12.3. Power down the Computer system. 
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10. Attachments

Figure 1. Buck Scientific BLC-20G HPLC System with Pumps and Detectors 
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Figure 2. HPLC Front Panel 

Figure 3. Purge Valve with 25 mL Luer-Lok Syringe Attached 
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Figure 4. Sample Injection Port with HLPC Syringe Attached in ‘Load’ Position 

Figures 5. Sample Injection Port Positions: ‘Load’ and ‘Inject’ 
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Table 1. Common Column Volumes 

Column 

dimension 

Column 

volume (mL) 

250 x 4.6 mm 2.91 

150 x 4.6 mm 1.74 

100 x 4.6 mm 1.16 

50 x 4.6 mm 0.58 

250 x 4.0 mm 2.20 

125 x 4.0 mm 1.10 

250 x 2.0 mm 0.55 

150 x 2.0 mm 0.33 

50 x 2.0 mm 0.11 

𝐶𝑉 =  𝜋𝑟2𝐿
where: 

CV = column volume in mL 

r = column radius in cm 

L = column length in cm 

Table 2. Example Solution Volume Calculations 

Mobile Phase solution 

Operation Calculation Volume (ml) 

Prime and purge 20 mL 20 

Increasing flow rate 0.75 mL/min * 5 min 4 

Initial equilibration 15 CV = 15 * 3 mL 45 

Assays N * flow rate * run time = 4 * 0.75 mL/min * 15 min 45 

Syringe cleaning 10 mL 10 

Re-equilibration N * 5 CV = 4 * 3 mL 12 

Reserve volume 100 mL 100 

Subtotal Sum of the above 236 

Minimum volume Subtotal * 120% 284 

Storage solution 

Operation Calculation Volume (ml) 

Prime and purge 20 mL 20 

Increasing flow rate 0.5 mL/min * 5 min 3 

Wash 15 CV = 15 * 3 mL 45 

Reserve volume 100 mL 100 

Subtotal Sum of the above 168 
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Minimum volume Subtotal * 120% 202 

Equation 1. Example Run Time Calculations 

𝑅𝑢𝑛 𝑣𝑜𝑙𝑢𝑚𝑒 = 15 𝐶𝑉 

𝐶𝑜𝑙𝑢𝑚𝑛 𝑣𝑜𝑙𝑢𝑚𝑒 (𝐶𝑉) = 3 𝑚𝐿 

𝐹𝑙𝑜𝑤 𝑟𝑎𝑡𝑒 =  0.75 𝑚𝑙/𝑚𝑖𝑛 

𝑅𝑢𝑛 𝑡𝑖𝑚𝑒 =
𝑅𝑢𝑛 𝑣𝑜𝑙𝑢𝑚𝑒

𝐹𝑙𝑜𝑤 𝑟𝑎𝑡𝑒
=

15 𝐶𝑉 ∗  3 𝑚𝐿/𝐶𝑉

0.75 𝑚𝐿/𝑚𝑖𝑛
= 60 𝑚𝑖𝑛. 

Table 3. Example Flow Rates & Pressure Readings for Ultra C8 5μm 250 X 4.6mm Column (Restek) 

Mobile Phase Solution Flow Rate (mL/min) Pressure Readings (psi) 

50% MeOH/H2O 0.5 ~1450 

11. History

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 17JUL15 John Buford, 

Jason McMillan, 

Jack O’Neill 

Initial release 
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1. Purpose

1.1. Characterization of Green Fluorescent Protein (GFP) in a sample using a Buck Scientific

BLC-30G HPLC Gradient system. The GFP is detected using both UV-Vis and 

Fluorescence detectors. 

2. Scope and Applicability

2.1.  High performance liquid chromatography (HPLC) is an analytical chemistry technique

that separates the components of a liquid sample to assist in the identification and 

quantification of the components within the sample. This Process SOP makes use of 

reverse-phase HPLC to separate the constituents of a GFP sample on a Restek C8 

column in a 50% MeOH/H2O mobile phase. This SOP details the HPLC column 

selection, flow rates, operational run times, mobile phase and sample preparations to 

perform this separation.  

3. Summary of Method

3.1. Prepare a mobile phase solution of 50% MeOH/H2O

3.2. Power up the BLC-30G HPLC system and equilibrate the HPLC with the mobile phase

3.3. Set the parameters for the detectors.

3.4. Prepare the assay sample in the mobile phase.

3.5. Set the assay conditions.

3.6. Run an assay for each of the samples and record the data

3.7. Wash the system with mobile phase solution

3.8. Power down the system

4. References

4.1. SOP: Degassing a Solution by Helium Sparge, document number QCB 6, revision 0,

effective 25SEP13. 

4.2. SOP: Buck Scientific BLC-30G HPLC Operation, QCB 9, revision 0, effective 17JUL15 

5. Definitions

CV Column Volume; the volume (mL) of the column containing the stationary 

phase; CV=2.91 mL for a standard size (4.6 X 250 mm) column 

Equilibration Running the mobile phase solution through the column prior to injecting 

the sample in order to bring the system into equilibrium  

Flow rate The rate (mL/min) that liquid solution is pumped through the column. The 

operating flow rate is determined by the assay protocol. 

Fluorescence 

detector, FL 

A detector that measures the emitted light from the sample cell. The 

emitted light is of higher wavelength (lower in energy) than that of 

excitation wavelength. 
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Gradient The composition of the mobile phase is variable; the system has two 

pumps 

Helium sparge Using a stream of helium bubbles to sweep dissolved air out of liquids 

(helium is virtually insoluble in most HPLC solvent solutions, so very 

little helium replaces the air) 

HPLC High Performance Liquid Chromatography 

Mobile phase The solvent solution used to carry the sample through the column 

PeakSimple  Software used to collect and display data  

PSI Pounds per Square Inch 

Reverse Phase 

chromatography 

Separation based on hydrophobicity under conditions where the stationary 

phase is more hydrophobic than the mobile phase.  

Stationary 

phase 

The chromatography matrix through which the sample travels.  

UV-Vis detector A detector that measures the % transmitted light across the sample cell and 

converts it to Absorbance, ABS.  The detector wavelength is variable.  

6. Precautions

6.1. Wear personal protection equipment (PPE) and use a fume hood as required.

6.2. Use HPLC-grade solvents and filter solutions with a sub-micron filter (preferably 0.22

μm). Degas solutions prior to use.  

6.3. Methanol is flammable. Can cause blindness if swallowed. Vapor is harmful. Irritating to 

skin and eyes. Read the Material Safety Data Sheet (MSDS) for additional hazards, 

handling and storage information. Store solvents as indicated by the MSDSs. 

6.4. HPLC systems operate at high pressures. Personnel injury and equipment damage can 

result if maximum pressure is exceeded or the pump runs dry. Monitor pressure readings 

and solution level whenever the pump is running. If pressure exceeds 2500 psi or if the 

solution runs out, stop the pump immediately by pressing the RUN/STOP button. Do not 

set the flow rate higher than 1.5 ml/min with a 250 mm column. 

6.5. To avoid microbial growth, do not leave the system in a high aqueous solution for a 

prolonged period. The system should be washed with a storage solution of 50% 

Methanol/H20 or 50% Acetonitrile/H20 if it is to be idle more than a few hours. 

7. Responsibilities

7.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary.  

7.2. It is the responsibility of the students/technician to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while performing 

the procedure.  

8. Equipment and Materials

8.1. Buck Scientific BLC-30G HPLC system pre-configured with:

8.1.1. UV-Vis detector 

8.1.2. Fluorescence Detector (optional) 
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8.1.3. PeakSimple Chromatography Data System 

8.1.4. Computer system with PeakSimple software installed 

8.1.5. Restek Ultra C8 5μm 250 X 4.6mm HPLC column  

8.2. Analytic balance 

8.3. Assorted micropipettes 

8.4. Green Fluorescent Protein sample 

8.5. HPLC-grade methanol to prepare the mobile phase solution 

8.6. HPLC-grade water to prepare the mobile phase solution 

8.7. Nalgene Rapid-flow filtration unit with sub-micron filters (preferably 0.22 μm), that is 

chemically compatible with the mobile phase 

8.8. Parafilm  

8.9. Stirring plate 

8.10. Timer 

8.11. 2 – 50 mL laboratory beakers (for overflow waste and to rinse the sample syringe) 

8.12. 2 – 500 mL laboratory bottles (for mobile phase solution and waste) 

8.13. 4 – microfuge tubes (for GFP and diluted GFP samples) 

8.14. 25 mL Luer-Lok syringe to purge the HPLC pumps 

8.15. 100 μL HPLC sample syringe 

8.16. 100 mL volumetric flask 

8.17. 250 mL or 500 mL graduated cylinder 

8.18. 500 mL volumetric flask 

9. Procedure

9.1. Prepare 500 mL 50% methanol/H2O mobile phase solution:

9.1.1. Measure 250 mL HPLC-grade methanol using a graduated cylinder and pour into 

a 500 mL volumetric flask. 

9.1.2. Bring to volume 500 mL with HPLC-grade H2O. Cover with parafilm and invert 

to mix. Check the volume and adjust as necessary (when methanol and water 

combine, the total volume may be slightly less than the original volumes). 

9.1.3. Filter the mobile phase solution using a Nalgene Rapid-flow filtration unit. 

Transfer approximately 10 mL of mobile phase solution to a small labeled bottle to 

be used for rinsing the sample syringe. Transfer remaining solution to a labeled 500 

mL laboratory bottle. 

9.1.4. Sparge the mobile phase with Helium per the Degassing a Solution by Helium 

Sparge SOP. 

9.1.5. Label an empty bottle as mobile phase solution waste. 

9.2. Power up the HPLC system and equilibrate with mobile phase solution: 

9.2.1. Power up the HPLC system components and start the PeakSimple data collection 

software per the Buck Scientific BLC-30G HPLC Operation SOP. 

9.2.2. Switch the system to mobile phase solution per the Buck Scientific BLC-30G 

HPLC Operation SOP. 

9.2.3. Purge the intake line and prime the pump with mobile phase solution per the Buck 

Scientific BLC-30G HPLC Operation SOP. 
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9.2.4. Set the pumps to 50% Pump A and Pump B per the Buck Scientific BLC-30G 

HPLC Operational SOP and confirm that both Pumps A & B are set at 50%. 

9.2.5. Gradually increase the flow rate to 0.5 mL/min over 5 minutes per the Buck 

Scientific BLC-30G HPLC Operation SOP. Monitor the pressure readings and 

verify that mobile phase solution is dripping into the waste bottle. 

9.2.6. Equilibrate the system with mobile phase solution at the flow rate 0.5 mL/min for 

30 minutes per the Buck Scientific BLC-30G HPLC Operational SOP. 

9.3. Set the UV-Vis detector wavelength and autozero the detector:  

9.3.1. Set the UV-Vis detector wavelength to 400 nm. After 60 minutes, autozero the 

detector per the Buck Scientific BLC-30G HPLC Operation SOP. 

9.3.2. Ensure that the UV-Vis detector warms up for 60 minutes prior to collecting data 

per the Buck Scientific BLC-30G HPLC Operation SOP. 

9.4. Prepare the GFP sample solutions: 

9.4.1. Locate the 3.74 mg/mL GFP stock solution and confirm its use for this exercise. 

9.4.2. Using micropipettes with the GFP stock, prepare 500 μL each of a 1-to-5 and 1-

to-10 GFP sample dilutions (in mobile solution) in labeled microfuge tubes. Pipette 

up and down, then cap and vortex to mix each sample. 

9.5. Set the assay conditions: 

9.5.1. For each of the GFP samples, set up an assay for 8 minutes at a flow rate of 0.5 

mL/min. 

9.5.1.1.Use PeakSimple to start a new run. 

9.5.1.2.Select File > New from the menu bar. 

9.5.1.3.Select Edit > Channels… from the menu bar. The Channels dialog box should 

appear. 

9.5.1.4.Next to Channel 1:Uv-Vis, ensure that “active,” “display” and “integrate” all 

have checks in them. 

9.5.1.5.Select “Details” 

9.5.1.6.Under the section “Control by” select “Gradient” 

9.5.1.7.Under “End Time” input a value of 8 minutes for the length of the run. 

9.5.1.8.Verify that the “Remote start” check box is checked 

9.5.1.9.Press “OK” when finished. 

9.5.1.10. Select “Gradient” 

9.5.1.11. Select “Clear” 

9.5.1.12. Select “Add” 

9.5.1.13. Enter 50 into the % field for initial gradient. 

9.5.1.14. Press “OK” when finished. 

9.5.1.15. Close the dialog boxes for Channel 1 and repeat steps 9.5.1.4-9.5.1.9 for 

Channel 2. 

9.5.1.16. Next to Channel 6, ensure that “active,” and “display” have checks in 

them. 

9.5.1.17. Select “Details” 

9.5.1.18. Ensure that “Datalogger mode” has a check in the box next to it. 

303



Montgomery County Community College 

340 DeKalb Pike 

Document Number: 60.2.0 

Revision Number:  2 

Blue Bell, PA Effective Date: 17JUL15 

Page 5 of 8 

SOP: Characterization of Green Fluorescent Protein using BLC-

30G HPLC System 

9.5.1.19. Ensure Offset = 0 

9.5.1.20. Ensure Gain = 1 

9.5.1.21. Ensure Decimal Places = 0 

9.5.1.22. Under “End Time” input a value of 8 minutes for the length of the run. 

9.5.1.23. Press “OK” when finished. 

9.5.1.24. Press “OK” to close the Channels window. 

9.6. For each sample, run an assay: 

9.6.1. For each of the GFP samples, run an assay for 8 minutes at a flow rate of 0.5 

mL/min. 

9.6.1.1.Use PeakSimple to start a new 8 minute run. 

9.6.1.2.Autozero the UV-Vis detector. 

9.6.2. Load and inject a 100L GFP sample using a syringe as per the Buck Scientific 

BLC-30G HPLC Operation SOP. 

9.6.2.1.1. Verify that the injector port handle is set to the “Load” position. 

9.6.2.1.2. Fill the HPLC sample syringe with 100 μL of sample, using care to 

avoid bubbles in the syringe. 

9.6.2.1.3. Insert the syringe needle into the sample injection port (Figure 3). 

9.6.2.1.4. Depress the syringe plunger, using care to avoid introducing bubbles. 

(Often there is a small bubble at the base of the plunger. Watch carefully 

and stop depressing the plunger before the bubble is loaded into the 

injector port. It is OK to leave a few μL of sample in the syringe.) 

9.6.2.1.5. Turn the injector port handle clockwise from the “Load” to the 

“Inject” position (Figure 4). Turning the port will engage the PeakSimple 

software to START the assay and the elapsed run time will display in 

upper right corner. Leave the port in the “Inject” position.  

9.6.2.1.6. After 10 seconds, turn the injector port handle counter-clockwise from 

the “Inject” position back to the “Load” position. 

9.6.2.2.Remove the syringe from the sample injection port. 

9.6.2.3.Rinse the syringe by filling it from the small bottle of mobile phase solution 

and expelling it into the mobile phase waste bottle at least three times. 

9.6.2.4.Operate the pump for 8 minutes at 0.5 mL/min. At the end of the assay run, 

the PeakSimple elapsed time switches to STANDBY mode in the upper corner. 

9.7. For each assay, view the results and collect/save the data: 

9.7.1. Identify/save both the GFP peak/s of interest on the chromatographs and the 

retention times for each sample run. 

9.7.1.1.Select View > Results… from the menu bar. The Results dialog box should 

appear. 

9.7.1.2.Click the Copy button to copy the data. 

9.7.1.3.Paste the data into an Excel spreadsheet. 

9.7.1.4.Close the Results dialog box. 

9.7.2. Select File > Save as… from the menu bar. The Save as dialog box should appear. 

Save the data to a separate chromatogram file. 
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9.7.2.1.Enter a directory and a meaningful file name (e.g. operator initials, experiment 

name, and run number). Click the Save button. 

9.8. Repeat assay.  

9.8.1. Repeat another assay sample run as per 9.6 until each sample has been placed 

across the column 

9.9. Wash the system with 5 CV of mobile phase as per Buck Scientific BLC-30G HPLC 

Operational SOP 

10. Compute data for the GFP samples:

10.1.1. Document the retention time and peak heights of the GFP samples using Excel. 

11. Stop the pump and allow the pressure to decrease to 0 per the Buck Scientific BLC-30G

HPLC HPLC Operation SOP. 

12. Power down the system per the Buck Scientific BLC-30G HPLC HPLC Operational SOP.

13. Attachments

Figure 1. Buck Scientific BLC-20G HPLC System with Pumps and Detectors 
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Figure 2. HPLC Front Panel 

Figure 3. HLPC Syringe in the Sample Injection Port in the ‘Load’ Position 
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Figures 4. Sample Injection Port Positions: ‘Load’ and ‘Inject’ 

14. History

Revision 

Number 

Effective 

Date Preparer Description of Change 

0 17JUL15 John Buford, 
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Initial release 
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Reviewer: Jack O’Neill        Date: 24OCT13 

1. Purpose

1.1. Measure the light absorbance of microliter (µL) samples using a NanoDrop 2000

spectrophotometer in order to analyze ultraviolet and visible light spectral signature and 

to quantify DNA and protein content based on spectral signature.  

2. Scope and Applicability

2.1.  A spectrophotometer transmits known wavelengths of light through a sample and

measure the amount of light absorbed by the sample. Nucleic acids (such as DNA) and 

proteins absorb light at the 260 nm and 280 nm respectively, so a spectrophotometer can 

be used to quantify the DNA and protein content of a sample. This SOP describes the 

general operation of the NanoDrop 2000 spectrophotometer and its use to measure DNA 

concentration, protein concentration, and ultraviolet-visible (UV-Vis) light absorption. 

3. Summary of Method

3.1. Connect and power up the spectrophotometer to a PC.

3.2. Launch the NanoDrop 2000 software interface.

3.3. Apply 2 µL blank solution onto the lower pedestal and initiate a blank measurement.

3.4. Wipe the blank from both the upper and lower pedestals using a clean lint-free

laboratory wipe. 

3.5. Apply 2 µL sample solution onto the lower pedestal and initiate a spectral measurement. 

3.6. Wipe the sample from both the upper and lower pedestals using a clean lint-free 

laboratory wipe. 

4. References

4.1. Thermo Scientific NanoDrop 2000/2000c Spectrophotometer V1.0 User Manual

5. Definitions

Spectrophotometer an instrument for measuring light intensity of known light wavelengths 

UV-Vis Ultraviolet and visible light 

6. Precautions

6.1. The NanoDrop 2000 spectrophotometer contains no user serviceable parts; do not open.

7. Responsibilities

7.1. It is the responsibility of the course instructor/lab assistant to ensure that this SOP is

performed as described and to update the procedure when necessary.  

7.2. It is the responsibility of the students/technician to follow the SOP as described and to 

inform the instructor about any deviations or problems that may occur while 

performing the procedure.  

8. Equipment and Materials

8.1. NanoDrop 2000 spectrophotometer

8.2. 12V power supply
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8.3. PC with NanoDrop 2000/2000c software interface installed 

8.4. Precision micropipette (2 µL or 10 µL) and micropipette tips 

8.5. Laboratory grade water (dH2O) 

8.6. Sample solution(s) 

8.7. Blank solution 

8.8. Lint-free laboratory wipes (e.g. Kimwipes) 

9. Procedure

9.1. Connecting and powering up the spectrophotometer

9.1.1. Connect the USB cable to the NanoDrop 2000 spectrophotometer. 

9.1.2. Plug in the 12V power supply and connect to the power input at the back of the 

spectrophotometer. (The power supply may remain plugged into the 

spectrophotometer while not in use.) 

9.2. Launching the NanoDrop 2000 software interface 
9.2.1. Double click the NanoDrop 2000 icon of the desktop. 

9.2.2. Alternatively, select Start > All Programs > Thermo Scientific NanoDrop 2000 > 

NanoDrop 2000. 

9.2.3. The Home window should appear, containing task options on the left pane (e.g. 

Home, My Data, Diagnostics) and application buttons on the right pane (e.g. 

Nucleic Acid, Protein A280, UV-Vis). 

9.2.4. Selecting a task option or application replaces the Home window with a window 

for that specific task or application. 

9.2.5. To return to the Home window from any other window, select the “Home” task 

option from the left pane. 

9.3. Basic use of the pedestal 
9.3.1. Raise the sampling arm. 

9.3.2. Apply 2 µL solution onto the lower pedestal using a micropipette. 

9.3.3. Lower the sampling arm. 

9.3.4. Initiate a spectral measurement using the PC software interface. 

9.3.5. When measurement is complete, raise the sampling arm and wipe the solution 

from both the upper and lower pedestals using a clean lint-free laboratory wipe. 

9.3.6. Lower the sampling arm. 

9.3.7. Leave the sampling arm in the down position between uses. 

9.4. Pedestal cleaning 
9.4.1. Use dH2O to clean the measurement surfaces before the first sample measurement 

and after the last sample measurement. 

9.4.2. Raise the sampling arm. 

9.4.3. Apply 3-5 µL dH2O onto the lower pedestal using a micropipette. 

9.4.4. Lower the sampling arm. 

9.4.5. Let sit for approximately 2-3 minutes. 

9.4.6. Raise the sampling arm and wipe the dH2O from both the upper and lower 

pedestals using a clean lint-free laboratory wipe. 

9.4.7. Lower the sampling arm. 

9.4.8. Generally, it is not necessary to clean with dH2O between samples. 

9.5. Performing an intensity check 
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9.5.1. At regular intervals (weekly or monthly), confirm that the internal spectrometer is 

functioning as expected. 

9.5.2. Select the “Diagnostic” task from the Home window.  

9.5.3. Select the “Intensity Check” task. 

9.5.4. Ensure that the sampling arm is down. 

9.5.5. Click “Measure”. 

9.5.6. If yellow triangles are displayed in the top left of the spectral display, clean the 

pedestal and then repeat the intensity check. 

9.5.7. Return to the Home window by selecting the “Home” task option from the left 

pane. 

9.6. Measuring DNA concentration 
9.6.1. Select the “Nucleic Acid” application from the Home window.  

9.6.2. If the wavelength verification window appears, ensure that the sampling arm is 

down and click OK. 

9.6.3. Select File > New Workbook, enter a filename and directory, then click Save. 

9.6.3.1.(Optional) Select the type of sample to be measured from the “Type” drop-

down list (the default is DNA-50). 

9.6.4. Select the “Add to report” checkbox to include measurements in the current 

report. 

9.6.5. Select the “Overlay spectra” checkbox if more than one sample is to be measured 

and displayed on the same spectral graph. 

9.6.6. Establish a blank using the appropriate blank solution: 

9.6.6.1.Apply 2 µL blank solution onto the lower pedestal per 9.3 Basic use of the 

pedestal. 

9.6.6.2.Click the “Blank” button. 

9.6.6.3. When the blank measurement is complete, wipe the blank solution from both 

the upper and lower pedestals using a clean lint-free laboratory wipe per 9.3 

Basic use of the pedestal. 

9.6.7. Measure each sample: 

9.6.7.1.Enter a sample ID in the “Sample ID” field. 

9.6.7.2.Apply 2 µL sample solution onto the lower pedestal per 9.3 Basic use of the 

pedestal. 

9.6.7.3.Click the “Measure” button. 

9.6.7.4. When the sample measurement is complete, wipe the sample solution from 

both the upper and lower pedestals per 9.3 Basic use of the pedestal. 

9.6.7.5.Repeat with the next sample solution if more than one sample is to be 

measured and displayed on the same spectral graph. 

9.6.8. Click the “Print” button to print the spectral display. Alternatively, select the 

Reports task option to format and print a report. 

9.6.9. Save the data and return to the Home window by selecting File > Close 

Workbook and go Home. 

9.6.10. After the last sample of the day, clean the pedestal per 9.4 Pedestal cleaning. 
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9.7. Measuring protein concentration 
9.7.1. Select the “Protein A280” application from the Home window.  

9.7.2. If the wavelength verification window appears, ensure that the sampling arm is 

down and click OK. 

9.7.3. Select File > New Workbook, enter a filename and directory, then click Save. 

9.7.3.1.(Optional) Select the type of sample to be measured from the “Type” drop-

down list (the default is 1 Abs = 1 mg/mL). 

9.7.4. Select the “Add to report” checkbox to include measurements in the current 

report. 

9.7.5. Select the “Overlay spectra” checkbox if more than one sample is to be measured 

and displayed on the same spectral graph. 

9.7.6. Establish a blank using the appropriate blank solution: 

9.7.6.1.Apply 2 µL blank solution onto the lower pedestal per 9.3 Basic use of the 

pedestal. 

9.7.6.2.Click the “Blank” button. 

9.7.6.3. When the blank measurement is complete, wipe the blank solution from both 

the upper and lower pedestals using a clean lint-free laboratory wipe per 9.3 

Basic use of the pedestal. 

9.7.7. Measure each sample: 

9.7.7.1.Enter a sample ID in the “Sample ID” field. 

9.7.7.2.Apply 2 µL sample solution onto the lower pedestal per 9.3 Basic use of the 

pedestal. 

9.7.7.3.Click the “Measure” button. 

9.7.7.4. When the sample measurement is complete, wipe the sample solution from 

both the upper and lower pedestals per 9.3 Basic use of the pedestal. 

9.7.7.5.Repeat with the next sample solution if more than one sample is to be 

measured and displayed on the same spectral graph. 

9.7.8. Click the “Print” button to print the spectral display. Alternatively, select the 

Reports task option to format and print a report. 

9.7.9. Save the data and return to the Home window by selecting File > Close 

Workbook and go Home. 

9.7.10. After the last sample of the day, clean the pedestal per 9.4 Pedestal cleaning. 

9.8. Measuring UV-Vis absorbance 
9.8.1. Select the “UV-Vis” application from the Home window.  

9.8.2. If the wavelength verification window appears, ensure that the sampling arm is 

down and click OK. 

9.8.3. Select File > New Workbook, enter a filename and directory, then click Save. 

9.8.4. Enter up to 40 wavelengths of interest in the “nm – Add wavelength(s)” list:  

9.8.4.1.Select the first row, enter a wavelength (in nm), then press the Entry key.  

9.8.4.2.Continue entering values until all wavelengths of interest have been added. 

9.8.4.3.A wavelength can be cleared by selecting the wavelength, then clicking the 

“Clear Wavelength” button. 

9.8.5. Select the “Add to report” checkbox to include measurements in the current 

report. 
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9.8.6. Select the “Overlay spectra” checkbox if more than one sample is to be measured 

and displayed on the same spectral graph. 

9.8.7. Establish a blank using the appropriate blank solution: 

9.8.7.1.Apply 2 µL blank solution onto the lower pedestal per 9.3 Basic use of the 

pedestal. 

9.8.7.2.Click the “Blank” button. 

9.8.7.3. When the blank measurement is complete, wipe the blank solution from both 

the upper and lower pedestals using a clean lint-free laboratory wipe per 9.3 

Basic use of the pedestal. 

9.8.8. Measure each sample: 

9.8.8.1.Enter a sample ID in the “Sample ID” field. 

9.8.8.2.Apply 2 µL sample solution onto the lower pedestal per 9.3 Basic use of the 

pedestal. 

9.8.8.3.Click the “Measure” button. 

9.8.8.4. When the sample measurement is complete, wipe the sample solution from 

both the upper and lower pedestals per 9.3 Basic use of the pedestal. 

9.8.8.5.Repeat with the next sample solution if more than one sample is to be 

measured and displayed on the same spectral graph. 

9.8.9. Click the “Print” button to print the spectral display. Alternatively, select the 

Reports task option to format and print a report. 

9.8.10. Save the data and return to the Home window by selecting File > Close 

Workbook and go Home. 

9.8.11. After the last sample of the day, clean the pedestal per 9.4 Pedestal cleaning. 
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10. Attachments

Figure 1. NanoDrop 2000 Spectrophotometer 

Sampling 

arm 

Lower 

pedestal 

Upper 

pedestal 
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Figure 2. Applying solution onto the lower pedestal 
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Figure 3. DNA Concentration Spectral Graph 

Figure 4. Protein Concentration Spectral Graph 
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Figure 5. UV-Vis Spectral Graph 

11. History
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Date Preparer Description of Change 
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